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Sicherheitshinweise

Zum Schutz von Personal und Geraten finden Sie in der gesamten Betriebsanleitung entsprechende Sicherheitshinweise. Lesen Sie
diese Sicherheitshinweise sorgféltig durch, bevor Sie mit dem nachsten Schritt fortfahren.
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Erste Schritte

Teil |
Erste Schritte

In diesem Teil enthaltene Kapitel:

e Einfiihrung
. Schnellstart
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Einfiihrung

1.1

1.2

1.3

Einfihrung

In diesem Kapitel behandelte Themen:

e Informationen (ber diese Betriebsanleitung
*  Modellcode der Auswerteelektronik

*  Kommunikations-Hilfsmittel und -protokolle
e Zusdtzliche Dokumentation und Ressourcen

Informationen iiber diese Betriebsanleitung

Dieses Handbuch enthélt Informationen (iber die Konfiguration, Inbetriebnahme,
Verwendung, Wartung und Stérungssuche der Micro Motion Modell 2500Modell 2700
Auswerteelektronik.

Wichtig

Dieses Handbuch setzt voraus, dass die Auswerteelektronik richtig und vollstdndig gemaR den
Anweisungen im entsprechenden Installationshandbuch installiert wurde, und dass die Installation
alle geltenden Sicherheitsanforderungen erfiillt.

Modellcode der Auswerteelektronik

Ihre Auswerteelektronik kann anhand der Modellnummer auf dem Typenschild
identifiziert werden.

Die Auswerteelektronik hat eine Modellnummer in folgender Form:
2500D**B****** oder 2500D* *C* * * ***

D DIN Tragschienenmontage
B Konfigurierbare Ein-/Ausgadnge, voreingestellte Konfiguration (2x mA, 1x Frequenz)
C Konfigurierbare Ein-/Ausgdnge, vom Anwender zu spezifizierende Konfiguration

Kommunikations-Hilfsmittel und -protokolle

Eine Verbindung mit der Auswerteelektronik kann nur mit einem Kommunikations-
Hilfsmittel hergestellt werden. Es werden mehrere unterschiedliche Kommunikations-
Hilfsmittel und -protokolle unterstiitzt. Es konnen unterschiedliche Hilfsmittel an
unterschiedlichen Standorten fiir unterschiedliche Aufgaben verwendet werden.
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Tabelle 1-1: Kommunikations-Hilfsmittel, -protokolle und zugehorige Informationen

Kommunika-
tions-Hilfsmit-
tel

Unterstiitzte Proto-
kolle

Anwendungsbereich

In dieser Betriebsan-
leitung

Weitere Informatio-
nen

ProLink II

e HART/Bell 202
e Modbus/RS-485
e Service Port

Vollstandige Konfigura-
tion und Inbetrieb-
nahme

Basis-Benutzerinforma-
tionen. Siehe Anhang A.

Betriebsanleitung

e Mit der Software in-
stalliert

¢ Auf Micro Motion
Benutzerdokumen-
tations-CD

¢ Auf Micro Motion
Website (www.mi-
cromotion.com)

ProLink Il

e HART/Bell 202
e Modbus/RS-485
e Service Port

Vollstandige Konfigura-
tion und Inbetrieb-
nahme

Grundlegende Benut-
zerinformationen. Siehe
Anhang B.

Betriebsanleitung

e Mitder Software in-
stalliert

¢ Auf Micro Motion
Benutzerdokumen-
tations-CD

e Auf Micro Motion
Website (www.mi-
cromotion.com)

Handterminal

HART/Bell 202

Vollstandige Konfigura-
tion und Inbetrieb-
nahme

Grundlegende Benut-
zerinformationen. Siehe
Anhang C.

Betriebsanleitung auf
Micro Motion Website
(www.micromo-
tion.com

1.4

Hinweis

Moglicherweise konnen andere Kommunikations-Hilfsmittel von Emerson Process Management
verwendet werden, wie AMS Suite: Intelligent Device Manager oder der Smart Wireless THUM™
Adapter. Die Verwendung des Smart Wireless THUM Adapters wird in diesem Handbuch nicht
behandelt. Das AMS Interface dhnelt dem ProLink Il Interface. Weitere Informationen zum Smart
Wireless THUM Adapter finden Sie in der Dokumentation unter www.micromotion.com.

Zusatzliche Dokumentation und Ressourcen

Micro Motion bieten eine zusdtzliche Dokumentation, um die Installation und den Betrieb
der Auswerteelektronik zu untersttitzen.

Tabelle 1-2: Zusatzliche Dokumentation und Ressourcen

Thema

Dokument

Sensor

Sensor Dokumentation

Auswerteelektronik In-
stallation

Micro Motion Auswerteelektronik Modell 1500 und Modell 2500: Installa-

tionsanleitung
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Tabelle 1-2: Zusatzliche Dokumentation und Ressourcen (Fortsetzung)

Thema Dokument
Installation im Ex-Be- Weitere Informationen sind in der mit der Auswerteelektronik geliefert-
reich en Zulassungsdokumentation zu finden oder alternativ kann die en-

tsprechende Dokumentation auch von der Website Micro Motion unter
www.micromotion.com herunterladen werden.

Alle Dokumentationsressourcen sind auf der Website Micro Motion unter
www.micromotion.com oder auf der Micro Motion Anwender Dokumentations-CD zu

finden.
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2.1

2.2

Schnellstart

In diesem Kapitel behandelte Themen:

*  Einschalten der Auswerteelektronik

e Status des Durchfluss-Messsystems priifen

. Herstellen einer Inbetriebnahme Verbindung mit der Auswerteelektronik
e Charakterisieren des Durchfluss-Messsystems (falls erforderlich)

. Verifizieren der Massedurchflussmessung

»  Verifizieren des Nullpunkts

Einschalten der Auswerteelektronik

Die Auswerteelektronik muss fiir alle Konfigurations- und Inbetriebnahmeaufgaben sowie
fiir Prozessmessungen eingeschaltet sein.

1. Stellen Sie sicher, dass alle Auswerteelektronik und Sensor Gehdusedeckel sowie
Verschliisse geschlossen sind.

A\ VORSICHT!

Sicherstellen, dass alle Gehdusedeckel und Dichtungen dicht verschlossen sind, um eine
Entziindung in einer brennbaren Umgebung zu vermeiden. Bei Installationen in
explosionsgefdahrdeten Bereichen und mit ge6ffneten Gehdusedeckeln kann das
Einschalten der Stromversorgung zu einer Explosion fiihren.

2. Schalten Sie die Spannungsversorgung ein.

Die Auswerteelektronik fiihrt automatisch Diagnoseroutinen durch. In dieser
Zeitspanne ist Alarm 009 aktiv. Die Diagnoseroutinen sind in ungefahr 30 Sekunden
abgeschlossen. Die Status-LED wechselt auf griin wenn die Inbetriebnahme
Diagnose beendet ist. Zeigt die Status-LED ein abweichendes Verhalten, liegt eine
Alarmbedingung vor.

Nachbereitungsverfahren

Obwohl der Sensor bereits kurz nach dem Startvorgang das Prozessmedium verarbeiten
kann, kann die Elektronik bis zu 10 Minuten bend&tigen, um ein thermisches Gleichgewicht
zu erreichen. Aus diesem Grund kann es bei dem erstmaligen Startvorgang bzw. bei einer
Abschaltung, die so lange gedauert hat, dass die Komponenten die
Umgebungstemperatur annehmen konnten, ungefdhr 10 Minuten dauern, bis sich die
Elektronik erwarmt hat und zuverldssige Prozessmessungen liefert. Wahrend dieser
Warmlaufphase kann es sein, dass Sie geringfligige Instabilititen oder Ungenauigkeiten
der Messung feststellen.

Status des Durchfluss-Messsystems priifen

Das Durchfluss-Messsystem auf jegliche Stérbedingungen priifen, die eine Aktion des
Anwenders erforderlich machen oder die die Messgenauigkeit beeinflussen.
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Ca. 10 Sekunden warten, bis der Startvorgang abgeschlossen ist.

Sofort nach dem Startvorgang durchlauft die Auswerteelektronik Diagnoseroutinen
und priift auf Stérbedingungen. Wahrend des Startvorgangs ist Alarm A009 aktiv.
Dieser Alarm sollte nach dem Startvorgang automatisch geléscht werden.

Priifen Sie die Status-LED an der Auswerteelektronik.

Tabelle 2-1: Durch die Status-LED angezeigter Status der Auswerteelektronik

LED-Status Beschreibung Empfehlung
griin Es sind keine Alarme aktiv. Es kann mit der Mit der Konfiguration oder der Prozessmes-
Konfiguration oder der Prozessmessung for- sung fortfahren.
tgefahren werden.
gelb Es ist mindestens ein Alarm niedriger Stufe ak- | Eine Alarmbedingung niedriger Stufe wirkt
tiv. sich nicht auf die Genauigkeit oder das Aus-
gangsverhalten aus. Es kann mit der Konfigu-
ration oder der Prozessmessung fortgefahren
werden. Falls erforderlich, kann die Alarmbe-
dingung identifiziert und behoben werden.
rot Es ist mindestens ein Alarm hoher Stufe aktiv. | Eine Alarmbedingung hoher Stufe wirkt sich

auf die Genauigkeit oder das Ausgangsverhal-
ten aus. Die Alarmbedingungen vor dem For-
tfahren korrigieren.

2.3

Nachbereitungsverfahren

Weitere Informationen bzgl. der Anzeige der Liste aktiver Alarme sind unter Abschnitt 9.4
zu finden.

Weitere Informationen bzgl. der einzelnen Alarme und empfohlener MaRnahmen sind
unter Abschnitt 12.2 zu finden.

Herstellen einer Inbetriebnahme Verbindung
mit der Auswerteelektronik

Es muss eine aktive Verbindung von einem Kommunikations-Hilfsmittel vorhanden sein,
um die Auswerteelektronik konfigurieren zu kénnen. Diesem Verfahren folgen, um die
erste Verbindung zu der Auswerteelektronik herzustellen.

Den anzuwendenden Verbindungstyp identifizieren und den Anweisungen fiir diesen
Verbindungstyp im entsprechenden Anhang folgen. Die im Anhang aufgefiihrten
Standard-Kommunikationsparameter verwenden.

Zu verwendender Verbin-

Kommunikations-Hilfsmittel

dungstyp

Anweisungen

ProLink Il Modbus/RS-485 Anhang A
ProLink Il Modbus/RS-485 Anhang B
Handterminal HART Anhang C

MicroMotion® Auswerteelektronik Modell 2500 mit konfigurierbaren Ein-/Ausgéngen
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2.4

Konfigurations- und Bedienungsanleitung

Nachbereitungsverfahren
(Optional) Die Kommunikationsparameter auf die standortspezifischen Werte andern.

Andern der Kommunikationsparameter mittels ProLink II:

. ProLink > Configuration > RS-485 auswahlen, um das Protokoll, die Baudrate, die Paritat
oder die Stoppbits zu dndern.

. ProLink > Configuration > Device auswdhlen, um die Adresse zu dndern.

Device Tools > Configuration > Communications auswahlen, um die Kommunikationsparameter
mittels ProLink Ill zu &ndern.

On-Line Menu > Configure > Manual Setup > Inputs/Outputs > Communications auswahlen, um die
Kommunikationsparameter mittels Handterminal zu dndern.

Wichtig

Wenn die Kommunikationsparameter fiir den verwendeten Verbindungstyp gedndert werden, geht
die Verbindung beim Schreiben der Parameter auf die Auswerteelektronik verloren. Eine erneute
Verbindung mit den neuen Parametern herstellen.

Charakterisieren des Durchfluss-Messsystems
(falls erforderlich)

ProLink Il *  ProLink > Configuration > Device > Sensor Type
¢ ProLink > Configuration > Flow

e ProLink > Configuration > Density

e ProLink > Configuration > T Series

ProLink Il Device Tools > Calibration Data
Handterminal Configure > Manual Setup > Characterize
Uberblick

Die Charakterisierung des Durchfluss-Messsystems passt die Auswerteelektronik an die
spezifischen Eigenschaften des angeschlossenen Sensors an. Die
Charakterisierungsparameter (auch Kalibrierparameter genannt) stellen die
Sensorempfindlichkeit beziiglich Durchfluss, Dichte und Temperatur dar. Abhangig vom
Sensortyp sind unterschiedliche Parameter erforderlich. Die fiir den Sensor zutreffenden
Werte von Micro Motion sind auf dem Typenschild des Sensors oder dem Kalibrierzertifikat
abzulesen.

Hinweis
Wenn das Durchfluss-Messsystem als eine Einheit bestellt wurde, wurde die Charakterisierung
bereits ab Werk vorgenommen. Die Charakterisierungsparameter sollten trotzdem Gberpriift
werden.

Verfahren
1. Sensor Type spezifizieren.

e Straight-tube (T-Serie)
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2.4.1

 Curved-tube (alle Sensoren auBer T-Serie)
2. Die Durchfluss Charakterisierungsparameter einstellen. Darauf achten, dass alle
Kommastellen beriicksichtigt werden.

* Bei Geradrohrsensoren FCF (Flow Cal oder Flow Calibration Factor), FTG und FFQ
einstellen.

 Bei Sensoren mit gebogenem Rohr Flow Cal (Flow Calibration Factor) einstellen.

3.  Die Dichte Charakterisierungsparameter einstellen.

e Bei Geradrohrsensoren D1, D2, DT, DTG, K1, K2, FD, DFQ1 und DFQ2 einstellen.

 Bei Sensoren mit gebogenem Rohr D1, D2, TC, K1, K2 und FD einstellen. (TC wird
manchmal als DT angezeigt.)

Beispiel Sensor Typenschilder

Abbildung 2-1: Typenschild an dlteren Sensoren mit gebogenem Messrohr (alle
Sensoren aulBer T-Serie)

oMAX. PRESSURE RATING Al
oMAX. PRESSURE RATING Al

=5

r N
Sensor S/N
Meter Type
Meter Factor
Flow Cal Factor 19.0005.13

Dens Cal Factor 12500142864.44
Cal Factor Ref to 0°C

TEMP °C

TUBE * CONN % *

25'C, ACCORDING TO ASME B31.3.
25'C, ACCORDING TO ANSI/ASME B16.5 OR MFR'S RATING.

J

Abbildung 2-2: Typenschild an neueren Sensoren mit gebogenem Messrohr (alle

Sensoren auf3er T-Serie)

(MODEL

S/N

\

FLOW CALx 19.0005.13
DENS CAL* 12502142824 .44

D1 0.0010
D2 0.9980

K1 12502.000
K2 14282.000

TC 4.44000 FD 310

TEMP RANGE

TO

C

TUBE * %

CONN** % CASE * %

« GALIBRATION FACTORS REFERENCE T0 0 C*
s« NAXIMUM PRESSURE RATING AT 25 C, ACCCRDING TG ASME B31.3
C* NAXINUM PRESSURE RATING AT 25¢. ACCORDING TO ANSI/ZASME B16.5 OR MFR‘S RATING

4/
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2.4.2

Konfigurations- und Bedienungsanleitung

Abbildung 2-3: Typenschild an élteren Sensoren mit geradem Messrohr (T-Serie)

4 )
MODEL T100T628SCAZEZZ7Z S/N 1234567890

FLOW FCF X.XXXX FT X XX
FTG X.XX FFQ X XX
DENS D1 X.XXXXX K1 XXXXX . XXX
D2 X.XXXXX K2 XXXXX . XXX
DT X.XX FD XX . XX

DTG X.XX DFQ1 XX.XX DFQ2 X.XX
TEMP RANGE -XXX TO XXX C
TUBEx*  CONNx*x  CASE=*
XXXX XXXXX XXXX XXXXXX

o MAXIAM RATING AT 25°C, ACCORDING TO ASME B31.3
oe MAXIMM PRESSURE RATING AT 25°C, ACCORDING TO ANSI/ASIE B16.5, OR WFR‘S RATING )

.

Abbildung 2-4: Typenschild an neueren Sensoren mit geradem Messrohr (T-Serie)

4 )
MODEL T100T628SCAZEZZ7Z7Z S/N 1234567890
FLOW FCF XXXX.XX.XX

FTG X.XX FFQ X . XX

DENS D1 X.XXXXX K1 XXXXX . XXX
D2 X.XXXXX K2 XXXXX . XXX
DT X.XX FD XX, XX

DTG X.XX DFQ1 XX. XX DFQ2 X.XX
TEMP RANGE —-XXX TO XXX C
TUBE* CONNx*x*  CASEx
XXXX XXXXX XXXX XXXXXX

* MAXIMUM PRESSURE RATING AT 25°C, ACCORDING TO ASME B31.3
\ #*# MAXIMUM PRESSURE RATING AT 25°C, ACCORDING TO ANSI/ASME B16.5, OR MFR‘S RATING /

Durchflusskalibrierparameter (FCF, FT)

Zur Beschreibung der Durchflusskalibrierung werden zwei separate Werte verwendet: ein
6 Zeichen langer FCF-Wert und ein 4 Zeichen langer FT-Wert. Diese stehen auf dem
Sensor-Typenschild.

Beide Werte beinhalten Dezimalpunkte. Bei der Charakterisierung konnen diese als zwei
Werte oder als eine Zahl, bestehend aus 10 Zeichen eingegeben werden. Der 10 Zeichen
lange String wird entweder Flowcal oder FCF genannt.

Wenn die FCF- und FT-Werte separat auf lhrem Sensor-Typenschild angezeigt werden und
sie einen einzelnen Wert eingeben miissen, verkniipfen Sie die beiden Werte, um den
einzelnen Parameterwert zu bilden.

Wenn lhr Sensor-Typenschild einen verkniipften Flowcal- oder FCF-Wert anzeigt und Sie die
FCF- und FT-Werte separat eingeben miissen, trennen Sie den verkniipften Wert:

o FCF = Die ersten 6 Zeichen, einschlieRlich des Dezimalpunkts

. FT = Die letzten 4 Zeichen, einschlieRlich des Dezimalpunkts

Beispiel: Verkniipfen von FCF und FT

FCF = x.xxxx

FT=yyy
Flow calibration parameter: X.xxxxy.yy
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Beispiel: Teilen des verkniipften Flowcal- oder FCF-Werts
Flow calibration parameter: x.xxxxy.yy

FCF = x.xxxx

FT=yyy

Dichtekalibrierparameter (D1, D2, K1, K2, FD, DT, TC)

Dichtekalibrierparameter sind normalerweise auf dem Sensortypenschild und dem
Kalibrierzertifikat zu finden.

Wenn das Typenschild lhres Sensors keinen D1 oder D2 Wert aufweist:

o Fiir D1 geben Sie den Dens A oder den D1 Wert vom Kalibrierzertifikat ein. Dieser
Wert ist die Betriebsdichte des Kalibriermediums mit der niedrigen Dichte.
Micro Motion verwendet Luft. Wenn Sie keinen Wert Dens A oder D1 finden, geben
Sie 0,001 g/cm?3 ein.

o Fiir D2 geben Sie den Wert Dens B oder D2 vom Kalibrierzertifikat ein. Dieser Wert ist
die Betriebsdichte des Kalibriermediums mit der h6heren Dichte. Micro Motion
verwendet Wasser. Wenn Sie keinen Wert Dens B oder D2 finden, geben Sie
0,998 g/cm? ein.

Wenn das Typenschild lhres Sensors keinen Wert K1 oder K2 aufweist:

. Fiir K1 geben Sie die ersten 5 Ziffern des Dichtekalibrierfaktors ein. Im Beispiel-
Typenschild ist dieser Wert 12500.

o Fiir K2 geben Sie die zweiten 5 Ziffern des Dichtekalibrierfaktors ein. Im Beispiel-
Typenschild ist dieser Wert 14286.

Wenn das Typenschild lhres Sensors keinen Wert FD aufweist, nehmen Sie mit dem
Micro Motion Kontakt auf.

Wenn das Typenschild Ihres Sensors keinen Wert DT oder TC aufweist, geben Sie die
letzten 3 Ziffern des Dichtekalibrierfaktors ein. Im Beispiel-Typenschild ist dieser Wert
4,44,

Verifizieren der Massedurchflussmessung

Uberpriifen Sie, ob der von der Auswerteelektronik ausgegebene Massedurchfluss korrekt
ist. Daflir kann jede beliebige Methode verwendet werden.

. Verbinden Sie die Auswerteelektronik mit ProLink Il und lesen Sie den Wert fir Mass
Flow Rate im Fenster Process Variables ab (ProLink > Process Variables).

o Verbinden Sie die Auswerteelektronik mit ProLink Ill und lesen Sie den Wert fiir Mass
Flow Rate im Bereich Process Variables ab.

o Vrbinden Sie die Auswerteelektronik mit Handterminal und lesen Sie den Wert fir
Mass Flow Rate im Meni Process Variables ab (On-Line Menu > Overview > Primary Purpose
Variables).

Nachbereitungsverfahren

Wenn der gemeldete Massedurchfluss nicht korrekt ist:
. Priifen Sie die Charakterisierungsparameter.

. Beachten Sie die Vorschlage zur Stérungsanalyse und -beseitigung bei Problemen
mit Durchflussmessungen. Siehe Abschnitt 12.3.
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2.6

2.6.1

Verifizieren des Nullpunkts

Das Verifizieren des Nullpunkts kann dabei helfen zu bestimmen, ob der gespeicherte
Nullpunkt fiir die entsprechende Anlage geeignet ist oder ob eine Nullpunktkalibrierung
vor Ort die Messgenauigkeit verbessert.

Die Nullpunktverifizierung analysiert den Nullpunktwert unter Bedingungen mit Null
Durchfluss und vergleicht diesen mit dem Nullpunktstabilitdtsbereich des Sensors. Wenn
der mittlere Nullpunktwert innerhalb eines angemessenen Bereichs liegt, ist der in der
Auswerteelektronik gespeicherte Nullpunktwert giiltig. Eine Feldkalibrierung fiihrt in
diesem Fall nicht zu einer Verbesserung der Messgenauigkeit.

Verifizieren des Nullpunkts mittels ProLink Il

Das Verifizieren des Nullpunkts kann dabei helfen zu bestimmen, ob der gespeicherte
Nullpunkt fiir die entsprechende Anlage geeignet ist oder ob eine Nullpunktkalibrierung
vor Ort die Messgenauigkeit verbessert.

Wichtig
In den meisten Fallen ist die werksseitige Nullpunktkalibrierung genauer als die im Feld. Kalibrieren
Sie den Nullpunkt des Durchflussmesssystems nicht, es sei denn:

. Anlagenverfahren erfordern eine Nullpunktkalibrierung.

. Der gespeicherte Nullpunktwert besteht das Nullpunktverifizierungsverfahren nicht.

Vorbereitungsverfahren

ProLink Il v2.94 oder hoher

Wichtig

Verifizieren bzw. kalibrieren Sie den Nullpunkt nicht, wenn ein Alarm mit hoher Prioritét aktiv ist. Das
Problem muss erst behoben werden, bevor der Nullpunkt des Durchflussmesssystems verifiziert
bzw. kalibriert wird. Sie kdnnen den Nullpunkt verifizieren bzw. kalibrieren, wenn ein Alarm mit
niedriger Prioritdt aktiv ist.

Verfahren
1. Vorbereiten des Durchflussmesssystems:
a. Lassen Sie das Durchflussmesssystem nach dem Einschalten mindestens

20 Minuten aufwdarmen.

b. Lassen Sie das Prozessmedium durch den Sensor strémen, bis die
Sensortemperatur ungefahr die normale Betriebstemperatur erreicht hat.

c. Stoppen Sie den Durchfluss durch den Sensor, indem Sie das in Flussrichtung
abwarts liegende Ventil und danach das in Flussrichtung aufwarts liegende Ventil
schlieBen (falls verfligbar).

d. Stellen Sie sicher, dass der Sensor abgesperrt ist, kein Durchfluss mehr
vorhanden ist und der Sensor vollstandig mit dem Prozessmedium gefiillt ist.

2. Wihlen Sie ProLink > Calibration > Zero Verification and Calibration > Verify Zero und warten
Sie, bis der Vorgang abgeschlossen ist.

3. Wenn die Nullpunktkalibrierung fehlschlagt:

Konfigurations- und Bedienungsanleitung 11
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a. Bestdtigen Sie, dass der Sensor vollstandig abgesperrt ist, der Durchfluss
gestoppt ist und der Sensor vollstdndig mit dem Prozessmedium gefiillt ist.

b. Stellen Sie sicher, dass durch das Prozessmedium keine Kondensationsschliage
entstehen bzw. Kondensation entsteht und es keine Partikel enthalt, die sich
absetzen kénnen.

c. Wiederholen Sie die Nullpunktverifizierung.

d. Falls sie erneut fehlschlagt, den Nullpunkt des Durchflussmesssystems
kalibrieren.

Siehe Nullpunktkalibrierung des Durchflussmesssystems bzgl. Anweisungen zur
Nullpunktkalibrierung.

Nachbereitungsverfahren

Offnen Sie die Ventile, um den normalen Durchfluss durch den Sensor wieder herzustellen.

Verifizieren des Nullpunkts mittels ProLink Il

Das Verifizieren des Nullpunkts kann dabei helfen zu bestimmen, ob der gespeicherte
Nullpunkt fiir die entsprechende Anlage geeignet ist oder ob eine Nullpunktkalibrierung
vor Ort die Messgenauigkeit verbessert.

Wichtig
In den meisten Fallen ist die werksseitige Nullpunktkalibrierung genauer als die im Feld. Kalibrieren
Sie den Nullpunkt des Durchflussmesssystems nicht, es sei denn:

. Anlagenverfahren erfordern eine Nullpunktkalibrierung.

. Der gespeicherte Nullpunktwert besteht das Nullpunktverifizierungsverfahren nicht.

Vorbereitungsverfahren

ProLink Il v1.0 mit Patch Build 31 oder neuerer Version

Wichtig

Verifizieren bzw. kalibrieren Sie den Nullpunkt nicht, wenn ein Alarm mit hoher Prioritat aktiv ist. Das
Problem muss erst behoben werden, bevor der Nullpunkt des Durchflussmesssystems verifiziert
bzw. kalibriert wird. Sie konnen den Nullpunkt verifizieren bzw. kalibrieren, wenn ein Alarm mit
niedriger Prioritdt aktiv ist.

Verfahren
1. Vorbereiten des Durchflussmesssystems:
a. Lassen Sie das Durchflussmesssystem nach dem Einschalten mindestens

20 Minuten aufwdrmen.

b. Lassen Sie das Prozessmedium durch den Sensor stromen, bis die
Sensortemperatur ungefahr die normale Betriebstemperatur erreicht hat.

c. Stoppen Sie den Durchfluss durch den Sensor, indem Sie das in Flussrichtung
abwarts liegende Ventil und danach das in Flussrichtung aufwadrts liegende Ventil
schlieRen (falls verfiigbar).

d. Stellen Sie sicher, dass der Sensor abgesperrt ist, kein Durchfluss mehr
vorhanden ist und der Sensor vollstandig mit dem Prozessmedium gefillt ist.

MicroMotion® Auswerteelektronik Modell 2500 mit konfigurierbaren Ein-/Ausgéngen
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Wabhlen Sie Device Tools > Device Calibration > Zero Verification and Calibration > Verify Zero
und warten Sie, bis der Vorgang abgeschlossen ist.

Wenn die Nullpunktkalibrierung fehlschlagt:

d.

Bestdtigen Sie, dass der Sensor vollstandig abgesperrt ist, der Durchfluss
gestoppt ist und der Sensor vollstdndig mit dem Prozessmedium gefiillt ist.

. Stellen Sie sicher, dass durch das Prozessmedium keine Kondensationsschliage

entstehen bzw. Kondensation entsteht und es keine Partikel enthalt, die sich
absetzen konnen.

c. Wiederholen Sie die Nullpunktverifizierung.

Falls sie erneut fehlschldgt, den Nullpunkt des Durchflussmesssystems
kalibrieren.

Siehe Nullpunktkalibrierung des Durchflussmesssystems bzgl. Anweisungen zur
Nullpunktkalibrierung.

Nachbereitungsverfahren

Offnen Sie die Ventile, um den normalen Durchfluss durch den Sensor wieder herzustellen.

2.6.3 Terminologie verwendet bei Nullpunktverifizierung und
Nullpunktkalibrierung

Tabelle 2-2: Terminologie verwendet bei Nullpunktverifizierung und Nullpunktkalibrierung

Begriff

Definition

Null

Im Allgemeinen ist dies der Offet, der erforderlich ist, um den linken mit dem rechten
Aufnehmer unter Null Durchflussbedingungen zu synchronisieren. Einheit = Mikrosekun-
den

Hersteller Nullpunktwert

Der unter Laborbedingungen werksseitig ermittelte Nullpunktwert.

Nullpunkt im Feld

Der Nullpunktwert, der durch eine Nullpunktkalibrierung auBerhalb des Werks erzielt
wird.

Vorheriger Nullpunktwert

Der Nullpunktwert, der zum Beginn der Nullpunktkalibrierung gespeichert ist. Kann der
werksseitige Nullpunktwert oder ein vorheriger Nullpunktwert im Feld sein.

Manueller Nullpunktwert

Der in der Auswerteelektronik gespeicherte Nullpunktwert, der normalerweise durch
eine Nullpunktkalibrierung ermittelt wird. Dieser Wert kann auch manuell konfiguriert
werden. Auch “mechanischer Nullpunkt” oder “gespeicherter Nullpunktwert genannt.”

Nullpunktwert

Biredirektionale Echtzeit-Massedurchfluss ohne angewendeter Durchflussddampfung oder
Massedurchflussabschaltung. Ein adaptiver Dampfungswert wird nur angewendet, wenn
sich die Massedurchflussrate (iber eine sehr kurze Zeitspanne stark verdndert. Einheit =
konfigurierte Messeinheit fiir Massedurchfluss

Nullpunktstabilitdt

Ein im Labor ermittelter Wert, der verwendet wird, um die erwartete Genauigkeit fiir ei-
nen Sensor zu berechnen. Unter Laborbedingungen bei Null Durchfluss wird davon aus-
gegangen, dass der durchschnittliche Durchfluss in dem Bereich liegen wird, die durch
den Nullpunktstabilitdtswert (0 + Nullpunktstabilitdt) definiert ist. Jede SensorgréRe und
jedes Sensormodell besitzen einen eindeutigen Nullpunktstabilitdtswert. Statistisch ge-
sehen fallen 95 % aller Datenpunkte innerhalb des durch den Nullpunktstabilitdtswert fes-
tgelegten Bereich.

Nullpunktkalibrierung

Das Verfahren, das verwendet wird, um den Nullpunktwert zu bestimmen.

Nullzeit

Die Zeitdauer, die fiir das Nullpunkt Kalibrierungsverfahren angewandt wird. Einheit = Se-
kunden.

Konfigurations- und Bedienungsanleitung 13
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Tabelle 2-2: Terminologie verwendet bei Nullpunktverifizierung und Nullpunktkalibrierung

(Fortsetzung)

Begriff

Definition

Feld Verifizierungsnullpunkt

Ein 3-min(tiger laufender Durchschnitt des aktuellen Nullpunktwertes, berechnet durch
die Auswerteelektronik . Einheit = konfigurierte Messeinheit fiir Massedurchfluss

Nullpunktverifizierung

Ein Verfahren, das verwendet wird, um den gespeicherten Nullpunktwert zu bewerten
und zu bestimmen, ob ein Nullpunkt im Feld die Messgenauigkeit erhéhen kann.

14
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Teil Il

Konfiguration und Inbetriebnahme

In diesem Teil enthaltene Kapitel:

Konfiguration und Inbetriebnahme - Einflihrung
Prozessmessung konfigurieren

Gerdteoptionen und Préferenzen konfigurieren
Integrieren des Messgerdtes mit dem Steuersystem
Abschluss der Konfiguration

Einstellungen der eichamtlichen Transfer Anwendung

Konfigurations- und Bedienungsanleitung
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3

3.1

16

Konfiguration und Inbetriebnahme -
Einfihrung

In diesem Kapitel behandelte Themen:

e Ablaufdiagramm - Konfiguration
. Voreingestellte Werte und Bereiche

Deaktivieren des Schreibschutzes der Konfiguration der Auswerteelektronik
*  Werkskonfiguration wiederherstellen

Ablaufdiagramm - Konfiguration

Verwenden Sie das folgende Ablaufdiagramm als allgemeine Richtlinie fir die
Konfiguration und Inbetriebnahme der Auswerteelektronik.

Einige Optionen treffen ggf. nicht auf lhre Installation zu. In diesem Handbuch finden Sie
detaillierte Informationen tiber die Verfahren. Falls Sie die Anwendung Gewichte und
MaRe verwenden, sind zusatzliche Konfigurations- und Einrichtungsschritte erforderlich.

MicroMotion® Auswerteelektronik Modell 2500 mit konfigurierbaren Ein-/Ausgéngen
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Abbildung 3-1: Ablaufdiagramm - Konfiguration
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3.2 Voreingestellte Werte und Bereiche

Siehe Abschnitt D.1 bzgl. der voreingestellten Werte und Bereiche fiir die meist
verwendeten Parameter.

3.3 Deaktivieren des Schreibschutzes der
Konfiguration der Auswerteelektronik

ProLink Il ProLink > Configuration > Device > Enable Write Protection

ProLink Il Device Tools > Configuration > Write-Protection

Handterminal Configure > Manual Setup > Info Parameters > Transmitter Info > Write Protect
Uberblick

Wenn die Auswerteelektronik schreibgeschiitzt ist, ist die Konfiguration gesperrt und
muss vor dem Andern von Konfigurationsparametern entsperrt werden. StandardmaRig
ist die Auswerteelektronik nicht schreibgeschiitzt.

Hinweis

Wenn die Auswerteelektronik schreibgeschiitzt ist, werden ungewollte Anderungen an der
Konfiguration verhindert. Der normale Betrieb wird dadurch nicht beeintrédchtigt. Sie kénnen den
Schreibschutz jederzeit aufheben, erforderliche Konfigurationsdnderungen durchfiihren und den
Schreibschutz danach wieder aktivieren.

3.4 Werkskonfiguration wiederherstellen
ProLink Il ProLink > Configuration > Device > Werkskonfiguration wiederherstellen
ProLink Il Gerate Extras > Konfigurationstibertragung > Restore Factory Configuration
Handterminal Nicht verflighar
Uberblick

Das Wiederherstellen der Werkskonfiguration versetzt die Auswerteelektronik in eine
bekannte Betriebskonfiguration. Dies kann hilfreich sein, wenn wéhrend der Konfiguration
Probleme auftreten.

Hinweis

Die Wiederherstellung der Werkskonfiguration ist keine Aktion, die haufig durchgefiihrt werden
sollte. Wenn Sie einen diesbezliglichen Bedarf erkennen, sollten Sie sich an Micro Motion wenden,
um in Erfahrung zu bringen, ob fiir die Lésung bestimmter Probleme eine bevorzugte Methode
existiert.
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4

4.1

4.1.1

Prozessmessung konfigurieren

In diesem Kapitel behandelte Themen:

e Massedurchflussmessung konfigurieren

*  Konfigurieren von Volumendurchflussmessungen fir Flissigkeitsanwendungen
e Gas Standard Volumendurchflussmessung konfigurieren

. Konfigurieren von Durchflussrichtung

e Konfigurieren der Dichtemessung

. Konfigurieren einer Temperaturmessung

*  Anwendung Mineralélmessung konfigurieren

e Konfigurieren der Anwendung Konzentrationsmessung

*  Druckkompensation konfigurieren

Massedurchflussmessung konfigurieren

Die Parameter der Massedurchflussmessung steuern, wie Massedurchfluss gemessen und
ausgegeben wird.

Die Parameter der Massedurchflussmessung umfassen:

. Massedurchfluss Messeinheit

. Durchflussdampfung

. Massedurchfluss Abschaltung

Massedurchfluss Messeinheit konfigurieren

ProLink Il ProLink > Configuration > Flow > Mass Flow Units

ProLink Il Device Tools > Configuration > Process Measurement > Flow

Handterminal Configure > Manual Setup > Measurements > Flow > Mass Flow Unit
Uberblick

Massedurchfluss Messeinheit spezifiziert die Messeinheit, die fiir den Massedurchfluss
verwendet wird. Die fiir die Masse Summen- und Gesamtzahler verwendet Messeinheit
wird von dieser Einheit abgeleitet.

Verfahren
Setzen Sie Massedurchfluss Messeinheit auf die Einheit, die Sie verwenden mochten.

Die Voreinstellung fiir Massedurchfluss Messeinheit ist g/s (Gramm pro Sekunde).

Hinweis
Wenn die Messeinheit, die Sie verwenden mochten, nicht verfiigbar ist, konnen Sie eine Spezial-
Messeinheit definieren.
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Optionen fiir Massedurchfluss Messeinheit

Die Auswerteelektronik stellt einen Standardsatz sowie eine anwenderdefinierbare
Messeinheit fiir die Massedurchfluss Messeinheit zur Verfiigung. Verschiedene
Kommunikations-Hilfsmittel verwenden u. U. unterschiedliche Kennzeichnungen fiir die

Gerate.

Tabelle 4-1: Optionen fiir Massedurchfluss Messeinheit

Bezeichnung

Beschreibung der Einheit ProLink I ProLink Ill Handterminal
Gramm pro Sekunde glsec glsec gls
Gramm pro Minute g/min g/min g/min
Gramm pro Stunde g/hr glhr g/h
Kilogramm pro Sekunde kg/sec kglsec kals
Kilogramm pro Minute kg/min kg/min kg/min
Kilogramm pro Stunde kg/hr kg/hr kg/h
Kilogramm pro Tag kg/Tag kg/day kg/d
Metrische Tonnen pro Minute mT/min mTon/min MetTon/min
Metrische Tonnen pro Stunde mTon/hr mTon/hr MetTon/h
Metrische Tonnen pro Tag T/Tag mTon/day MetTon/d
Pfund pro Sekunde Ibs/sec Ibs/sec Ib/s
Pfund pro Minute Ibs/min Ibs/min Ib/min
Pfund pro Stunde Ibs/hr Ibsthr Ib/h
Pfund pro Tag Ibs/Tag Ibs/day Ib/d

Short tons (2000 Pfund) pro Minute sTon/min sTon/min ShTon/min
Short tons (2000 Pfund) pro Stunde sTon/hr sTon/hr STon/h
Short tons (2000 Pfund) pro Tag sTon/Tag sTon/day STon/d
Long tons (2240 Pfund) pro Stunde [Ton/hr [Ton/hr LTon/h
Long tons (2240 Pfund) pro Tag [Ton/Tag [Ton/day LTon/d
Spezialeinheit Spezial special Spez

20

Spezial-Messeinheit fiir Massedurchfluss definieren

ProLink Il ProLink > Configuration > Special Units

ProLink Il Device Tools > Configuration > Process Measurement > Flow > Special Units

Handterminal

Configure > Manual Setup > Measurements > Special Units > Mass Special Units

Uberblick

Eine Spezial-Messeinheit ist eine benutzerdefinierte Messeinheit, mit der Prozessdaten,
Zahlerdaten und Summendaten in einer Einheit ausgegeben werden kénnen, die nicht in
der Auswerteelektronik verfiigbar ist. Eine Spezial-Messeinheit wird mithilfe eines
Umrechnungsfaktors aus einer bestehenden Messeinheit berechnet.
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4.1.2

Verfahren

1.  Sperzifizieren sie die Basis Masseeinheit.
Basis Masseeinheit ist die existierende Masseeinheit auf der die Spezialeinheit basieren
wird.

2.  Spezifizieren Sie die Basiszeiteinheit.
Basiszeiteinheit ist die existierende Zeiteinheit, auf der die Spezialeinheit basieren
wird.

3. Berechnen Sie den Massedurchfluss Umrechnungsfaktor wie folgt:

a. xBasiseinheiten =y Spezialeinheiten
b. Massedurchfluss Umrechnungsfaktor = x|y
4. Geben Sie den Massedurchfluss Umrechnungsfaktor ein.

5. Setzen Sie die Massedurchfluss Bezeichnung auf den Namen, den Sie fiir die
Massedurchfluss Einheit verwenden mochten.

6. Setzen Sie die Masse Summenzahler Bezeichnung auf den Namen, den Sie fiir die Masse
Summenzdhler und Gesamtzéhler Messeinheit verwenden moéchten.

Die Spezial-Messeinheit wird in der Auswerteelektronik gespeichert. Die
Auswerteelektronik kann so konfiguriert werden, dass sie die Spezial-Messeinheit zu jeder
Zeit verwendet.

Beispiel: Spezial-Messeinheit fiir Massedurchfluss definieren
Sie wollen den Massedurchfluss in Unzen pro Sekunden (oz/s) messen.

1. Setzen Sie die Basis Masseeinheit auf Ib. (Ib).
Setzen Sie die Basiszeiteinheit auf Sekunden (sec).
Berechnen Sie den Massedurchfluss Umrechnungsfaktor:
a. 11Ib/sec=160z/sec
b. Massedurchfluss Umrechnungsfaktor = 1/16 = 0.0625

4. Setzen Sie den Massedurchfluss Umrechnungsfaktor auf 0,0625.
Setzen Sie die Massedurchfluss Bezeichnung auf oz/s.

6. Setzen Sie die Masse Summenzahler Bezeichnung auf oz.

Konfigurieren der Durchflussdampfung

ProLink Il ProLink > Configuration > Flow > Flow Damp

ProLink Il Device Tools > Configuration > Process Measurement > Flow

Handterminal Configure > Manual Setup > Measurements > Flow > Flow Damping
Uberblick

Die Ddmpfung wird verwendet, um kleine, pl6tzlich auftretende Schwankungen des
Prozessmesswerts zu glatten. Damping Value gibt die Zeitdauer (in Sekunden) an, Gber die
die Auswerteelektronik die Anderungen in der ausgegebenen Prozessvariable verteilt. Am
Ende des Intervalls spiegelt die ausgegebene Prozessvariable 63 % der Anderung des
eigentlichen gemessenen Wertes wider.
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Verfahren
Flow Damping auf den gewiinschten Wert einstellen.

Der Standardwert ist 0,8 Sekunden. Der Bereich richtet sich nach dem Typ des Core
Prozessors und der Einstellung fiir Update Rate (siehe nachfolgende Tabelle).

Core Prozessor Typ Einstellung Update Rate: Bereich fiir Flow Damping
Standard Normal 0 bis 51,2 Sekunden
Spezial 0 bis 10,24 Sekunden
Erweiterte Funktionalitdt | Nicht anwendbar 0 bis 51,2 Sekunden
Hinweise

e Ein hoher Dampfungswert |dsst die Prozessvariable regelmaRiger erscheinen, da der
ausgegebene Wert sich langsamer andert.

* Ein niedriger Dampfungswert ldsst die Prozessvariable unregelmdRiger erscheinen, da der
ausgegebene Wert sich schneller andert.

* Die Kombination eines hohen Ddmpfungswertes und plotzlich auftretenden, groen
Anderungen in der Durchflussrate kann zu erhéhten Messfehlern fiihren.

* Immer, wenn der Ddmpfungswert nicht Null ist, wird der ausgegebene Messwert hinter der
eigentlichen Messung liegen, da der ausgegebene Wert iiber die Zeit gemittelt wird.

* Allgemein werden niedrigere Dampfungswerte vorgezogen, da das Risiko von Datenverlusten
und die Verzoégerung zwischen dem eigentlichem und dem ausgegebenen Wert geringer ist.

* In Gasanwendungen empfiehlt Micro Motion, den Wert fiir Flow Damping auf 2.56 oder héher
einzustellen.

Der eingegebene Wert wird automatisch auf den nachst giiltigen Wert abgerundet.
Giiltige Dampfungswerte sind in der folgenden Tabelle dargestellt.

Tabelle 4-2: Giiltige Werte fiir Flow Damping

Core Prozessor Typ Einstellung Update Rate: Giiltige Dampfungswerte
Standard Normal 0,0.2,04,08,...51.2

Spezial 0,0.04,0.08,0.16, ... 10.24
Erweiterte Funktionalitdt | Nicht anwendbar 0,0.2,04,08,...51.2

Auswirkung der Durchflussddmpfung auf die Volumenmessung

Die Durchflussdampfung wirkt sich auf die Volumenmessung fiir die
Flissigkeitsvolumendaten aus. Die Durchflussdampfung wirkt sich auBerdem auf die
Volumenmessung fiir die Gas-Standardvolumendaten aus. Die Auswerteelektronik
berechnet die Volumendaten anhand der geddmpften Massedurchflussdaten.

Wechselwirkung zwischen Durchflussdampfung und Zusatzlicher
Dampfung

In einigen Fallen werden sowohl die Durchflussddmpfung als auch die Zusétzliche Dampfung auf
den ausgegebenen Massedurchfluss angewandt.
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4.1.3

Die Durchflussdampfung regelt die Anderungsrate der Durchfluss-Prozessvariablen. Die
Zusétzliche Dampfung regelt die Anderungsrate, die iiber den mA-Ausgang ausgegeben wird.
Wenn die mA-Ausgangs-Prozessvariable auf Massedurchfluss gesetzt ist und sowohl die
Durchflussdampfung als auch die Zusatzliche Dampfung auf einen Wert ungleich Null gesetzt
sind, wird zuerst die Durchflussddmpfung angewandt, und die Berechnung der
zusdtzlichen Dampfung wird auf das Ergebnis der ersten Rechnung angewandt

Massedurchfluss Abschaltung konfigurieren

ProLink Il ProLink > Configuration > Flow > Mass Flow Cutoff

ProLink Il Device Tools > Configuration > Process Measurement > Flow

Handterminal Configure > Manual Setup > Measurements > Flow > Mass Flow Cutoff
Uberblick

Massedurchfluss Abschaltung spezifiziert den niedrigsten Massedurchfluss, der als Messwert
ausgegeben wird. Jeder Massedurchfluss unterhalb dieses Abschaltungswerts wird als 0
ausgegeben.

Verfahren
Setzen Sie Massedurchfluss Abschaltung auf den gewiinscthen Wert.

Der voreingestellte Wert fiir Massedurchfluss Abschaltung ist 0,0 g/s oder ein werkseitig
eingestellter, sensorspezifischer Wert. Die empfohlene Einstellung ist 0,05 % des
maximalen Nenndurchflusses des Sensors bzw. ein Wert unter dem hdchsten erwarteten
Durchfluss. Setzen Sie Massedurchfluss Abschaltung nicht auf 0,0 g/s.

Auswirkung der Massedurchflussabschaltung auf die
Volumenmessung

Die Massedurchflussabschaltung wirkt sich nicht auf die Volumenmessung aus. Die
Volumendaten werden anhand der tatsachlichen Massendaten errechnet anstelle des
ausgegebenen Werts.

Wechselwirkung zwischen Massedurchflussabschaltung und AO-
Abschaltung

Massedurchflussabschaltung spezifiziert den niedrigsten Massedurchfluss, den die
Auswerteelektronik als Messwert ausgibt. Die AO-Abschaltung definiert die niedrigste
Durchflussrate, die iber den mA-Ausgang ausgegeben wird. Wenn die Prozessvariable mA-
Ausgang auf Massedurchfluss eingestellt ist, wird der vom mA-Ausgang ausgegebene
Massedurchfluss vom héheren der beiden Abschaltwerte geregelt.

Massedurchflussabschaltung wirkt sich auf alle ausgegebenen Werte aus, die in anderen
Auswerteelektronik-Verhalten verwendet werden (z. B. Ereignisse, die fiir den
Massedurchfluss definiert wurden).

Die AO-Abschaltung wirkt sich nur auf die Massedurchfliisse aus, die (iber den mA-Ausgang
ausgegeben wurden.
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Beispiel: Abschaltwechselwirkung bei AO-Abschaltung kleiner als
Massedurchflussabschaltung

Konfiguration:

. mA-Ausgang-Prozessvariable: Massedurchfluss

. Frequenzausgang-Prozessvariable: Massedurchfluss
AO-Abschaltung: 10 g/s

. Massedurchflussabschaltung: 15 g/s

Ergebnis: Wenn der Massedurchfluss unter 15 g/s abfallt, wird der Massedurchfluss als 0
ausgegeben und fiir alle internen Verarbeitungsverfahren verwendet.

Beispiel: Abschaltwechselwirkung bei AO-Abschaltung groRer als
Massedurchflussabschaltung

Konfiguration:

mA-Ausgang-Prozessvariable: Massedurchfluss

Frequenzausgang-Prozessvariable: Massedurchfluss
AO-Abschaltung: 15 g/s
Massedurchflussabschaltung: 10 g/s

Ergebnis:
. Fallt der Massedurchfluss unter 15 g/s aber nicht unter 10 g/s:
- Gibt der mA-Ausgang Nulldurchfluss aus.

- Der Frequenzausgang gibt den Istdurchfluss aus, und der Istdurchfluss wird fiir
alle internen Verarbeitungsverfahren verwendet.

. Wenn der Massedurchfluss unter 10 g/s abfillt, geben beide Ausgange
Nulldurchfluss aus, und fiir alle internen Verarbeitungsverfahren wird 0 verwendet.

Konfigurieren von
Volumendurchflussmessungen fiir
Fliissigkeitsanwendungen

Die Parameter fiir Volumendurchflussmessungen steuern, wie der
Flissigkeitsvolumenstrom gemessen und gemeldet wird.

Die Parameter fiir Volumendurchflussmessungen umfassen:

. Volume Flow Type

. Volume Flow Measurement Unit

. Volume Flow Cutoff

Einschrdankung

Flissigkeit Volumendurchfluss und Gas Standard Volumendurchfluss kdnnen nicht gleichzeitig
verwendet werden. Sie konnen jeweils immer nur eine Option auswdéhlen.
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4.2.1

4.2.2

Konfigurieren von Volumendurchfluss Art fiir
FlGissigkeitsanwendungen

ProLink Il ProLink > Configuration > Flow > Vol Flow Type > Liquid Volume

ProLink Il Device Tools > Configuration > Process Measurement > Flow

Handterminal Configure > Manual Setup > Measurements > Gas Standard Volume > Volume Flow Type > Liquid
Uberblick

Volume Flow Type steuert, ob Fliissigkeit oder Gas Standard Volumendurchfluss gemessen
wird.

Einschrankung

Bei Verwendung der Anwendung Mineral6lmessung muss Volume Flow Type auf Liquid eingestellt
werden. Eine Gas Standard Volumenmessung ist mit der Anwendung Mineralélmessung nicht
kompatibel.

Einschrankung

Bei Verwendung der Anwendung Konzentrationsmessung muss Volume Flow Type auf Liquid eingestellt
werden. Eine Gas Standard Volumenmessung ist mit der Anwendung Konzentrationsmessung nicht
kompatibel.

Verfahren

Setzen Sie Volume Flow Type auf Liquid.

Konfigurieren von Volumendurchfluss-Messeinheit fiir
FlGssigkeitsanwendungen

ProLink Il ProLink > Configuration > Flow > Vol Flow Units

ProLink Il Device Tools > Configuration > Process Measurement > Flow

Handterminal Configure > Manual Setup > Measurements > Flow > Volume Flow Unit
Uberblick

Volume Flow Measurement Unit gibt die Messeinheit an, die fiir die Anzeige des
Volumendurchflusses verwendet wird. Die Einheit, die flir den Volumen Summen- und
Gesamtzahler verwendet wird, basiert auf dieser Einheit.

Vorbereitungsverfahren

Stellen Sie vor dem Konfigurieren von Volume Flow Measurement Unit sicherstellen, dass
Volume Flow Type auf Liquid gesetzt ist.

Verfahren
Setzen Sie Volume Flow Measurement Unit auf die gew(inschte Einheit.

Die Voreinstellung fiir Volume Flow Measurement Unit ist I/s (Liter pro Sekunde).
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Hinweis

Wenn die Messeinheit, die Sie verwenden mochten, nicht verfiigbar ist, kénnen Sie eine Spezial-
Messeinheit definieren.

Optionen fiir Volume Flow Measurement Unit fiir
Fliissigkeitsanwendungen

Die Auswerteelektronik bietet ein Standardsatz an Messeinheiten fiir Volume Flow
Measurement Unit und eine zuséatzliche benutzerdefinierbare Messeinheit. Unterschiedliche
Kommunikations-Hilfsmittel verwenden mdéglicherweise unterschiedliche

Kennzeichnungen fiir die Einheiten.

Tabelle 4-3: Optionen fiir Volume Flow Measurement Unit fiir Fliissigkeitsanwendungen

Kennzeichnung
Beschreibung der Einheit ProLink II ProLink IlI Handterminal
Kubikfuss pro Sekunde ft3/sec ft3/sec ft3/s
Kubikfuss pro Minute ft3/min ft3/min ft3/min
Kubikfuss pro Stunde ft3/hr ft3/hr ft3/h
Kubikfuss pro Tag ft3/day ft3/day ft3/Tag
Kubikmeter pro Sekunde m3/sec m3/sec m3/s
Kubikmeter pro Minute m3/min m3/min m3/min
Kubikmeter pro Stunde m3/hr m3/hr m3/h
Kubikmeter pro Tag m3/day m3/day m3/Tag
U.S. Gallonen pro Sekunde US gallsec US gallsec Galls
U.S. Gallonen pro Minute US gal/min US gal/min Gal/min
U.S. Gallonen pro Stunde US gal/hr US gal/hr Gal/h
U.S. Gallonen pro Tag US gal/Tag US gal/day GallTag
Millionen U.S. Gallonen pro Tag mil US gal/day mil US gal/day Mgal/Tag
Liter pro Sekunde I/'sec IIsec I/s
Liter pro Minute I/min I/min L/min
Liter pro Stunde I/hr I/hr I’h
Millionen Liter pro Tag mil /Tag mil l/day ml/Tag
Imperial Gallonen pro Sekunde Imp galls Imp gallsec ImpGal/s
Imperial Gallonen pro Minute Imp gal/min Imp gal/min ImpGal/min
Imperial Gallonen pro Stunde Imp galh Imp gallhr ImpGal/h
Imperial Gallonen pro Tag Imp gal/Tag Imp gal/day ImpGal/Tag
Barrel pro Sekunde(1) Barrel/s barrels/sec bblis
Barrel pro Minute(") Barrel/min barrels/min bbl/min
Barrel pro Stunde(") Barrel/h barrels/hr bbl/h
Barrel pro Tag(") Barrel/Tag barrels/day bbl/Tag
Bier Barrel pro Sekunde(2) Bier Barrel/s Beer barrels/sec bbblis

(1) Einheiten basieren auf Ol Barrels (42 U.S Gallonen).
(2) Einheiten basieren auf Bier Barrels (31 U.S Gallonen).
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Tabelle 4-3: Optionen fiir Volume Flow Measurement Unit fiir Fliissigkeitsanwendungen (Fortsetzung)

Kennzeichnung

Beschreibung der Einheit ProLink II ProLink IlI Handterminal
Bier Barrel pro Minute(2) Bier Barrel/min Beer barrels/min bbbl/min

Bier Barrel pro Stunde(?) Bier Barrel/h Beer barrels/hr bbbl/h

Bier Barrel pro Tag(?) Bier Barrel/Tag Beer barrels/day bbbl/d
Spezialeinheit Spezial special Spez

Festlegen einer speziellen Messeinheit fiir
Volumendurchfluss

ProLink Il ProLink > Configuration > Special Units

ProLink Il Device Tools > Configuration > Process Measurement > Flow > Special Units

Handterminal Configure > Manual Setup > Measurements > Special Units > Volume Special Units

Uberblick

Eine Spezial-Messeinheit ist eine benutzerdefinierte Messeinheit, mit der Prozessdaten,
Zahlerdaten und Summendaten in einer Einheit ausgegeben werden kénnen, die nichtin
der Auswerteelektronik verfliigbar ist. Eine Spezial-Messeinheit wird mithilfe eines
Umrechnungsfaktors aus einer bestehenden Messeinheit berechnet.

Verfahren

1. Legen Sie die Base Volume Unit fest.
Base Volume Unit ist die existierende Volumeneinheit, auf der die Spezialeinheit
basieren wird.

2.  Legen Sie die Base Time Unit fest.
Base Time Unit ist die existierende Zeiteinheit, auf der die Spezialeinheit basieren
wird.

3. Berechnen Sie Volume Flow Conversion Factor wie folgt:

a. xBasiseinheiten =y Spezialeinheiten
b. Volume Flow Conversion Factor = x/y
4. Geben Sie den Volume Flow Conversion Factor ein.

5. Setzen Sie Volume Flow Label auf den Namen, den Sie fiir die
Volumendurchflusseinheit verwenden mochten.

6. Setzen Sie Volume Total Label auf den Namen, den Sie fiir die Einheit fir des Volumen
Summen- und Gesamtzahlers verwenden mochten.

Die Spezial-Messeinheit wird in der Auswerteelektronik gespeichert. Die
Auswerteelektronik kann so konfiguriert werden, dass sie die Spezial-Messeinheit zu jeder
Zeit verwendet.
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Beispiel: Festlegen einer speziellen Messeinheit fiir Volumendurchfluss
Es soll der Volumendurchfluss in Pint/s gemessen werden.

1. Setzen Sie Base Volume Unit auf Gallons (gal).
Setzen Sie Base Time Unit auf Seconds ().
Umrechnungsfaktor berechnen:

a. 1gallsec=8 pints/sec
b. Volume Flow Conversion Factor=1/8 =0.1250

4. Setzen Sie Volume Flow Conversion Factor auf 0,1250.
Setzen Sie Volume Flow Label auf pints/sec.

6. Setzen Sie Volume Total Label auf pints.

Konfigurieren der Volumendurchflussabschaltung

ProLink Il ProLink > Configuration > Flow > Vol Flow Cutoff

ProLink Il Device Tools > Configuration > Process Measurement > Flow

Handterminal Configure > Manual Setup > Measurements > Flow > Volume Flow Cutoff
Uberblick

Volume Flow Cutoff gibt den niedrigsten Volumendurchfluss an, der als gemessen gemeldet
wird. Jeder Volumendurchfluss unter diesem Grenzwert wird als 0 gemeldet.

Verfahren
Setzen Sie Volume Flow Cutoff auf den gewlinschten Wert.

Der Standardwert fiir Volume Flow Cutoff betrdgt 0,0 I/s (Liter pro Sekunde). Der untere
Grenzwert ist 0. Der obere Grenzwert ist der Durchflusskalibrierfaktor des Sensors in
Einheiten von I/sec, multipliziert mit 0.2.

Wechselwirkung zwischen Volumendurchflussabschaltung und AO-
Abschaltung

Volumendurchflussabschaltung spezifiziert den niedrigsten Fllissigkeitsvolumendurchfluss, den
die Auswerteelektronik als Messwert ausgibt. Die AO-Abschaltung definiert die niedrigste
Durchflussrate, die (iber den mA-Ausgang ausgegeben wird. Wenn die Prozessvariable mA-
Ausgang auf Volumendurchfluss eingestellt ist, wird der vom mA-Ausgang ausgegebene
Volumendurchfluss vom héheren der beiden Abschaltwerte geregelt.

Die Volumendurchflussabschaltung wirkt sich auf die iber die Ausgdange ausgegebenen
Vlumendurchflusswerte und die in anderen Auswerteelektronik-Verhalten (z. B. Ereignisse,
die fir den Vvolumendurchfluss definiert wurden) verwendeten Volumendurchflusswerte
aus.

Die AO-Abschaltung wirkt sich nur auf die Durchfliisse aus, die (iber den mA-Ausgang
ausgegeben wurden.
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Beispiel: Abschaltwechselwirkung bei AO-Abschaltung kleiner als
Volumendurchflussabschaltung

Konfiguration:

. mA-Ausgang-Prozessvariable: Volumendurchfluss

. Frequenzausgang-Prozessvariable: Volumendurchfluss
AQ-Abschaltung: 10 1/s

Volumendurchflussabschaltung: 15 1/s

Ergebnis: Wenn der Volumendurchfluss unter 15 SLPM abfillt, wird der
Volumendurchfluss als 0 ausgegeben und fiir alle internen Verarbeitungsverfahren
verwendet.

Beispiel: Abschaltwechselwirkung bei AO-Abschaltung groRer als
Volumendurchflussabschaltung

Konfiguration:

. mA-Ausgang-Prozessvariable: Volumendurchfluss

U Frequenzausgang-Prozessvariable: Volumendurchfluss

. AQ-Abschaltung: 15 1/s

o Volumendurchflussabschaltung: 10 1/s

Ergebnis:
. Fallt der Volumendurchfluss unter 15 I/s aber nicht unter 10 1/s:
- Gibt der mA-Ausgang Nulldurchfluss aus.

- Der Frequenzausgang gibt den Istdurchfluss aus, und der Istdurchfluss wird fiir
alle internen Verarbeitungsverfahren verwendet.

. Wenn der Volumendurchfluss unter 10 I/s abfillt, geben beide Ausgdnge
Nulldurchfluss aus, und fiir alle internen Verarbeitungsverfahren wird 0 verwendet.

4.3 Gas Standard Volumendurchflussmessung
konfigurieren

Die Parameter der Gas Standard Volumendurchflussmessung steuern, wie der Gas
Standard Volumendurchfluss gemessen und ausgegeben wird.

Die Parameter der Gas Standard Volumendurchflussmessung umfassen:

o Volumendurchfluss Art

. Standard Dichte des Gases

. Gas Standard Volumendurchfluss Einheit

. Gas Standard Volumen Durchflussabschaltung

Einschrankung

Fliissigkeit Volumendurchfluss und Gas Standard Volumendurchfluss kdnnen nicht gleichzeitig
verwendet werden. Sie kdnnen jeweils immer nur eine Option auswdhlen.
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Volumendurchfluss Art flir Gasmessungen konfigurieren

ProLink Il ProLink > Configuration > Flow > Vol Flow Type > Standard Gas Volume

ProLink Il Device Tools > Configuration > Process Measurement > Flow

Handterminal Configure > Manual Setup > Measurements > GSV > Volume Flow Type > Standard Gas Volume
Uberblick

Volumendurchfluss Art steuert, ob Fliissigkeit oder Gas Standard Volumendurchfluss
gemessen wird.

Einschrankung

Bei Verwendung der Anwendung Mineral6lmessung muss Volume Flow Type auf Liquid eingestellt
werden. Eine Gas Standard Volumenmessung ist mit der Anwendung Mineralélmessung nicht
kompatibel.

Einschrankung

Bei Verwendung der Anwendung Konzentrationsmessung muss Volume Flow Type auf Liquid eingestellt
werden. Eine Gas Standard Volumenmessung ist mit der Anwendung Konzentrationsmessung nicht
kompatibel.

Verfahren

Setzen Sie Volumendurchfluss Art auf Gas Standard Volumen.

Standard Gas Dichte konfigurieren

ProLink Il ProLink > Configuration > Flow > Std Gas Density

ProLink Il Device Tools > Configuration > Process Measurement > Flow

Handterminal Configure > Manual Setup > Measurements > GSV > Gas Ref Density
Uberblick

Der Wert Standard Gas Dichte wird verwendet, um die gemessenen Durchflussdaten in die
Standard Referenzwerte umzurechnen.

Vorbereitungsverfahren

Stellen Sie sicher, dass Dichte Messeinheit auf die Messeinheit gesetzt ist, die Sie fiir Standard
Gas Dichte verwenden mochten.

Verfahren

Setzen Sie Standard Gas Dichte auf die Standard Referenzdichte des Gases, das Sie messen
wollen.

Anmerkung

ProLink Il und ProLink Ill bieten eine gefiihrten Methode, die Sie zur Berechnung der Standard Dichte
des zu messenden Gases verwenden kénnen, falls diese nicht bekannt ist.

MicroMotion® Auswerteelektronik Modell 2500 mit konfigurierbaren Ein-/Ausgéngen



Prozessmessung konfigurieren

4.3.3

Gas Standard Volumendurchfluss Messeinheit konfigurieren

ProLink Il ProLink > Configuration > Flow > Std Gas Vol Flow Units

ProLink Il Device Tools > Configuration > Process Measurement > Flow

Handterminal Configure > Manual Setup > Measurements > GSV > GSV Flow Unit
Uberblick

Gas Standard Volumendurchfluss Messeinheit spezifiziert die Messeinheit, die fir den Gas
Standard Volumendurchfluss angezeigt wird. Die fiir den Gas Standard Volumen
Summenzdhler und den Gas Standard Volumen Gesamtzdhler verwendete Messeinheit
wird von dieser Einheit abgeleitet.

Vorbereitungsverfahren

Bevor Sie Gas Standard Volumendurchfluss Messeinheit konfigurieren, miissen Sie sicherstellen,
dass Volumendurchfluss Art auf Gas Standard Volumen gesetzt ist.

Verfahren

Setzen Sie Gas Standard Volume Flow Measurement Unit auf die Einheit, die Sie verwenden
mochten.

Die Voreinstellung fiir Gas Standard Volume Flow Measurement Unit ist SCFM (Standard
KubikfuB pro Minute).

Hinweis
Wenn die Messeinheit, die Sie verwenden mochten, nicht verfiigbar ist, konnen Sie eine Spezial-
Messeinheiten definieren.

Optionen fiir die Messwerteinheit von Gas-Standardvolumendurchfluss

Die Auswerteelektronik bietet ein Standardsatz an Messwerteinheiten fiir die Einheit von
Standardvolumendurchfluss von Gas und eine zusatzliche benutzerdefinierte Messwerteinheit.
Verschiedene Kommunikations-Hilfsmittel verwenden u. U. unterschiedliche
Kennzeichnungen fiir die Geréte.

Tabelle 4-4: Optionen fiir die Messwerteinheit von Gas-Standardvolumen

Bezeichnung

Beschreibung der Einheit ProLink II ProLink IlI Handterminal
Normkubikmeter pro Sekunde Nm3/s Nm3/sec Nm3/s
Normkubikmeter pro Minute Nm3/min Nm3/sec Nm3/min
Normkubikmeter pro Stunde Nm3/h Nm3/hr Nm3/h
Normkubikmeter pro Tag Nm3/Tag Nm3/day Nm3/Tag
Normliter pro Sekunde NLPS NLPS NLPS
Normliter pro Minute NLPM NLPM NLPM
Normliter pro Stunde NLPH NLPH NLPH
Normliter pro Tag NLPD NLPD NLPD
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Tabelle 4-4: Optionen fiir die Messwerteinheit von Gas-Standardvolumen (Fortsetzung)

Bezeichnung
Beschreibung der Einheit ProLink II ProLink IlI Handterminal
Standard-Kubikfu® pro Sekunde SCFS SCFS SCFS
Standard-Kubikful8 pro Minute SCFM SCFM SCFM
Standard-KubikfuR pro Stunde SCFH SCFH SCFH
Standard-KubikfuR pro Tag SCFD SCFD SCFD
Standardkubikmeter pro Sekunde Sm3/s Sm3/sec Sm3/s
Standardkubikmeter pro Minute Sm3/min Sm3/min Sm3/min
Standardkubikmeter pro Stunde Sm3/h Sm3/hr Sm3/h
Standardkubikmeter pro Tag Sm3/Tag Sm3/day Sm3/Tag
Standardliter pro Sekunde SLPS SLPS SLPS
Standardliter pro Minute SLPM SLPM SLPM
Standardliter pro Stunde SLPH SLPH SLPH
Standardliter pro Tag SLPD SLPD SLPD
Spezial-Messwerteinheit Spezial special Spezial

Spezial-Messeinheit fiir Gas Standard Volumendurchfluss

definieren
ProLink Il ProLink > Configuration > Special Units
ProLink Il Device Tools > Configuration > Process Measurement > Flow > Special Units
Handterminal Configure > Manual Setup > Measurements > Special Units > Special GSV Units
Uberblick

Eine Spezial-Messeinheit ist eine benutzerdefinierte Messeinheit, mit der Prozessdaten,
Zahlerdaten und Summendaten in einer Einheit ausgegeben werden kénnen, die nichtin
der Auswerteelektronik verfliigbar ist. Eine Spezial-Messeinheit wird mithilfe eines
Umrechnungsfaktors aus einer bestehenden Messeinheit berechnet.

Verfahren
1.  Spezifizieren Sie die Base Gas Standard Volume Unit.

Base Gas Standard Volume Unit ist die existierende Gas Standard Volumeneinheit, auf
der die Spezialeinheit basieren wird.

2. Spezifizieren Sie die Base Time Unit.
Base Time Unit ist die existierende Zeiteinheit, auf der die Spezialeinheit basieren
wird.

3. Berechnen Sie den Gas Standard Volume Flow Conversion Factor wie folgt:

a. xBasiseinheiten =y Spezialeinheiten
b. Gas Standard Volume Flow Conversion Factor = x/y
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4.3.4

4, Geben Sie den Gas Standard Volume Flow Conversion Factor ein.

5. Setzen Sie Gas Standard Volume Flow Label auf den Namen, den Sie fiir die Einheit des
Gas Standard Volumendurchflusses verwenden mochten.

6. Setzen Sie Gas Standard Volume Total Label auf den Namen, den Sie fiir die Einheit des
Gas Standard Volumen Summenzdhlers und des Gas Standard Volumen
Gesamtzahlers verwenden mochten.

Die Spezial-Messeinheit wird in der Auswerteelektronik gespeichert. Die
Auswerteelektronik kann so konfiguriert werden, dass sie die Spezial-Messeinheit zu jeder
Zeit verwendet.

Beispiel: Spezial-Messeinheit fiir Gas Standard Volumendurchfluss definieren

Sie mochten den Gas Standard Volumendurchfluss als Tausenderwert (K) von Standard
KubikfuR pro Minute messen.
1. Setzen Sie Base Gas Standard Volume Unit auf SCFM.
Setzen Sie Base Time Unit auf minutes (min).
Umrechnungsfaktor berechnen:
a. Tausenderwert von Standard Kubikfu8 pro Minute = 1000 Kubikfu pro Minute
b. Gas Standard Volume Flow Conversion Factor=1/1000 = 0,001
4, Setzen Sie Gas Standard Volume Flow Conversion Factor auf 0,001.
. Setzen Sie Gas Standard Volume Flow Label auf KSCFM.
6. Setzen Sie Gas Standard Volume Total Label auf KSCF.

Gas Standard Volumen Durchflussabschaltung konfigurieren

ProLink Il ProLink > Configuration > Flow > Std Gas Vol Flow Cutoff

ProLink Il Device Tools > Configuration > Process Measurement > Flow

Handterminal Configure > Manual Setup > Measurements > GSV > GSV Cutoff
Uberblick

Gas Standard Volumen Durchflussabschaltung spezifiziert den niedrigsten Gas Standard
Volumendurchfluss, der als Messwert ausgegeben wird. Jeder Gas Standard
Volumendurchfluss unterhalb dieses Schwellenwerts wird als 0 ausgegeben.

Verfahren
Setzen Sie Gas Standard Volumen Durchflussabschaltung auf den gewtinschten Wert.

Der voreingestellt Wert fiir Gas Standard Volumen Durchflussabschaltung ist 0.0. Der untere
Grenzwert ist 0.0. Es gibt keine Obergrenze.

Wechselwirkung zwischen Gas-Standardvolumen-
Durchflussabschaltung und AO-Abschaltung
Gas-Standardvolumen-Durchflussabschaltung spezifiziert den niedrigsten Gas-

Standardvolumendurchfluss, den die Auswerteelektronik als Messwert ausgibt. Die AO-
Abschaltung definiert die niedrigste Durchflussrate, die (iber den mA-Ausgang ausgegeben
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wird. Wenn die Prozessvariable mA-Ausgang auf Gas-Standardvolumendurchfluss eingestellt ist,
wird der vom mA-Ausgang ausgegebene Volumendurchfluss vom héheren der beiden
Abschaltwerte geregelt.

Die Gas-Standardvolumen-Durchflussabschaltung wirkt sich auf die iber die Ausgdnge
ausgegebenen Gas-Standardvolumendurchflusswerte und die in anderen
Auswerteelektronik-Verhalten (z. B. Ereignisse, die fiir den Gas-
Standardvolumendurchfluss definiert wurden) verwendeten Gas-
Standardvolumendurchflusswerte aus.

Die AO-Abschaltung wirkt sich nur auf die Durchfliisse aus, die (iber den mA-Ausgang
ausgegeben wurden.

Beispiel: Abschaltwechselwirkung bei AO-Abschaltung kleiner als Gas-Standardvolumen-
Durchflussabschaltung
Konfiguration:

. Prozessvariable mA-Ausgang fir den primaren mA-Ausgang: Gas-
Standardvolumendurchfluss

. Frequenzausgang-Prozessvariable: Gas-Standardvolumendurchfluss

. AQ-Abschaltung fiir den primdren mA-Ausgang: 10 SLPM (Standardliter pro Minute)
. Gas-Standardvolumen-Durchflussabschaltung: 15 SLPM

Ergebnis: Wenn der Gas-Standardvolumendurchfluss unter 15 SLPM abfillt, wird der

Volumendurchfluss als 0 ausgegeben und fiir alle internen Verarbeitungsverfahren
verwendet.

Beispiel: Abschaltwechselwirkung bei AO-Abschaltung groRer als Gas-Standardvolumen-
Durchflussabschaltung
Konfiguration:

. Prozessvariable mA-Ausgang fir den primaren mA-Ausgang: Gas-
Standardvolumendurchfluss

° Frequenzausgang-Prozessvariable: Gas-Standardvolumendurchfluss
o AO-Abschaltung fiir den primaren mA-Ausgang: 15SLPM (Standardliter pro Minute)
. Gas-Standardvolumen-Durchflussabschaltung: 10SLPM

Ergebnis:
o Wenn der Gas-Standardvolumendurchfluss unter 15 SLPM, aber nicht unter 10 SLPM
abfallt:

- Gibt der primare mA-Ausgang Nulldurchfluss aus

- Der Frequenzausgang gibt den Istdurchfluss aus, und der Istdurchfluss wird fiir
alle internen Verarbeitungsverfahren verwendet.

. Wenn der Gas-Standardvolumendurchfluss unter 10 SLPM abfillt, geben beide
Ausgdnge Nulldurchfluss aus, und fir alle internen Verarbeitungsverfahren wird 0
verwendet.
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4.4

4.4.1

Konfigurieren von Durchflussrichtung

ProLink Il ProLink > Configuration > Flow > Flow Direction

ProLink Il Device Tools > Configuration > Process Measurement > Flow

Handterminal Configure > Manual Setup > Measurements > Flow > Flow Direction
Uberblick

Mittels Flow Direction steuert, wie sich Vorwarts- und Riickwartsstromung auf
Durchflussmessungen und deren Anzeige auswirken.
Flow Direction wird entsprechend dem Durchfluss-Richtungspfeil auf dem Sensor definiert:

. Eine Vorwartsstromung (positiver Durchfluss) bewegt sich in Richtung des
Durchflusspfeils auf dem Sensor.

. Eine Riickwdrtsstromung (negativer Durchfluss) bewegt sich entgegengesetzt zu
dem auf dem Sensor angegebenen Durchflusspfeil.

Hinweis
Micro Motion Die Sensoren sind bidirektional. Die Messgenauigkeit wird nicht durch die eigentliche
Durchflussrichtung oder durch die Einstellung des Parameters Durchflussrichtung beeinflusst.

Verfahren

Flow Direction auf den gewiinschten Wert einstellen.

Optionen der Durchflussrichtung

Tabelle 4-5: Optionen der Durchflussrichtung

Einstellung der Durchflussrichtung Beziehung zum Durchflussrich-

ProLink Il

] . tungspfeil auf dem Sensor
ProLink 1l Handterminal

Vorwarts

Vorwarts Korrekt, wenn der Durchflussrich-
tungspfeil in dieselbe Richtung wie der
GroRteil des Durchflusses weist.

Riickwarts

Ruckwarts Korrekt, wenn der Durchflussrich-
tungspfeil in dieselbe Richtung wie der
GroRteil des Durchflusses weist.

Absolutwert

Absolutwert Durchflussrichtungspfeil ist unrele-
vant.

Bidirektional

Beide Richtungen Korrekt, wenn beide Stromungen
(vorwarts, riickwarts) zu erwarten
sind, der Vorwadrtsfluss dominiert und
der Riickwartsfluss jedoch beachtlich
ist.

Vorwarts negieren

Negieren/nur Vorwérts Korrekt, wenn der Durchflussrich-
tungspfeil in die entgegengesetzte
Richtung wie der GroRteil des Durch-
flusses weist.
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Tabelle 4-5: Optionen der Durchflussrichtung (Fortsetzung)

Einstellung der Durchflussrichtung Beziehung zum Durchflussrich-
] ] ] tungspfeil auf dem Sensor
ProLink Il ProLink Ill Handterminal
Bidirektional negieren Negieren/Bi-direktional Korrekt, wenn beide Stromungen

(vorwarts, riickwarts) zu erwarten
sind, der Riickwartsfluss dominiert
und der Vorwartsfluss jedoch beacht-
lichist.

Auswirkungen der Durchflussrichtung auf die mA-Ausgdnge

Die Durchflussrichtung beeinflusst die Art, in der die Auswerteelektronik Durchflusswerte
ber die mA-Ausgdnge ausgibt. Die mA-Ausgange werden nur dann von der
Durchflussrichtung beeinflusst, wenn die Prozessvariable mA-Ausgang auf eine
Durchflussvariable eingestellt ist.

Durchflussrichtung und mA-Ausgdnge

Die Auswirkung der Durchflussrichtung auf mA-Ausgange hdngt vom Messanfang ab, der fiir
den mA-Ausgang konfiguriert wurde:

. Wenn der Messanfang auf 0 eingestellt ist, siehe Abbildung 4-1.

o Wenn der Messanfang auf einen Minuswert eingestellt ist, siehe Abbildung 4-2.

Abbildung 4-1: Auswirkung der Durchflussrichtung auf den mA-Ausgang: Messanfang = 0

Durchflussrichtung = Vorwarts Durchflussrichtung = Riickwarts, Vorwarts Durchflussrichtung = Absolutwert, Bidirektional,
negieren Bidirektional negieren
20fF-----m - 20 20

| |
| |
| |
| |
212 | 212 212 |

© [ [
[ I {2 {2 I
(2] | (2] 2] |

=] =] 3
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. Messanfang = 0
. Messende = x
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Abbildung 4-2: Auswirkung der Durchflussrichtung auf den mA-Ausgang: Messanfang < 0

Durchflussrichtung = Vorwarts Durchflussrichtung = Riickwarts, Vorwarts

Durchflussrichtung = Absolutwert, Bidirektional,

20— 20 20
I v
I I I
I I I
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< : 1 :(( ::( 1 : 1
t 4 i i E 4 £ 4 i | i
1 1 | 1 | |
! ! . ! ! !

negieren Bidirektional negieren
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. Messanfang = -x

o Messende = x
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Beispiel: Durchflussrichtung = Vorwéarts und Messanfang = 0

Konfiguration:

o Durchflussrichtung = Vorwérts
. Messanfang =0 g/s

. Messende = 100 g/s

Ergebnis:
. Bei Riickwarts- oder Nulldurchfluss hat der mA-Ausgang 4 mA.

. Bei Vorwadrtsdurchfluss bis zu einem Durchfluss von 100 g/s liegt der mA-Ausgang
zwischen 4 mA und 20 mA, proportional zum Durchfluss.

. Bei Vorwdrtsdurchfluss, wenn der Durchfluss gleich oder héher als 100 g/s ist, ist der
mA-Ausgang bis 20,5 mA proportional zum Durchfluss und wird bei hoherem
Durchfluss auf 20,5 mA begrenzt.

Beispiel: Durchflussrichtung = Vorwarts und Messanfang < 0

Konfiguration:

. Durchflussrichtung = Vorwérts
o Messanfang =-100 g/s

. Messende = +100 g/s

Ergebnis:

o Bei Nulldurchfluss hat der mA Ausgang 12 mA.

. Bei Vorwdrtsdurchfluss bis zu einem Durchfluss zwischen 0 und +100 g/s liegt der
mA-Ausgang zwischen 12 mA und 20 mA, proportional zum Durchfluss (absoluter
Wert).

. Bei Vorwdrtsdurchfluss, wenn der Durchfluss (absoluter Wert) gleich oder héher als

100 g/s ist, ist der mA-Ausgang bis 20,5 mA proportional zum Durchfluss und wird
bei héherem Durchfluss auf 20,5 mA begrenzt.
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. Bei Riickwartsdurchfluss bis zu einem Durchfluss zwischen 0 und -100 g/s liegt der
mA-Ausgang zwischen 4 mA und 12 mA umgekehrt proportional zum absoluten
Wert des Durchflusses.

. Bei Riickwartsdurchfluss, wenn der absolute Wert des Durchflusses gleich oder
héherals 100 g/s ist, ist der mA-Ausgang bis 3,8 mA umgekehrt proportional und
wird bei héheren Absolutwerten auf 3,8 mA begrenzt.

Beispiel: Durchflussrichtung = Riickwarts

Konfiguration:

J Durchflussrichtung = Riickwérts
. Messanfang = 0 g/s

o Messende = 100 g/s

Ergebnis:
. Bei Vorwarts- oder Nulldurchfluss hat der mA-Ausgang 4 mA.

. Bei Riickwdrtsdurchfluss bis zu einem Durchfluss zwischen 0 und +100 g/s liegt der
mA-Ausgang zwischen 4 mA und 20 mA umgekehrt proportional zum absoluten
Wert des Durchflusses.

. Bei Riickwdrtsdurchfluss, wenn der absolute Wert des Durchflusses gleich oder
héherals 100 g/s ist, ist der mA Ausgang bis 20,5 mA proportional zum absoluten
Wert des Durchflusses und wird bei héherem absoluten Durchfluss auf 20,5 mA
begrenzt.

Auswirkungen der Durchflussrichtung auf die Frequenzausgdnge

Die Durchflussrichtung beeinflusst die Art, in der die Auswerteelektronik Durchflusswerte
ber die Frequenzausgange ausgibt. Frequenzausgiange werden nur dann von der
Durchflussrichtung beeinflusst, wenn die Prozessvariable Frequenzausgang auf eine
Durchflussvariable eingestellt ist.

Tabelle 4-6: Auswirkung des Parameters Durchflussrichtung und der tatsachlichen
Durchflussrichtung auf die Frequenzausgdnge

Einstellung der Durchfluss- Tatsachliche Durchflussrichtung
richtung Vorwarts Nulldurchfluss Riickwarts
Vorwérts Hz>0 0Hz 0Hz
Riickwarts OHz 0Hz Hz>0
Bidirektional Hz>0 0Hz Hz>0
Absolutwert Hz>0 0Hz Hz>0
Vorwarts negieren 0Hz OHz Hz>0
Bidirektional negieren Hz>0 0 Hz Hz>0

Auswirkungen der Durchflussrichtung auf die Bindrausgdange

Die Durchflussrichtung wirkt sich nur dann auf das Verhalten der Bindrausgdnge aus, wenn die
Bindrausgangsquelle auf Durchflussrichtung eingestellt ist.
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Tabelle 4-7: Auswirkung des Parameters Durchflussrichtung und der tatsachlichen
Durchflussrichtung auf die Bindrausgdnge

Einstellung der Durchflussrich- Tatsdchliche Durchflussrichtung

tung Vorwarts Nulldurchfluss Riickwarts
Vorwarts OFF OFF ON
Ruickwarts OFF OFF ON
Bidirektional OFF OFF ON
Absolutwert OFF OFF OFF
Vorwarts negieren ON OFF OFF
Bidirektional negieren ON OFF OFF

Auswirkungen der Durchflussrichtung auf die digitale
Kommunikation

Die Durchflussrichtung wirkt sich auf die Ausgabe von Durchflusswerten (iber die digitale
Kommunikation aus.

Tabelle 4-8: Auswirkung des Parameters Durchflussrichtung und der tatsachlichen
Durchflussrichtung auf die iiber die digitale Kommunikation
ausgegebenen Durchflusswerte

Einstellung der Durchfluss- Tatsachliche Durchflussrichtung
richtung Vorwarts Nulldurchfluss Riickwarts
Vorwarts Positiv 0 Negativ
Ruckwarts Positiv 0 Negativ
Bidirektional Positiv 0 Negativ
Absolutwert Positiv(3) 0 Positiv
Vorwarts negieren Negativ 0 Positiv
Bidirektional negieren Negativ 0 Positiv

Auswirkung der Durchflussrichtung auf Durchflusswerte

Die Durchflussrichtung wirkt sich auf die Berechnung von Summen- und Gesamtzdhlern aus.

Tabelle 4-9: Auswirkung des Parameters Durchflussrichtung und der tatsachlichen
Durchflussrichtung auf die Summen- und Gesamtzahler

. Tatsachliche Durchflussrichtung
Einstellung der Durch-
flussrichtung Vorwarts Nulldurchfluss Riickwarts
Vorwérts Zahler steigen Zahler andern sich nicht | Zahler andern sich
nicht
Riickwarts Zahler dndern sich Zdhler dndern sich nicht | Zahler steigen
nicht

(3) Siehe Statusbits der digitalen Kommunikation als Indikation, ob der Durchfluss positiv oder negativ ist.
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4.5

4.5.1

40

Tabelle 4-9: Auswirkung des Parameters Durchflussrichtung und der tatsachlichen
Durchflussrichtung auf die Summen- und Gesamtzdhler (Fortsetzung)

. Tatsdchliche Durchflussrichtung
Einstellung der Durch-
flussrichtung Vorwarts Nulldurchfluss Riickwarts
Bidirektional Zahler steigen Zahler andern sich nicht | Z&hler fallen
Absolutwert Zdhler steigen Zdhler andern sich nicht | Zahler steigen
Vorwarts negieren Zahler andern sich Zahler andern sich nicht | Zahler steigen

nicht

Bidirektional negieren Zahler fallen Zahler andern sich nicht | Zahler steigen

Konfigurieren der Dichtemessung

Die Dichtemessparameter steuern, wie die Dichte gemessen und ausgegeben wird. Die
Dichtemessung (zusammen mit der Massemessung) wird verwendet, um den
Volumendurchfluss fir Flissigkeiten zu bestimmen.

Die Dichtemessparameter beinhalten:

. Dichte Messeinheit

U Schwallstromparameter

. Dichtedampfung

. Dichteabschaltung

Konfigurieren der Dichte Messeinheit

ProLink Il ProLink > Configuration > Density > Density Units

ProLink Il Device Tools > Configuration > Process Measurement > Density

Handterminal Configure > Manual Setup > Measurements > Density > Density Unit
Uberblick

Die Density Measurement Unit gibt die Messeinheiten an, die als Dichtemessung angezeigt
werden.

Verfahren
Die Density Measurement Unit auf die gew{inschte Option einstellen.
Die Standardeinstellung fiir die Density Measurement Unit ist g/cm3 (Gramm pro

Kubikzentimeter).

Optionen fiir die Dichtemesseinheit

Die Auswerteelektronik bietet einen Standardsatz an Messeinheiten fiir die
Dichtemesseinheit. Verschiedene Kommunikations-Hilfsmittel verwenden u. U.
unterschiedliche Kennzeichnungen.
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Tabelle 4-10: Optionen fiir die Dichtemesseinheit

Bezeichnung
Beschreibung der Einheit ProLink II ProLink IlI Handterminal
Spezifische Dichteeinheit (nicht Temp. | SGU SGU
korrigiert)
Gramm pro Kubikzentimeter glem3 glem3
Gramm pro Liter gl g/l
Gramm pro Milliliter g/ml g/ml
Kilogramm pro Liter kg/l kgll
Kilogramm pro Kubikmeter kg/m3 kg/m3
Pfund pro U.S. Gallone Ibs/Usgal Ib/Gal
Pfund pro Kubikfu Ibs/ft3 Ib/ft3
Pfund pro Kubikzoll Ibs/in3 Ib/Culn
API Dichte degAPI degAPI
Short ton pro Kubikyard sTlyd3 ShTonlyd3
4.5.2 Schwallstrom Parameter konfigurieren
ProLink Il e ProLink > Configuration > Density > Slug High Limit

e ProLink > Configuration > Density > Slug Low Limit
e ProLink > Configuration > Density > Slug Duration

ProLink Il Device Tools > Configuration > Process Measurement > Density

Handterminal *  Configure > Manual Setup > Measurements > Density > Slug Low Limit
*  Configure > Manual Setup > Measurements > Density > Slug High Limit
*  Configure > Manual Setup > Measurements > Density > Slug Duration

Uberblick

Die Schwallstrom Parameter steuern, wie die Auswerteelektronik eine
Zweiphasenstromung (Gas in einem Fliissigkeitsprozess oder Fliissigkeit in einem
Gasprozess) erkennt und ausgibt.

Verfahren

1. Setzen Sie Unterer Schwallstrom Grenzwert auf den niedrigsten Dichtewert, derin Ihrem
Prozess als normal betrachtet wird.

Werte unter diesem Grenzwert fiihren dazu, gass die Auswerteelektronik die fiir
Schwallstrom konfigurierte Aktion ausfiihrt. Ublicherweise ist dieser Wert die
niedrigste Dichte im normalen Bereich Ihres Prozesses.

Hinweis

Gaseinschliisse konnen dazu fiihren, dass die Prozessdichte kurzzeitig abfallt. Um das
Auftreten von Schwallstrom Alarmen, die fiir den Prozess nicht von Bedeutung sind, zu
reduzieren, setzen Sie Unterer Schwallstrom Grenzwert etwas unterhalb der niedrigsten
erwarteten Prozessdichte.
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Sie miissen Unterer Schwallstrom Grenzwert in g/cm?3 auch dann eingeben, wenn Sie eine
andere Einheit fiir die Dichtemessung konfiguriert haben.

Der voreingestellte Wert fiir Unterer Schwallstrom Grenzwert ist 0,0 g/cm?. Der Bereich
ist 0,0 bis 10,0 g/cm?.

2. Setzen Sie Oberer Schwallstrom Grenzwert auf den hochsten Dichtewert, der in lhrem
Prozess als normal betrachtet wird.

Werte iber diesem Grenzwert fiihren dazu, dgss die Auswerteelektronik die fiir
Schwallstrom konfigurierte Aktion ausfiihrt. Ublicherweise ist dieser Wert die
hdchste Dichte im normalen Bereich lhres Prozesses.

Hinweis

Um das Auftreten von Schwallstrom Alarmen, die fiir den Prozess nicht von Bedeutung sind,
zu reduzieren, setzen Sie Oberer Schwallstrom Grenzwert etwas oberhalb der héchsten erwarteten
Prozessdichte.

Sie miissen Oberer Schwallstrom Grenzwert in g/cm? auch dann eingeben, wenn Sie eine
andere Einheit fiir die Dichtemessung konfiguriert haben.

Der voreingestellte Wert fiir Oberer Schwallstrom Grenzwert ist 5,0 g/cm?3. Der Bereich
ist 0,0 bis 10,0 g/cm?.

3. Setzen Sie Schwallstromdauer auf die Anzahl der Sekunden, die die Auswerteelektronik
auf die Beseitigung einer Schwallstrombedingung wartet, bevor die fiir
Schwallstrom konfigurierte Aktion ausgefiihrt wird.

Der voreingestellte Wert fiir Schwallstromdauer ist 0,0 s. Der Bereich ist 0,0 bis 60,0 s.

Schwallstromerkennung und -ausgabe

Die Schwallstromung wird (iblicherweise als Indikator eines Zweiphasenstroms (Gas in
einem Fliissigkeitsprozess oder Fliissigkeit in einem Gasprozess) verwendet. Der
Zweiphasenstrom kann verschiedene Probleme bei der Prozessregelung verursachen.
Durch die richtige Konfiguration der Schwallstromparameter fiir Ihre Anwendung kénnen
Sie Prozessbedingungen erkennen, die korrigiert werden mdiissen.

Hinweis
Um das Auftreten von Schwallstromalarmen zu reduzieren, senken Sie den Unteren Schwallstrom-
Grenzwert oder erhohen den Oberen Schwallstrom-Grenzwert.

Eine Schwallstrémung tritt auf, wenn die gemessene Dichte unter den Unteren Schwallstrom-
Grenzwert fallt oder Giber den Oberen Schwallstrom-Grenzwert steigt. In diesem Fall:

. Wird ein Schwallstromalarm in der aktiven Alarmliste gesetzt.

o Alle Ausgange, die auf Durchfluss konfiguriert sind, halten den letzten gemessenen
Durchflusswert vor der Schwallstromung bis zum Ende der konfigurierten
Schwallstromdauer.

Wenn der Schwallstromzustand verschwindet, bevor die Schwallstromdauer abgelaufen ist:

. Ausgange, die auf Durchfluss konfiguriert sind, kehren zur aktuellen
Durchflussanzeige zuriick.

o Der Schwallstromalarm wird deaktiviert, verbleibt aber in der Alarmliste bis er
bestatigt ist.
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Wenn der Schwallstromzustand nicht verschwindet, bevor die Schwallstromdauer abgelaufen
ist, zeigen die Ausgange die auf Durchfluss konfiguriert sind, Nulldurchfluss an.

Wenn die Schwallstromdauer auf 0,0 Sekunden eingestellt ist, zeigen die Ausgdnge, die auf
Durchfluss konfiguriert sind, Nulldurchfluss an, sobald ein Schwallstromzustand erkannt
wird.

4.5.3 Konfigurieren der Dichtedampfung

ProLink Il ProLink > Configuration > Density > Density Damping

ProLink Il Device Tools > Configuration > Process Measurement > Density

Handterminal Configure > Manual Setup > Measurements > Density > Density Damping
Uberblick

Die Ddmpfung wird verwendet, um kleine, pl6tzlich auftretende Schwankungen des
Prozessmesswerts zu glatten. Damping Value gibt die Zeitdauer (in Sekunden) an, Gber die
die Auswerteelektronik die Anderungen in der ausgegebenen Prozessvariable verteilt. Am
Ende des Intervalls spiegelt die ausgegebene Prozessvariable 63 % der Anderung des
eigentlichen gemessenen Wertes wider.

Verfahren
Density Damping auf den gewiinschten Wert einstellen.

Der Standardwert ist 1,6 Sekunden. Der Bereich richtet sich nach dem Typ des Core
Prozessors und der Einstellung von Update Rate (siehe nachfolgende Tabelle):

Core Prozessor Typ EinstellungUpdate Rate: Bereich fiir Density Damping
Standard Normal 0 bis 51,2 Sekunden
Spezial 0 bis 10,24 Sekunden
Erweiterte Funktionalitdt | Nicht anwendbar 0 bis 40,96 Sekunden
Hinweise

e Ein hoher Dampfungswert |dsst die Prozessvariable regelmaRiger erscheinen, da der
ausgegebene Wert sich langsamer andert.

* Ein niedriger Dampfungswert ldsst die Prozessvariable unregelmaRiger erscheinen, da der
ausgegebene Wert sich schneller andert.

e Immer, wenn der Dampfungswert nicht Null ist, wird der ausgegebene Messwert hinter der
eigentlichen Messung liegen, da der ausgegebene Wert (iber die Zeit gemittelt wird.

* Allgemein werden niedrigere Dampfungswerte vorgezogen, da das Risiko von Datenverlusten
und die Verzdgerung zwischen dem eigentlichem und dem ausgegebenen Wert geringer ist.

Der eingegebene Wert wird automatisch auf den nachst gliltigen Wert abgerundet. Die
glltigen Werte fiir Density Damping sind von der Einstellung von Update Rate abhdngig.
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4.5.4
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Tabelle 4-11: Giiltige Werte fiir Density Damping

Core Prozessor Typ EinstellungUpdate Rate: Giiltige Dampfungswerte
Standard Normal 0,0.2,04,08,...51.2

Spezial 0,0.04,0.08, 0.16, ... 10.24
Erweiterte Funktionalitdt | Nicht anwendbar 0,0.04, 0.08, 0.16, ... 40.96

Effekt der Dichtedampfung auf die Volumenmessung

Die Dichtedampfung wirkt sich auf die Fliissigkeitsvolumenmessung aus. Die Werte des
Flissigkeitsvolumens werden mittels des gedampften Dichtewerts anstatt des
gemessenen Dichtewerts errechnet. Die Dichteddmpfung wirkt sich nicht auf die Standard-
Gasvolumenmessung aus.

Interaktion zwischen Dichteddmpfung und Zusatzlicher Dampfung

In einigen Féllen werden sowohl die Dichteddmpfung als auch die Zusatzliche Dampfung auf den
ausgegebenen Dichtewert angewandt.

Die Dichteddmpfung regelt die Anderungsrate der Dichte-Prozessvariablen. Die Zusétzliche
Dampfung regelt die Anderungsrate, die (iber den mA-Ausgang ausgegeben wird. Wenn die
mA-Ausgangs-Prozessvariable auf Dichte gesetzt ist und sowohl die Dichteddmpfung als auch die
Zusatzliche Dampfung auf einen Wert ungleich Null gesetzt sind, wird zuerst die
Dichtedampfung angewandt, und die Berechnung der zusatzlichen Dampfung wird auf
das Ergebnis der ersten Rechnung angewandt

Konfigurieren der Dichteabschaltung

ProLink Il ProLink > Configuration > Density > Low Density Cutoff

ProLink Il Device Tools > Configuration > Process Measurement > Density

Handterminal Configure > Manual Setup > Measurements > Density > Density Cutoff
Uberblick

Density Cutoff gibt den niedrigsten Dichtewert an, der als gemessen ausgegeben wird. Alle
Dichtewerte unter dieser Abschaltung werden als 0 ausgegeben.

Verfahren

Density Cutoff auf den gewiinschten Wert einstellen.

Der Standardwert fiir Density Cutoff ist 0,2 g/cm3. Der Bereich liegt bei 0,0 g/cm?3 bis
0,5 g/cm3.

Auswirkung der Dichteabschaltung auf die Volumenmessung

Dichteabschaltung beeinflusst die Volumenmessung von Fliissigkeiten. Wenn der Dichtewert
die Dichteabschaltung unterschreitet, wird die Volumendurchflussrate als 0 wiedergegeben.
Dichteabschaltung beeinflusst nicht die Standardvolumenmessung von Gas.
Standardvolumenwerte von Gas werden immer vom gemessenen Dichtewert berechnet.
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4.6

4.6.1

Konfigurieren einer Temperaturmessung

Die Parameter der Temperaturmessung steuern, wie die Temperaturdaten vom Sensor
ausgegeben werden. Die Temperaturdaten werden verwendet, um die Auswirkungen zu
kompensieren, die die Temperatur auf Messrohre wahrend Durchflussmessungen hat.
Die Parameter der Temperaturmessung umfassen:

J Temperature Measurement Unit

U Temperature Damping

Konfigurieren einer Temperatur Messeinheit

ProLink Il ProLink > Configuration > Temperature > Temp Units

ProLink Il Device Tools > Configuration > Process Measurement > Temperature

Handterminal Configure > Manual Setup > Measurements > Temperature > Temperature Unit
Uberblick

Temperature Measurement Unit gibt die Einheit an, die fiir die Temperaturmessung verwendet
wird.

Verfahren
Setzen Sie Temperature Measurement Unit auf die gew{inschte Option.

Die Standardeinstellung ist Degrees Celsius.

Optionen fiir die Temperatur Messeinheit

Die Auswerteelektronik bietet einen Standardsatz an Messeinheiten fiir Temperature
Measurement Unit. Unterschiedliche Kommunikations-Hilfsmittel verwenden
maoglicherweise unterschiedliche Kennzeichnungen fiir die Einheiten.

Tabelle 4-12: Optionen fiir Temperature Measurement Unit

Kennzeichnung
Beschreibung der Einheit ProLink I ProLink IlI Handterminal
Grad Celsius GradC °C GradC
Grad Fahrenheit °F °F °F
Grad Rankine °R °R °R
Kelvin degK °K Kelvin
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4.6.2
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Konfigurieren der Temperaturdampfung

ProLink Il ProLink > Configuration > Temperature > Temp Damping

ProLink Il Device Tools > Configuration > Temperature

Handterminal Configure > Manual Setup > Measurements > Temperature > Temp Damping
Uberblick

Die Ddmpfung wird verwendet, um kleine, pl6tzlich auftretende Schwankungen des
Prozessmesswerts zu glatten. Damping Value gibt die Zeitdauer (in Sekunden) an, Gber die
die Auswerteelektronik die Anderungen in der ausgegebenen Prozessvariable verteilt. Am
Ende des Intervalls spiegelt die ausgegebene Prozessvariable 63 % der Anderung des
eigentlichen gemessenen Wertes wider.

Verfahren
Geben Sie den Wert ein, der fiir Temperature Damping verwendet werden soll.

Der Standardwert betridgt 4,8 Sekunden. Der Bereich liegt zwischen 0,0 und
76,8 Sekunden.

Hinweise

e Ein hoher Dampfungswert |3sst die Prozessvariable regelmaRiger erscheinen, da der
ausgegebene Wert sich langsamer dndert.

* Ein niedriger Dampfungswert ldsst die Prozessvariable unregelmdRiger erscheinen, da der
ausgegebene Wert sich schneller andert.

* Immer, wenn der Ddmpfungswert nicht Null ist, wird der ausgegebene Messwert hinter der
eigentlichen Messung liegen, da der ausgegebene Wert {iber die Zeit gemittelt wird.

* Allgemein werden niedrigere Ddmpfungswerte vorgezogen, da das Risiko von Datenverlusten
und die Verzégerung zwischen dem eigentlichem und dem ausgegebenen Wert geringer ist.

Der eingegebene Wert wird automatisch auf den nachsten giiltigen Wert abgerundet.
Giiltige Werte fiir Temperature Damping sind 0, 0,6, 1,2,2,4,48, ... 76,8.

Auswirkung der Temperaturddmpfung auf die Prozessmessung

Die Temperaturdampfung beeinflusst die Reaktionsgeschwindigkeit der
Temperaturkompensation bei schwankenden Temperaturen. Die
Temperaturkompensation passt die Prozessmessung an, um den Temperatureinfluss auf
das Messrohr zu kompensieren.

Die Temperaturddmpfung beeinflusst die Prozessvariablen der Mineralélmessung nur dann,
wenn die Auswerteelektronik so konfiguriert wurde, dass sie Temperaturdaten vom Sensor
verwendet. Wenn ein externer Temperaturwert fiir die Mineral6lmessung verwendet wird,
wirkt sich die Temperaturd@mpfung nicht auf die Prozessvariablen der Mineral6lmessung aus

Die Temperaturddmpfung beeinflusst die Prozessvariablen der Konzentrationsmessung nur
dann, wenn die Auswerteelektronik so konfiguriert wurde, dass sie Temperaturdaten vom
Sensor verwendet. Wenn ein externer Temperaturwert fiir die Konzentrationsmessung
verwendet wird, wirkt sich die Temperaturddmpfung nicht auf die Prozessvariablen der
Konzentrationsmessung aus
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4.7 Anwendung Mineralélmessung konfigurieren

Die Mineral6lmessung ermdglicht die Messung des temperaturkorrigierten
Flissigkeitsvolumens oder CTL. Die Anwendung berechnet einen Volumendurchfluss-
Korrekturfaktor und wendet diesen auf die Volumenmessung an. Interne Berechnungen
entsprechen den Standards des American Petroleum Institute (API).

4.7.1 Mineralolmessung konfigurieren unter Verwendung von
ProLink Il

Wahlen Sie ProLink > Configuration > API Setup.

2. Geben Sie an, welche API-Tabelle verwendet werden soll.

a. Widhlen Sie unter API-Kapitel 11.1 Tabellentyp die API-Tabellengruppe.

b. Wadhlen Sie unter Units die zu verwendenden MaReinheiten.

Die API-Tabelle wird durch diese zwei Parameter genau spezifiziert.

3. Wenn lhre API Tabelle 53A, 53B, 53D oder 54C ist, setzen Sie die Referenztemperatur auf
den entsprechenden Wert fiir Ihre Anwendung. Geben Sie den Wert in °C ein.

4. Wenn lhre APl Tabelle 6C, 24C oder 54C ist, setzen Sie den Warmeausdehnungskoeffizient
auf den entsprechenden Wert fiir Ihre Anwendung.

5.  Ermitteln Sie, wie die Auswerteelektronik die Temperaturdaten fir die
Berechnungen der Minerallmessung empfangt und fiihren Sie die entsprechende
Einrichtung durch.

Option Einrichtung
Temperaturdaten a. Wabhlen Sie View > Preferences .
vom Sensor b. Deaktivieren Sie Use External Temperature.

Wabhlen Sie View > Preferences .

Aktivieren Sie Use External Temperature.

Wabhlen Sie ProLink > Configuration > Temperature.

Stellen Sie die External Temperature auf den zu verwendenden
Wert ein.

Ein vom Anwender
konfigurierter sta-
tischer Temperatur-
wert

on oo
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Option

Einrichtung

Abfrage fiir Tem-
peratur(4)

a. Stellen Sie sicher, dass der primdre mA Ausgang gemaR HART-

Abfrage verdrahtet wurde.

Wahlen Sie View > Preferences .

Aktivieren Sie Use External Temperature.

Wahlen Sie ProLink > Configuration > Polled Variables.

Wahlen Sie einen freien Abfrage-Slot.

Setzen Sie Polling Control auf Poll As Primary oder Poll as Secondary

und klicken Sie dann auf Apply.

g. Setzen Sie External Tag auf die HART-Kennzeichnung des exter-
nen Temperaturmessgerats.

h. Setzen Sie Variable Type auf External Temperature.

mpon o

Hinweis

e Als Primar abfragen: Auf dem Netzwerk ist kein anderer HART Mas-
ter vorhanden.

e Als Sekundar abfragen: Auf dem Netzwerk sind andere HART Mas-
ter vorhanden. Das Handterminal ist kein HART Master.

Ein von der digital-
en Kommunikation
bereitgestellter
Wert

a. Wahlen Sie View > Preferences .

b. Aktivieren Sie Use External Temperature.

c. Fihren Sie die erforderlichen Schritte zur Programmierung des
Hostsystems und zur Einrichtung der Kommunikation durch, um
Temperaturdaten in entsprechenden Intervallen auf die Auswer-
teelektronik zu schreiben.

Anmerkung

Wenn die Weights & Measures Anwendung (eichamtlicher Transfer)
implementiert ist und die Auswerteelektronik schreibgeschiitzt ist,
kann die digitale Kommunikation nicht verwendet werden, um
Temperaturdaten auf die Auswerteelektronik zu schreiben.

4.7.2 Mineral6lmessung konfigurieren unter Verwendung von

ProLink Il

Wahlen Sie Device Tools > Configuration > Process Measurement > Petroleum Measurement.

2. Geben Sie an, welche API-Tabelle verwendet werden soll.

a. Widhlen Sie die API-Tabellengruppe aus dem API-Tabellentyp aus.

b. Stellen Sie die Petroleum Measurement Units auf die zu verwendenden MaReinheiten

ein.

c. Klicken Sie auf Apply.

Die API-Tabelle wird durch diese zwei Parameter genau spezifiziert.

3. Wenn lhre APl Tabelle 53A, 53B, 53D oder 54C ist, setzen Sie die Referenztemperatur auf
den entsprechenden Wert fiir lhre Anwendung. Geben Sie den Wert in °C ein.

4.  Wenn lhre API Tabelle 6C, 24C oder 54C ist, setzen Sie den Warmeausdehnungskoeffizient
auf den entsprechenden Wert fiir Ihre Anwendung.

(4) Nicht bei allen Auswerteelektroniken verfiigbar.
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5. Setzen Sie Temperature Source auf die Methode, die die Auswerteelektronik fiir den
Empfang der Temperaturdaten verwendet.

Option Beschreibung

Externen Wert abfragen(®) Die Auswerteelektronik fragt ein externes Temperaturmess-
gerat ab. Sie verwendet hierfiir das HART-Protokoll iiber den
primdren mA Ausgang.

Widerstandsthermometer Die Auswerteelektronik verwendet die Temperaturdaten
vom Sensor.

Statische oder digitale Kommuni- = Die Auswerteelektronik verwendet den aus dem Speicher

kation gelesenen Temperaturwert.

 Statisch: Der konfigurierte Wert wird verwendet.

¢ Digitale Kommunikation: Ein externer Host schreibt Dat-
en in den Speicher der Auswerteelektronik.

Fiir beide Optionen wird der gleiche Speicherort verwendet.

Externe Temperaturdaten werden nur fiir Berechnungen bei Mineral6lmessungen
verwendet. Alle anderen Berechnungen der Auswerteelektronik verwenden die
Temperaturdaten vom Sensor.

6.  Wenn Sie RTD wahlen, ist keine weitere Konfiguration erforderlich. Klicken Sie auf
Apply um zu verlassen.

7. Wenn Sie die Abfrage von Temperaturdaten wahlen:

a. Waihlen Sie den zu verwendenden Polling Slot.

b. Setzen Sie Polling Control auf Poll as Primary oder auf Poll as Secondary und klicken Sie
dann auf Apply.

Hinweis
 Als Primér abfragen: Auf dem Netzwerk ist kein anderer HART Master vorhanden.

e Als Sekundar abfragen: Auf dem Netzwerk sind andere HART Master vorhanden. Das
Handterminal ist kein HART Master.

c. Setzen Sie die External Device Tag auf die HART-Kennzeichnung des externen
Temperaturmessgerdts und klicken Sie auf Apply.

8.  Wenn Sie einen statischen Temperaturwert wahlen, stellen Sie External Temperature
auf den zu verwendenden Wert ein und klicken Sie auf Apply.

9.  Wenn Sie digitale Kommunikation verwenden méchten, fiihren Sie die
erforderlichen Schritte zur Programmierung des Hostsystems und zur Einrichtung
der Kommunikation durch, um Temperaturdaten in entsprechenden Intervallen auf
die Auswerteelektronik zu schreiben.

Anmerkung

Wenn die Weights & Measures Anwendung (eichamtlicher Transfer) implementiert ist und die
Auswerteelektronik schreibgeschiitzt ist, kann die digitale Kommunikation nicht verwendet
werden, um Temperaturdaten auf die Auswerteelektronik zu schreiben.

(5) Nicht bei allen Auswerteelektroniken verfiigbar.
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4.7.3 Mineralolmessung konfigurieren unter Verwendung von
Handterminal

1. Wahlen Sie Online > Configure > Manual Setup > Measurements > Set Up Petroleum.

2. Geben Sie an, welche API-Tabelle verwendet werden soll.

a. Offnen Sie das Menti Petroleum Measurement Source und wihlen Sie die API-
Tabellennummer.

Je nach Ihrer Auswahl werden Sie evtl. zur Eingabe einer Referenztemperatur
oder eines Warmeausdehnungskoeffizienten aufgefordert.

b. Geben Sie den Buchstaben der API-Tabelle ein.

Die API-Tabelle wird durch diese zwei Parameter genau spezifiziert.
3. Ermitteln Sie, wie die Auswerteelektronik die Temperaturdaten fir die

Berechnungen der Konzentrationsmessung empfangt und fiihren Sie die
entsprechende Einrichtung durch.

Option Einrichtung

Temperaturdaten a. Wahlen Sie Online > Configure > Manual Setup > Measurements > Exter-
vom Sensor nal Pressure/Temperature > Temperature.
b. Setzen Sie die External Temperature auf Disabled.

Ein vom Anwender | a. Waéhlen Sie Online > Configure > Manual Setup > Measurements > Exter-

konfigurierter sta- nal Pressure/Temperature > Temperature.

tischer Temperatur- b. Setzen Sie die External Temperature to Enabled.

wert c. Stellen Sie die Correction Temperature auf den zu verwendenden
Wert ein.

Abfrage fiir Tem- a. Stellen Sie sicher, dass der primdre mA Ausgang gemaR HART-

peratur(®) Abfrage verdrahtet wurde.

b. Wihlen Sie Online > Configure > Manual Setup > Measurements > Exter-
nal Pressure/Temperature > Temperature.

c. Setzen Sie die External Temperature auf Enabled.

d. Wabhlen Sie External Polling.

e. Setzen Sie die Poll Control auf Poll As Primary oder auf Poll as Secon-
dary.

f. Entscheiden Sie, ob Abfrage-Slot 1 oder Abfrage-Slot 2 verwen-
det werden soll.

g. Setzen Sie die Externe Geratekennung fiir den gewdhlten Slot auf
die HART-Kennzeichnung des externen Temperaturmessgeréts.

h. Setzen Sie die Polled Variable fiir den gewahlten Slot auf Tempera-
ture.

Hinweis

e Als Primar abfragen: Auf dem Netzwerk ist kein anderer HART Mas-
ter vorhanden.

e Als Sekundar abfragen: Auf dem Netzwerk sind andere HART Mas-
ter vorhanden. Das Handterminal ist kein HART Master.

(6) Nicht bei allen Auswerteelektroniken verfiigbar.
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4.7.4

Option

Einrichtung

Ein von der digital-  a.
en Kommunikation
bereitgestellter

Wert

Wahlen Sie Online > Configure > Manual Setup > Measurements > Exter-
nal Pressure/Temperature > Temperature.

b. Setzen Sie die External Temperature auf Enabled.

Fiihren Sie die erforderlichen Schritte zur Programmierung des
Hostsystems und zur Einrichtung der Kommunikation durch, um
Temperaturdaten in entsprechenden Intervallen auf die Auswer-
teelektronik zu schreiben.

Anmerkung

Wenn die Weights & Measures Anwendung (eichamtlicher Transfer)
implementiert ist und die Auswerteelektronik schreibgeschiitzt ist,
kann die digitale Kommunikation nicht verwendet werden, um
Temperaturdaten auf die Auswerteelektronik zu schreiben.

API Referenztabellen

Tabelle 4-13: API Referenztabellen, zugehérige Prozessmedien und zugehorige Berechnungswerte

konstanter Basisdichte
oder bekanntem War-
meausdehnungskoeffi-
zient

ferte Dichte (oder War-
meausdehnungskoeffi-
zient) und die beobach-
tete Temperatur

bar)

Tabellen-
name Prozessmedium CTL Quelldaten Referenztemperatur Dichteeinheit
5A Allgemeines Rohdlund | Beobachtete Dichte und | 60 °F (nicht konfigurier- = Grad API
JP4 Temperatur bar) Bereich: 0 bis 100
5B Allgemeine Produkte Beobachtete Dichte und | 60 °F (nicht konfigurier- | Grad API
Temperatur bar) Bereich: 0 bis 85
5D Schmieréle Beobachtete Dichte und | 60 °F (nicht konfigurier- | Grad API
Temperatur bar) Bereich: -10 bis +40
6C Flissigkeiten mit Vom Anwender gelie- 60 °F (nicht konfigurier- | Grad API
konstanter Basisdichte | ferte Dichte (oder War- | bar)
oder bekanntem War- meausdehnungskoeffi-
meausdehnungskoeffi- | zient) und die beobach-
zient tete Temperatur
23A Allgemeines Rohdlund | Gemessene Dichte und | 60 °F (nicht konfigurier- | Relative Dichte
P4 Temperatur bar) Bereich: 0,6110 bis
1,0760
23B Allgemeine Produkte Beobachtete Dichte und | 60 °F (nicht konfigurier- | Relative Dichte
Temperatur bar) Bereich: 0,6535 bis
1,0760
23D Schmieréle Beobachtete Dichte und | 60 °F (nicht konfigurier- | Relative Dichte
Temperatur bar) Bereich: 0,8520 bis
1,1640
24C FlGssigkeiten mit Vom Anwender gelie- 60 °F (nicht konfigurier- | Relative Dichte
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Tabelle 4-13: API Referenztabellen, zugehérige Prozessmedien und zugehorige Berechnungswerte

(Fortsetzung)
Tabellen-
name Prozessmedium CTL Quelldaten Referenztemperatur Dichteeinheit
53A Allgemeines Rohdlund | Beobachtete Dichte und | 15 °C (konfigurierbar) Basisdichte
P4 Temperatur Bereich: 610 bis
1075 kg/m3
53B Allgemeine Produkte Beobachtete Dichte und | 15 °C (konfigurierbar) Basisdichte
Temperatur Bereich: 653 bis
1075 kg/m3
53D Schmieréle Beobachtete Dichte und | 15 °C (konfigurierbar) Basisdichte
Temperatur Bereich: 825 bis
1164 kg/m?3
54C FlGssigkeiten mit Vom Anwender gelie- 15 °C (konfigurierbar) Basisdichte in kg/m3
konstanter Basisdichte | ferte Dichte (oder War-
oder bekanntem War- meausdehnungskoeffi-
meausdehnungskoeffi- | zient) und die beobach-
zient tete Temperatur
4.8 Konfigurieren der Anwendung
Konzentrationsmessung
Die Anwendung Konzentrationsmessung berechnet Konzentrationsdaten aus
Prozesstemperatur und Dichte. Micro Motion stellt einen Satz von Konzentrationsmatrizen
zur Verfligung, die die Referenzdaten fiir viele hundert Standard-Industrieanwendungen
und Prozessmedien liefern. Falls gewiinscht kann eine anwenderdefinierte Matrix fiir das
entsprechende Prozessmedium erstellt oder eine tiber Micro Motion erworben werden.
Weiteren Informationen bzgl. der Anwendung zur Konzentrationsmessung sind im
folgenden Handbuch verfiigbar: Micro Motion Anwendung mit erweiterter Dichte: Theorie,
Konfiguration und Betrieb.
Anmerkung
Die Anwendung zur Konzentrationsmessung ist auch als erweiterte Dichteanwendung bekannt.
4.8.1 Konfigurieren der Konzentrationsmessung unter

Verwendung von ProLink I

Diese Aufgabe fiihrt Sie durch das Laden und die Einrichtung einer Konzentrationsmatrix
fiir die Messung. Das Erstellen einer Konzentrationsmatrix wird hier nicht beschrieben.

Anmerkung

Konzentrationsmatrixen kdnnen entweder durch Laden einer bestehenden Matrix aus einer Datei
oder durch Erstellen einer neuen Matrix geladen werden. lhre Auswerteelektronik kann bis zu sechs
Matrixen laden, es kann jedoch immer nur eine Matrix zur Messung verwendet werden. Detaillierte
Informationen zum Erstellen einer Matrix finden Sie unter Micro Motion Anwendung mit erweiterter
Dichte: Theorie, Konfiguration und Betrieb.
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Vorbereitungsverfahren

Bevor Sie die Konzentrationsmessung konfigurierent kénnen:

Die Anwendung Konzentrationsmessung muss auf Ihrer Auswerteelektronik
aktiviert sein.

Die zu verwendende Konzentrationsmatrix muss entweder auf Ihrer
Auswerteelektronik oder als Datei auf lhrem Computer vorhanden sein.

Sie missen die abgeleitete Variable kennen, fiir die Ihre Matrix vorgesehen ist.
Sie miissen die von lhrer Matrix verwendete MaReinheit fiir die Dichte kennen.
Sie missen die von lhrer Matrix verwendete MaReinheit fiir die Temperatur kennen.

Die Anwendung zur Konzentrationsmessung muss freigegeben sein.

Verfahren

1.

Wabhlen Sie ProLink > Configuration > Density und stellen Sie die Density Units auf die von
lhrer Matrix verwendete Dichte Einheit ein.

Wahlen Sie ProLink > Configuration > Temperature und stellen Sie die Temp Units auf die
von lhrer Matrix verwendete Temperatur Einheit ein.

Wahlen Sie ProLink > Configuration > CM Setup.

Stellen Sie unter Global Config, set Derived Variable auf die von Ihrer Matrix
verwendete abgeleitete Variable ein.

Wichtig

e Alle Konzentrationsmatrixen in der Auswerteelektronik miissen die gleiche abgeleitete
Variable verwenden. Wenn Sie eine der Standardmatrixen von Micro Motion verwenden,
stellen Sie die Derived Variable auf Mass Conc (Density) ein. Wenn Sie eine benutzerdefinierte
Matrix verwenden, siehe Referenzinformationen fiir Ihre Matrix.

e Wenn Sie die Einstellung der abgeleiteten Variable verandern, werden alle vorhandenen
Konzentrationsmatrizen aus dem Speicher der Auswerteelektronik geldscht. Stellen Sie
die abgeleitete Variable ein, bevor Sie die Konzentrationsmatrixen laden.

Laden Sie eine oder mehrere Matrizen.

a. Unter Curve Specific Config, setzen Sie Curve Configured auf den Speicherort, auf
den die Matrix geladen wird.

b. Klicken Sie auf Load this curve from a file, navigieren Sie zur Matrixdatei auf Ihrem PC
und laden Sie die Matrix.

c. Wiederholen Sie diesen Vorgang, bis alle benétigten Matrixen geladen wurden.

Richten Sie die Extrapolationsalarme ein.

Jede Konzentrationsmatrix ist fiir einen bestimmten Dichtebereich und einen
bestimmten Temperaturbereich ausgelegt. Wenn die Prozessdichte oder -
temperatur diesen Bereich verldsst, extrapoliert die Auswerteelektronik die
Konzentrationswerte. Die Extrapolation kann jedoch die Genauigkeit
beeintrachtigen. Extrapolationsalarme machen den Bediener darauf aufmerksam,
dass eine Extrapolation stattfindet.

a. Unter Curve Specific Config, setzen Sie Curve Configured auf die zu konfigurierende
Matrix.

b. Stellen Sie Alarm Limit auf den Prozentsatz ein, bei dem ein Extrapolationsalarm
ausgegeben werden soll.
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c. Aktivieren bzw. deaktivieren Sie je nach Wunsch die oberen und unteren
Alarmgrenzwerte fiir die Temperatur und Dichte.

Einschrdnkung

Fiir die unteren und oberen Alarmgrenzwerte ist ein Core Prozessor mit erweiterter
Funktionalitat erforderlich.

Beispiel: Wenn die Alarm Limit auf 5 % eingestellt ist, Enable Temp High markiert ist und
eine Matrix fir den Temperaturbereich von 40 °F bis 80 °F eingerichtet wird, wird ein
Extrapolationsalarm gesetzt, wenn die Temperatur 82 °F (iberschreitet.

7. Wihlen Sie die Kennzeichnung fiir die Konzentrationseinheit aus.
a. Unter Curve Specific Config stellen Sie Curve Configured auf die zu konfigurierende
Matrix ein.
b. Wabhlen Sie die gewlinschte Kennzeichnung aus der Liste Units aus.

c. Wenn die Units auf Special eingestellt werden, geben Sie eine benutzerdefinierte
Kennzeichnung ein.

8.  Ermitteln Sie, wie die Auswerteelektronik die Temperaturdaten fir die
Berechnungen der Konzentrationsmessung empfangt und fiihren Sie die
entsprechende Einrichtung durch.

Option Einrichtung
Temperaturdaten  a. Waihlen Sie View > Preferences .
vom Sensor b. Deaktivieren Sie Use External Temperature.

Ein vom Anwender | a. Wéhlen Sie View > Preferences .

konfiguriertersta- | b. Aktivieren Sie Use External Temperature.

tischer Temperatur- c. Wahlen Sie ProLink > Configuration > Temperature.

wert d. Stellen Sie die externe Temperatur auf den zu verwendenden Wert
ein.

Abfrage fiir Tem- a. Stellen Sie sicher, dass der primare mA Ausgang gemaR HART-

peratur(?) Abfrage verdrahtet wurde.

Wabhlen Sie View > Preferences .

Aktivieren Sie Use External Temperature.

Wabhlen Sie ProLink > Configuration > Polled Variables.

Wabhlen Sie einen freien Abfrage-Slot.

Setzen Sie Polling Control auf Poll As Primary oder Poll as Secondary

und klicken Sie dann auf Apply.

g. Setzen Sie External Tag auf die HART-Kennzeichnung des exter-
nen Temperaturmessgerats.

h. Setzen Sie Variable Type auf External Temperature.

hoan o

Hinweis

e Als Primar abfragen: Auf dem Netzwerk ist kein anderer HART Mas-
ter vorhanden.

e Als Sekundar abfragen: Auf dem Netzwerk sind andere HART Mas-
ter vorhanden. Das Handterminal ist kein HART Master.

(7) Nicht bei allen Auswerteelektroniken verfiigbar.
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Option Einrichtung

Einvon der digital- | a. Wahlen Sie View > Preferences .

en Kommunikation | b. Aktivieren Sie Use External Temperature.

bereitgestellter c. Fuhren Sie die erforderlichen Schritte zur Programmierung des
Wert Hostsystems und zur Einrichtung der Kommunikation durch, um
Temperaturdaten in entsprechenden Intervallen auf die Auswer-
teelektronik zu schreiben.

Anmerkung

Wenn die Weights & Measures Anwendung (eichamtlicher Transfer)
implementiert ist und die Auswerteelektronik schreibgeschiitzt ist,
kann die digitale Kommunikation nicht verwendet werden, um
Temperaturdaten auf die Auswerteelektronik zu schreiben.

9.  Stellen Sie unter Global Config die Active Curve auf die fiir die Prozessmessung zu
verwendende Matrix ein.

Die Prozessvariablen fiir die Konzentration sind jetzt auf der Auswerteelektronik verfligbar.
Sie konnen Sie auf die gleiche Weise anzeigen und ausgeben wie andere Prozessvariablen.

4.8.2 Konfigurieren der Konzentrationsmessung unter
Verwendung von ProLink Il

Diese Aufgabe fiihrt Sie durch das Laden und die Einrichtung einer Konzentrationsmatrix
fiir die Messung. Das Erstellen einer Konzentrationsmatrix wird hier nicht beschrieben.

Anmerkung

Konzentrationsmatrixen kénnen entweder durch Laden einer bestehenden Matrix aus einer Datei
oder durch Erstellen einer neuen Matrix geladen werden. Ihre Auswerteelektronik kann bis zu sechs
Matrixen laden, es kann jedoch immer nur eine Matrix zur Messung verwendet werden. Detaillierte
Informationen zum Erstellen einer Matrix finden Sie unter Micro Motion Anwendung mit erweiterter
Dichte: Theorie, Konfiguration und Betrieb.

Vorbereitungsverfahren

Bevor Sie die Konzentrationsmessung konfigurierent kénnen:

. Die Anwendung Konzentrationsmessung muss auf lhrer Auswerteelektronik
aktiviert sein.

. Die zu verwendende Konzentrationsmatrix muss entweder auf Ihrer
Auswerteelektronik oder als Datei auf lhrem Computer vorhanden sein.

. Sie missen die abgeleitete Variable kennen, fiir die Ihre Matrix vorgesehen ist.

. Sie missen die von hrer Matrix verwendete MaReinheit fiir die Dichte kennen.

. Sie missen die von lhrer Matrix verwendete MaReinheit fiir die Temperatur kennen.

. Die Anwendung zur Konzentrationsmessung muss freigegeben sein.

Verfahren

1. Wabhlen Sie Device Tools > Configuration > Process Measurement > Density und stellen Sie

die Density Unit auf die von lhrer Matrix verwendete Dichte Einheit ein.
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Wabhlen Sie Device Tools > Configuration > Process Measurement > Temperature und stellen
Sie die Temperature Unit auf die von lhrer Matrix verwendete Temperatur Einheit ein.

Wahlen Sie Device Tools > Configuration > Process Measurement > Concentration
Measurement.

Stellen Sie die Derived Variable auf die von Ihrer Matrix verwendete abgeleitete
Variable ein und klicken Sie auf Apply.

Wichtig

Alle Konzentrationsmatrixen in der Auswerteelektronik miissen die gleiche abgeleitete
Variable verwenden. Wenn Sie eine der Standardmatrixen von Micro Motion verwenden,
stellen Sie die Derived Variable auf Mass Concentration (Density) ein. Wenn Sie eine
benutzerdefinierte Matrix verwenden, siehe Referenzinformationen fiir Ihre Matrix.

Wenn Sie die Einstellung der Derived Variable verandern, werden alle vorhandenen
Konzentrationsmatrixen aus dem Speicher der Auswerteelektronik geléscht. Stellen Sie
die Derived Variable ein, bevor Sie die Konzentrationsmatrizen laden.

Laden Sie eine oder mehrere Matrixen.

d.

C.

Stellen Sie die Matrix Being Configured auf den Speicherort ein, auf den die Matrix
geladen wird.

Klicken Sie auf Matrix von Datei laden, navigieren Sie zur Matrixdatei auf Ihrem
Computer und laden Sie die Matrix.

Wiederholen Sie diesen Vorgang, bis alle benétigten Matrizen geladen wurden.

Priifen und konfigurieren Sie die Matrixdaten.

d.

d
e
f.
g

Falls erforderlich stellen Sie Matrix Being Configured auf die Matrix ein, die Sie
anzeigen mochten, und klicken Sie auf Change Matrix.

. Stellen Sie Concentration Unit auf die Kennzeichnung ein, die fiir die

Konzentrationseinheit verwendet wird.

Wenn die Concentration Unit auf Special eingestellt werden, geben Sie eine
benutzerdefinierte Kennzeichnung ein.

. Falls gewiinscht, kann der Matrixname gedndert werden.

. Priifen Sie die Datenpunkte fiir diese Matrix.

Reference Temperature und der Curve Fit Maximum Order nicht andern.

. Wenn Matrixdaten gedndert wurden, klicken Sie auf Apply.

Richten Sie die Extrapolationsalarme ein.

Jede Konzentrationsmatrix ist fiir einen bestimmten Dichtebereich und einen
bestimmten Temperaturbereich ausgelegt. Wenn die Prozessdichte oder -
temperatur diesen Bereich verldsst, extrapoliert die Auswerteelektronik die
Konzentrationswerte. Die Extrapolation kann jedoch die Genauigkeit
beeintrachtigen. Extrapolationsalarme machen den Bediener darauf aufmerksam,
dass eine Extrapolation stattfindet.

d.

b.

C.

Stellen Sie ggf. die Matrix Being Configured auf die Matrix ein, die Sie anzeigen
mochten, und klicken Sie auf Change Matrix.

Stellen Sie die Extrapolation Alarm Limit auf den Prozentsatz ein, bei dem ein
Extrapolationsalarm ausgegeben werden soll.

Aktivieren bzw. deaktivieren Sie je nach Wunsch die oberen und unteren
Alarmgrenzwerte fiir die Temperatur und Dichte und klicken Sie auf Apply.
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Einschrankung

Fiir die unteren und oberen Alarmgrenzwerte ist ein Core Prozessor mit erweiterter

Funktionalitat erforderlich.

Beispiel: Wenn Extrapolation Alarm Limit auf 5 % eingestellt ist, ist der High Extrapolation
Limit (Temperature) aktiviert und es wird eine Matrix fiir den Temperaturbereich von
40 °F bis 80 °F eingerichtet. Wenn die Temperatur 82 °F iberschreitet, wird ein
Extrapolationsalarm ausgegeben.

8. Setzen Sie Temperature Source auf die Methode, die die Auswerteelektronik fiir den
Empfang der Temperaturdaten verwendet.

Option

Beschreibung

Externen Wert abfragen(8)

Die Auswerteelektronik fragt ein externes Temperaturmess-
gerdt ab. Sie verwendet hierfiir das HART-Protokoll Giber den
primdren mA Ausgang.

Widerstandsthermometer

Die Auswerteelektronik verwendet die Temperaturdaten
vom Sensor.

Statische oder digitale Kommuni-

kation

Die Auswerteelektronik verwendet den aus dem Speicher

gelesenen Temperaturwert.

 Statisch: Der konfigurierte Wert wird verwendet.

 Digitale Kommunikation: Ein Host schreibt Daten in den
Speicher der Auswerteelektronik.

Anmerkung

Wenn die Weights & Measures Anwendung (eichamtlicher
Transfer) implementiert ist und die Auswerteelektronik
schreibgeschiitzt ist, kann die digitale Kommunikation nicht
verwendet werden, um Temperaturdaten auf die Auswer-
teelektronik zu schreiben.

9.  Wenn Sie RTD wahlen, ist keine weitere Konfiguration erforderlich. Klicken Sie auf

Apply um zu verlassen.

10.  Wenn Sie die Abfrage von Temperaturdaten wahlen:

a. Wahlen Sie den zu verwendenden Polling Slot.

b. Setzen Sie Polling Control auf Poll as Primary oder auf Poll as Secondary und klicken Sie

dann auf Apply.

Hinweis

e Als Primar abfragen: Auf dem Netzwerk ist kein anderer HART Master vorhanden.

e Als Sekundar abfragen: Auf dem Netzwerk sind andere HART Master vorhanden. Das
Handterminal ist kein HART Master.

c. Setzen Sie die External Device Tag auf die HART-Kennzeichnung des externen
Temperaturmessgerdts und klicken Sie auf Apply.

(8) Nicht bei allen Auswerteelektroniken verfiigbar.
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4.8.3
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11.  Wenn Sie einen statischen Temperaturwert wahlen, stellen Sie External Temperature
auf den zu verwendenden Wert ein und klicken Sie auf Apply.

12.  Wenn Sie digitale Kommunikation verwenden moéchten, klicken Sie auf Apply und
fiihren Sie dann die erforderlichen Schritte zur Programmierung des Hostsystems
und zur Einrichtung der Kommunikation durch, um Temperaturdaten in
entsprechenden Intervallen auf die Auswerteelektronik zu schreiben.

13.  Stellen Sie die Active Matrix auf die fiir die Messung zu verwendende Matrix ein.

Die Prozessvariablen fiir die Konzentration sind jetzt auf der Auswerteelektronik verfligbar.
Sie kénnen Sie auf die gleiche Weise anzeigen und ausgeben wie andere Prozessvariablen.

Konfigurieren der Konzentrationsmessung unter
Verwendung des Handterminal

Diese Aufgabe fiihrt Sie durch die Einrichtung einer Konzentrationsmatrix fiir die Messung.
Das Laden oder Erstellen einer Konzentrationsmatrix wird hier nicht beschrieben.

Anmerkung

Konzentrationsmatrixen kénnen entweder durch Laden einer bestehenden Matrix aus einer Datei
oder durch Erstellen einer neuen Matrix geladen werden. Ihre Auswerteelektronik kann bis zu sechs
Matrixen laden, es kann jedoch immer nur eine Matrix zur Messung verwendet werden. Detaillierte
Informationen zum Erstellen einer Matrix finden Sie unter Micro Motion Anwendung mit erweiterter
Dichte: Theorie, Konfiguration und Betrieb.

Vorbereitungsverfahren

Bevor Sie die Konzentrationsmessung konfigurierent konnen:

. Die Anwendung Konzentrationsmessung muss auf Ihrer Auswerteelektronik
aktiviert sein.

. Sie missen die abgeleitete Variable kennen, fiir die Ihre Matrix vorgesehen ist.

. Sie missen die von lhrer Matrix verwendete MaReinheit fiir die Dichte kennen.

. Sie miissen die von lhrer Matrix verwendete MaReinheit fiir die Temperatur kennen.

. Die Anwendung zur Konzentrationsmessung muss freigegeben sein.

Verfahren

1. Wabhlen Sie Online > Konfiguration > Manuelle Einrichtung > Messungen > Dichte und stellen
Sie die MaReinheit fiir die Dichte auf die von Ihrer Matrix verwendete Dichte-MaReinheit
ein.

2. Wabhlen Sie Online > Konfiguration > Manuelle Einrichtung > Messungen > Temperatur und

stellen Sie die MaReinheit fiir die Temperatur auf die von lhrer Matrix verwendete
Temperatur-MaReinheit ein.

3. Wabhlen Sie Online > Konfiguration > Manuelle Einrichtung > Messungen > Konzmess. (CM) >
KM-Konfiguration.

4, Richten Sie die Extrapolationsalarme ein.

Jede Konzentrationsmatrix ist fiir einen bestimmten Dichtebereich und einen
bestimmten Temperaturbereich ausgelegt. Wenn die Prozessdichte oder -
temperatur diesen Bereich verlasst, extrapoliert die Auswerteelektronik
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Konzentrationswerte. Die Extrapolation kann jedoch die Genauigkeit
beeintrachtigen. Extrapolationsalarme machen das Bedienpersonal darauf
aufmerksam, dass eine Extrapolation stattfindet.

a. Wahlen Sie Online > Konfiguration > Manuelle Einrichtung > Messungen > Konzmess. (CM)
> Matrix-Konfiguration.

b. Stellen Sie Matrix wird konfiguriert auf die zu konfigurierende Matrix ein.

c. Stellen Sie die Extrapolationsalarmgrenze auf den Prozentsatz ein, bei dem ein
Extrapolationsalarm ausgegeben werden soll.

d. Wabhlen Sie Online > Configure > Alarm-Einstellung > KM-Alarme.

e. Aktivieren bzw. deaktivieren Sie je nach Wunsch die oberen und unteren
Alarmgrenzwerte fiir die Temperatur und Dichte.

Einschrdankung

Fiir die unteren und oberen Alarmgrenzwerte ist ein Core Prozessor mit erweiterter
Funktionalitat erforderlich.

Beispiel: Wenn die Alarmgrenze auf 5 % eingestellt ist, ist der Extrapolationsalarm fir
hohe Temperatur aktiviert und es wird eine Matrix fiir den Temperaturbereich von
40 °F (5 °C) bis 80 °F (26 °C) eingerichtet. Wenn die Temperatur 82 °F (27 °C)
iberschreitet, wird ein Extrapolationsalarm ausgegeben.

5.  Wadhlen Sie die Kennzeichnung fir die Konzentrationseinheit aus.
a. Wabhlen Sie Online > Konfiguration > Manuelle Einrichtung > Messungen > Konzmess. (CM)
> Matrix-Konfiguration.
b. Stellen Sie Matrix wird konfiguriert auf die zu konfigurierende Matrix ein.
c. Stellen Sie die gew(inschte Kennzeichnung fiir die Konzentrationseinheiten ein.

d. Wenn die Einheiten auf Spezial eingestellt werden, geben Sie eine
benutzerdefinierte Kennzeichnung ein.

6. Ermitteln Sie, wie die Auswerteelektronik die Temperaturdaten fiir die
Konzentrationsmessungsberechnungen empfangt und fiihren Sie die
entsprechende Einrichtung durch.

Option Einrichtung

Temperaturdaten a. Wahlen Sie Online > Konfiguration > Manuelle Einrichtung > Messungen
vom Sensor > Externe(r) Druck/Temperatur > Temperatur.
b. Deaktivieren Sie Externe Temperatur.

Einvom Anwender | a. Wdhlen Sie Online > Konfiguration > Manuelle Einrichtung > Messungen

konfigurierter sta- > Externe(r) Druck/Temperatur > Temperatur.

tischer Temperatur- b. Aktivieren Sie Externe Temperatur.

wert c. Stellen Sie die Korrekturtemperatur auf den zu verwendenden Wert
ein.
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Option Einrichtung

Abfrage fiir Tem- a. Stellen Sie sicher, dass der primare mA Ausgang gemaR HART

peratur(®) Abfrage verdrahtet wurde.

b. Wahlen Sie Online > Konfiguration > Manuelle Einrichtung > Messungen
> Externe(r) Druck/Temperatur > Temperatur.

c. Aktivieren Sie Externe Temperatur.

d. Wabhlen Sie Online > Configure > Manual Setup > Measurements > Exter-
nal Pressure/Temperature > External Polling.

e. Setzen Sie Poll Control auf Poll As Primary Host oder auf Poll as Secon-
dary Host.

f.  Wahlen Sie einen freien Abfrage-Slot.

g. Setzen Sie External Tag auf die HART-Kennzeichnung des exter-
nen Temperaturmessgerats.

h. Setzen Sie Abgefragte Variable auf Temperatur.

Hinweis

e Als Primar abfragen: Auf dem Netzwerk ist kein anderer HART Mas-
ter vorhanden.

e Als Sekundar abfragen: Auf dem Netzwerk sind andere HART Mas-
ter vorhanden. Das Handterminal ist kein HART Master.

Ein von der digital- | a. Wahlen Sie Online > Konfiguration > Manuelle Einrichtung > Messungen

en Kommunikation > Externe(r) Druck/Temperatur > Temperatur.
bereitgestellter b. Aktivieren Sie Externe Temperatur.
Wert c. Fihren Sie die erforderlichen Schritte zur Programmierung des

Hostsystems und zur Einrichtung der Kommunikation durch, um
Temperaturdaten in entsprechenden Intervallen auf die Auswer-
teelektronik zu schreiben.

Anmerkung

Wenn die Weights & Measures Anwendung (eichamtlicher Transfer)
implementiert ist und die Auswerteelektronik schreibgeschiitzt ist,
kann die digitale Kommunikation nicht verwendet werden, um
Temperaturdaten auf die Auswerteelektronik zu schreiben.

7. Online > Konfiguration > Manuelle Einrichtung > Messungen > Konzmess. (KM) > KM-
Konfiguration und stellen Sie die Aktive Matrix auf die flir die Messung zu verwendende
Matrix ein.

Die Prozessvariablen fiir die Konzentration sind jetzt auf der Auswerteelektronik verfiigbar.
Sie kénnen Sie auf die gleiche Weise anzeigen und ausgeben wie andere Prozessvariablen.

4.8.4 Standardmatrixen fiir die Anwendung
Konzentrationsmessung

Die verfiigbaren Standard Konzentrationsmatrixen von Micro Motion sind anwendbar fiir
eine Vielzahl von Prozessmedien.

(9) Nicht bei allen Auswerteelektroniken verfiigbar.
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Tabelle 4-14 zeigt eine Liste der Standard Konzentrationsmatrixen von Micro Motion, die in
der Berechnung verwendeten MaReinheiten fiir Dichte und Temperatur sowie die zur
Angabe der Konzentrationsdaten verwendete MaReinheit.

Hinweis

Sollten die Standardmatrixen fiir hre Anwendung nicht geeignet sein, knnen Sie selbst eine Matrix
definieren oder eine kundenspezifische Matrix bei Micro Motion bestellen.

Tabelle 4-14: Standard Konzentrationsmatrixen und zugehérige MaReinheiten

Matrixname

Beschreibung

Dichteeinheit

Temperaturein-
heit

Einheit fiir Kon-
zentration

Deg Balling

Die Matrix reprasentiert den prozen-
tualen Extraktanteil in Masse in der Lo-
sung, basierend auf °Balling. Beispiel:
Wenn eine Wiirze 10 °Balling hat und
der Extrakt in der Losung 100 % Sac-
charose ist, so ist der Extrakt 10 % vom
Gesamtgewicht.

g/cm?3

°F

°Balling

Deg Brix

Die Matrix reprasentiert eine Fllissig-
keitsskala fiir Saccharosel6sungen, die
den prozentualen Gewichtsanteil der
Saccharaose an der Lésung bei gegeb-
ener Temperaturen angibt. Beispiel:
40 kg Saccharose gemischt mit 60 kg
Wasser ergeben eine 40 °Brix Losung.

g/cm?

°C

°Brix

Deg Plato

Die Matrix reprasentiert den prozen-
tualen Extraktanteil in Masse in der L6-
sung, basierend auf °Plato. Beispiel:
Wenn eine Wiirze 10 °Plato hat und
der Extrakt in der Losung 100 % Sac-
charose ist, so ist der Extrakt 10 % vom
Gesamtgewicht.

g/cm3

°F

°Plato

HFCS 42

Die Matrix reprdsentiert eine Fllssig-
keitsskala fiir HFCS 42 (high fructose
corn syrup) Losung, die den prozen-
tualen Gewichtsanteil der HFCS in der
Lésung angibt.

g/cm?3

°C

%

HFCS 55

Die Matrix reprdsentiert eine Fllssig-
keitsskala fiir HFCS 55 (high fructose
corn syrup) Losung, die den prozen-
tualen Gewichtsanteil der HFCS in der
Losung angibt.

g/cm?3

°C

%

HFCS 90

Die Matrix reprasentiert eine Fl{issig-
keitsskala fiir HFCS 90 (high fructose
corn syrup) Losung, die den prozen-
tualen Gewichtsanteil der HFCS in der
L6sung angibt.

g/cm?

°C

%

Konfigurations- und Bedienungsanleitung
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4.8.5

Tabelle 4-15: Abgeleitete Variablen und berechnete Prozessvariablen

Abgeleitete Variablen und berechnete Prozessvariablen

Fiir jede abgeleitete Variable berechnet die Anwendung Konzentrationsmessung einen

anderen Satz an Prozessvariablen.

Berechnete Prozessvariablen

tion abgeleitet vom
spezifischen Ge-
wicht

eines gel6sten Stoffes
oder Stoff in Ldsung in
der Gesamtldsung, ab-
geleitet vom spezifi-
schen Gewicht

Dichte bei | Standard Netto Netto
Referenz-  Volumen- | Spezi- Masse- Volumen-
tempera- | durch- fisches Konzen- | durch- durch-
Abgeleitete Variable | Beschreibung tur fluss Gewicht | tration fluss fluss
Dichte bei Refer- Masse/Einheit Volu- v v
enztemperatur men, korrigiert auf eine
gegebene Referenz-
temperatur
Spezifisches Ge- Verhaltnis der Dichte v v v
wicht des Prozessmediums
bei gegebener Temper-
atur zur Dichte von
Wasser bei gegebener
Temperatur. Die bei-
den gegebenen Tem-
peraturbedingungen
miissen nicht gleich
sein.
Massekonzentration = Prozentualer Massean- v v v v
abgeleitet von der | teil eines (gelsten)
Referenzdichte Stoffes in einer Losung,
abgeleitet von der Ref-
erenzdichte
Massekonzentration = Prozentuale Masse v v v v v
abgeleitet vom spe- | eines gelosten Stoffes
zifischen Gewicht | oder Stoff in Lésung in
der Gesamtl6ésung, ab-
geleitet vom spezifi-
schen Gewicht
Volumenkonzentra- | Prozentuale Volumen v v v v
tion abgeleitet von | eines gelOsten Stoffes
der Referenzdichte | oder Stoff in Losungin
der Gesamtloésung, ab-
geleitet von der Refer-
enzdichte
Volumenkonzentra- | Prozentuale Volumen v v v v v
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Tabelle 4-15: Abgeleitete Variablen und berechnete Prozessvariablen (Fortsetzung)

Berechnete Prozessvariablen

leitet von der Refer-
enzdichte

Dichte bei | Standard Netto Netto

Referenz-  Volumen- | Spezi- Masse- Volumen-

tempera-  durch- fisches Konzen- | durch- durch-
Abgeleitete Variable | Beschreibung tur fluss Gewicht | tration fluss fluss
Konzentration abge- = Masse, Volumen, Ge- v v v

wicht oder Anzahl der
Mole eines geldsten
Stoffes oder Stoff in L6-
sung proportional zur
Gesamtldsung, zur L6-
sung, abgeleitet von
der Referenzdichte

Konzentration abge-
leitet vom spezifi-
schen Gewicht

Masse, Volumen, Ge- v v v v
wicht oder Anzahl der
Mole eines gel6sten
Stoffes oder Stoff in L6-
sung proportional zur
Gesamtlosung, zur L6-
sung, abgeleitet vom
spezifischen Gewicht

4.9

4.9.1

Konfigurations- und Bedienungsanleitung

Druckkompensation konfigurieren

Die Druckkompensation nimmt Anpassungen an der Prozessmessung vor, um den Einfluss
des Drucks auf den Sensor zu kompensieren. Der Einfluss des Drucks ist die Anderung der
Empfindlichkeit des Sensors beziiglich Durchfluss und Dichte, die durch die Differenz
zwischen dem Kalibrierdruck und dem Prozessdruck verursacht wird.

Hinweis

Nicht alle Sensoren oder Anwendungen erfordern eine Druckkompensation. Der Einfluss des Drucks
auf ein bestimmtes Sensormodell ist im Produktdatenblatt aufgefiihrt, das unter
www.micromotion.com zu finden ist. Wenn Sie sich nicht sicher sind, ob die Druckkompensation zu
verwenden ist, wenden Sie sich an den Micro Motion Kundenservice.

Druckkompensation konfigurieren mittels ProLink I

Vorbereitungsverfahren
Sie benoétigen den Durchflussfaktor, den Dichtefaktor und die Kalibrierdruckwerte fiir den
Sensor.

. Durchflussfaktor und Dichtefaktor sind im Produktdatenblatt des Sensors
angegeben.

. Der Kalibrierdruck ist im Kalibrierdatenblatt des Sensors zu finden. Sind die Daten
nicht verfligbar, verwenden Sie 20 psi.
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Verfahren

1.

Wibhlen Sie View > Preferences und stellen Sie sicher, dass das Kontrollfeld Externe
Druckkompensation aktivieren markiert ist.

Wabhlen Sie ProLink > Configuration > Pressure.

Geben Sie den Flow Factor fur Ihren Sensor ein.

Der Durchflussfaktor ist die prozentuale Anderung des Durchflusses pro psi. Bei der
Eingabe des Wertes verwenden Sie das umgekehrte Vorzeichen.

Beispiel:
Wenn der Durchflussfaktor 0,000004 % pro psi ist, geben Sie -0,000004 % pro psi ein.
Geben Sie den Density Factor fiir lhren Sensor ein.

Der Dichtefaktor ist die Anderung der Dichte des Prozessmediums in g/cm3/psi. Bei
der Eingabe des Wertes verwenden Sie das umgekehrte Vorzeichen.

Beispiel:
Wenn der Dichtefaktor 0,000006 g/cm3/psi ist, geben Sie -0,000006 g/cm3/psi ein.
Geben Sie den Cal Pressure fiir hren Sensor ein.

Der Kalibrierdruck ist der Druck, bei dem der Sensor kalibriert wurde. Dies entspricht
dem Druck, bei dem kein Einfluss des Drucks vorhanden ist. Sind die Daten nicht
verfligbar, geben Sie 20 psi ein.

Ermitteln Sie, wie die Auswerteelektronik die Druckdaten empfangt, und fiihren Sie
die entsprechende Einrichtung durch.

Option Einrichtung

Einvom Anwender | a. Setzen Sie Pressure Units auf die gewiinschte Einheit.
konfigurierter, sta- | b. Setzen Sie External Pressure auf den gewlinschten Wert.
tischer Druckwert

Abfragen von a. Stellen Sie sicher, dass der primare mA Ausgang gemaR HART

Druck(10) Abfrage verdrahtet wurde.

b. Wahlen Sie ProLink > Configuration > Polled Variables.

Wahlen Sie einen freien Abfrage Slot.

d. Setzen Sie Polling Control auf Poll As Primary oder Poll as Secondary
und klicken Sie dann auf Apply.

e. Setzen Sie External Tag auf die HART Kennzeichnung des externen
Druckmessgerits.

f. Setzen Sie Variable Type auf Pressure.

n

Hinweis

e Als Primér abfragen: Auf dem Netzwerk ist kein anderer HART Mas-
ter vorhanden.

e Als Sekundar abfragen: Auf dem Netzwerk sind andere HART Mas-
ter vorhanden. Das Handterminal ist kein HART Master.

(10) Nicht bei allen Auswerteelektroniken verfiigbar.
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4.9.2

Option Einrichtung

Einvon derdigital- | a. Setzen Sie Pressure Units auf die gew(inschte Einheit.

en Kommunikation b. Fiihren Sie die erforderlichen Schritte zur Programmierung des
bereitgestellter Hostsystems und zur Einrichtung der Kommunikation durch, um
Wert die Druckdaten in entsprechenden Intervallen auf die Auswer-
teelektronik zu schreiben.

Anmerkung

Wenn die Weights & Measures Anwendung (eichamtlicher Transfer)
implementiert ist und die Auswerteelektronik schreibgeschiitzt ist,
kann die digitale Kommunikation nicht verwendet werden, um
Temperaturdaten auf die Auswerteelektronik zu schreiben.

Nachbereitungsverfahren

Wenn Sie ein externes Druckmessgerat verwenden, (iberpriifen Sie die Einstellung, indem
Sie ProLink > Process Variables wahlen und den in External Pressure angezeigten Wert priifen.
Druckkompensation konfigurieren mittels ProLink I

Vorbereitungsverfahren

Sie beno6tigen den Durchflussfaktor, den Dichtefaktor und die Kalibrierdruckwerte fiir den
Sensor.

. Durchflussfaktor und Dichtefaktor sind im Produktdatenblatt des Sensors
angegeben.
. Der Kalibrierdruck ist im Kalibrierdatenblatt des Sensors zu finden. Sind die Daten

nicht verfligbar, verwenden Sie 20 psi.
Verfahren

1. Wahlen Sie Device Tools > Configuration > Process Measurement > Pressure Compensation.
Setzen Sie Pressure Compensation Status to Enabled.

Geben Sie den Flow Calibration Pressure fiir Ihren Sensor ein.

Der Kalibrierdruck ist der Druck, bei dem der Sensor kalibriert wurde. Dies entspricht
dem Druck, bei dem kein Einfluss des Drucks vorhanden ist. Sind die Daten nicht
verfligbar, geben Sie 20 psi ein.

4, Geben Sie den Flow Factor fiir lhren Sensor ein.

Der Durchflussfaktor ist die prozentuale Anderung des Durchflusses pro psi. Bei der
Eingabe des Wertes verwenden Sie das umgekehrte Vorzeichen.

Beispiel:
Wenn der Durchflussfaktor 0,000004 % pro psi ist, geben Sie -0,000004 % pro psi ein.
5. Geben Sie den Density Factor fiir lhren Sensor ein.

Der Dichtefaktor ist die Anderung der Dichte des Prozessmediums in g/cm3/psi. Bei
der Eingabe des Wertes verwenden Sie das umgekehrte Vorzeichen.

Beispiel:
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Wenn der Dichtefaktor 0,000006 g/cm3/psi ist, geben Sie -0,000006 g/cm3/psi ein.

6. Setzen Sie Pressure Source auf die Methode, die die Auswerteelektronik fiir den
Empfang der Druckdaten verwendet.

Option Beschreibung

Externen Wert abfragen(11) Die Auswerteelektronik fragt ein externes Druckmessgerdt
ab. Sie verwendet hierfiir das HART Protokoll Gber den pri-
madren mA Ausgang.

Statische oder digitale Kommuni- = Die Auswerteelektronik verwendet den aus dem Speicher

kation gelesenen Druckwert.

 Statisch: Der konfigurierte Wert wird verwendet.

¢ Digitale Kommunikation: Ein Host schreibt Daten in den
Speicher der Auswerteelektronik.

Anmerkung

Wenn die Weights & Measures Anwendung (eichamtlicher
Transfer) implementiert ist und die Auswerteelektronik
schreibgeschiitzt ist, kann die digitale Kommunikation nicht
verwendet werden, um Temperaturdaten auf die Auswer-
teelektronik zu schreiben.

7. Wenn Sie die Abfrage von Druckdaten wahlen:

a. Wahlen Sie den zu verwendenden Abfrage Slot.

b. Setzen Sie Polling Control auf Poll as Primary oder auf Poll as Secondary und klicken Sie
dann auf Apply.

Hinweis
 Als Primar abfragen: Auf dem Netzwerk ist kein anderer HART Master vorhanden.

e Als Sekundar abfragen: Auf dem Netzwerk sind andere HART Master vorhanden. Das
Handterminal ist kein HART Master.

c. Setzen Sie External Device Tag auf die HART Kennzeichnung des externen
Druckmessgerats und klicken Sie dann auf Apply.

8. Wenn Sie einen statischen Druckwert verwenden:

a. Setzen Sie Pressure Unit auf die gewlinschte Einheit.

b. Setzen Sie Static or Current Pressure auf den Wert, den Sie verwenden mochten,
und klicken Sie auf Apply.

9.  Wenn Sie digitale Kommunikation verwenden mdéchten, klicken Sie auf Apply und
fiihren Sie dann die erforderlichen Schritte zur Programmierung des Hostsystems
und zur Einrichtung der Kommunikation durch, um Druckdaten in entsprechenden
Intervallen auf die Auswerteelektronik zu schreiben.

Nachbereitungsverfahren

Wenn Sie einen externen Druckwert verwenden, (iberpriifen Sie die Einstellung, indem Sie
den Wert External Pressure priifen, derim Bereich Inputs des Hauptfensters angezeigt wird.

(11) Nicht bei allen Auswerteelektroniken verfiigbar.
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49.3 Druckkompensation konfigurieren mittels Handterminal

Vorbereitungsverfahren

Sie benétigen den Durchflussfaktor, den Dichtefaktor und die Kalibrierdruckwerte fiir den

Sensor.

. Durchflussfaktor und Dichtefaktor sind im Produktdatenblatt des Sensors
angegeben.

. Der Kalibrierdruck ist im Kalibrierdatenblatt des Sensors zu finden. Sind die Daten

nicht verfligbar, verwenden Sie 20 psi.
Verfahren

1. Wabhlen Sie Online > Configure > Manual Setup > Measurements > External Pressure/
Temperature > Pressure.

Setzen Sie Pressure Compensation auf Enabled.
Geben Sie den Flow Cal Pressure ftir Ihren Sensor ein.

Der Kalibrierdruck ist der Druck, bei dem der Sensor kalibriert wurde. Dies entspricht
dem Druck, bei dem kein Einfluss des Drucks vorhanden ist. Sind die Daten nicht
verfiigbar, geben Sie 20 psi ein.

4, Geben Sie den Flow Press Factor fir Ihren Sensor ein.

Der Durchflussfaktor ist die prozentuale Anderung des Durchflusses pro psi. Bei der
Eingabe des Wertes verwenden Sie das umgekehrte Vorzeichen.

Beispiel:
Wenn der Durchflussfaktor 0,000004 % pro psi ist, geben Sie -0,000004 % pro psi ein.
5.  Geben Sie den Dens Press Factor fiir Ihren Sensor ein.

Der Dichtefaktor ist die Anderung der Dichte des Prozessmediums in g/cm?/psi. Bei
der Eingabe des Wertes verwenden Sie das umgekehrte Vorzeichen.

Beispiel:
Wenn der Dichtefaktor 0,000006 g/cm3/psi ist, geben Sie -0,000006 g/cm3/psi ein.
6. Ermitteln Sie, wie die Auswerteelektronik die Druckdaten empfangt, und fiihren Sie

die entsprechende Einrichtung durch.

Option Einrichtung

Einvom Anwender | a. Setzen Sie Pressure Unit auf die gewtinschte Einheit.
konfigurierter, sta- b. Setzen Sie Compensation Pressure auf den gewiinschten Wert.
tischer Druckwert
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Option

Einrichtung

Abfragen von
Druck(12)

a.

Stellen Sie sicher, dass der primare mA Ausgang gemaR HART
Abfrage verdrahtet wurde.

Wahlen Sie Online > Configure > Manual Setup > Measurements > Exter-
nal Pressure/Temperature > External Polling.

Setzen Sie Poll Control auf Poll As Primary Host oder auf Poll as Secon-
dary Host.

d. Wabhlen Sie einen freien Abfrage Slot.

e. Setzen Sie External Tag auf die HART Kennzeichnung des externen
Druckmessgerits.
f.  Setzen Sie Polled Variable auf Pressure.
Hinweis
e Als Primar abfragen: Auf dem Netzwerk ist kein anderer HART Mas-
ter vorhanden.
e Als Sekundar abfragen: Auf dem Netzwerk sind andere HART Mas-
ter vorhanden. Das Handterminal ist kein HART Master.
Einvon derdigital- | a. Setzen Sie Pressure Unit auf die gewiinschte Einheit.
en Kommunikation b. Fiihren Sie die erforderlichen Schritte zur Programmierung des
bereitgestellter Hostsystems und zur Einrichtung der Kommunikation durch, um
Wert die Druckdaten in entsprechenden Intervallen auf die Auswer-
teelektronik zu schreiben.
Anmerkung

Nachbereitungsverfahren

Wenn die Weights & Measures Anwendung (eichamtlicher Transfer)
implementiert ist und die Auswerteelektronik schreibgeschiitzt ist,
kann die digitale Kommunikation nicht verwendet werden, um
Temperaturdaten auf die Auswerteelektronik zu schreiben.

Wenn Sie einen externen Druckwert verwenden, (iberpriifen Sie die Einstellung, indem Sie
Service Tools > Variables > External Variables wahlen und den fiir External Pressure angezeigten

Wert priifen.

49.4 Optionen fiir Druckmesseinheit

Die Auswerteelektronik bietet ein Standardsatz an Messeinheiten fiir Pressure Measurement
Unit. Unterschiedliche Kommunikations-Hilfsmittel verwenden moglicherweise
unterschiedliche Kennzeichnungen fiir die Einheiten. In den meisten Anwendungen sollte
Pressure Measurement Unit so eingestellt sein, dass sie mit dem vom externen Gerat
verwendeten Druckmesseinheit (ibereinstimmt.

(12) Nicht bei allen Auswerteelektroniken verfiigbar.
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Tabelle 4-16: Optionen fiir Pressure Measurement Unit

Kennzeichnung

Beschreibung der Einheit ProLink II ProLink IlI Handterminal
Feet Wasser bei 68 °F Ft Wasser bei 68 °F Ft Water @ 68°F ftH20

In. Wasser bei 4 °C In. Wasser bei 4 °C In Water @ 4°C inH20 (4°C)

In. Wasser bei 60 °F In. Wasser bei 60 °F In Water @ 60°F inH20 bei 60 °F
In. Wasser bei 68 °F In. Wasser bei 68 °F In Water @ 68°F inH20
Millimeter Wasser bei 4 °C mm Wasser bei 4 °C mm Water @ 4°C mmH20 bei 4 °C
Millimeter Wasser bei 68 °F mm Wasser bei 68 °F mm Water @ 68°F mmH20
Millimeter Quecksilber bei 0 °C mm Quecksilber bei 0°C | mm Mercury @ 0°C mmHg

In. Quecksilber bei 0 °C In. Quecksilber bei0°C | In Mercury @ 0°C inHG

Pounds pro Quadratinch PSI PSI psi

bar bar bar bar

mbar mbar millibar mbar

Gramm pro Quadratzentimeter glcm2 glcm2 glcm2
Kilogramm pro Quadratzentimeter kg/cm2 kg/cm2 kg/cm2

Pascal Pa pascals Pa

kPa kPa Kilopascals kPa
Megapascal MPa Megapascals MPa

Torr bei 0°C Torr bei 0°C Torr @ 0°C torr
Atmosphdren at atms at
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5.1

5.1.1

70

Gerateoptionen und Praferenzen
konfigurieren

In diesem Kapitel behandelte Themen:

. Konfigurieren von Antwortzeitparametern
e Konfigurieren der Alarmverwaltung
e Informationsparameter konfigurieren

Konfigurieren von Antwortzeitparametern

Die Haufigkeit, mit der die Prozessdaten abgefragt und Prozessvariablen berechnet
werden, ist konfigurierbar.

Die Parameter der Antwortzeit umfassen:
U Update Rate
. Calculation Speed (Antwortzeit)

Konfigurieren der Messwertaktualisierung

ProLink Il ProLink > Configuration > Device > Update Rate
ProLink Il Device Tools > Configuration > Process Measurement > Response > Update Rate
Handterminal Configure > Manual Setup > Measurements > Update Rate

Uberblick

Update Rate steuert die Rate, mit der die Prozessdaten abgefragt und Prozessvariablen
berechnet werden. Update Rate = Special bietet eine schnellere Reaktion auf
Prozessdnderungen, die jedoch mit “h6herem Rauschen” verbunden ist. Nicht den Modus
Special verwenden, es sei denn, die Anwendung erfordert dies.

Hinweis

Bei Systemen mit einem Standard Core Prozessor kann der Modus Special die Leistung fir
Anwendungen mit Gaseinschliissen oder Leer-Voll-Leer-Bedingungen verbessern. Das betrifft keine
Systeme mit Core Prozessor mit erweiterter Funktionalitat.

Vorbereitungsverfahren

Vor dem Einstellen von Update Rate auf Special:

. Priifen Sie die Auswirkungen des Modus Special auf bestimmte Prozessvariablen.
. Kontaktieren Sie Micro Motion.

Verfahren

1. Setzen Sie Update Rate wie gew{inscht.
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Option Beschreibung

Normal | Alle Prozessdaten werden 20 x pro Sekunde abgefragt (20 Hz).
Alle Prozessvariablen werden bei einer Frequenz von 20 Hz berechnet.
Diese Option kann fiir die meisten Anwendungen verwendet werden.

Special | Eine einzige benutzerdefinierte Prozessvariable wird 100 x pro Sekunde abgefragt
(100 Hz). Andere Prozessdaten werden mit einer Frequenz von 6,25 Hz abgefragt.
Einige Prozess-, Diagnose- und Kalibrierdaten werden nicht abgefragt.

Alle verfiigbaren Prozessvariablen werden bei einer Frequenz von 100 Hz berech-
net.

Diese Option nur verwenden, wenn die Anwendung dies erfordert.

Wenn Update Rate gedandert wird, werden die Einstellungen fiir Flow Damping, Density
Damping und Temperature Damping automatisch angepasst.

Wenn Update Rate auf Special gesetzt wird, sollte die Abfrage der Prozessvariable mit
100 Hz durchgefiihrt werden.

Effekte der Aktualisierungsrate = Spezial

Inkompatible Merkmale und Funktionen

Der Spezial-Modus ist mit den folgenden Merkmalen und Funktionen nicht kompatibel:

Erweiterte Ereignisse Verwenden Sie stattdessen Basisereignisse.
Alle Kalkibrierverfahren.
Nullpunktverifizierung.

Wiederherstellen des Nullpunktwerts des Herstellers speichern oder des vorherigen
Nullpunktwerts.

Im Bedarfsfall kénnen Sie in den Normal-Modus schalten, die gew(inschten Verfahren
durchfiihren und dann zuriick in den Spezial-Modus wechseln.

Aktualisierungen der Prozessvariablen

Einige Prozessvariablen werden nicht aktualisiert, wenn der Spezial-Modus aktiviert wird.
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Tabelle 5-1: Spezial-Modus und Prozessvariablen-Aktualisierungen

Nur aktualisiert, wenn die Anwen-
dung Mineralélmessung deaktiviert

Immer abgefragt und aktualisiert ist Nie aktualisiert
e Massedurchfluss ¢ Re Aufnehmerspule Amplitude Alle anderen Prozessvariablen und Ka-
e Volumendurchfluss e Platinentemperatur librierdaten. Behalten die Werte, die
e Gas-Standardvolumendurchfluss | ¢ CoreProzesso- Eingangsspannung | bei Aktivierung des Spezial-Modus ein-
e Dichte e Masse-Gesamtzdhler gestellt waren.
e Temperatur ¢ Volumen-Gesamtzahler
e Antriebsverstarkung e (Gas-Standardvolumen-Gesamt-
e Li Aufnehmerspule Amplitude zahler
e Status [enthalt Ereignis 1 und

Ereignis 2 (Basisereignisse)]
e Messrohrfrequenz
* Masse-Summenzahler
*  Volumen-Summenzahler
* Gas-Standardvolumen-Summen-

zdhler
e Temperaturkorrigierter Volumen-

Summenzéhler
e Temperaturkorrigierte Dichte
e Temperaturkorrigierter Volumen-

durchfluss
e Gewichteter Temperaturmittel-

wert pro Dosiervorgang
e Gewichteter Dichtemittelwert pro

Dosiervorgang

5.1.2 Berechnungsgeschwindigkeit (Reaktionszeit) konfigurieren
ProLink Il ProLink > Configuration > Device > Response Time
ProLink Il Device Tools > Configuration > Process Measurement > Response > Calculation Speed

Handterminal

Not available

Uberblick

Berechnungsgeschwindigkeit wird verwendet, um einen alternativen Algorithmus fiir die
Berechnung der Prozessvariablen aus den originalen Prozessdaten zu verwenden.
Berechnungsgeschwindigkeit = Spezial bietet eine schnellere Reaktion auf Prozessanderungen,
die jedoch mit “h6herem Rauschen” verbunden ist.

In ProLink Il wird Berechnungsgeschwindigkeit als Reaktionszeit bezeichnet.

Einschrankung

Berechnungsgeschwindigkeit ist nur auf Systemen mit Core Prozessor mit erweiterter Funktionalitdt

verfligbar.
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Hinweis

Sie kdnnen Berechnungsgeschwindigkeit = Spezial mit beiden Einstellungen fiir die Messwertaktualisierung
verwenden. Die Parameter steuern unterschiedliche Aspekte der Verarbeitung der vom Durchfluss-
Messsystem gelieferten Werte.

Verfahren

Setzen Sie Berechnungsgeschwindigkeit wie gewlinscht.

Option Beschreibung

Normal = Die Auswerteelektronik berechnet die Prozessvariablen mit der normalen Geschwindig-
keit.

Spezial = Die Auswerteelektronik berechnet die Prozessvariablen mit einer héheren Geschwindig-
keit.

5.2 Konfigurieren der Alarmverwaltung

Die Alarmverwaltungsparameter steuern die Reaktion der Auswerteelektronik auf Prozess-
und Gerdtebedingungen.

Die Alarmverwaltungsparameter umfassen:
. Fehler-Timeout
. Status Alarmstufe

5.2.1 Konfigurieren von Stérung-Timeout

ProLink Il ProLink > Configuration > Analog Output > Last Measured Value Timeout

ProLink > Configuration > Frequency > Last Measured Value Timeout

ProLink Il Device Tools > Configuration > Fault Processing
Handterminal Configure > Alert Setup > Alert Severity > Fault Timeout
Uberblick

Fault Timeout steuert die Verzégerung, bevor Stéraktionen eingeleitet werden.

Einschrdankung

Fault Timeout findet nur auf die folgenden Alarme Anwendung (aufgelistet nach Statusalarmcode):
A003, A004, A005, A008, A016, A017, A033. Bei allen anderen Alarmen werden Storaktionen
durchgefiihrt, sobald ein Alarm erkannt wird.

Verfahren
Fault Timeout wie gewlinscht einstellen.
Der Standardwert ist 0 Sekunden. Der Bereich liegt bei 0 bis 60 Sekunden.

Wenn Fault Timeout auf 0 eingestellt wird, werden Stéraktionen durchgefiihrt, sobald eine
Alarmbedingung erkannt wird.
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5.2.2

74

Die Zeitspanne Storung-Timeout beginnt, sobald die Auswerteelektronik eine
Alarmbedingung erkennt. Wahrend der Zeitspanne Stérung-Timeouts gibt die
Auswerteelektronik weiterhin die zuletzt giiltigen Messwerte aus.

Wenn Stérung-Timeout ablauft und der Alarm noch aktiv ist, werden die Stéraktionen
durchgefiihrt. Wenn die Alarmbedingung nicht mehr aktiv ist, bevor Stérung-Timeout
ablduft, wird keine Storaktionen durchgefiihrt.

Hinweis
ProLink llermdglicht die Einstellung von Fault Timeout in zwei Bereichen. Allerdings gibt es nur einen
Parameter und dieselbe Einstellung gilt fiir alle Ausgénge.

Konfigurieren von Status Alarmstufe

ProLink Il ProLink > Configuration > Alarm > Severity

ProLink Il Device Tools > Configuration > Alert Severity

Handterminal Configure > Alert Setup > Alert Severity > Set Alert Severity
Uberblick

Verwenden Sie Status Alarm Severity, um Storaktionen zu steuern, die die
Auswerteelektronik ausfiihrt, wenn eine Alarmbedingung erkannt wird.

Einschrankungen

. Fiir einige Alarme ist Status Alarm Severity nicht konfigurierbar.
. Fiir einige Alarme kann Status Alarm Severity nur auf zwei der drei Optionen eingestellt werden.
Hinweis

Micro Motion empfiehlt, die Standardeinstellungen fiir Status Alarm Severity zu verwenden, es sei
denn, es bestehen spezielle Anforderungen, diese zu andern.

Verfahren
1. Wahlen Sie einen Statusalarm aus.
2. Setzen Sie Status Alarm Severity wie gewlinscht fiir den ausgewahlten Statusalarm.
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Option

Beschreibung

Fault

MaRnahmen bei Erkennung einer Stérung:

* Der Alarm wird in der Alarmliste angezeigt.

» Die Ausgdnge werden auf die konfigurierte Storaktion gesetzt (nach Ablauf
von Fault Timeout, falls zutreffend).

* Die digitale Kommunikation wird auf die konfigurierte Stéraktion gesetzt
(nach Ablauf von Fault Timeout, falls zutreffend).

 Die Farbe der Status-LED (falls vorhanden) wechselt auf rot oder gelb (abhén-
gig von der Alarmstufe).

MaRnahmen, wenn der Alarm gel6scht wird:

* Die Ausgdnge kehren zu ihrem normalen Verhalten zuriick.

 Die digitale Kommunikation kehrt zu ihrem normalen Verhalten zuriick.

* Die Farbe der Status-LED (falls vorhanden) wechselt zu griin und die LED kann
ggf. blinken.

Informa-
tional

MaRnahmen bei Erkennung einer Stérung:

e Der Alarm wird in der Alarmliste angezeigt.

* Die Farbe der Status-LED (falls vorhanden) wechselt auf rot oder gelb (abhén-
gig von der Alarmstufe).

MaRnahmen, wenn der Alarm geléscht wird:

* Die Farbe der Status-LED (falls vorhanden) wechselt zu griin und die LED kann
ggf. blinken.

Ignore

Keine Aktion

Statusalarme und Optionen fiir Status-Alarmstufe

Tabelle 5-2: Statusalarme und Status-Alarmstufe

Voreingestellte Konfigurier-

Alarm Code Statusmeldung Alarmstufe Hinweise bar?

A001 EEPROM-Fehler (Core-Pro- | Stérung Nein
zessor)

A002 RAM-Fehler (Core-Prozes- | Storung Nein
sor)

A003 Keine Antwort vom Sensor | Storung IE

A004 Messbereichsiiberschrei- | Stdrung Nein
tung fiir Temperatur

A005 Messbereichsiiberschrei- | Storung Ja
tung fiir Massedurchfluss

A006 Charakterisierung erfor- Stérung Ja
derlich

A008 Dichte Bereichsiiberschrei- | Stérung Ja
tung

A009 Auswerteelektronik Initiali- = Stérung Ja
sierung/Aufwarmphase

A010 Kalibrierfehler Storung Nein

A0T1 Nullpunktkalibrierung fehl- | Stérung Ja
geschlagen: Tief
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Tabelle 5-2: Statusalarme und Status-Alarmstufe (Fortsetzung)

Voreingestellte Konfigurier-
Alarm Code Statusmeldung Alarmstufe Hinweise bar?
A012 Nullpunktkalibrierung fehl- | Stérung Ja
geschlagen: Hoch
A013 Nullpunktkalibrierung fehl- | Stérung Ja
geschlagen: Instabil
A014 Auswerteelektronikfehler | Stérung Nein
A016 Sensor-RTD-Fehler Stdrung Ja
A017 T-Serien-RTD-Fehler Storung Ja
A018 EEPROM-Fehler (Auswer- | Stdrung Nein
teelektronik)
A019 RAM-Fehler (Auswertee- Stdrung Nein
lektronik)
A020 K.wrt f. k. Drchflss Stdrung Ja
A021 Falscher Sensortyp (K1) Stérung Nein
A022 Konfigurationsdatenbank | Stdrung Betrifft nur Durchflussmesser mit  Nein
beschédigt (Core-Prozes- Core-Prozessor mit Standard-Funk-
sor) tionalitat.
A023 Interne Zahler beschadigt | Stérung Betrifft nur Durchflussmesser mit | Nein
(Core-Prozessor) Core-Prozessor mit Standard-Funk-
tionalitat.
A024 Programm beschadigt Storung Betrifft nur Durchflussmesser mit | Nein
(Core-Prozessor) Core-Prozessor mit Standard-Funk-
tionalitat.
A025 Bootsektorfehler (Core- Stérung Betrifft nur Durchflussmesser mit  Nein
Prozessor) Core-Prozessor mit Standard-Funk-
tionalitat.
A026 Sensor-/Auswerteelektro- | Storung Nein
nik-Kommunikationsfehler
A027 Sicherheitsverstol Stdrung Nein
A028 Core-Prozessor-Schreib- Storung Nein
fehler
A031 Spannung zu niedrig Stdrung Betrifft nur Durchflussmesser mit ~ Nein
Core-Prozessor mit erweiterter
Funktionalitat.
A032 Systemverifizierung lauft: | Unterschiedlich | Betrifft nur Auswerteelektroniken | Nein
Ausgange zu Fehler mit Smart-Systemverifizierung.
Wenn Ausgédnge auf Zuletzt gemess-
ener Wert gesetzt sind, ist die Alarm-
stufe Info. Wenn die Ausgdnge auf
Fehler gesetzt sind, ist die Alarm-
stufe Storung.
A033 Unzureichendes Signal von | Stdrung Betrifft nur Durchflussmesser mit | Ja
rechter/linker Aufnehmer- Core-Prozessor mit erweiterter
spule Funktionalitat.
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Tabelle 5-2: Statusalarme und Status-Alarmstufe (Fortsetzung)

Voreingestellte Konfigurier-
Alarm Code Statusmeldung Alarmstufe Hinweise bar?
A034 Systemverifizierung fehl- | Informativ Betrifft nur Auswerteelektroniken | |a
geschlagen mit Smart-Systemverifizierung.
A035 Systemverifizierung abge- | Informativ Betrifft nur Auswerteelektroniken | Ja
brochen mit Smart-Systemverifizierung.
A100 mA-Ausgang 1 gesattigt | Informativ Kann entweder auf Informativoder | Ja
Ignorieren gesetzt werden, aber
nicht auf Storung.
A101 mA-Ausgang 1 fest Informativ Kann entweder auf Informativoder | |a
Ignorieren gesetzt werden, aber
nicht auf Storung.
A102 Antrieb Bereichsiibers- Informativ Ja
chreitung
A103 Méglicher Datenverlust Informativ Betrifft nur Durchflussmesser mit | Ja
(Zahler und Besténde) Core-Prozessor mit Standard-Funk-
tionalitat.
Kann entweder auf Informativ oder
Ignorieren gesetzt werden, aber
nicht auf Storung.
A104 Kalibrierung lauft Informativ Kann entweder auf Informativoder | Ja
Ignorieren gesetzt werden, aber
nicht auf Storung.
A105 Schwallstrémung Informativ Ja
A106 Burst-Betriebsart aktiviert | Informativ Kann entweder auf Informativoder | |a
Ignorieren gesetzt werden, aber
nicht auf Storung.
A107 Spannungsunterbrechung | Informativ Normales Verhalten der Auswer- Ja
eingetreten teelektronik; tritt nach jedem Aus-/
Einschalten der Stromversorgung
auf.
A108 Basisereignis 1 Ein Informativ Betrifft nur Basisereignisse. Ja
A109 Basisereignis 2 Ein Informativ Betrifft nur Basisereignisse. Ja
A110 Frequenzausgang gesadt- Informativ Kann entweder auf Informativoder | |a
tigt Ignorieren gesetzt werden, aber
nicht auf Storung.
AT Frequenzausgang fixiert Informativ Kann entweder auf Informativoder | Ja
Ignorieren gesetzt werden, aber
nicht auf Storung.
A112 Auswerteelektronik-Soft- | Informativ Betrifft nur Systeme mit Auswer- | Ja
ware aktualisieren teelektronik-Software vor v5.0.
A113 mA-Ausgang 2 gesdttigt Informativ Kann entweder auf Informativoder | |a
Ignorieren gesetzt werden, aber
nicht auf Storung.
Al114 mA-Ausgang 2 fest Informativ Kann entweder auf Informativoder | Ja
Ignorieren gesetzt werden, aber
nicht auf Storung.
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Tabelle 5-2: Statusalarme und Status-Alarmstufe (Fortsetzung)

Voreingestellte Konfigurier-

Alarm Code Statusmeldung Alarmstufe Hinweise bar?

A115 Kein externer Eingang oder | Informativ IE
abgefragte Daten

A116 Messbereichstiberschrei- | Informativ Betrifft nur Auswerteelektroniken | Ja
tung der Temperatur (Min- mit der Anwendung Mineralolmes-
eralol) sung.

A117 Messbereichsiiberschrei- | Informativ Betrifft nur Auswerteelektroniken | Ja
tung der Dichte (Mineraldl) mit der Anwendung Mineral6lmes-

sung.

A118 Bindrer mA Ausgang 1 fix | Informativ Kann entweder auf Informativoder | |a

Ignorieren gesetzt werden, aber
nicht auf Storung.
A119 Bindrer mA Ausgang 2 fix | Informativ Kann entweder auf Informativoder | |a
Ignorieren gesetzt werden, aber
nicht auf Storung.

A120 Kurvenanpassung fehlges- | Informativ Betrifft nur Auswerteelektroniken | Nein
chlagen (Konzentration) mit der Anwendung Mineral6lmes-

sung.

A121 Extrapolationsalarm (Kon- | Informativ Betrifft nur Auswerteelektroniken | Ja
zentration) mit der Anwendung Mineral6lmes-

sung.

A131 Systemverifizierung lauft: | Informativ Betrifft nur Auswerteelektroniken | Ja
Ausgange auf zuletzt ge- mit Smart-Systemverifizierung.
messenen Wert

A132 Sensorsimulation aktiv Informativ Betrifft nur Durchflussmesser mit | Ja

Core-Prozessor mit erweiterter
Funktionalitat.

Kann entweder auf Informativ oder
Ignorieren gesetzt werden, aber
nicht auf Storung.

A141 DDC-Trigger abgeschlos- | Informativ Betrifft nur Durchflussmesser mit | Ja
sen Core-Prozessor mit erweiterter

Funktionalitat.

Kann entweder auf Informativ oder
Ignorieren gesetzt werden, aber
nicht auf Storung.

5.3 Informationsparameter konfigurieren

Die Informationsparameter kdnnen verwendet werden, um das Durchflussmessgerat zu
identifizieren oder zu beschrieben. Sie werden jedoch nicht fiir die Verarbeitung in der
Auswerteelektronik bendétigt und sind auch nicht erforderlich.
Die Informationsparameter umfassen:
. Gerdteparameter

- Beschreibung
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5.3.1

5.3.2

- Nachricht
- Datum
. Sensorparameter
- Sensor Seriennummer
- Sensor Werkstoff
- Sensor Auskleidungswerkstoff
- Sensor Flanschtyp

Konfigurieren der Beschreibung

ProLink Il ProLink > Configuration > Device > Descriptor

ProLink Il Device Tools > Configuration > Informational Parameters > Transmitter

Handterminal Configure > Manual Setup > Info Parameters > Transmitter Info > Descriptor
Uberblick

Mit Descriptor kann eine Beschreibung im Speicher der Auswerteelektronik gespeichert
werden. Die Beschreibung wird nicht fiir die Verarbeitung benétigt und ist nicht
erforderlich.

Verfahren
Eine Beschreibung fiir die Auswerteelektronik eingeben.

Es konnen bis zu 16 Zeichen als Beschreibung eingegeben werden.

Nachricht konfigurieren

ProLink Il ProLink > Configuration > Device > Message

ProLink Il Device Tools > Configuration > Informational Parameters > Transmitter

Handterminal Configure > Manual Setup > Info Parameters > Transmitter Info > Message
Uberblick

Nachricht ermdglicht das Speichern einer kurzen Nachricht im Speicher der
Auswerteelektronik. Dieser Parameter wird nicht fiir die Verarbeitung in der
Auswerteelektronik benétigt und ist auch nicht erforderlich.

Verfahren
Geben Sie eine kurze Nachricht fiir die Auswerteelektronik ein.

Die Nachricht kann bis zu 32 Zeichen lang sein.
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5.3.3

5.3.4

5.3.5
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Konfigurieren des Datums

ProLink Il ProLink > Configuration > Device > Date

ProLink Il Device Tools > Configuration > Informational Parameters > Transmitter

Handterminal Configure > Manual Setup > Info Parameters > Transmitter Info > Date
Uberblick

Mittels Date kann eine statisches Datum (wird nicht durch die Auswerteelektronik
aktualisiert) im Speicher der Auswerteelektronik gespeichert werden. Dieser Parameter
wird nicht fiir die Verarbeitung benétigt und ist nicht erforderlich.

Verfahren

Das Datum im Format MM/TT/JJJJ eingeben.

Hinweis
ProLink Il und ProLink Il bietet einen Kalender, der die Auswahl des Datums erleichtert.

Sensor Seriennummer konfigurieren

ProLink Il ProLink > Configuration > Sensor > Sensor S/N

ProLink Il Device Tools > Configuration > Informational Parameters > Sensor

Handterminal Configure > Manual Setup > Info Parameters > Sensor Information > Sensor Serial Number
Uberblick

Sensor Seriennummer ermdglicht Ihnen das Speichern der Seriennummer der Sensor-
Komponente des Durchflussmessgerdts im Speicher der Auswerteelektronik. Dieser
Parameter wird nicht fiir die Verarbeitung in der Auswerteelektronik benétigt und ist auch
nicht erforderlich.

Verfahren
1. Siefinden die Seriennummer des Sensors in der Sensor Kennzeichnung.
2. Geben Sie die Seriennummer in das Feld Sensor Seriennummer ein.

Sensor Werkstoff konfigurieren

ProLink Il ProLink > Configuration > Sensor > Sensor Mat|
ProLink Il Device Tools > Configuration > Informational Parameters > Sensor
Handterminal Configure > Manual Setup > Info Parameters > Sensor Information > Tube Wetted Material
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5.3.6

5.3.7

Uberblick

Sensor Werkstoff ermdglicht Thnen das Speichern der Art des Werkstoffs, die fiir die
mediumberiihrten Teile des Sensors verwendet werden, im Speicher der
Auswerteelektronik. Dieser Parameter wird nicht fir die Verarbeitung in der
Auswerteelektronik bendétigt und ist auch nicht erforderlich.

Verfahren

1. Der fiir die mediumberiihrten Teile des Sensors verwendete Werkstoff ist in den
Dokumenten aufgefiihrt, die im Lieferumfang des Sensors enthalten sind, bzw. aus
einem Code in der Modellnummer des Sensor ersichtlich.

Eine Aufschliisselung der Modellnummer ist im Produktdatenblatt des jeweiligen
Sensors zu finden.

2. Setzen Sie Sensor Werkstoff auf die entsprechende Option.

Sensor Auskleidungswerkstoff konfigurieren

ProLink Il ProLink > Configuration > Sensor > Liner Mat|

ProLink Il Device Tools > Configuration > Informational Parameters > Sensor

Handterminal Configure > Manual Setup > Info Parameters > Sensor Information > Tube Lining
Uberblick

Sensor Auskleidungswerkstoff ermdglicht Ihnen das Speichern der Art des Werkstoffs, die fiir
die Auskleidung des Sensors verwendet wird, im Speicher der Auswerteelektronik. Dieser
Parameter wird nicht fiir die Verarbeitung in der Auswerteelektronik benétigt und ist auch
nicht erforderlich.

Verfahren

1. Der Auskleidungswerkstoff des Sensors ist in den Dokumenten aufgefiihrt, die im
Lieferumfang des Sensors enthalten sind, bzw. aus einem Code in der
Modellnummer des Sensors ersichtlich.

Eine Aufschliisselung der Modellnummer ist im Produktdatenblatt des jeweiligen
Sensors zu finden.

2. Setzen Sie Sensor Auskleidungswerkstoff auf die entsprechende Option.

Sensor Flanschtyp konfigurieren

ProLink Il ProLink > Configuration > Sensor > Flange

ProLink Il Device Tools > Configuration > Informational Parameters > Sensor

Handterminal Configure > Manual Setup > Info Parameters > Sensor Information > Sensor Flange
Uberblick

Sensor Flanschtyp ermdglicht Ihnen das Speichern des Flanschtyps lhres Sensors im Speicher
der Auswerteelektronik. Dieser Parameter wird nicht fiir die Verarbeitung in der
Auswerteelektronik benétigt und ist auch nicht erforderlich.
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Verfahren

1. Der Flanschtyp des Sensors ist in den Dokumenten aufgefthrt, die im Lieferumfang
des Sensors enthalten sind, bzw. aus einem Code in der Modellnummer des Sensors
ersichtlich.

Eine Aufschliisselung der Modellnummer ist im Produktdatenblatt des jeweiligen
Sensors zu finden.

2. Setzen Sie Sensor Flanschtyp auf die entsprechende Option.
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6 Integrieren des Messgerates mit dem
Steuersystem

In diesem Kapitel behandelte Themen:

*  Konfigurieren der Auswerteelektronikkandle
*  mAAusgang konfigurieren

*  Frequenzausgang konfigurieren

*  Konfigurieren des Bindrausgangs

*  Bindreingang konfigurieren

J Konfigurieren von Ereignissen

e Konfigurieren der digitalen Kommunikation

6.1 Konfigurieren der Auswerteelektronikkandle
ProLink Il ProLink > Configuration > Channel
ProLink Il Device Tools > Configuration > /O > Channels
Handterminal Configure > Manual Setup > Inputs/Outputs > Channels > Channel B
Configure > Manual Setup > Inputs/Outputs > Channels > Channel C

Uberblick

Die Kanale der Auswerteelektronik kénnen so konfiguriert werden, dass ein Betrieb auf
unterschiedliche Weise maoglich ist. Die Kanalkonfiguration muss der Verdrahtung an den
Anschlussklemmen der Auswerteelektronik entsprechen.

Anmerkung

Kanal A arbeitet immer als mA Ausgang mit interner Spannungsversorgung. Wenn Kanal B als mA
Ausgang konfiguriert ist, wird er intern mit Spannung versorgt.

Wichtig
Wenn sowohl ein Frequenzausgang und ein Bindrausgang benétigt werden, muss zuerst Kanal B als

Frequenzausgang und dann Kanal C als Bindrausgang konfiguriert werden. Andere Kombinationen
sind ungiiltig und werden von der Auswerteelektronik nicht akzeptiert.

Vorbereitungsverfahren

Vermeiden von Prozessstérungen:
. Konfigurieren Sie die Kanile, bevor Sie die Ausgdnge konfigurieren.

. Vor dem Andern der Kanalkonfiguration sicherstellen, dass alle durch diesen Kanal
betroffenen Regelkreise manuell gesteuert werden.
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A\ VORSICHT!

Bevor Sie einen Kanal als Bindreingang konfigurieren, priifen Sie den Status des externen
Eingangsgerates und die Aktionen, die dem Bindreingang zugeordnet sind. Wenn der
Bindreingang EIN ist, werden alle dem Bindreingang zugeordneten Aktionen ausgefiihrt, wenn
die neue Kanalkonfiguration implementiert wird. Ist dies nicht akzeptabel, andern Sie den
Status des externen Gerdtes oder warten mit der Konfiguration des Kanals als Bindreingang auf
einen geeigneten Zeitpunkt.

Verfahren

1. Kanal B wie gew(inscht einstellen.
Option Beschreibung
Sekunddrer mA Ausgang Kanal B arbeitet als mA Ausgang.
Frequenzausgang Kanal B arbeitet als Frequenzausgang.
Bindrausgang Kanal B arbeitet als Bindrausgang.

2. Wenn Kanal B als Frequenzausgang oder als Bindrausgang arbeiten soll, muss die

Spannungsquelle fiir den Kanal konfiguriert werden.

Option Beschreibung
Intern (aktiv) Der Kanal wird tiber die Auswerteelektronik mit Spannung
versorgt.
Extern (passiv) Der Kanal wird iber eine externe Quelle mit Spannung ver-
sorgt.
3. Kanal C wie gewiinscht einstellen.
Option Beschreibung
Frequenzausgang Kanal C arbeitet als Frequenzausgang.
Bindrausgang Kanal C arbeitet als Bindrausgang.
Bindreingang Kanal C arbeitet als Bindreingang.
4. Die Spannungsquelle fiir Kanal C konfigurieren.
Option Beschreibung
Intern (aktiv) Der Kanal wird tiber die Auswerteelektronik mit Spannung
versorgt.
Extern (passiv) Der Kanal wird (iber eine externe Quelle mit Spannung ver-
sorgt.

Nachbereitungsverfahren

Fiir jeden konfigurierten Kanal die entsprechende Eingangs- oder Ausgangskonfiguration
durchfiihren bzw. Gberpriifen. Wenn die Konfiguration eines Kanals sich andert, wird das
Verhalten des Kanals durch die Konfiguration geregelt, die fiir den ausgewdhlten
Eingangs- oder Ausgangstyp gespeichert ist. Die gespeicherte Konfiguration ist fir den
bestimmten Prozess mdglicherweise nicht geeignet.
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Nach dem Uberpriifen der Kanal- und Ausgangskonfiguration die automatische Steuerung
des Regelkreises wieder aktivieren.

6.2 mA Ausgang konfigurieren

Der mA Ausgang wird zum Ausgeben der konfigurierten Prozessvariablen verwendet. Die
mA Ausgangsparameter steuern, wie die Prozessvariable ausgegeben wird. Ihre
Auswerteelektronik kann einen oder zwei mA Ausgdnge haben: Kanal A ist immer ein mA
Ausgang (der primare mA Ausgang) und Kanal B kann als mA Ausgang konfiguriert sein
(der sekundare mA Ausgang).

Die Parameter des mA Ausgangs umfassen:

. mA Ausgang Prozessvariable

. Lower Range Value (LRV) und Upper Range Value (URV)

. Analogausgang Abschaltung

. Zusétzliche Dampfung

. AO Fault Action und AO Fault Value

Wichtig

Immer wenn Sie einen Parameter des mA Ausgangs dndern, priifen Sie alle anderen Parameter des
mA Ausgangs, bevor Sie das Durchfluss-Messsystem wieder in Betrieb nehmen. In einigen
Situationen |adt die Auswerteelektronik automatisch einige gespeicherte Werte und es kann sein,
dass diese Werte nicht passend fiir lhre Anwendung sind.

6.2.1 mA Ausgang Prozessvariable konfigurieren
ProLink Il e ProLink > Configuration > Analog Output > Primary Output > PV Is
*  ProLink > Configuration > Analog Output > Secondary Output > SV Is
ProLink Il Device Tools > Configuration > /0 > Outputs > mA Output
Handterminal *  Configure > Manual Setup > Inputs/Outputs > mA Output 1 > Primary Variable

*  Configure > Manual Setup > Inputs/Outputs > mA Output 2 > Secondary Variable

Uberblick

Verwenden Sie mA Ausgang Prozessvariable, um die Variable auszuwahlen, die (iber den mA
Ausgang ausgegeben wird.

Vorbereitungsverfahren

. Wenn Sie vorhaben, den Ausgang zu konfigurieren, um Volumendurchfluss
auszugeben, stellen Sie sicher, dass Sie die Volumendurchfluss-Art wie gewiinscht
eingestellt haben: Fliissigkeit oder Gas-Standardvolumen.

. Wenn Sie vorhaben einen Ausgang zu konfigurieren, um eine Prozessvariable der
Konzentrationsmessung auszugeben, stellen Sie sicher, dass die Anwendung
Konzentrationsmessung so konfiguriert ist, dass die gewlinschte Variable verfligbar
ist.

. Wenn Sie die HART Variablen verwenden, seien Sie sich bewusst, dass das Andern
der Konfiguration der mA Ausgang Prozessvariable die Konfiguration der HART
Primarvariablen (PV) und/oder die HART Sekundarvariablen (SV) andert.
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Verfahren

Setzen Sie die mA Ausgang Prozessvariable wie gewiinscht.

Die Voreinstellungen sind:

e Primdrer mA Ausgang: Massedurchfluss

e Sekunddrer mA Ausgang: Dichte

Optionen fiir mA Ausgang Prozessvariable

Die Auswerteelektronik liefert einen Grundoptionssatz fiir Ausgang Prozessvariable,
einschlieBlich mehrerer anwendungsspezifischer Optionen. Verschiedene
Kommunikations-Hilfsmittel verwenden u. U. unterschiedliche Kennzeichnungen fiir die
Optionen.

Tabelle 6-1: Optionen fiir mA Ausgang Prozessvariable

gierte Dichte

Aufkleber
Prozessvariable ProLink I ProLink Ill Handterminal
Standard
Massedurchflussrate Massendurchflussrate Massedurchfluss
Volumendurchfluss Volumendurchflussrate Volumendurchfluss
Gas Standard Volumen- Gas Std Volumendurchfluss Gasvolumendurchfluss
durchfluss
Temperatur Temperatur Temp
Dichte Dichte Dichte
Externer Druck Externer Druck Externer Druck
Externe Temperatur Externe Temperatur Externe Temperatur
Antriebsverstdrkung Antriebsverstarkung Steuersignal
Mineral6lmessung
Temperaturkorrigierte API: Temperaturkorrigierte TC-Dichte
Dichte Dichte
Temperaturkorrigierter API: Temperaturkorrigierter Volu- TC-Volumen
(Standard) Volumendurch- | mendurchfluss
fluss
Durchschnittliche korri- API: Durchschnittsdichte Durchschnittsdichte Durchschnittliche TC-Dichte

Durchschnittstemperatur

API: Durchschnittstemperatur

Durchschnittstemperatur

Durchschnittliche TC-Temperatur

Konzentrationsmessung

Dichte bei Referenzbedin-
gungen

CM: Dichte bei Referenzwerten

ED-Dichte bei Referenz

Spezifisches Gewicht

CM: Dichte (feste SG-Einheiten)

ED-Dichte (SGU)

Standard-Volumendurch-
fluss

CM: Standardvolumendurchfluss-
rate

ED-Standardvolumendurchfluss

Netto Massedurchfluss

CM: Nettomassedurchflussrate

ED-Nettomassedurchfluss

Netto-Volumendurchfluss

CM: Nettovolumendurchflussrate

ED-Nettovolumendurchfluss
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Tabelle 6-1: Optionen fiir mA Ausgang Prozessvariable (Fortsetzung)

Aufkleber
Prozessvariable ProLink I ProLink Il Handterminal
Konzentration CM: Konzentration ED-Konzentration
Baume CM: Dichte (feste Baume Einheit- ED-Dichte (Baume)
en)

6.2.2

Messanfang (LRV) und Messende (URV) konfigurieren

ProLink Il *  ProLink > Configuration > Analog Output > Primary Output > LRV
*  ProLink > Configuration > Analog Output > Primary Output > URV
¢ ProLink > Configuration > Analog Output > Secondary Output > LRV
*  ProLink > Configuration > Analog Output > Secondary Output > URV

ProLink Il Device Tools > Configuration > 1/O > Outputs > mA Output

Handterminal *  Configure > Manual Setup > Inputs/Outputs > mA Output 1 > mA Output Settings > PV LRV
¢ Configure > Manual Setup > Inputs/Outputs > mA Output 1 > mA Output Settings > PV URV
*  Configure > Manual Setup > Inputs/Outputs > mA Output 2 > mA Output Settings > SV LRV
¢ Configure > Manual Setup > Inputs/Outputs > mA Output 2 > mA Output Settings > SV URV

Uberblick

Der Messanfang (LRV) und das Messende (URV) werden verwendet, um den mA Ausgang zu
skalieren, d. h. das Verhaltnis zwischen der mA Ausgang Prozessvariablen und dem mA
Ausgangswert zu definieren.

Verfahren
Setzen Sie LRV und URV wie gewiinscht.

e LRVist der Wert der mA Ausgang Prozessvariablen, der durch einen Ausgang von 4 mA
reprasentiert wird. Der voreingestellte Wert fiir LRV ist von der Einstellung der mA
Ausgang Prozessvariablen abhdngig. Geben Sie den Wert fiir LRV in den Messeinheiten ein,
die fiir die mA Ausgang Prozessvariable konfiguriert wurden.

e URVist der Wert der mA Ausgang Prozessvariablen, der durch einen Ausgang von 20 mA
reprasentiert wird. Der voreingestellte Wert fiir URV ist von der Einstellung der mA
Ausgang Prozessvariablen abhdngig. Geben Sie URV in den Messeinheiten ein, die fiir die
mA Ausgang Prozessvariable konfiguriert wurden.

Hinweise

Fiir optimale Leistungsmerkmale:

* Setzen Sie LRV > LSL (untere Sensorgrenze).

e Setzen Sie URV < USL (obere Sensorgrenze).

e Setzen Sie diese Werte so, dass die Differenz zwischen URV und LRV = Min Spanne
(Mindestmessspanne) ist.

Die Festlegung von URV und LRV innerhalb der empfohlenen Werte fiir Min Spanne, LSL und USL sorgt
dafiir, dass die Auflésung des mA Ausgang Signals innerhalb des Bereichs der Bitgenauigkeit des
D/A-Wandlers liegt.

Konfigurations- und Bedienungsanleitung 87



Integrieren des Messgerdtes mit dem Steuersystem

Anmerkung

Sie konnen URV unterhalb von LRV setzen. Zum Beispiel kdnnen Sie URV auf 50 und LRV auf 100
setzen.

Der mA Ausgang verwendet einen Bereich von 4-20 mA zur Darstellung der mA Ausgang
Prozessvariablen. Zwischen LRV und URV ist der mA Ausgang linear zur Prozessvariablen.
Fallt die Prozessvariable unter LRV oder steigt iber URV, setzt die Auswerteelektronik
einen Sattigungsalarm.

Voreingestelle Werte fiir Messanfang (LRV) und Messende (URV)

Jede Option flir die mA Ausgang Prozessvariable hat ihre eigenen LRV und URV. Wenn Sie die
Konfiguration der mA Ausgang Prozessvariable andern, werden die korrospondierenden LRV
und URV geladen und verwendet.

6.2.3
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Tabelle 6-2: Voreingestelle Werte fiir Messanfang (LRV) und Messende (URV)

Prozessvariable Messanfang Messende
Alle Massedurchfluss-Variablen | -200,000 g/s 200,000 g/s
Alle Fltssigkeits-Volumen- -0,2001/s 0,2001/s
durchfluss-Variablen

Alle Dichtevariablen 0,000 g/cm? 10,000 g/cm3
Alle Temperaturvariablen -240,000 °C 450,000 °C
Antriebsverstarkung 0,00 % 100,00 %
Gas-Standardvolumendurch- -423,78 SCFM 423,78 SCFM
fluss

Externe Temperatur -240,000 °C 450,000 °C
Externer Druck 0,000 bar 100,000 bar
Konzentration 0% 100 %
Baume 0 10
Spezifisches Gewicht 0 10

Analogausgang Abschaltung konfigurieren

ProLink Il *  ProLink > Configuration > Analog Output > Primary Output > AO Cutoff
*  ProLink > Configuration > Analog Output > Secondary Output > AO Cutoff
ProLink Il Device Tools > Configuration > /O > Outputs > mA Output
Handterminal *  Configure > Manual Setup > Inputs/Outputs > mA Output 1 > mA Output Settings > MAO Cutoff

*  Configure > Manual Setup > Inputs/Outputs > mA Output 2 > mA Output Settings > MAO Cutoff

Uberblick

AO Cutoff (Analogausgang Abschaltung) spezifiziert den niedrigsten Massedurchfluss,
Volumendurchfluss oder Gas Standard Volumendurchfluss, der durch den mA Ausgang
ausgegeben wird. Jeder Durchfluss unterhalb der Analogausgang Abschaltung wird als 0

ausgegeben.
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Einschrankung

Die Analogausgang Abschaltung wird nur angewandt, wenn die mA Ausgang Prozessvariable auf
Massedurchfluss, Volumendurchfluss oder Gas Standard Volumendurchfluss gesetzt ist. Ist die mA Ausgang
Prozessvariable auf eine andere Prozessvariable gesetzt, ist die Analogausgang Abschaltung nicht
konfigurierbar und die Auswerteelektronik implementiert die Funktion der Analogausgang
Abschaltung nicht.

Verfahren
Setzen Sie die Analogausgang Abschaltung wie gewiinscht.

Die voreingestellten Werte fiir Analogausgang Abschaltung sind:
e Primdrer mA Ausgang: 0,0 g/s

e Sekunddrer mA Ausgang: Not-A-Number

Hinweis
Fiir die meisten Anwendungen sollte der voreingestellte Wert der Analogausgang Abschaltung

verwendet werden. Setzen Sie sich mit dem Micro Motion Kundenservice in Verbindung, bevor Sie
die Analogausgang Abschaltung andern.

Wechselwirkung zwischen AO-Abschaltung und
Prozessvariablen-Abschaltungen

Wenn die mA-Ausgang-Prozessvariable auf eine Durchflussvariable (beispielsweise
Massendurchfluss oder Volumendurchfluss) gesetzt ist, dann hat die AO-Abschaltung
Wechselwirkungen mit der Massendurchfluss-Abschaltung oder der Volumendurchfluss-
Abschaltung. Die Auswerteelektronik setzt die Abschaltung beim héchsten Durchfluss ein,
bei dem diese anwendbar ist.

Beispiel: Wechselwirkung bei Abschaltung

Konfiguration:

U mA-Ausgang-Prozessvariable = Massedurchfluss

° Frequenzausgang-Prozessvariable = Massedurchfluss
. AO-Abschaltung = 10 g/s

. Massedurchfluss-Abschaltung = 15 g/s

Ergebnis: Fallt der Massedurchfluss unter 15 g/s, geben alle Ausgdnge, die den
Massedurchfluss reprasentieren, null Durchfluss aus.

Beispiel: Wechselwirkung bei Abschaltung

Konfiguration:

. mA-Ausgang-Prozessvariable = Massedurchfluss

. Frequenzausgang-Prozessvariable = Massedurchfluss
. AO-Abschaltung = 15 g/s

. Massedurchfluss-Abschaltung = 10 g/s

Ergebnis:
. Fallt der Massedurchfluss unter 15 g/s aber nicht unter 10 g/s:
- gibt der mA-Ausgang null Durchfluss aus.
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- gibt der Frequenzausgang den aktuellen Durchfluss aus.

. Féllt der Massedurchfluss unter 10 g/s, geben beide Ausgdnge null Durchfluss aus.
6.2.4 Zusatzliche Dampfung konfigurieren
ProLink Il e ProLink > Configuration > Analog Output > Primary Output > AO Added Damp
*  ProLink > Configuration > Analog Output > Secondary Output > AO Added Damp
ProLink IlI Device Tools > Configuration > /0O > Outputs > mA Output
Handterminal *  Configure > Manual Setup > Inputs/Outputs > mA Output 1 > mA Output Settings > PV Added
Damping
*  Configure > Manual Setup > Inputs/Outputs > mA Output 2 > mA Output Settings > SV Added
Damping
Uberblick

Die Dampfung wird verwendet, um kleine, plotzlich auftretende Schwankungen des
Prozessmesswerts zu gldtten. Damping Value gibt die Zeitdauer (in Sekunden) an, iber die
die Auswerteelektronik die Anderungen in der ausgegebenen Prozessvariable verteilt. Am
Ende des Intervalls spiegelt die ausgegebene Prozessvariable 63 % der Anderung des
eigentlichen gemessenen Wertes wider. Zuséatzliche Dampfung steuert den Wert der
Dampfung, die fir den mA Ausgang angewandt werden soll. Sie beeinflusst nur die
Ausgabe der mA Ausgang Prozessvariablen durch den mA Ausgang. Sie beeinflusst nicht die
Ausgabe der Prozessvariablen mittels einer anderen Methode (z. B. dem Frequenzausgang
oder der digitalen Kommunikation) oder den Wert der Prozessvariablen, der fiir
Berechnungen verwendet wird.

Anmerkung

Zusétzliche Dampfung wird nicht auf den mA Ausgang angewandt, wenn dieser fixiert ist (z. B. wahrend
des Messkreistests) oder wenn der mA Ausgang eine Stérung ausgibt. Zusatzliche Dampfung wird
angewandt, wdhrend die Sensor Simulation aktiv ist.

Verfahren
Setzen Sie Zuséatzliche Dampfung auf den gewiinschten Wert.
Der voreingestellte Wert ist 0,0 Sekunden.

Wenn Sie einen Wert fiir Added Damping setzen, rundet die Auswerteelektronik den Wert
automatisch auf den nachsten Wert nach unten ab.

Anmerkung

Die Werte flir Zusatzliche Dampfung werden durch das Setzen der Messwertaktualisierung und der 100 Hz
Variablen beeinflusst.
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Tabelle 6-3: Giiltige Werte fiir Zusétzliche Dampfung

Beeinflusste
Messwer-
Einstellung der Messwertak- taktualisier-
tualisierung Prozessvariable ung Giiltige Werte fiir Zusatzliche Dampfung
Normal k.A. 20 Hz 0,0,0,1,0,3,0,75,1,, 3,3, 6,5, 13,5, 27,5, 55,
110, 220, 440
Spezial 100 Hz Variable (wenn ei- 100 Hz 0,0, 0,04, 0,12, 0,30, 0,64, 1,32, 2,6, 5,4, 11, 22,
nem mA Ausgang zugeord- 44,88, 176, 350
net)
100 Hz Variable (keinem mA | 6,25 Hz 0,0, 0,32, 0,96, 2,40, 5,12, 10,56, 20,8, 43,2, 88,
Ausgang zugeordnet) 176, 352
Alle anderen Prozessvaria-
blen

6.2.5

Interaktion zwischen Zusatzdampfung und
Prozessvariablendampfung

Wenn die mA-Ausgang-Prozessvariable auf eine Durchflussvariable, Dichte oder Temperatur
gesetzt ist, dann hat die Zusétzliche Dampfung Wechselwirkungen mit der Durchflussddmpfung,
Dichteddmpfung oder Temperaturddmpfung. Wenn mehrere Dampfungsparameter verwendet
werden, wird zuerst der Effekt der Ddmpfung der Prozessvariablen berechnet, und die
zusatzliche Dampfung wird auf das Ergebnis dieser Berechnung angewandt.

Beispiel: Wechselwirkung bei Dampfung

Konfiguration:

. Durchflussdampfung = 1 Sekunde

. mA-Ausgang-Prozessvariable = Massedurchfluss

. Zusétzliche Dampfung = 2 Sekunden

Ergebnis: Eine Anderung des Massedurchflusses wirkt sich am mA-Ausgang nach mehr als

3 Sekunden aus. Die genaue Zeit wird durch die Auswerteelektronik berechnet, gemaR
einem internen Algorithmus, der nicht konfiguriert werden kann.

mA Ausgang Stéraktion und mA Ausgang Storwert
konfigurieren

ProLink Il e ProLink > Configuration > Analog Output > Primary Output > AO Fault Action

*  ProLink > Configuration > Analog Output > Primary Output > AO Fault Level

e ProLink > Configuration > Analog Output > Secondary Output > AO Fault Action
*  ProLink > Configuration > Analog Output > Secondary Output > AO Fault Level

ProLink Il Device Tools > Configuration > Fault Processing

Handterminal ¢ Configure > Manual Setup > Inputs/Outputs > mA Output 1 > MAO1 Fault Settings
*  Configure > Manual Setup > Inputs/Outputs > mA Output 2 > MA02 Fault Settings
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Uberblick

Die mA Ausgang Storaktion steuert das Verhalten des mA Ausgangs, wenn die
Auswerteelektronik eine interne Stérbedingung erkennt.

Anmerkung

Nur fiir manche Fehler: Wenn Zuletzt gemessener Wert - Zeitiiberschreitung auf einen Wert ungleich null
gesetzt ist, wird die Auswerteelektronik die Stdraktion erst nach Ablauf der Zeitliberschreitung
implementieren.

Verfahren
1. Setzen Sie die mA Ausgang Stdraktion auf den gewiinschten Wert.

Die Voreinstellung ist Abwarts.

2. Wenn Sie mA Ausgang Storaktion auf Aufwarts oder Abwarts setzen, setzen Sie den mA
Ausgang Storwert wie gewiinscht.

Optionen fiir mA Ausgang Storaktion und mA Ausgang Storwert

Tabelle 6-4: Optionen fiir mA Ausgang Storaktion und mA Ausgang Storwert

Option mA Ausgang Verhalten mA Ausgang Storwert

Aufwarts Geht auf den konfigurierten Storwert Default: 22,0 mA
Bereich: 21 bis 24 mA

Abwarts (Voreinstellung) Geht auf den konfigurierten Stérwert Voreinstellung: 2,0 mA
Bereich: 1,0 bis 3,6 mA

Interner Nullpunkt Geht auf den mA-Ausgangswert, der Nicht zutreffend
dem Wert der Prozessvariablen von 0
(Null) zugeordnet ist, wie durch die Mes-
sanfang und Messende Werte Einstellun-
gen.

Keine Ubertragungsdaten fiir die zugeordnete | Nicht zutreffend
Prozessvariable, keine Storaktion

A\ VORSICHT!

Wenn Sie die mA-Ausgang-Storaktion oder Frequenzausgang-Storaktion auf Keine setzen, stellen Sie
sicher, dass auch Digitale Kommunikations-Storaktion auf Keine gesetzt ist. Andernfalls gibt der
Ausgang nicht die aktuellen Prozessdaten aus und dies kann Messfehler erzeugen oder
ungewollte Konsequenzen fiir Ihren Prozess haben.

Einschrankung

Wenn Sie die Digitale Kommunikations-Storaktion auf NAN setzen, konnen Sie die mA-Ausgang-Stéraktion
oder Frequenzausgang-Storaktion nicht auf Keine setzen. Wenn Sie dies versuchen, akzeptiert die
Auswerteelektronik die Konfiguration nicht.
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6.3

6.3.1

Frequenzausgang konfigurieren

Der Frequenzausgang wird zum Ausgeben einer Prozessvariablen verwendet. Die
Parameter fiir den Frequenzausgang steuern, wie die Prozessvariable ausgegeben wird.
Ihre Auswerteelektronik kann keinen, einen oder zwei Frequenzausgdnge haben, abhangig
von der Konfiguration der Kandle B und C. Wenn beide, Channel B und Kanal C als
Frequenzausgang konfiguriert sind, sind diese elektrisch getrennt aber nicht unabhdngig.
Sie kénnen diese Kanale nicht unabhdngig voneinander konfigurieren.

Die Parameter Frequenzausgang umfassen:

. Frequenzausgang Prozessvariable

o Frequenzausgang Polaritat

° Frequenzausgang Skaliermethode

o Frequenzausgang max. Impulsbreite

. Frequenzausgang Modus

. Frequency Output Fault Action und Frequency Output Fault Value

Wichtig

Immer wenn Sie einen Parameter des Frequenzausgangs dandern, priifen Sie alle anderen Parameter
des Frequenzausgangs, bevor Sie das Durchfluss-Messsystem wieder in Betrieb nehmen. In einigen
Situationen |adt die Auswerteelektronik automatisch einige gespeicherte Werte und es kann sein,
dass diese Werte nicht passend fiir lhre Anwendung sind.

Frequenzausgang Prozessvariable konfigurieren

ProLink Il ProLink > Configuration > Frequency > Tertiary Variable

ProLink Il Device Tools > Configuration > 1/0 > Outputs > Frequency Output

Handterminal Configure > Manual Setup > Inputs/Outputs > Frequency Output > FO Settings > Third Variable
Uberblick

Die Frequenzausgang Prozessvariable steuert die Variable, die (iber den Frequenzausgang
ausgegeben wird.

Vorbereitungsverfahren

Wenn Sie vorhaben, den Ausgang zu konfigurieren, um Volumendurchfluss auszugeben,
stellen Sie sicher, dass Sie die Volumendurchfluss-Art wie gewlinscht eingestellt haben:
Fliissigkeit oder Gas-Standardvolumen.

Wenn Sie vorhaben einen Ausgang zu konfigurieren, um eine Prozessvariable der
Konzentrationsmessung auszugeben, stellen Sie sicher, dass die Anwendung
Konzentrationsmessung so konfiguriert ist, dass die gewiinschte Variable verfiigbar ist.

Wenn Sie die HART Variablen verwenden, seien Sie sich bewusst, dass das Andern der
Konfiguration der Frequenzausgang Prozessvariable die Konfiguration der HART
Tertidrvariablen (TV) dndert.

Verfahren

Setzen Sie die Frequenzausgang Prozessvariable wie gewiinscht.
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Die Voreinstellung ist Massedurchfluss.

Optionen fiir Frequenzausgang Prozessvariable

Die Auswerteelektronik liefert einen Grundoptionssatz fiir Ausgang Prozessvariable,
einschlieBlich mehrerer anwendungsspezifischer Optionen. Verschiedene
Kommunikations-Hilfsmittel verwenden u. U. unterschiedliche Kennzeichnungen fiir die

Optionen.

Tabelle 6-5: Optionen fiir Frequenzausgang Prozessvariable

Volumendurchfluss

ence Temperature

Aufkleber

Prozessvariable ProLink II ProLink IlI Handterminal
Standard
Massedurchfluss Massedurchfluss Mass Flow Rate Massedurchfluss
Volumendurchfluss Volumendurchfluss Volume Flow Rate Volumendurchfluss
Gas Standard Volumendurchfluss Gas Std Volumendurchfluss | Gas Standard Volume Flow | Gasvolumendurchfluss

Rate
Mineral6lmessung
Temperaturkorrigierter (Standard) Std Vol Flow Volume Flow Rate at Refer- | TC-Volumen

Konzentrationsmessung

Standard-Volumendurchfluss

ED : Std Vol Durchfluss

Volume Flow Rate at Refer-

ence Temperature

ED-Standardvolumendurch-
fluss

Netto Massedurchfluss

ED : Netto Massedurchfluss

Net Mass Flow Rate

ED-Nettomassedurchfluss

Netto Volumendurchfluss

ED : Net Vol Durchfluss

Net Volume Flow Rate

ED-Nettovolumendurchfluss

6.3.2

Frequenzausgang Polaritat konfigurieren

ProLink Il

ProLink > Configuration > Frequency > Freq Output Polarity

ProLink IlI

Device Tools > Configuration > /0 > Outputs > Frequency Output

Handterminal

Configure > Manual Setup > Inputs/Outputs > Frequency Output > FO Settings > FO Polarity

Uberblick

Die Frequenzausgang Polaritat steuert, wie der Ausgang einen Status EIN (aktiv) anzeigt. Der
voreingestellte Wert Aktiv Hoch ist fiir die meisten Anwendungen anwendbar. Es kann sein,
dass Aktiv Niedrig fiir Anwendungen mit niederfrequentem Signal benétigt wird.

Verfahren

Setzen Sie die Frequenzausgang Polaritit wie gewiinscht.

Die vorgegebene Einstellung ist Aktiv Hoch.
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6.3.3

Optionen fiir Frequenzausgang Polaritat

Tabelle 6-6: Optionen fiir Frequenzausgang Polaritat

Polaritat Referenzspannung (AUS) Impulsspannung (ON)

Aktiv hoch 0 Bestimmt durch Spannungs-
versorgung, Pull-up-Wider-
stand und Biirde (siehe Installa-
tionsanleitung lhrer Auswer-
teelektronik)

Aktiv niedrig Bestimmt durch Spannungs- 0

versorgung, Pull-up-Wider-
stand und Biirde (siehe Installa-
tionsanleitung Ihrer Auswer-
teelektronik)

Frequenzausgang Skaliermethode konfigurieren

ProLink Il

ProLink > Configuration > Frequency > Scaling Method

ProLink IlI

Device Tools > Configuration > 1/0 > Outputs > Frequency Output

Handterminal

Configure > Manual Setup > Inputs/Outputs > Frequency Output > FO Scaling

Uberblick

Die Frequenzausgang Skaliermethode definiert das Verhaltnis zwischen Ausgangsimpulsen und
Durchflusseinheiten. Setzen Sie die Frequenzausgang Skaliermethode entsprechend den
Anforderungen lhres frequenzempfangenden Gerates.

Verfahren
1. Setzen Sie die Frequenzausgang Skaliermethode.
Option Beschreibung
Frequenz = Durchfluss (Vor- = Frequenz berechnet vom Durchfluss
einstellung)
Impulse/Einheit Eine durch den Anwender spezifizierte Impulszahl reprasentiert
eine Durchflusseinheit
Einheiten/Impulse Ein Impuls reprasentiert eine durch den Anwender spezifizierte
Anzahl an Durchflusseinheiten
2. Setzen Sie zusatzlich erforderlicher Parameter.

e Wenn Sie die Frequency Output Scaling Method auf Frequency=Flow setzen, setzen Sie
den Rate Factor und Frequency Factor.

* Wenn Sie die Frequency Output Scaling Method auf Pulses/Unit setzen, definieren Sie
die Anzahl der Impulse, die eine Durchflusseinheit reprasentieren soll.

*  Wenn Sie die Frequency Output Scaling Method auf Units/Pulse setzen, definieren Sie
die Einheiten, die jeder Impuls anzeigen soll.
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96

Frequenz anhand des Durchflusses berechnen

Die Option Frequenz = Durchfluss wird verwendet, um den Frequenzausgang lhrer
Anwendung kundenspezifisch anzupassen, wenn Sie die entsprechenden Werte fiir
Einheiten/Impuls oder Impulse/Einheit nicht kennen.

Wenn Sie Frequenz = Durchfluss wahlen, miissen Sie die Werte fiir Durchflussfaktor und
Frequenzfaktor angeben:

Durchflussfaktor Der max. Durchfluss, den der Frequenzausgang ausgeben soll. Oberhalb
dieses Durchflusses gibt die Auswerteelektronik A110: Frequenzausgang
geséttigt aus.

Frequenzfaktor  Ein Wert wird wie folgt berechnet:

RateFactor x N

FrequencyFactor = T

wobei:

T Faktor zum Umrechnen der gewahlten Zeitbasis in Sekunden

N Anzahl der Impulse pro Durchflusseinheit gemaR Konfiguration am
empfangenden Gerat

Der resultierende Frequenzfaktor muss innerhalb des Frequenzbereichs des Ausgangs liegen
(von 0 bis 10 000 Hz).

o Ist der Frequenzfaktor kleiner als 1 Hz, konfigurieren Sie das empfangende Gerat auf
einen hoheren Wert fir Impulse/Einheit.

. Ist der Frequenzfaktor gréRer als 10.000 Hz, konfigurieren Sie das empfangende Gerdt
auf einen niedrigeren Wert fiir Impulse/Einheit.

Hinweis

Ist die Frequenzausgang-Skaliermethode auf Frequenz = Durchfluss gesetzt und Max. Impulsbreite fiir
Frequenzausgang auf einen Wert ungleich Null gesetzt, empfiehlt MicroMotion die Einstellung des
Frequenzfaktors auf einen Wert kleiner als 200 Hz.

Beispiel: Frequenz = Durchfluss konfigurieren

Wenn Sie mochten, dass der Frequenzausgang alle Durchfliisse bis 2000 kg/min ausgeben
soll.

Das frequenzempfangende Gerat ist auf 10 Impulse/kg konfiguriert.

Losung:

FrequencyFactor = M XN
FrequencyFactor = % x 10

FrequencyFactor = 333.33

Setzen Sie die Parameter wie folgt.
. Durchflussfaktor: 2000
° Frequenzfaktor; 333,33
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6.3.4 Frequenzausgang max. Impulsbreite konfigurieren
ProLink Il ProLink > Configuration > Frequency > Freq Pulse Width
ProLink Il Device Tools > Configuration > /0 > Outputs > Frequency Output
Handterminal Configure > Manual Setup > Inputs/Outputs > Frequency Output > FO Settings > Max Pulse Width
Uberblick

Die Frequenzausgang max. Impulsbreite stellt sicher, dass die Dauer des EIN Signals lang genug
ist, damit das Frequenz empfangende Gerat es erkennt.

Das EIN Signal kann die hohe Spannung sein oder 0,0 V, abhdngig von der Frequenzausgang
Polaritat.

Tabelle 6-7: Wechselwirkung von Frequenzausgang max. Impulsbreite und Frequenzausgang

Polaritat
Polaritdt Impulsbreite
Aktiv hoch
+—> < > < > N E—
Aktiv niedrig

Einschrdankung

Ist die Auswerteelektronik fiir zwei Frequenzausgédnge konfiguriert, ist die Frequenzausgang max.
Impulsbreite nicht implementiert. Die Ausgange arbeiten immer mit einem Impuls/Pause-Verhaltnis
von 50 %.

Verfahren
Setzen Sie die Frequenzausgang max. Impulsbreite wie gew{inscht.

Der voreingestellte Wert ist 277 ms. Sie kénnen den Frequenzausgang max. Impulsbreite auf
0 ms oder einen Wert zwischen 0,5 ms und 277,5 ms einstellen. Die Auswerteelektronik
setzt den eingegebenen Wert automatisch auf den nachsten gliltigen Wert.

Hinweis

Micro Motion empfiehlt, den voreingestellten Wert fiir die Frequenzausgang max. Impulsbreite nicht zu
dndern. Wenden Sie sich an den Micro Motion Kundendienst, wenn Sie die Frequenzausgang max.
Impulsbreite andern mochten.
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6.3.5 Frequenzausgang Modus konfigurieren
ProLink Il ProLink > Configuration > Frequency > Freq Output Mode
ProLink Il Device Tools > Configuration > /0 > Outputs > Frequency Output
Handterminal Not available
Uberblick

Frequenzausgang Modus definiert das Verhdltnis zwischen zwei Frequenzausgdngen (Dual-
Impulse Modus).

Vorbereitungsverfahren

Bevor Sie den Frequenzausgang Modus konfigurieren, stellen Sie sicher, dass beide, Kanal B
und Kanal C als Frequenzausgang konfiguriert sind. Wenn Sie an lhrer Auswerteelektronik
keine zwei Frequenzausgdnge haben, ist der Frequenzausgang Modus auf Einfach gesetzt und
kann nicht gedndert werden.

Verfahren
Setzen Sie den Frequenzausgang Modus wie gew(inscht.

Der voreingestellte Wert ist Quadratur.

Optionen fiir Frequenzausgang Modus

Tabelle 6-8: Optionen fiir Frequenzausgang Modus

Option Kanalverhalten Prozessbedingung
In-Phase Kanal B

Puls/Pause- Kanal C M

Verhaltnis von

50%

90° Phasenver- Kanal B

SN analc L
puls/Pouse: Epiigipigh

Verhaltnis von
50 %

-90° Phasenver- = Kanal B

SN analc [
puls/Pouse: Hpigipins

Verhaltnis von
50 %

180° Phasenver- | Kanal B

schiebung Kanal C B R A S
Puls/Pause- EEERERENE

Verhaltnis von
50 %
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Tabelle 6-8: Optionen fiir Frequenzausgang Modus (Fortsetzung)

Option Kanalverhalten Prozessbedingung

Quadrature(™ Kanal B Mrnrnri Vorwirtsdurchfluss

Verhéltnis von

Puls/Pause- Kanal C Enlininiinl Kanal Cum 90° zu Kanal B verzé-
gert

>0% KanalB [ [ [ Riickwartsdurchfluss
Kanal C 1Tl Kanal C fiihrt Kanal B um 90°

Kanal B Stérung

Kanal C Kanal Cgehtauf0
6.3.6 Frequenzausgang Storaktion und Frequenzausgang Storwert
konfigurieren
ProLink Il *  ProLink > Configuration > Frequency > Freq Fault Action
e ProLink > Configuration > Frequency > Freq Fault Level
ProLink Il Device Tools > Configuration > Fault Processing
Handterminal ¢ Configure > Manual Setup > Inputs/Outputs > Frequency Output > FO Fault Parameters > FO
Fault Action
*  Configure > Manual Setup > Inputs/Outputs > Frequency Output > FO Fault Parameters > FO
Fault Level
Uberblick

Frequenzausgang Storaktion steuert das Verhalten des Frequenzausgangs, wenn die
Auswerteelektronik eine interne Stérbedingung erkennt.

Anmerkung

Nur fiir manche Fehler: Wenn Zuletzt gemessener Wert - Zeitiiberschreitung auf einen Wert ungleich null
gesetzt ist, wird die Auswerteelektronik die Stdraktion erst nach Ablauf der Zeitliberschreitung
implementieren.

Verfahren
1. Setzen Sie die Frequenzausgang Storaktion wie gewiinscht.

Der voreingestellte Wert ist Abwarts (0 Hz).

2. Wenn Sie die Frequenzausgang Storaktion auf Aufwérts setzen, setzen Sie den
Frequenzausgang Storwert auf den gewlinschten Wert.

Der voreingestellte Wert ist 15000 Hz. Der Bereich ist 10 bis 15000 Hz.

(1) Der Quadrature Modus wird nur fiir eichamtliche Anwendungen (Weights & Measures) verwendet, wo das Gesetz es fordert.
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Optionen fiir Frequenzausgang Stéraktion

Tabelle 6-9: Optionen fiir Frequenzausgang Storaktion

Frequenzausgang Verhalten

Bezeichnung Alle Modi auBer Quadratur Quadratur-Modus
Upscale Geht zum konfigurierten Aufwarts Kanal B: Geht zum konfigurierten
Wert: Aufwarts Wert

e Bereich: 10 Hz bis 15000 Hz Kanal C: 0 Hz
e Standardwert: 15000 Hz

Downscale 0Hz Kanal B: Geht zum konfigurierten
Aufwarts Wert
Kanal C: 0 Hz
Interner Nullpunkt 0Hz Kanal B: Geht zum konfigurierten
Aufwarts Wert
Kanal C: 0 Hz
Keine (Voreinstellung) | Ubertragungsdaten fiir die zu- Kanal B: Fiihrt die Daten der zu-
geordnete Prozessvariable, keine geordneten Prozessvariablen
Storaktion Kanal C: Fiihrt die Daten der zu-

geordneten Prozessvariablen

Wenn lhre Auswerteelektronik (iber zwei Frequenzausgdnge verfligt, ist ihr Storverhalten
dasselbe in allen Modi auBer Quadratur.

A\ VORSICHT!

Wenn Sie die mA-Ausgang-Storaktion oder Frequenzausgang-Storaktion auf Keine setzen, stellen Sie
sicher, dass auch Digitale Kommunikations-Storaktion auf Keine gesetzt ist. Andernfalls gibt der
Ausgang nicht die aktuellen Prozessdaten aus und dies kann Messfehler erzeugen oder
ungewollte Konsequenzen fiir Ihren Prozess haben.

Einschrankung

Wenn Sie die Digitale Kommunikations-Storaktion auf NAN setzen, konnen Sie die mA-Ausgang-Stéraktion
oder Frequenzausgang-Storaktion nicht auf Keine setzen. Wenn Sie dies versuchen, akzeptiert die
Auswerteelektronik die Konfiguration nicht.

6.4 Konfigurieren des Bindrausgangs

Der Bindrausgang wird verwendet, um spezifische Durchfluss-Messsystem oder
Prozessbedingungen auszugeben. Die Parameter des Bindrausgangs steuern welche
Bedingung ausgegeben wird und wie. Ihre Auswerteelektronik kann keinen oder einen
oder zwei Bindrausgange haben, je nach Konfiguration der Channels B und C. Wenn beide
Channels B und C als Bindrausgdnge konfiguriert sind, funktionieren sie unabhdngig
voneinander und kdnnen separat konfiguriert werden.

Die Parameter Binarausgang enthalt:
. Bindrausgang Quelle
. Bindrausgang Polaritat
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6.4.1

. Binadrausgang Storaktion

Einschrdankung

Bevor Sie den Binarausgang konfigurieren kénnen, miissen Sie einen Kanal konfigurieren der als
Bindrausgang arbeitet.

Wichtig

Immer wenn Sie einen Parameter des Bindrausgangs andern, priifen Sie alle anderen Parameter des
Bindrausgangs bevor Sie das Durchfluss-Messsystem wieder in Betrieb nehmen. In einigen
Situationen l3dt die Auswerteelektronik automatisch einige gespeicherte Werte und es kann sein,
dass diese Werte nicht passend fiir Ihre Anwendung sind.

Konfigurieren der Bindrausgangsquelle

ProLink Il e ProLink > Configuration > Discrete Output > DO 1 Assignment

e ProLink > Configuration > Discrete Output > DO 2 Assignment

ProLink Il Device Tools > Configuration > 1/O > Outputs > Discrete Output
Handterminal *  Configure > Manual Setup > Inputs/Outputs > Discrete Output > DO 1 Assignment
*  Configure > Manual Setup > Inputs/Outputs > Discrete Output > DO 2 Assignment
Uberblick

Die Discrete Output Source steuert welche Bedingung oder Prozessvariable des Durchfluss-
Messsystems (iber den Bindrausgang ausgegeben wird.

Verfahren
Discrete Output Source auf die gewlinschte Option einstellen.

Die Standardeinstellungen fiir Discrete Output Sourcelauten wie folgt:
e Bindrausgang 1: Flow Direction

e Bindrausgang 2: Flow Switch mit Flow Switch Variable eingestellt auf Mass Flow Rate, Flow
Switch Setpoint eingestellt auf 0,0 g/s und Flow Switch Hysteresis eingestellt auf 0,05 (5 %).

Optionen fiir Bindrausgang Quelle

Tabelle 6-10: Optionen fiir Bindrausgang Quelle

Bezeichnung -
Bindrausgang
Option ProLink II ProLink Ill Handterminal Zustand Spannung
Binarereignis 1-52) | Discrete Event x Discrete Event x EIN Anwenderspezi-
fisch
AUS ov
Ereignis 1-203) Event 1 Event 1 EIN Anwenderspezi-
Ereignis 2 Ereignis 2 fisch

(2) Mithilfe des erweiterten Ereignismodells konfigurierte Ereignisse
(3) Mithilfe des Basis-Ereignismodells konfigurierte Ereignisse
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Tabelle 6-10: Optionen fiir Bindrausgang Quelle (Fortsetzung)

Bezeichnung -
Bindrausgang
Option ProLink II ProLink Ill Handterminal Zustand Spannung
Ereignis 1 oder Ereignis 1 oder AUS ov
Ereignis 2 Ereignis 2
Durchflussschalter | Flow Switch Indi- Flow Switch EIN Anwenderspezi-
cation fisch
AUS oV
Durchflussrichtung Forward/Reverse Forward/Reverse | Vorwdrtsdurch- ov
Indication fluss
Riickwartsdurch- | Anwenderspezi-
fluss fisch
Kalibrierung lduft Calibration in Pro- Calibration in Pro- | EIN Anwenderspezi-
gress gress fisch
AUS oV
Storung Fault Condition Fault EIN Anwenderspezi-
Indication fisch
AUS oV
Wichtig
In dieser Tabelle wird davon ausgegangen, dass Bindrausgang Polaritat auf Aktiv Hoch eingestellt ist. Ist
die Bindrausgang Polaritat auf Aktiv Niedrig gesetzt, Spannungswerte umkehren.
Wichtig
Ist der Durchflussschalter dem Bindrausgang zugeordnet, miissen auBerdem die Durchflussvariable,
der Durchflussschalter-Sollwert und die Hysterese spezifiziert werden.
Anmerkung
Wenn lhre Auswerteelektronik zwei Bindrausgange hat:
. Koénnen Sie diese unabhangig voneinander konfigurieren. Zum Beispiel, kbnnen Sie einen
dem Durchflussschalter zuordnen und einen der Stérung.
. Wenn Sie beide dem Durchflussschalter zuordnen, werden die gleichen Einstellungen fir
Durchflussschalter Variable, Durchflussschalter Sollwert und Durchflussschalter Hysterese fiir beide
Bindrausgdnge implementiert.
Parameter Durchflussschalter konfigurieren
ProLink Il *  ProLink > Configuration > Flow > Flow Switch Setpoint
e ProLink > Configuration > Flow > Flow Switch Variable
e ProLink > Configuration > Flow > Flow Switch Hysteresis
ProLink Il Device Tools > Configuration > 1/0 > Outputs > Discrete Output
Handterminal *  Configure > Manual Setup > Inputs/Outputs > Discrete Output > Flow Switch Source
*  Configure > Manual Setup > Inputs/Outputs > Discrete Output > Flow Switch Setpoint
*  Configure > Manual Setup > Inputs/Outputs > Discrete Output > Hysteresis
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Uberblick

Der Durchflussschalter wird dazu verwendet, anzuzeigen, dass der Durchfluss (gemessen
durch die konfigurierte Durchflussvariable) den konfigurierten Sollwert (iber- oder
unterschritten hat. Der Durchflussschalter wird mit einer anwenderkonfigurierbaren
Hysterese implementiert.

Verfahren

1. Setzen Sie die Discrete Output Source auf Flow Switch, wenn Sie dies noch nicht getan
haben.

2. Setzen Sie die Flow Switch Variable auf die Durchflussvariable, die zum Steuern des

Durchflussschalters verwendet werden soll.

3. Setzen Sie den Flow Switch Setpoint auf den Wert, bei dem der Durchflussschalter
(nach Anwendung der Hysteresis) ausgel6st werden soll.

* Wenn der Durchfluss unter diesem Wert liegt, ist der Bindrausgang EIN.
*  Wenn der Durchfluss Giber diesem Wert liegt, ist der Bindrausgang AUS.

4.  Setzen Sie die Hysteresis auf die prozentuale Abweichung oberhalb und unterhalb des
Sollwertes, die als Totzone dient.

Die Hysteresis definiert einen Bereich um den Sollwert, innerhalb derer sich der
Durchflussschalter nicht dndert. Die Voreinstellung ist 5 %. Der giiltige Bereich liegt
zwischen 0,1 % und 10 %.

Beispiel: Wenn der Flow Switch Setpoint = 100 g/s und die Hysteresis = 5 % ist und der
erste gemessene Durchfluss (iber 100 g/s liegt, ist der Bindrausgang AUS. Der
Bindrausgang bleibt AUS, bis der Durchfluss unter 95 g/s fillt. In diesem Fall wird der
Bindrausgang auf EIN gesetzt und bleibt auf EIN, bis der Durchfluss iber 105 g/s
steigt. An diesem Punkt wechselt er auf AUS und bleibt auf AUS bis der Durchfluss
unter 95 g/s fallt.

6.4.2 Konfigurieren derPolaritat des Binarausgangs
ProLink Il e ProLink > Configuration > Discrete Output > DO 1 Polarity
e ProLink > Configuration > Discrete Output > DO 2 Polarity
ProLink Il Device Tools > Configuration > 1/O > Outputs > Discrete Output
Handterminal *  Configure > Manual Setup > Inputs/Outputs > Discrete Output > DO 1 Polarity

*  Configure > Manual Setup > Inputs/Outputs > Discrete Output > DO 2 Polarity

Uberblick

Bindrausgdnge haben zwei Zustdnde: EIN (aktiv) und AUS (inaktiv). Zwei unterschiedliche
Spannungswerte werden verwendet, um diese Zustdnde zu reprasentieren. Die Discrete
Output Polarity steuert welcher Spannungswert welchen Zustand reprdsentiert.

Verfahren
Discrete Output Polarity wie gewlinscht einstellen.

Die Standardeinstellung ist Active High.
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Optionen fiir Bindrausgang Polaritat

Tabelle 6-11: Optionen fiir Bindrausgang Polaritat

Polaritat Bindrausgangs-Span-
nungsversorgung Beschreibung

Aktiv hoch l Intern e Wenn die festgelegte Bedingung
fir den Bindrausgang zutrifft, er-

zeugt der Pull-up 15 V.
e Wenn die festgelegte Bedingung

fir den Bindrausgang nicht zutrifft,
erzeugt die Schaltung 0 V.

Extern ¢ Wenn die festgelegte Bedingung
fiir den Bindrausgang zutrifft, er-
zeugt der Schaltung eine entspre-
chende Pull-up-Spannung, max.
30V.

¢ Wenn die festgelegte Bedingung
fiir den Bindrausgang nicht zutrifft,
erzeugt die Schaltung 0 V.

Aktiv niedrig _lj Intern ¢ Wenn die festgelegte Bedingung
fiir den Bindrausgang zutrifft, er-

zeugt die Schaltung 0 V.
¢ Wenn die festgelegte Bedingung

fiir den Bindrausgang nicht zutrifft,
erzeugt der Pull-up 15 V.

Extern ¢ Wenn die festgelegte Bedingung
fir den Bindrausgang zutrifft, er-
zeugt die Schaltung 0 V.

¢ Wenn die festgelegte Bedingung
fur den Bindrausgang nicht zutrifft,
erzeugt die Schaltung eine en-
tsprechende Pull-up-Spannung,
max. 30 V.
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Abbildung eines Kreislaufs mit Bindrausgang

Abbildung 6-1: Typische Bindrausgangs-Schaltung (interne Spannungsversorgung)

AVA
<_1C
!
!
<_1D
A\
A. 15V (Nom)
B. 3,2 KQ
C. Out+
D. Out-
6.4.3 Konfigurieren von Bindrausgang Storaktion
ProLink Il *  ProLink > Configuration > Discrete Output > DO 1 Fault Action
*  ProLink > Configuration > Discrete Output > DO 2 Fault Action
ProLink Il Device Tools > Configuration > Fault Processing
Handterminal *  Configure > Manual Setup > Inputs/Outputs > Discrete Output > DO 1 Fault Action
*  Configure > Manual Setup > Inputs/Outputs > Discrete Output > DO 2 Fault Action
Uberblick

Discrete Output Fault Action steuert das Verhalten des Binarausgangs, wenn die
Auswerteelektronik eine interne Stérbedingung erkennt.

Anmerkung

Nur fiir manche Fehler: Wenn Zuletzt gemessener Wert — Zeitliberschreitung auf einen Wert ungleich null
gesetzt ist, wird die Auswerteelektronik die Storaktion erst nach Ablauf der Zeitliberschreitung
implementieren.

A\ VORSICHT!

Verwenden Sie Discrete Output Fault Action nicht als Stéranzeige. Moglicherweise ldsst sich eine
Storbedingung nicht von einem normalen Betriebszustand unterscheiden.

SieheStéranzeige mit dem Bindrausgang, wenn der Bindrausgang als Storindikator verwendet
werden soll.
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6.5
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Verfahren
Discrete Output Fault Action wie gewiinscht einstellen.

Die Standardeinstellung ist None.

Optionen fiir Bindrausgang Storaktion

Tabelle 6-12: Optionen fiir Bindrausgang Stéraktion

Bindrausgang Verhalten
Bezeichnung Polaritdt = Aktiv Hoch Polaritdt = Aktiv Niedrig
Upscale e Storung: Bindrausgang ist EIN e Stérung: Bindrausgang ist AUS
(anwenderspezifische Span- (ov)
nung) * Keine Stérung: Bindrausgang
* Keine Stérung: Bindrausgang wird durch seine Zuweisung
wird durch seine Zuweisung gesteuert
gesteuert
Downscale e Storung: Bindrausgangist AUS | ¢ Stdrung: Bindrausgangist EIN
(oV) (anwenderspezifische Span-
e Keine Storung: Bindrausgang nung)
wird durch seine Zuweisung e Keine Stérung: Bindrausgang
gesteuert wird durch seine Zuweisung
gesteuert
Keine (Voreinstellung) | Bindrausgang wird durch seine Zuweisung gesteuert

Storanzeige mit dem Bindrausgang

Um Stérungen Giber den Bindrausgang anzuzeigen, setzen Sie die Parameter wie folgt:
. Bindrausgang-Quelle = Stérung
J Bindrausgang-Storaktion = Keine

Anmerkung

Wenn Bindrausgang-Quelle auf Stdrung gesetzt ist und eine Stérung eintritt, ist der Bindrausgang immer
EIN. Die Einstellung Bindrausgang-Storaktion wird ignoriert.

Bindreingang konfigurieren

Der Binareingang wird verwendet, um eine oder mehrere Aktionen der Auswerteelektronik
von einem externen Gerdt aus zu veranlassen. Ihre Auswerteelektronik kann keinen oder
einen Bindreingang haben, abhdnging von der Konfiguration von Kanal C.

Der Parameter Binareingang enthalt:

J Binareingang Aktion

. Polaritat Bindreingang
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6.5.1

Wichtig

Immer wenn Sie einen Parameter des Bindreingangs andern, priifen Sie alle anderen Parameter des
Bindreingangs bevor Sie das Durchfluss-Messsystem wieder in Betrieb nehmen. In einigen
Situationen l3dt die Auswerteelektronik automatisch einige gespeicherte Werte und es kann sein,
dass diese Werte nicht passend fiir lhre Anwendung sind.

Bindreingang Aktion konfigurieren

ProLink Il ProLink > Configuration > Discrete Input > Assignment

ProLink Il Device Tools > Configuration > 1/0 > Action Assignment

Handterminal Configure > Manual Setup > Inputs/Outputs > Discrete Input > DI Assignment
Uberblick

Die Bindreingang Aktion steuert die Aktion oder Aktionen, die die Auswerteelektronik
ausfiihrt wenn der Bindreingang von AUS auf EIN wechselt.

A\ VORSICHT!

Bevor Sie Aktionen einem erweitertem Ereignis oder einem Bindreingang zuordnen, priifen Sie
den Status des Ereignisses oder des externen Eingangsgerites. Ist es auf EIN, werden alle
Aktionen ausgefiihrt, wenn die neue Kanalkonfiguration implementiert wird. Ist dies nicht
akzeptabel, warten Sie auf einen geeigneten Zeitpunkt, um Aktionen dem Ereignis oder
Bindreingang zuzuordnen.

Verfahren

Wahlen Sie eine Aktion.
Wiéhlen Sie den Bindreingang, der die ausgewdhlte Aktion durchfihren soll.

Wiederholen Sie diesen Vorgang, bis alle vom Bindreingang auszufiihrenden
Aktionen zugeordnet sind.

Optionen fiir Binareingang Aktion

Tabelle 6-13: Optionen fiir Binareingang-Aktion oder Erweiterte Ereignisaktion

Kennzeichnung
Aktion ProLink I ProLink Il Handterminal
Standard
Keine (Voreinstellung) Keine None Keine
Start Sensor Nullpunktkali- | Start Sensor Nullpunktkalibrier- = Start Sensor Zero Automatische Nullpunktkalibrier-
brierung ung ung durchfiihren
Start/Stopp aller Zéhler Start/Stopp aller Zahlungen Start/Stopp aller Zahlungen Start/stop totals
Massezahler zuriicksetzen Reset Mass Total Reset Mass Total Massezahler zurlicksetzen
Volumenzéhler zuriickset- Reset Volume Total Reset Volume Total Volumen-Summenzahler zurlick-
zen setzen
Gas-Standardvolumen-Sum- = Gas-Standardvolumen-Summen- | Gas-Standardvolumen-Summen- | Gas-Standardvolumen-Summen-
menzahler zuriicksetzen zahler zurlicksetzen zahler zuriicksetzen zahler zurlicksetzen
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Tabelle 6-13: Optionen fiir Binareingang-Aktion oder Erweiterte Ereignisaktion (Fortsetzung)

Kennzeichnung

Aktion ProLink I ProLink Il Handterminal

Alle Zahler zuriicksetzen Reset All Totals Reset All Totals Zahler zurlicksetzen

Mineral6lmessung

Temperaturkorrigierte Volu- = APl Referenzvolumen-Summen- | Reset Volume Total at Reference = Korrigierten Volumenzahler zur-
men-Summenzahler zuriick- | zahler zuriicksetzen Temperature licksetzen
setzen

Konzentrationsmessung

CM Referenzvolumen-Sum- | CM Referenzvolumen-Summen- | Reset Volume Total at Reference | Nicht verfiigbar

menzdhler zurlicksetzen zahler zurlicksetzen Temperature

CM Nettomasse-Summen- | CM Nettomasse-Summenzéhler = Reset Net Mass Total Nicht verfiighar
zdhler zurilicksetzen zurlicksetzen

CM Nettovolumen-Sum- CM Nettovolumen-Summenzah- | Reset Net Volume Total Nicht verfiighar
menzdhler zuriicksetzen ler zuriicksetzen

CM-Matrix fortschalten Aktuelle CM-Kurve fortschalten | Konzentrationsmatrix fortschalten | Nicht verfligbar

Systemverifizierung

Systemverifizierungstest Systemverifizierung starten Systemverifizierung starten Nicht verfiighar
starten

A\ VORSICHT!

Bevor Sie Aktionen einem erweitertem Ereignis oder einem Bindreingang zuordnen, priifen Sie
den Status des Ereignisses oder des externen Eingangsgerdtes. Ist es auf EIN, werden alle
Aktionen ausgefiihrt, wenn die neue Kanalkonfiguration implementiert wird. Ist dies nicht
akzeptabel, warten Sie auf einen geeigneten Zeitpunkt, um Aktionen dem Ereignis oder
Bindreingang zuzuordnen.

6.5.2 Binareingang Polaritat konfigurieren
ProLink Il ProLink > Configuration > Discrete Input > Polarity
ProLink Il Device Tools > Configuration > /0 > Inputs > Discrete Input
Handterminal Configure > Manual Setup > Inputs/Outputs > Discrete Input > DI Polarity
Uberblick

Der Bindreingang hat zwei Zustande: EIN und AUS. Die Binareingang Polaritat steuert wie die
Auswerteelektronik die eingehenden Spannungswerte dem EIN und AUS Status zuordnet.

Verfahren
Polaritat Binareingang wie gewiinscht einstellen.

Die Standardeinstellung ist Aktiv Niedrig.
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Optionen fiir Binareingang Polaritat

Tabelle 6-14: Optionen fiir Binareingang Polaritat

Polaritat Bindreingang Spannung Status Bindreingin-
Spannungsver- gang an der Auswer-
sorgung teelektronik

Aktiv hoch Intern Spannung tiber Anschlussklemmen | EIN

hoch
Spannung zwischen Anschlussklem- | AUS
men ist 0 VDC

Extern Angelegte Spannung zwischen Ans- | EIN
chlussklemmen ist 3-30 VDC
Angelegte Spannung zwischen Ans- = AUS
chlussklemmen ist <0,8 VDC

Aktiv niedrig Intern Spannung zwischen Anschlussklem- | EIN

men ist 0 VDC
Spannung tber Anschlussklemmen | AUS
hoch

Extern Angelegte Spannung zwischen Ans- | EIN
chlussklemmen ist <0,8 VDC
Angelegte Spannung zwischen Ans- | AUS
chlussklemmen ist 3-30 VDC

6.6

6.6.1

Konfigurieren von Ereignissen

Ein Ereignis tritt ein, wenn der Echtzeitwert einer anwenderspezifizierten Prozessvariable
den anwenderspezifizierten Sollwert tiberschreitet. Ereignisse werden verwendet, um bei
Prozessdanderungen Meldungen zu erzeugen oder spezifische Aktionen der
Auswerteelektronik auszufiihren wenn eine Prozessanderung eintritt.

Die Auswerteelektronik unterstiitzt zwei Ereignismodelle:

. Basis Ereignismodell

. Erweitertes Ereignismodell

Konfigurieren eines Basisereignisses

ProLink Il

ProLink > Configuration > Events

ProLink Il

Device Tools > Configuration > Events > Basic Events

Handterminal Not available

Uberblick

Ein Basisereignis dient dazu, Benachrichtigungen bei Prozessveranderungen zu liefern. Ein
Basisereignis tritt ein (ist EIN), wenn der Real-Time Wert einer anwenderspezifizierten
Prozessvariablen den anwenderspezifizierten Sollwert (HI) (iberschreitet oder (LO)
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unterschreitet. Sie kdnnen bis zu zwei Basisereignisse definieren. Der Ereignisstatus kann
mittels digitaler Kommunikation abgefragt werden und es kann ein Bindrausgang
konfiguriert werden, um den Ereignisstatus auszugeben.

Verfahren
1. Das Ereignis auswdhlen, das konfiguriert werden soll.
2.  Spezifizieren Sie die Ereignisart.
Options Description
HI x>A
Das Ereignis tritt ein, wenn der Wert der zugeordneten Prozessvariable
(x) groRer als der Sollwert (Sollwert A) ist (Endpunkt nicht eingeschlossen).
LO X<A
Das Ereignis tritt ein, wenn der Wert der zugeordneten Prozessvariable
(x) kleiner als der Sollwert (Sollwert A) ist (Endpunkt nicht eingeschlossen).
3. Prozessvariable dem Ereignis zuordnen.
Einen Wert fiir Sollwert A festlegen.
5.  (Optional) Einen Bindrausgang konfigurieren, um den Status entsprechend dem

Ereignisstatus zu wechseln.

Konfigurieren eines erweiterten Ereignisses

ProLink Il ProLink > Configuration > Discrete Events
ProLink Il Device Tools > Configuration > Events > Enhanced Events
Handterminal Configure > Alert Setup > Discrete Events

Uberblick

Ein erweitertes Ereignis wird verwendet, um Meldungen zu Prozessénderungen zu liefern
und um spezielle Auswerteelektronik Aktionen auszufiihren wenn ein Ereignis eintritt. Das
Erweiterte Ereignis tritt ein (ist EIN), wenn der Real-Time Wert einer
anwenderspezifizierten Prozessvariablen den anwenderspezifizierten Sollwert (HI)
tiberschreitet oder (LO) unterschreitet oder im Bereich (IN) oder ausserhalb des Bereichs
(OUT) liegt, unter Beriicksichtigung zweier anwenderspezifizierten Sollwerte. Sie konnen
bis zu finf Erweiterte Ereignisse konfigurieren. Fiir jedes Erweiterte Ereigniss konnen Sie
eine oder mehrere Aktionen zuordnen, die die Auswerteelektronik ausfiihrt, wenn das
Erweiterte Ereigniss eintritt.

Verfahren

1. Das Ereignis auswdhlen, das konfiguriert werden soll.

2.  Spezifizieren Sie die Ereignisart.

Options Description

HI x>A

Das Ereignis tritt ein, wenn der Wert der zugeordneten Prozessvariable
(x) groRer als der Sollwert (Sollwert A) ist (Endpunkt nicht eingeschlossen).
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Options
LO

Description

xX<A

Das Ereignis tritt ein, wenn der Wert der zugeordneten Prozessvariable
(x) kleiner als der Sollwert (Sollwert A) ist (Endpunkt nicht eingeschlossen).
A<x<B

Das Ereignis tritt ein, wenn der Wert der zugeordneten Prozessvariable
(x) sich innerhalb “des Bereichs befindet,” d. h. zwischen Sollwert A und
Sollwert B (Endpunkte eingeschlossen).

AUS x<Aoderx=B

Das Ereignis tritt ein, wenn der Wert der zugeordneten Prozessvariable
(x) sich “auRerhalb des Bereichs befindet,” d. h. kleiner als Sollwert A oder
groRer als Sollwert B ist (Endpunkte eingeschlossen).

Prozessvariable dem Ereignis zuordnen.

Setzen Sie die Werte fir die erforderlichen Sollwerte.

Bei HI- und LO-Ereignissen Sollwert A festlegen.

Bei IN- und OUT-Ereignissen Sollwert A und Sollwert B festlegen.

(Optional) Einen Bindrausgang konfigurieren, um den Status entsprechend dem
Ereignisstatus zu wechseln.

(Optional) Spezifizieren Sie die Aktion oder Aktionen die die Auswerteelektronik
ausfiihren soll, wenn das Ereignis eintritt.

Mit ProLink I1: ProLink > Configuration > Discrete Input

Mit ProLink Ill:Device Tools > Configuration > 1/O > Action Assignment

Mit Handterminal: Configure > Alert Setup > Discrete Events > Assign Discrete Action

Optionen fiir Erweitertes Ereignisaktion

Tabelle 6-15: Optionen

fiir Bindreingang-Aktion oder Erweiterte Ereignisaktion

Kennzeichnung

brierung

Aktion ProLink I ProLink Il Handterminal

Standard

Keine (Voreinstellung) Keine None Keine

Start Sensor Nullpunktkali- | Start Sensor Nullpunktkalibrier- = Start Sensor Zero Automatische Nullpunktkalibrier-

ung ung durchfiihren

Start/Stopp aller Zéhler

Start/Stopp aller Zahlungen Start/Stopp aller Zahlungen Start/stop totals

Massezahler zurlicksetzen

Reset Mass Total Reset Mass Total Massezahler zurlicksetzen

Volumenzdhler zuriickset-
zen

Volumen-Summenzahler zuriick-
setzen

Reset Volume Total Reset Volume Total

menzdhler zuriicksetzen

Gas-Standardvolumen-Sum-

Gas-Standardvolumen-Summen-
zahler zurlicksetzen

Gas-Standardvolumen-Summen-
zahler zuriicksetzen

Gas-Standardvolumen-Summen-
zahler zurlicksetzen

Alle Zahler zurticksetzen

Reset All Totals Reset All Totals Zahler zurlicksetzen

Mineral6lmessung
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Tabelle 6-15: Optionen fiir Binareingang-Aktion oder Erweiterte Ereignisaktion (Fortsetzung)

Aktion

Kennzeichnung

ProLink I

ProLink Il

Handterminal

Temperaturkorrigierte Volu-
men-Summenzahler zuriick-
setzen

API Referenzvolumen-Summen-
zahler zurlicksetzen

Reset Volume Total at Reference
Temperature

Korrigierten Volumenzahler zur-
ticksetzen

Konzentrationsmessung

starten

CM Referenzvolumen-Sum- | CM Referenzvolumen-Summen- | Reset Volume Total at Reference | Nicht verflighar
menzdhler zuriicksetzen zahler zurlicksetzen Temperature

CM Nettomasse-Summen- | CM Nettomasse-Summenzéhler = Reset Net Mass Total Nicht verfiighar
zdhler zuriicksetzen zurlicksetzen

CM Nettovolumen-Sum- CM Nettovolumen-Summenzah- | Reset Net Volume Total Nicht verflighar
menzdhler zuriicksetzen ler zurlicksetzen

CM-Matrix fortschalten Aktuelle CM-Kurve fortschalten | Konzentrationsmatrix fortschalten | Nicht verfligbar
Systemverifizierung

Systemverifizierungstest Systemverifizierung starten Systemverifizierung starten Nicht verftigbar

A\ VORSICHT!

Bevor Sie Aktionen einem erweitertem Ereignis oder einem Bindreingang zuordnen, priifen Sie
den Status des Ereignisses oder des externen Eingangsgerdtes. Ist es auf EIN, werden alle
Aktionen ausgefiihrt, wenn die neue Kanalkonfiguration implementiert wird. Ist dies nicht
akzeptabel, warten Sie auf einen geeigneten Zeitpunkt, um Aktionen dem Ereignis oder
Bindreingang zuzuordnen.

6.7

Konfigurieren der digitalen Kommunikation

Die Parameter der digitalen Kommunikation steuern die digitale Kommunikation der
Auswerteelektronik.

Die Auswerteelektronik unterstiitzt die folgenden Typen digitaler Kommmunikation:

. HART/Bell 202 iber die primdren mA Anschlussklemmen

. Modbus/RS-485 (iber die RS-485 Anschlussklemmen

o Modbus RTU tiber Service Port

Anmerkung

Der Service Port reagiert automatisch auf eine Vielzahl von Anschlussanfragen. Er ist nicht
konfigurierbar.
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6.7.1 HART/Bell 202 Kommunikation konfigurieren

ProLink Il ProLink > Configuration > Device > Digital Comm Settings

ProLink Il Device Tools > Configuration > Communications > Communications (HART)

Handterminal Configure > Manual Setup > Inputs/Outputs > Communications
Uberblick

Die HART/Bell 202 Kommunikationsparameter unterstiitzen die HART Kommunikation
mittels der primdren mA Anschlussklemmen der Auswerteelektronik (iber ein
HART/Bell 202 Netzwerk.

Die HART/Bell 202 Kommunikationsparameter umfassen:

. HART Adresse (Polling Adresse)

o Messkreis Strommodus (ProLink Il) oder mA Ausgang Aktion (ProLink I1I)

. Burst Parameter (optional)

. HART Variablen (optional)

Verfahren
1. HART Address auf eindeutigen Wert im Netzwerk einstellen.

Giiltige Adresswerte liegen im Bereich von 0 und 15. Die voreingestellte Adresse (0)
wird normalerweise verwendet, auRer in einer Multidrop-Umgebung.

Hinweis

Gerdte, die das HART-Protokoll zur Kommunikation mit der Auswerteelektronik verwenden,
kénnen entweder die HART Address or HART Tag (Software Tag) zur Identifizierung der
Auswerteelektronik verwenden. Entweder irgendeine oder beide Adressen entsprechend den
Anforderungen der anderen HART Gerate konfigurieren.

2. Stellen Sie sicher, dass Messkreis Strommodus (mA Ausgang Aktion) ordnungsgemald
konfiguriert ist.

Options Description
Aktiviert ‘ Der primare mA Ausgang gibt die Prozessdaten wie konfiguriert aus.
Deaktiviert Der primdre mA Ausgang ist auf 4 mA fixiert und gibt keine Prozess-

daten aus.

Wichtig

Wenn Sie ProLink Il oder ProLink Ill verwenden, um die HART Adresse auf 0 zu setzen, aktiviert
das Programm den Messkreis Strommodus automatisch. Wenn Sie ProLink Il oder ProLink Il
verwenden, um die HART Adresse auf einen anderen Wert zu setzen, deaktiviert das Programm
den Messkreis Strommodus automatisch. Dies erfolgt fiir eine einfache Konfiguration der
Auswerteelektronik zum entsprechenden Verhalten. Achten Sie stets darauf, dass Sie den
Messkreis Strommodus (iberpriifen, nachdem Sie die HART Adresse gesetzt haben.

3.  (Optional) Aktivieren und konfigurieren Sie die Burst Parameter.
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Hinweis

In typischen Installationen ist der Burst-Modus deaktiviert. Aktivieren Sie den Burst-Modus
nur dann, wenn andere Gerdte im Netzwerk die Burst-Modus-Kommunikation erfordern.

(Optional) Konfigurieren Sie die HART Variablen.

Konfigurieren der Burst-Parameter

ProLink Il

ProLink > Configuration > Device > Burst Setup

ProLink Il

Device Tools > Configuration > Communications > Communications (HART)

Handterminal

Configure > Manual Setup > Inputs/Outputs > Communications > Set Up Burst Mode

Uberblick

Der Burst-Modus ist ein Kommunikationsmodus, in dem die Auswerteelektronik in

regelmdBigen Abstanden digitale HART Informationen (iber denprimdren mA sendet. Die
Burst-Parameter steuern die Informationen, die gesendet werden, wenn der Burst-Modus
aktiviert ist.

Hinweis
In typischen Installationen ist der Burst-Modus deaktiviert. Aktivieren Sie den Burst-Modus nur dann,
wenn andere Gerdte im Netzwerk die Burst-Modus-Kommunikation erfordern.

Verfahren

1.
2.
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Burst Modus aktivieren.

Burst Mode Output wie gewiinscht einstellen.

Var

Variablen

Anzeige
ProLink I ProLink Ill Handterminal | Beschreibung
Priméarvariable Quelle (Primarvari- = PV Die Auswerteelektronik sendet die
able) Priméarvariable (PV) in den konfi-
gurierten Messeinheiten in jedem
Burst (z. B. 14,0 g/s, 13,5 g/s,
12,09/s).
PV Strom & % vom | Primarvariable % range/current Die Auswerteeletronik sendet den
Bereich (Prozentbereich/ Prozentbereich der Priméarvariablen
Strom) und den aktuellen mA Wert in je-
dem Burst (z. B. 25 %, 11,0 mA).
Dynamic Var & PV | Prozessvariablen/ | Process variables/ | Die Auswerteelektronik sendet PV-,
Strom Strom current SV-, TV-Und QV-Werte in Messein-
heiten und den eigentlichen Milli-
ampere-Wert der Primdrvariablen
in jedem Burst (z. B. 50 g/s, 23 °C,
50g/s, 0,0023 g/cm3, 11,8 mA).
Auswerteelektronik | Auswerteelektronik | Fld dev var Die Auswerteelektronik sendet vier

anwenderspezifizierte Prozessvar-
iablen bei jedem Burst.
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3. Sicherstellen, dass die Burst-Ausgangsvariablen ordnungsgeman eingestellt sind.

*  Wenn Burst Mode Output eingestellt wird, um vier benutzerdefinierte Variablen zu
senden, die vier Prozessvariablen so einstellen, dass sie in jedem Burst gesendet

werden.

*  Wenn Burst Mode Output auf eine andere Option eingestellt wird, sicherstellen,
dass die HART Variablen wie gewtinscht eingestellt sind.

HART Variablen (PV, SV, TV, QV) konfigurieren

ProLink Il

ProLink > Configuration > Variable Mapping

ProLink Il

Device Tools > Configuration > Communications > Communications (HART)

Handterminal

Configure > Manual Setup > Inputs/Outputs > Variable Mapping

Uberblick

Die HART Variablen sind ein Satz mit vier Variablen, vordefiniert fiir die HART Verwendung.
Die HART Variablen beinhalten die Primarvariable (PV), Sekundarvariable (SV),
Tertidrvariable (TV) und Quatarvariable (QV). Sie konnen den HART Variablen spezielle
Prozessvariablen zuordnen und verwenden dann die Standard HART Methoden, um die
zugeordneten Prozessdaten zu lesen oder zu senden.

HART Variablen Optionen

Tabelle 6-16: HART Variablen Optionen

Prozessvariable

Primarvaria-
ble (PV)

Sekundarvari-
able (SV)

Dritte Varia-
ble (TV)

Vierte Varia-
ble (QV)

Standard

Massedurchfluss

Bruttoleitungsvolumen-Durchflussrate

Temperatur

Dichte

Antriebsverstarkung

NIENENIENEN

NENENENES

Masse-Summenzahler

Rohrleitung (gesamt) Volumen Summenzéhler

Masse-Gesamtzdhler

Rohrleitung (gesamt) Volumen Gesamtzahler

Messrohrfrequenz

Sensortemperatur

Li Aufnehmerspule Amplitude

Re Aufnehmerspule Amplitude

Platinentemperatur

Externer Druck

Externe Temperatur

NENEN RN NN ENENENENENEN ENENENEN
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Tabelle 6-16: HART Variablen Optionen (Fortsetzung)

Prozessvariable Primdrvaria- | Sekunddrvari- Dritte Varia- | Vierte Varia-
ble (PV) able (SV) ble (TV) ble (QV)
Gas Standard Volumendurchfluss v v v v
Gas-Standardvolumen-Summenzéhler v
Gas-Standardvolumen-Gesamtzdhler v
Nullpunktwert v
Mineral6lmessung
API-Dichte v v v
APl Volumendurchfluss v v v v
APl Volumen (Summe) v
API Volumen (gesamt) v
API Durchschnittsdichte v v v
API mittlere Temperatur v v v
API CTL v
Konzentrationsmessung
ED-Dichte bei Referenztemperatur v v v
ED Spezifische Dichte v v v
ED Standard-Volumendurchfluss v v v v
ED Standard Volumen (Summe) v
ED Standard Volumen Gesamtzahler v
ED Netto Massedurchfluss v v v v
ED Netto Masse (Summe) v
ED Netto Masse Gesamtzdhler v
ED Netto Volumendurchfluss v v v v
ED Netto Volumen (Summe) v
ED Netto Volumen Gesamtzahler v
ED Konzentration v v v
ED Baume v v v

Wechselwirkung HART-Variablen und Auswerteelektronik-
Ausgdnge
Die HART-Variablen werden automatisch durch spezielle Ausgange der

Auswerteelektronik ausgegeben. Sie kénnen auch tiber den HART-Burstmodus
ausgegeben werden, falls dieser in Ihrer Auswerteelektronik aktiviert ist.

Tabelle 6-17: HART-Variablen und Auswerteelektronik-Ausgdnge

HART-Variable Ausgegeben iiber Bemerkungen

Primarvariable (PV) Primarer mA-Ausgang Hat sich eine Zuordnung gedndert, dndert sich die andere
automatisch und umgekehrt.
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Tabelle 6-17: HART-Variablen und Auswerteelektronik-Ausgange (Fortsetzung)

HART-Variable

Ausgegeben iiber

Bemerkungen

Sekundarvariable (SV)

Sekunddrer mA-Ausgang
(falls an Ihrer Auswerteelek-
tronik vorhanden)

Hat sich eine Zuordnung geandert, andert sich die andere
automatisch und umgekehrt. Ist Ihre Auswerteelektronik
nicht fiir einen sekundaren mA-Ausgang konfiguriert,
muss die SV direkt konfiguriert werden und der Wert der
SVist nur Giber die digitale Kommunikation verfiigbar.

Tertidrvariable (TV)

Frequenzausgang (falls an
Ihrer Auswerteelektronik vo-
rhanden)

Hat sich eine Zuordnung gedndert, dndert sich die andere
automatisch und umgekehrt. Hat Ihre Auswerteelektronik
keinen Frequenzausgang, muss die TV direkt konfiguriert

werden und der Wert der TV ist nur tGber die digitale Kom-
munikation verfligbar.

Quartdrvariable (QV)

Nicht mit einem Ausgang
verbunden

Die QV muss direkt konfiguriert werden, und der Wert der
QV st nur Giber die digitale Kommunikation verfiigbar.

6.7.2

Modbus/RS-485 Kommunikation konfigurieren

ProLink Il

ProLink > Configuration > Device > Digital Comm Settings

ProLink Il

Device Tools > Configuration > Communications > RS-485 Terminals

Handterminal

Configure > Manual Setup > Inputs/Outputs > Communications > Set Up RS-485 Port

Uberblick

Die Modbus/RS-485 Kommunikationsparameter steuern die Modbus Kommunikation
mittels der RS-485 Anschlussklemmen der Auswerteelektronik.

Modbus/RS-485 Kommunikationsparameters umfassen:
. Modbus ASCII deaktivieren

. Protokoll

. Modbus Adresse (Slave Adresse)

. Paritat, Stopp Bits und Baud Rate

. FlieRkomma Byte Befehl

. Zuséatzliche Kommunikations-Antwortverzogerung

Einschrankung

Um den FlieRkomma Byte Befehl oder die Zusatzliche Kommunikations-Antwortverzégerung zu konfigurieren,
miissen Sie ProLink Il verwenden.

Verfahren

1. Setzen Sie Modbus ASCII deaktivieren wie gew{inscht.

Unterstlitzung von Modbus ASCII beschrankt die Adressbereiche, die fiir die Modbus
Adresse der Auswerteelektronik zur Verfligung stehen.
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Modbus ASCII Unterstiitzung @ Verfiigbare Modbus Adressen

Deaktiviert 1-127,auBer 111 (111 ist fiir den Service Port reserviert)

Aktiviert 1-15,32-47,64-79 und 96-110

Setzen Sie Protokoll entsprechend des Protokolls, das von lhrem Modbus/RS-485
Hostsystem verwendet wird.

Options Description
Modbus RTU (voreingestellt) ‘ 8-bit Kommunikation
Modbus ASCII ' 7-bit Kommunikation

Wenn Unterstiitzung von Modbus ASCII deaktiviert ist, miissen Sie Modbus RTU
verwenden.

Setzen Sie Modbus Adresse auf einen Wert, der auf dem Netzwerk eindeutig ist.
Setzen Sie Paritat, Stopp-Bits und Baudrate entsprechend fiir Ihr Netzwerk.

Setzen Sie den FlieRkomma Byte Befehl entsprechend dem Byte Befehl den Ihr Modbus
Host verwendet.

Code Byte Reihenfolge
0 1-2 3-4
1 3-4 1-2
2 2-1 4-3
3 4-3 2-1

Die Bit Struktur der Bytes 1, 2, 3 und 4 ist in Tabelle 6-18 dargestellt.

Tabelle 6-18: Bit Struktur der FlieRBkomma Bytes

Byte Bits Definition
1 SEEEEEEE S =Vorzeichen
E = Exponent
2 EMMMMMMM E = Exponent
M = Mantisse
MMMMMMMM M = Mantisse
4 MMMMMMMM M = Mantisse

(Optional) Setzen Sie die Zusétzliche Kommunikations-Antwortverzogerung in den
“Verzégerungseinheiten.”

Eine Verz6gerungseinheit ist 2/3 der Zeit, die erforderlich ist, um ein Zeichen zu
ibertragen, wie fir den aktuell verwendeten Port berechnet und der Zeichen
Ubertragungsparameter. Gliltiger Wertebereich von 1 bis 255.

Die Zusatzliche Kommunikations-Antwortverzégerung wird dazu verwendet, um die Modbus
Kommunikation mit dem Host zu synchronisieren, wenn dieser langsamer arbeitet
als die Auswerteelektronik. Der hier spezifizierte Wert wird jeder Antwort
hinzuaddiert, die die Auswerteelektronik an den Host sendet.

MicroMotion® Auswerteelektronik Modell 2500 mit konfigurierbaren Ein-/Ausgéngen




Integrieren des Messgerdtes mit dem Steuersystem

Hinweis
Setzen Sie die Zusatzliche Kommunikations-Antwortverzdgerung nicht, wenn dies nicht durch lhren
Modbus Host erforderlich ist.

6.7.3 Digitale Kommunikation Stdraktion konfigurieren
ProLink Il ProLink > Configuration > Device > Digital Comm Settings > Digital Comm Fault Setting
ProLink Il Device Tools > Configuration > Fault Processing
Handterminal Configure > Alert Setup > I/O Fault Actions > Comm Fault Action
Uberblick

Die Digital Communications Fault Action spezifiziert den Wert der mittels digitaler
Kommunikation ausgegeben wird, wenn die Auswerteelektronik eine interne
Storbedingung erkennt.

Verfahren
Digital Communications Fault Action wie gewiinscht einstellen.

Die Standardeinstellung ist Keine.

Optionen fiir Digitale Kommunikation Storaktion

Tabelle 6-19: Optionen fiir Digitale Kommunikation Storaktion

Bezeichnung

ProLink I ProLink Ill Handterminal Beschreibung

Upscale Upscale e Die Prozessvariablenwerte zeigen, dass der
Wert hoher als der obere Sensorgrenzwert
ist.

e Zahlerfortschaltung stoppen.

Downscale Downscale e Die Prozessvariablenwerte zeigen, dass der
Wert hoher als der obere Sensorgrenzwert
ist.

e Zahlerfortschaltung stoppen.

Nullpunkt IntZero-All 0 e Durchflussvariablen gehen auf einen Wert,
der einen Durchfluss von 0 darstellt.

e Dichte wird als 0 ausgegeben.

e Temperatur wird als 0 °C ausgegeben oder
aquivalent, wenn andere Einheiten ver-
wendet werden (z. B. 32 °F).

e Antriebsverstirkung wird wie gemessen
ausgegeben.

e Zdhlerfortschaltung stoppen.
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Tabelle 6-19: Optionen fiir Digitale Kommunikation Stéraktion (Fortsetzung)

Bezeichnung

ProLink I ProLink Ill Handterminal Beschreibung
Not-A-Number (NAN) Not-a-Number e Prozessvariablen werden als IEEE NAN aus-
gegeben.
e Antriebsverstarkung wird wie gemessen
ausgegeben.
* Modbus skalierte Integer werden als Max Int
ausgegeben.

e Zahlerfortschaltung stoppen.

Durchfluss auf Null IntZero-Flow 0 e Durchfliisse werden als 0 ausgegeben.

e Andere Prozessvariablen werden wie ge-
messen ausgegeben.

e Zdhlerfortschaltung stoppen.

Keine (Voreinstellung) Keine (Voreinstellung) |  Alle Prozessvariablen werden wie gemes-
sen ausgegeben.
e Zahlerfortschaltung wenn sie laufen.

A\ VORSICHT!

Wenn Sie die mA-Ausgang-Stéraktion oder Frequenzausgang-Storaktion auf Keine setzen, stellen Sie
sicher, dass auch Digitale Kommunikations-Storaktion auf Keine gesetzt ist. Andernfalls gibt der
Ausgang nicht die aktuellen Prozessdaten aus und dies kann Messfehler erzeugen oder
ungewollte Konsequenzen fiir Ihren Prozess haben.

Einschrankung

Wenn Sie die Digitale Kommunikations-Stdraktion auf NAN setzen, kénnen Sie die mA-Ausgang-Stéraktion
oder Frequenzausgang-Storaktion nicht auf Keine setzen. Wenn Sie dies versuchen, akzeptiert die
Auswerteelektronik die Konfiguration nicht.
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7 Abschluss der Konfiguration

In diesem Kapitel behandelte Themen:

e Testen oder Anpassen des Systems mittels Sensorsimulation
e  Backup der Auswerteelektronik Konfiguration
*  Schreibschutz der Auswerteelektronik Konfiguration aktivieren

7.1 Testen oder Anpassen des Systems mittels
Sensorsimulation

Verwenden Sie Sensor Simulation, um die Reaktion des Systems auf eine Vielzahl von
Prozessbedingungen zu testen. Dazu gehoéren Grenz-, Problem- und Alarmbedingungen
sowie die Abstimmung des Messkreises.

Einschrankung

Die Sensorsimulation ist nur an Durchflussmesssystemen verfiigbar, die mit einem Core Prozessor
mit erweiterter Funktionalitdt ausgestattet sind.

Vorbereitungsverfahren

Bevor Sie die Sensor Simulation aktivieren, stellen Sie sicher, dass der Prozess die
Auswirkungen der simulierten Prozesswerte tolerieren kann.

Verfahren
1. Navigieren Sie zum Sensorsimulationsmen(.
Kommunikations-Hilfsmittel Meniipfad
ProLink I ProLink > Configuration > Sensor Simulation
ProLink IlI Device Tools > Diagnostics > Testing > Sensor Simulation
Handterminal Service Tools > Simulate > Simulate Sensor

Aktivieren Sie die Sensor Simulation.

Fir Massedurchfluss setzen Sie Wellenform wie gew{inscht und geben Sie die
erforderlichen Werte ein.

Option Erforderliche Werte
Fixed Fester Wert
Sawtooth Periode
Minimum
Maximum
Sine Periode
Minimum
Maximum
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4, Fiir Dichte setzen Sie Wellenform wie gew(inscht und geben Sie die erforderlichen
Werte ein.
Option Erforderliche Werte
Fixed Fester Wert
Sawtooth Periode
Minimum
Maximum
Sine Periode
Minimum
Maximum
5. Fir Temperatur setzen Sie Wellenform wie gewiinscht und geben Sie die

erforderlichen Werte ein.

Option Erforderliche Werte
Fixed Fester Wert
Sawtooth Periode
Minimum
Maximum
Sine Periode
Minimum
Maximum
6. Beobachten Sie die Reaktion des Systems auf die simulierten Werte und nehmen Sie

nach Bedarf entsprechende Anderungen an der Konfiguration der
Auswerteelektronik oder am System vor.

7. Modifizieren Sie die simulierten Werte und wiederholen Sie die
Simulationsverfahren.

8.  Nachdem Sie alle Test- oder Simulationsverfahren abgeschlossen haben,
deaktivieren Sie die Sensor Simulation.

Sensorsimulation

Mit der Sensorsimulation kénnen Sie das System testen oder den Messkreis einstellen,
ohne die Testbedingungen in Ihrem Prozess erstellen zu miissen. Bei aktivierter
Sensorsimulation gibt die Auswerteelektronik die simulierten Werte fiir Massedurchfluss,
Dichte und Temperatur aus und ergreift alle erforderlichen MaRnahmen. Beispielsweise
kann die Auswerteelektronik eine Abschaltung durchfiihren, ein Ereignis aktivieren oder
einen Alarm setzen.

Ist der Simulationsmodus aktiv, werden die simulierten Werte im gleichen Speicher wie die
Prozessdaten vom Sensor abgelegt. Dann werden die simulierten Werte wahrend des
Betriebs der Auswerteelektronik verwendet. Zum Beispie beeinflusst die Simulation:

. Alle Werte wie Massedurchfluss, Temperatur oder Dichte, die auf dem Display
angezeigt oder mittels Ausgdngen oder digitaler Kommunikation ausgegeben
werden

. Die Summen- und Gesamtzahler fiir Masse
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. Alle Volumenberechnungen und Daten, inkl. ausgegebener Werte, Volumen-
Summenzihler und Volumen-Gesamtzahler

. Alle im Datenlogger gespeicherten Werte fiir Masse, Dichte oder Volumen
Die Sensorsimulation dndert keine Diagnosewerte.

Im Gegensatz zu tatsachlichen Massedurchfluss- und Dichtewerten sind die simulierten
Werte nicht temperaturkompensiert (d. h. angepasst an den Temperatureinfluss auf die
Sensormessrohre).

Backup der Auswerteelektronik Konfiguration

ProLink Il und ProLink Ill bieten Upload- und Download-Funktionen fiir die Konfiguration,
um Konfigurationssatze auf lhrem PC zu speichern. Dies erméglicht ein Sichern und
Wiederherstellen der Auswerteelektronik Konfiguration. AuBerdem ist dies eine bequeme
Methode, um eine Konfiguration tiber mehrere Gerate hinweg zu zu reproduzieren.

Vorbereitungsverfahren

Eine der folgenden Versionen:
o Eine aktive Verbindung von ProLink Il

. Eine aktive Verbindung von ProLink IlI

Einschrdankung
Diese Funktion ist mit keinem anderen Kommunikations-Hilfsmittel verfiigbar.

Verfahren
o Sichern der Auswerteelektronik Konfiguration mittels ProLink II:

1. File>. Load from Xmtr to File auswahlen.

2. Einen Namen und einen Speicherort fiir die Sicherungsdatei auswahlen und auf
Save klicken.

3. Die Optionen auswahlen, die die Sicherungsdatei enthalten soll, und auf Download
Configuration klicken.

. Backup der Auswerteelektronik Konfiguration mittels ProLink Ill:

1. Device Tools > Configuration Transfer > Save or Load Configuration Data auswahlen.

2. Im Gruppenfeld Configuration die Konfigurationsdaten auswahlen, die gesichert
werden sollen.

3. Auf Save klicken und den Dateinamen und den Speicherort auf Ihrem Computer
auswdhlen.

4. Klicken Sie auf Start Save.

Die Sicherungsdatei wird mit dem ausgewdhlten Namen und an dem ausgewahlten
Speicherort gespeichert. Sie wird als Textdatei gespeichert und kann mittels beliebigem
Text-Editor gedffnet werden.
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Schreibschutz der Auswerteelektronik
Konfiguration aktivieren

ProLink Il ProLink > Configuration > Device > Enable Write Protection

ProLink Il Device Tools > Configuration > Write-Protection

Handterminal Configure > Manual Setup > Info Parameters > Transmitter Info > Write Protect
Uberblick

Wenn die Auswerteelektronik schreibgeschiitzt ist, ist die Konfiguration gesperrt und kann
nicht gedndert werden. Zum Andern der Konfiguration muss die Sperre aufgehoben
werden. Dadurch werden unbeabsichtigte oder unbefugte Anderungen an den
Konfigurationsparametern der Auswerteelektronik verhindert.
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8 Einstellungen der eichamtlichen
Transfer Anwendung

In diesem Kapitel behandelte Themen:

»  Eichamtliche Transfer Anwendung

e Einrichtung der eichamtlichen Transfer Anwendung unter Verwendung von
ProLink Il

e Einrichtung der eichamtlichen Transfer Anwendung unter Verwendung von
ProLink Il

Die Informationen in diesem Kapitel sind nur anwendbar, wenn lhre Auswerteelektronik
mit der eichamtlichen Transfer Anwendung bestellt wurde.

8.1 Eichamtliche Transfer Anwendung

Die eichamtliche Transfer Anwendung wird verwendet fiir Prozessdaten bei gesetzlichen
eichamtlichen Transfer Anwendungen, wenn eine zugelassene Methode zum Lesen oder
Erlangen der Messung verwendet wird.

Aufsichtsbehorden

Wenn die Micro Motion eichamtliche Transfer Anwendung gemdR den Empfehlungen
installiert, konfiguriert und eingesetzt wird, ist sie von den folgenden Aufsichtsbehérden
zertifiziert:

. NTEP (National Type Evaluation Program); NTEP Auflagen gelten in den USA und
Kanada.

. OIML (Organization of Legal Metrology); OIML Auflagen gelten in den restlichen
Landern der Welt.

Je nach der fiir Ihre Installation zustandigen Aufsichtsbehorde sind Einstellung,
Konfiguration und Betriebsmethoden unterschiedlich.

Gesichert und ungesichert

Bei der Installation der eichamtlichen Transfer Anwendung ist die Auswerteelektronik
immer auf “gesichert” oder “ungesichert eingestellt.” Die werkseitige Einstellung der
Auswerteelektronik ist ungesichert, und der Statusalarm A027 Sicherheitsverletzung ist
aktiv. AuBerdem kann die Durchflussmessung deaktiviert sein. Die Messdaten von einer
nicht gesicherten Auswerteelektronik diirfen nicht fiir eichamtliche Transfer
Anwendungen verwendet werden.

Um den Alarm zu |6schen und die Durchflussmessung zu aktivieren, muss die eichamtliche
Transfer Anwendung konfiguriert und die Auswerteelektronik gesichert werden. Sobald
die Auswerteelektronik gesichert ist, erfolgt die Loschung des Alarms und die Aktivierung
der Auswerteelektronik automatisch.

Sicherheitstypen und Anforderungen

Bevor die Auswerteelektronik fiir eichamtliche Transfer Anwendungen verwendet wird,
muss die metrologische und physikalische Sicherheit gewahrleistet werden.

Konfigurations- und Bedienungsanleitung 125



Einstellungen der eichamtlichen Transfer Anwendung

8.2

126

Metrologische Die metrologische Sicherheit schiitzt die Auswerteelektronik vor allen

Sicherheit Verdanderungen, die sich auf die Messwerte auswirken kénnen. Hierzu
gehéren Anderungen der Konfiguration und bestimmte
Wartungsverfahren.
Micro Motion implementiert die metrologische Sicherheit tiber
“Software-Sicherheit.” Software-Sicherheit ist eine Einstellung in der
Auswerteelektronik, die unzuldssige Vorgange tiber das Programm
blockiert. Die Software-Sicherheit kann ProLink Il und ProLink IlI
aktiviert bzw. deaktiviert werden. In der Praxis bedeutet diese
Software-Sicherheit einen vollstandigen Schutz gegen jegliche
unzuldssige Anderungen oder Vorginge.

Physikalische  Die physikalische Sicherheit wird durch eine von einem zertifizierten

Sicherheit eichamtlichen Priifer angebrachte Plombe gewahrleistet. Die Plombe
verhindert den Zugang zu den Service Port Anschlussklemmen.
Die Plombe ldsst sich zwar leicht zerstéren, kann jedoch nur von
einem eichamtlichen Priifer ersetzt werden. Auf diese Weise ist eine
Sicherheitsverletzung sofort erkennbar. Wenn die Plombe nicht intakt
ist, sind die Messwerte der Auswerteelektronik fiir den eichamtlichen
Transfer nicht zulassig.

Konfigurationsmethoden

Zur Konfiguration der eichamtlichen Transfer Parameter miissen ProLink Il oder ProLink IlI
und ein Service Port Anschluss verwendet werden.

Einrichtung der eichamtlichen Transfer
Anwendung unter Verwendung von ProLink i

Wenn lhre Auswerteelektronik so eingerichtet ist, dass sie die Anforderungen von OIML
oder NTEP erfiillt und die Auswerteelektronik “gesichert” ist, sind ausgewdhlte Messdaten
von der Auswerteelektronik fiir die eichamtlichen Transfer Anwendungen zugelassen.

Vorbereitungsverfahren

Wichtig
Priifen Sie die Anforderungen fiir den eichamtlichen Transfer fiir lhren Standort und vergewissern Sie
sich, dass diese sowie die Anforderungen von OIML oder NTEP erfiillt sind.

Falls erforderlich fiir lhre Installation, bitten Sie einen zertifizierten eichamtlichen Priifer
um einen Besuch und stellen Sie sicher, dass der Priifer den entsprechenden Teilen des
Verfahrens beiwohnt.

Stellen Sie eine Anbringungsstelle fiir die Plombe bereit, die der eichamtliche Priifer
anbringen wird.

Vergewissern Sie sich, dass die Auswerteelektronik fiir die Sicherung bereit ist, d. h. dass
sie richtig konfiguriert ist und alle nétigen Tests und Einstellungen durchgefiihrt wurden.
Nach der Sicherung der Auswerteelektronik kann die Konfiguration nicht mehr gedndert
werden, viele Wartungsvorgdnge sind nicht zuldssig und auch bestimmte
Bedienereingriffe sind nicht erlaubt.
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Verfahren
1. Stellen Sie eine Service Port Verbindung von ProLink Il zu Ihrer Auswerteelektronik
her.
2. Navigieren Sie zum Men(i fiir die eichamtliche Transfer-Anwendung: ProLink >
Configuration > System.
3. Setzen Sie die Approval auf die entsprechende Behorde fiir lhre Anwendung.
Option Beschreibung
NTEP Aufsichtsbehorde fiir die USA und Kanada
OIML Aufsichtsbehorde fiir den Rest der Welt

4, Stellen Sie die Totalizer Reset Options nach Bedarf ein.

Option Beschreibung

Nicht (iber Bedieninterface Wenn die Auswerteelektronik gesichert ist, kdnnen die Sum-

oder digitale Kommunikation menzahler nicht Giber das Bedieninterface oder digitale Kom-

riicksetzbar munikation zuriickgesetzt werden.

Nur Uber digitale Kommunika- | Wenn die Auswerteelektronik gesichert ist, miissen die Sum-

tion riicksetzbar menzahler iber die digitale Kommunikation zuriickgesetzt
werden.

Uber Bedieninterface und digi- = Wenn die Auswerteelektronik gesichert ist, kdnnen die Sum-
tale Kommunikation riicksetz- | menzéhler entweder iber das Bedieninterface oder digitale
bar Kommunikation zurliickgesetzt werden.

Nur iiber Bedieninterface riick- | Wenn die Auswerteelektronik gesichert ist, miissen die Sum-
setzbar menzdhler Giber das Bedieninterface zuriickgesetzt werden.

Alle Ubertragungsmethoden mittels Modbus- oder HART-Kommunikation fiir die
Auswerteelektronik werden als “digitale Kommunikation” bezeichnet. Hierzu
gehoren ProLink II, ProLink Il der Handterminal und alle Hosts.

5. Falls fiir Ihre Installation erforderlich, konfigurieren Sie Ihre Auswerteelektronik fiir
zwei Frequenzausgdnge und stellen Sie diese auf Quadraturbetrieb ein.
a. Wabhlen Sie ProLink > Configuration > Channel.

b. Stellen Sie Channel B Type Assignmen auf Frequency Output ein und klicken Sie auf

Apply.
c. Stellen Sie Channel C Type Assignment auf Frequency Output ein und klicken Sie auf
Apply.
d. Widhlen Sie ProLink > Configuration > Frequency und stellen Sie den Freq Output Mode
auf Quadrature.
6. Falls fiir Ihre Installation erforderlich, aktivieren Sie das Alarmmenii-Passwort fiir die

Anzeige: ProLink > Configuration > Display.

Ein Alarmmenii-Passwort ist in Deutschland fiir die PTB-Zulassung fiir Gasanwendungen
erforderlich und kann auch an anderen Standorten und fiir andere Anwendungen
vorgeschrieben sein.
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Falls fir Ihre Installation erforderlich, lesen und notieren Sie die Firmware-
Prifsummenwerte fur die Auswerteelektronik und den Core Prozessor: ProLink >
Konfiguration > Device.

Die Werte der Priifsumme der Auswerteelektronik Firmware und der Core Prozessor
Firmware missen wahrend der Inbetriebnahme gelesen werden, um den
Anforderungen fiir den eichamtlichen Transfer fiir Gasanwendungen in Deutschland
zu entsprechen. Diese kénnen ebenfalls fiir die MID/Welmec 7.2 Testberichte
hilfreich sein.

Falls fiir Ihre Installation erforderlich, konfigurieren Sie den Field Verification Zero (FVZ)
als Displyvariable. Beobachten und notieren Sie dann den aktuellen Wert fiir FVZ:
ProLink > Configuration > Display.

FVZist eine Diagnosevariable, die den Nullpunktwert (iber einen Zeitraum von

3 Minuten Gberwacht. Sie muss bei der Inbetriebnahme des Messgerats abgelesen
werden, um die Anforderungen fiir eichamtliche Transfer-Anwendungen in der
Messgerate Richtlinie (MID) 2004/22/EG zu erfiillen. Detaillierte Anweisungen
hierzu finden Sie in den Standard Arbeitsanweisungen.

Software-Sicherheit aktivieren:

a. Wabhlen Sie Plug-ins > Enable/Disable Custody Transfer.
b. Klicken Sie auf Enable Custody Transfer.

Wichtig
Je nach ortlich geltenden Gesetzen muss dieser Vorgang méglicherweise von einem
zertifizierten eichamtlichen Priifer beaufsichtigt werden.

Nach diesem Schritt ist die Auswerteelektronik metrologisch sicher. Die
Auswerteelektronik fiihrt folgende Aktionen durch:

* Sicherung aller Messparameter. Die aktuellen Konfigurationen kénnen
abgelesen, aber nicht gedandert werden.

» Loschen des Statusalarms A027: Sicherheitsverletzung

Anbringen der Plombe

Wichtig

In den meisten Installationen muss die Draht-Plombe von einem zertifizierten eichamtlichen
Priifer angebracht werden. Der Priifer stellt die Plombe bereit. Es liegt in der Verantwortung
des Kunden, eine physikalische Anordnung zur effektiven Anbringung der Plombe
bereitzustellen.
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Abbildung 8-1: Beispiel fiir Klammer und Plombe an der Auswerteelektronik
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8.3 Einrichtung der eichamtlichen Transfer
Anwendung unter Verwendung von ProLink Il

Wenn lhre Auswerteelektronik so eingerichtet ist, dass sie die Anforderungen von OIML
oder NTEP erfiillt und die Auswerteelektronik “gesichert” ist, sind ausgewdhlte Messdaten
von der Auswerteelektronik fiir die eichamtlichen Transfer Anwendungen zugelassen.

Vorbereitungsverfahren

Wichtig
Priifen Sie die Anforderungen fiir den eichamtlichen Transfer fiir lhren Standort und vergewissern Sie
sich, dass diese sowie die Anforderungen von OIML oder NTEP erfiillt sind.

Falls erforderlich fiir lhre Installation, bitten Sie einen zertifizierten eichamtlichen Priifer
um einen Besuch und stellen Sie sicher, dass der Priifer den entsprechenden Teilen des
Verfahrens beiwohnt.

Stellen Sie eine Anbringungsstelle fiir die Plombe bereit, die der eichamtliche Priifer
anbringen wird.
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Vergewissern Sie sich, dass die Auswerteelektronik fiir die Sicherung bereit ist, d. h. dass
sie richtig konfiguriert ist und alle nétigen Tests und Einstellungen durchgefiihrt wurden.
Nach der Sicherung der Auswerteelektronik kann die Konfiguration nicht mehr gedndert
werden, viele Wartungsvorgdnge sind nicht zuldssig und auch bestimmte
Bedienereingriffe sind nicht erlaubt.

Verfahren

1.

Stellen Sie eine Service Port Verbindung von ProLink lll zu Ihrer Auswerteelektronik
her.

Wahlen Sie Device Tools > Configuration > Weights & Measures und setzen Sie die
Aufsichtsbehdrde auf die entsprechende Behdérde fiir Ihre Anwendung.

Option Beschreibung

NTEP Aufsichtsbehérde fiir die USA und Kanada

OIML Aufsichtsbehorde fiir den Rest der Welt

Wahlen Sie Device Tools > Configuration > Totalizer Control Methods und stellen Sie die
Zéhler Steuerungsmethoden nach Bedarf ein.

Parameter Option

Summenzahler von dem Bedie- e Aktiviert: Sie kdnnen die Summenzahler von dem Bedie-

ninterface zuriicksetzen ninterface zuriicksetzen, gleichgiiltig, ob die Auswertee-
lektronik gesichert ist oder nicht.

e Deaktiviert: Sie kdnnen die Summenzahler von dem Be-
dieninterface zurlicksetzen, aber nur wenn die Auswer-
teelektronik nicht gesichert ist.

Riicksetzen der Summenzahler e Aktiviert: Sie kdnnen die Summenzéhler (iber digitale

iiber externe Kommunikation Kommunikation zuriicksetzen, gleichgiiltig, ob die Aus-
werteelektronik gesichert ist oder nicht.

e Deaktiviert: Sie konnen die Summenzdhler (iber digitale
Kommunikation zuriicksetzen, aber nur wenn die Aus-
werteelektronik nicht gesichert ist.

Alle Ubertragungsmethoden mittels Modbus- oder HART-Kommunikation fiir die
Auswerteelektronik werden als “digitale Kommunikation” bezeichnet. Hierzu
gehoren ProLink 11, ProLink Ill der Handterminal und alle Hosts.

Falls fiir Ihre Installation erforderlich, konfigurieren Sie Ihre Auswerteelektronik fiir
zwei Frequenzausgdnge und stellen Sie diese auf Quadraturbetrieb ein.
a. Wahlen Sie Device Tools > Configuration > I/0 > Channels.

b. Fiir Channel B stellen Sie den Channel Type auf Frequency Output ein und klicken Sie
auf Apply.

c. FirChannel Cstellen Sie den Channel Type auf Frequency Output ein und klicken Sie
auf Apply.

d. Widhlen Sie Device Tools > Configuration > I/0 > Outputs > Frequency Output Mode und
dann Quadrature.

Falls fiir Ihre Installation erforderlich, wahlen Sie Device Tools > Configuration >
Transmitter Display > Display Security. Aktivieren und konfigurieren Sie dann ein
Passwort fiir das Alarmmendi.

MicroMotion® Auswerteelektronik Modell 2500 mit konfigurierbaren Ein-/Ausgéngen




Einstellungen der eichamtlichen Transfer Anwendung

Die Sicherung des Alarmmeniis ist in Deutschland fiir PTB-Zulassungen fiir
Gasanwendungen gesetzlich vorgeschrieben.

6. Falls fir Ihre Installation erforderlich, wahlen Sie Device Tools > Device Information. Dann
lesen und notieren Sie die Firmware-Priifsummenwerte fir die Auswerteelektronik
und den Core Prozessor.

Die Werte der Priifsumme der Auswerteelektronik Firmware und der Core Prozessor
Firmware missen wahrend der Inbetriebnahme gelesen werden, um den
Anforderungen fiir den eichamtlichen Transfer fiir Gasanwendungen in Deutschland
zu entsprechen. Diese kénnen ebenfalls fiir die MID/Welmec 7.2 Testberichte
hilfreich sein.

7. Falls fiir Ihre Installation erforderlich, tiberwachen Sie den Nullpunktwert lhres
Systems:

a. Wabhlen Sie Device Tools > Configuration > Transmitter Display > Display Variables und
konfigurieren Sie Field Verification Zero (FVZ) als Displayvariable.

b. Lesen und notieren Sie den aktuellen Wert fiir FVZ auf der Anzeige der
Auswerteelektronik.

FVZist eine Diagnosevariable, die den Nullpunktwert (iber einen Zeitraum von

3 Minuten Gberwacht. Sie muss bei der Inbetriebnahme des Messgerats abgelesen
werden, um die Anforderungen fiir eichamtliche Transfer-Anwendungen in der
Messgerate Richtlinie (MID) 2004/22/EG zu erfiillen. Detaillierte Anweisungen
hierzu finden Sie in den Standard Arbeitsanweisungen.

8. Software-Sicherheit aktivieren: Device Tools > Configuration > Weights & Measures >
Software Security.

Wichtig
Je nach értlich geltenden Gesetzen muss dieser Vorgang méglicherweise von einem
zertifizierten eichamtlichen Priifer beaufsichtigt werden.

Nach diesem Schritt ist die Auswerteelektronik metrologisch sicher. Die
Auswerteelektronik fiihrt folgende Aktionen durch:

 Sicherung aller Messparameter. Die aktuellen Konfigurationen kénnen
abgelesen, aber nicht geandert werden.

* Loschen des Statusalarms A027: Sicherheitsverletzung

9.  Anbringen der Plombe

Wichtig

In den meisten Installationen muss die Draht-Plombe von einem zertifizierten eichamtlichen
Priifer angebracht werden. Der Priifer stellt die Plombe bereit. Es liegt in der Verantwortung
des Kunden, eine physikalische Anordnung zur effektiven Anbringung der Plombe
bereitzustellen.
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Abbildung 8-2: Beispiel fiir Klammer und Plombe an der Auswerteelektronik
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Teil Il

Geschaftstatigkeit, wartung sowie
Fehlersuche und -beseitigung

In diesem Teil enthaltene Kapitel:

. Auswerteelektronikbetrieb

Betrieb der Auswerteelektronik mit der eichamtlichen Transfer Anwendung
. Messunterstiitzung

e Stérungsanalyse und -behebung
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9 Auswerteelektronikbetrieb

In diesem Kapitel behandelte Themen:

*  Notieren der Prozessvariablen

*  Anzeigen von Prozessvariablen

*  Auswerteelektronik-Status anhand der Status-LED anzeigen
e Anzeigen und Bestdtigen von Statusalarmen

*  Lesenvon Gesamt- und Summenzdhlerwerten

e Starten und Stoppen von Gesamt- und Summenzdéhlern

e Zdbhler zuriicksetzen

e Gesamtzdhler zurticksetzen

9.1 Notieren der Prozessvariablen

Micro Motion empfiehlt die Aufzeichnung von speziellen Messungen von Prozessvariablen
einschlieRlich des akzeptablen Messbereiches unter normalen Betriebsbedingungen. Mit
diesen Daten kénnen Sie leichter erkennen, wann Prozessvariablenwerte ungewdhnlich
hoch oder niedrig sind, und sie konnen Ihnen dabei helfen, Anwendungsprobleme besser
zu diagnostizieren und zu lésen.

Verfahren

Notieren Sie die folgenden Prozessvariablen unter normalen Betriebsbedingungen:

Messung

Prozessvariable Typischer Durchschnitt Typisch hoch Typisch niedrig

Durchfluss
Dichte

Temperatur

Messrohrfrequenz

Aufnehmerspannung

Antriebsverstarkung
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9.2

9.2.1

9.3

Anzeigen von Prozessvariablen

ProLink Il ProLink > Process Variables
ProLink > API process variables (Mineralélmessung)

ProLink > CM process variables (Konzentrationsmessung)

ProLink Il Die gewiinschte Variable kann auf dem Hauptbildschirm unter Process Variables ange-
zeigt werden. Weitere Informationen finden Sie in Abschnitt 9.2.1.

Handterminal Overview > Shortcuts > Variables > Process Variables

Uberblick

Prozessvariablen liefern Informationen iber den Zustand des Prozessmediums, wie
Stromungsgeschwindigkeit, Dichte und Temperatur sowie (iber aktuelle Summen.
Prozessvariablen kdnnen auRerdem Daten (iber den Betrieb des Durchflussmessgerats
bereitstellen, wie Antriebsverstarkung und Aufnehmerspannung. Diese Informationen
kénnen zum besseren Verstdndnis des Prozesses und zur Stérungssuche und -beseitigung
verwendet werden.

Anzeigen von Prozessvariablen mittels ProLink IlI

Sobald eine Verbindung zu einem Gerat hergestellt ist, werden die Prozessvariablen auf
dem Hauptbildschirm von ProLink Ill angezeigt.

Verfahren

Zeigen Sie die gewiinschte(n) Prozessvariable(n) an.

Hinweis

ProLink Il erméglicht Ihnen das Auswahlen der Prozessvariablen, die auf dem Hauptbildschirm
angezeigt werden sollen. AuRerdem kdnnen Sie wéhlen, ob die Daten in der Ansicht Analog Gauge
oder als Digitalanzeige angezeigt werden sollen, und Sie konnen die Anzeigeeinstellungen anpassen.
Weitere Informationen finden Sie in der ProLink Ill Betriebsanleitung.

Auswerteelektronik-Status anhand der Status-
LED anzeigen

Die Status-LED zeigt die aktuelle Alarmbedingung der Auswerteelektronik. Die Status-LED
befindet sich vorne an der Auswerteelektronik.

Status-LED am Bedieninterface-Modul der Auswerteelektronik anzeigen.

e Bei einer Auswerteelektronik mit Display ist die Status-LED bei geschlossenem
Auswerteelektronik-Gehdusedeckel sichtbar.

* Beieiner Auswerteelektronik ohne Display ist die Status-LED nur sichtbar, wenn der
Auswerteelektronik-Gehdusedeckel entfernt wird.
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A\ VORSICHT!

Befindet sich die Auswerteelektronik in einem explosionsgefdhrdeten Bereich, den
Gehdusedeckel nicht entfernen, solange die Einheit mit Spannung versorgt wird. Das
Entfernen des Gehdusedeckels kann zu einer Explosion fiihren, solange die Einheit mit
Spannung versorgt wird. Zur Statusanzeige einer Auswerteelektronik in einer
explosionsgefdhrdeten Umgebung eine Kommunikationsmethode verwenden, bei der das
Entfernen des Auswerteelektronik-Gehdusedeckels nicht erforderlich ist.

Zur Interpretation der Status-LED siehe Tabelle 9-1.

Tabelle 9-1: Status-LED-Zustdnde

LED-Verhalten Alarmbedingung Beschreibung

Dauerhaft griin Kein Alarm Normalbetrieb

Gelb blinkend Kein Alarm Nullpunktkalibrierung lauft

Dauerhaft gelb Alarm niedriger Stufe Alarmbedingung, die keinen Messfehler verursacht

(Ausgdnge liefern weiterhin Prozessdaten)

Dauerhaft rot Alarm hoher Stufe Alarmbedingung, die einen Messfehler verursacht
(Ausgdnge sind auf Stérung)

9.4 Anzeigen und Bestatigen von Statusalarmen

Die Auswerteelektronik gibt einen Statusalarm aus, sobald eine Prozessvariable die
definierten Grenzen iberschreitet oder die Auswerteelektronik eine Stérung erkennt.
Aktive Alarme kénnen angezeigt und Alarme bestatigt werden.

9.4.1 Anzeigen und Bestdtigen von Alarmen mittels ProLink Il
Sie konnen eine Liste mit allen aktiven oder inaktiven aber unbestétigten Alarmen
anzeigen. Sie kénnen einzelne Alarme auf dieser Liste bestatigen.

1. Wabhlen Sie ProLink > Alarm Log.
2. Wahlen Sie den Bereich High Priority oder Low Priority.

Anmerkung

Das Gruppieren von Alarmen in diese beiden Kategorien ist fest programmiert und wird durch
Status Alarm Severity nicht beeinflusst.

Alle aktiven oder nicht bestétigten Alarme sind aufgefiihrt:
* Rote Anzeige: Alarm ist derzeit aktiv.

* Griine Anzeige: Alarm ist nicht aktiv, aber nicht bestétigt.

Anmerkung

Es werden nur Stérungs- und informative Alarme aufgefiihrt. Alarme mit Status Alarmstufe
Ignorieren werden von der Auswerteelektronik automatisch herausgefiltert.

3. Markieren Sie das Kontrollkdstchen Ack, um einen Alarm zu bestatigen.
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Nachbereitungsverfahren

. Um die folgenden Alarme zu I6schen, miissen Sie das Problem beheben, den Alarm
bestdtigen und anschlieBend die Auswerteelektronik aus- und wieder einschalten:
A001, A002,A010,A011,A012,A013, A018, A019, A022, A023, A024, A025, A028,
A029, A031.

. Fiir alle anderen Alarme:
- War der Alarm bei der Bestdtigung inaktiv, wird er aus der Liste geléscht.

- War der Alarm bei der Bestdtigung aktiv, wird er von der Liste entfernt, sobald
die Alarmbedingung gel6scht ist.

9.4.2 Anzeigen und Bestdtigen von Alarmen mittels ProLink Il

Sie kénnen eine Liste mit allen aktiven, inaktiven oder unbestétigten Alarmen anzeigen.
Bestimmte Alarme kénnen in der Liste bestdtigt oder alle Alarme als bestdtigt ausgewdhlt
werden.

1. Alle Alarme kénnen im ProLink Il Hauptbildschirm unter Alerts angezeigt werden.

Alle aktiven oder unbestétigten Alarme werden aufgefiihrt und entsprechend den
folgenden Kategorien angezeigt:

Kategorie Beschreibung
Failed: Fix Now Ein Messgerdtefehler ist aufgetreten und erfordert unverziigliche
MaRnahmen.

Maintenance: Fix Soon | Ein Zustand ist aufgetreten, der zu einem spdteren Zeitpunkt beho-
ben werden kann.

Advisory: Informational | Ein Zustand ist aufgetreten, der kein Eingreifen erfordert.

Anmerkungen
e Alle Fehleralarme werden in der Kategorie Failed: Fix Now angezeigt.

* Alle Informationsalarme werden entweder in der Kategorie Maintenance: Fix Soon oder
Advisory: Informational angezeigt. Die Kategoriezuweisung ist fest programmiert.

e Alarme mit Alert Severity Ignore werden von der Auswerteelektronik automatisch
herausgefiltert.

2. Markieren Sie das Kontrollkdstchen Ack fiir einen bestimmten Alarm, um diesen zu
bestdtigen. Klicken Sie auf Ack All, um alle Alarme auf einmal zu bestétigen.

Nachbereitungsverfahren

. Um die folgenden Alarme zu I6schen, miissen Sie das Problem beheben, den Alarm
bestdtigen und anschlieBend die Auswerteelektronik aus- und wieder einschalten:
A001, A002,A010,A011,A012,A013, A018, A019, A022, A023, A024, A025, A028,
A029, A031.

. Fiir alle anderen Alarme:
- Warder Alarm bei der Bestdtigung inaktiv, wird er aus der Liste geléscht.

- War der Alarm bei der Bestdtigung aktiv, wird er von der Liste entfernt, sobald
die Alarmbedingung gel6scht ist.
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9.4.3 Anzeigen von Alarmen mit Handterminal

Sie konnen eine Liste mit allen aktiven oder inaktiven aber unbestétigten Alarmen
anzeigen. Sie konnen einzelne Alarme auf dieser Liste bestatigen.

Zur Anzeige von aktiven oder unbestétigten Alarmen, Service Tools > Alerts driicken.

Alle aktiven oder nicht bestdtigten Alarme sind aufgefiihrt.

Anmerkung

Es werden nur Stérungs- und informative Alarme aufgefiihrt. Alarme mit Status Alarmstufe
Ignorieren werden von der Auswerteelektronik automatisch herausgefiltert.

Zur Bestatigung eines Alarms Service Tools > Alerts driicken, den entsprechenden
Alarm wahlen und anschlieBend XXXXX driicken.

- Um die folgenden Alarme zu I6schen, miissen Sie das Problem beheben, den
Alarm bestatigen und anschlieBend die Auswerteelektronik aus- und wieder
einschalten: AO01, A002, A010, A011,A012,A013, A018, A019, A022, A023,

A024, A025, A028, A029, A031.
- Furalle anderen Alarme:

- War der Alarm bei der Bestdtigung inaktiv, wird er aus der Liste geléscht.

- War der Alarm bei der Bestdtigung aktiv, wird er von der Liste entfernt, sobald

die Alarmbedingung gel6scht ist.

Zur Aktualisierung der Liste von aktiven oder unbestdtigten Alarmen, Service Tools >

Alerts > Refresh Alerts driicken.

9.4.4 Alarmdaten im Auswerteelektronik-Speicher

Die Auswerteelektronik speichert drei Datensets fiir jeden Alarm.

Fiir jedes Alarmvorkommen werden die folgenden drei Datensets im Auswerteelektronik-
Speicher gepflegt:

Alarmliste
Alarmstatistik

Neueste Alarme

Tabelle 9-2: Alarmdaten im Auswerteelektronik-Speicher

Auswerteelektronik-Aktion bei Eintreten der Bedingung
Alarmdatenstruktur | Inhalt Loschen
Alarmliste Je nach Bestimmung durch die Alarmstatus- Bei jedem Aus-/Einschalten der Spannungsver-
bits; eine Liste mit: sorgung zur Auswerteelektronik geldscht und
e Allen derzeit aktiven Alarmen neu generiert
e Allen zuvor aktiven Alarmen, die noch
nicht bestétigt wurden
Alarmstatistik Ein Datensatz fiir jeden Alarm (nach Alarm- Nicht gel6scht; gespeichert auch nach Aus-/
nummer), der seit der letzten Hauptriickset- Einschalten der Auswerteelektronik
zung gesetzt wurde. Jeder Eintrag enthdlt:
e Eine Zdhlung der Vorkommen
e Zeitstempel fiir die neuesten gesetzten
und geléschten Alarme
138
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Tabelle 9-2: Alarmdaten im Auswerteelektronik-Speicher (Fortsetzung)

Auswerteelektronik-Aktion bei Eintreten der Bedingung

Alarmdatenstruktur | Inhalt Loschen

Neueste Alarme

50 zuletzt gesetzte oder geléschte Alarme Nicht geldscht; gespeichert auch nach Aus-/
Einschalten der Auswerteelektronik

9.5

9.6

Lesen von Gesamt- und Summenzihlerwerten

Gesamtzdhler erfassen die von der Auswerteelektronik seit der letzten
Gesamtzahlerriicksetzung gemessene Masse und das Volumen. Summenzahler erfassen
die von der Auswerteelektronik seit der letzten Summenzahlerriicksetzung gemessene
Masse und das Volumen.

Hinweis
Die Summenzahler konnen als laufende Summe von Masse und Volumen tiber mehrere
Gesamtzdhlerriicksetzungen verwendet werden.

Starten und Stoppen von Gesamt- und
Summenzdhlern

Anzeiger Siehe Starten und Stoppen der Summen- und Gesamtzdéhler mit dem Display.

ProLink Il ProLink > Totalizer Control > Start

ProLink > Totalizer Control > Stop > Stop Totalizers

Handterminal Service Tools > Variables > Totalizer Control > All Totalizers > Start Totalizers

Service Tools > Variables > Totalizer Control > All Totalizers > Stop Totalizers

Uberblick

Durch Starten eines Gesamtzahlers werden Prozessmessungen {iberwacht. In einer
typischen Anwendung erhéht sich der Wert mit dem Durchfluss. Durch Stoppen eines
Gesamtzahlers wird die Uberwachung der Prozessmessungen gestoppt und sein Wert wird
nicht mehr durch den Durchfluss beeinflusst. Summenzahler werden durch Starten und
Stoppen der Gesamtzahler automatisch gestartet und gestoppt.

Wichtig

Gesamt- und Summenzdhler werden stets als Gruppe gestartet oder gestoppt. Wenn ein
Gesamtzdhler gestartet wird, werden gleichzeitig auch alle anderen Gesamt- und Summenzéhler
gestartet. Wenn ein Gesamtzdhler gestoppt wird, werden gleichzeitig auch alle anderen Gesamt-
und Summenzéhler gestoppt. Summenzéhler konnen nicht direkt gestartet oder gestoppt werden.
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9.7

9.8

140

Zahler zuriicksetzen

Anzeiger Siehe Summenzdhler mit dem Bedieninterface zuriicksetzen.

ProLink Il ProLink > Totalizer Control > Reset Mass Total
ProLink > Totalizer Control > Reset Volume Total
ProLink > Totalizer Control > Reset Gas Volume Total

ProLink > Totalizer Control > Reset

Handterminal Service Tools > Variables > Totalizer Control > Mass > Mass Total
Service Tools > Variables > Totalizer Control > Gas Standard Volume > Volume Total

Service Tools > Variables > Totalizer Control > Gas Standard Volume > GSV Total

Service Tools > Variables > Totalizer Control > All Totalizers > Reset All Totals

Uberblick

Wenn der Zahler zurlickgesetzt wird, setzt die Auswerteelektronik seinen Wert auf 0.
Hierbei spielt es keine Rolle, ob der Zahler gestartet oder gestoppt wurde. Wenn der
Zahler gestartet wurde, wird die Uberwachung der Prozessmessung fortgefiihrt.

Hinweis
Wenn ein einzelner Zdhler zuriickgesetzt wird, werden die Werte der anderen Zahler nicht
zuriickgesetzt. Gesamtzdhlerwerte werden nicht zurlickgesetzt.

Gesamtzdahler zuriicksetzen

ProLink Il ProLink > Totalizer Control > Reset Inventories
ProLink > Totalizer Control > Reset Mass Inventory
ProLink > Totalizer Control > Reset Volume Inventory

ProLink > Totalizer Control > Reset Gas Volume Inventory

ProLink Il Device Tools > Totalizer Control > Totalizer and Inventories > Reset Mass Inventory
Device Tools > Totalizer Control > Totalizer and Inventories > Reset Volume Inventory
Device Tools > Totalizer Control > Totalizer and Inventories > Reset Gas Inventory

Device Tools > Totalizer Control > Totalizer and Inventories > Reset All Inventories

Uberblick

Wenn Sie einen Gesamtzdhler zuriicksetzen, setzt die Auswerteelektronik den Wert auf 0.
Dabei spielt es keine Rolle, ob der Gesamtzdhler gestartet oder gestoppt wurde. Wenn der
Gesamtzahler gestartet wurde, wird die Verfolgung der Prozessmessung fortgesetzt.

Hinweis
Wenn Sie einen einzelnen Gesamtzahler zuriicksetzen, werden die Werte der anderen Gesamtzdhler
nicht zuriickgesetzt. Die Werte der Summenzahler werden nicht zurlickgesetzt.
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Vorbereitungsverfahren

Wenn Sie ProLink Il oder ProLink Ill zum Zuriicksetzen der Gesamtzahler verwenden
mochten, muss diese Funktion aktiviert sein.
. So aktivieren Sie das Zuriicksetzen von Gesamtzahlern in ProLink II:
1. Klicken Sie auf View > Preferences.
2. Markieren Sie das Kontrollfeld Enable Inventory Totals Reset.
3. Klicken Sie auf Apply.
. So aktivieren Sie das Zuriicksetzen von Gesamtzahlern in ProLink Ill:
1. Wabhlen Sie Tools > Options.
2. Waihlen Sie Reset Inventories from ProLink I1.
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10.1
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Betrieb der Auswerteelektronik mit
der eichamtlichen Transfer
Anwendung

In diesem Kapitel behandelte Themen:

Betrieb der Auswerteelektronik, wenn die eichamtliche Transfer Anwendung
installiert ist

Umschalten zwischen gesichertem und ungesichertem Modus
L6schen des Statusalarms A027: Sicherheitsverletzung
Austausch des Core Prozessors in einer eichamtlichen Transfer-Installation

Die Informationen in diesem Kapitel sind nur anwendbar, wenn lhre Auswerteelektronik
mit der eichamtlichen Transfer Anwendung bestellt wurde.

Betrieb der Auswerteelektronik, wenn die
eichamtliche Transfer Anwendung installiert ist

Wenn die eichamtliche Transfer Anwendung installiert ist, sind viele Grundfunktionen der
Auswerteelektronik abgedndert.

Verbindungsherstellung:
- Wenn keine Plombe angebracht ist, sind alle unterstiitzten Anschlusstypen
maglich.

- Wenn eine Plombe angebracht ist, ist kein Service Port Anschluss mdglich. Alle
anderen unterstiitzten Anschlusstypen konnen verwendet werden.

Ablesen und Erfassen von Prozessdaten:

- Flirzugelassene Messungen muss eine zugelassene Methode verwendet werden.

- Wenn die Messung nicht zugelassen sein muss, sind alle verfligbaren Methoden
maoglich.

Wichtig
Das Verhalten der Auswerteelektronik Ausgange und Prozessvariablenwerte wird durch die

eichamtliche Transfer Anwendung verdndert. Sie miissen sicher sein, wie sich diese
Anwendung auf Ausgange und Prozessvariablenwerte auswirkt.

Zurticksetzen der Summenzahler:

- Wenn die Auswerteelektronik nicht gesichert ist, konnen die Summenzahler
zuriickgesetzt werden. Wird ein Summenzdhler zuriickgesetzt, werden alle
anderen Summenzdhler automatisch auch zuriickgesetzt.

- Wenn die Auswerteelektronik gesichert ist, kbnnen die Summenzéhler je nach
Konfiguration eventuell nicht zuriickgesetzt werden. Wenn die Summenzahler
Riicksetzfunktion aktiviert ist, ist die Riicksetzung nur bei einem Durchfluss von 0
maoglich.
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Die Summenzahler knnen nicht angehalten werden, solange die

Auswerteelektronik gesichert ist.

Die Gesamtzdhler kénnen nicht zuriickgesetzt werden, solange die

Auswerteelektronik gesichert ist.

Zugelassene Methoden zum Ablesen oder Erfassen von
Prozessdaten

Wenn die eichamtliche Transfer Anwendung installiert ist, sind Prozessdaten nur dann fiir
eichpflichtige Transfer zuldssig, wenn eine genehmigte Methoden zum Ablesen oder
Erfassen verwendet wird.

Anmerkung
Am primaren mA Ausgang darf die HART/Bell 202-Kommunikation zusammen mit der Ausgabe von
Prozessdaten zur Abfrage von Temperatur oder Druck verwendet werden.

Prozessdaten

Tabelle 10-1: Von der NTEP zugelassene Methoden zum Ablesen oder Erfassen von

Frequenzausgang/-aus-

Prozessdaten mA Ausgang|Ausgdnge | gdnge
Masse v
Volumen v
Dichte v

Summenzahlerwerte

Gesamtzdhlerwerte

Prozessdaten

Tabelle 10-2: Von der OIML zugelassene Methoden zum Ablesen oder Erfassen von

Frequenzausgang/-aus-

Prozessdaten mA Ausgang|/Ausgdnge | gdnge
Masse v
Volumen v
Dichte v

Summenzahlerwerte

Gesamtzdhlerwerte
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10.1.2

Auswirkung der eichamtlichen Transfer Anwendung auf
Prozessmessungen und Ausgdnge

Wenn die eichamtliche Transfer Anwendung installiert ist, werden Prozessmessungen und
Berichterstattung gedndert, um die unbefugte Nutzung der Daten zu verhindern. Bei
bestimmten Anderungen hangt es davon ab, ob die Auswerteelektronik gesichert oder

ungesichert ist.

Tabelle 10-3: Auswerteelektronik Ausgdange und Prozessdaten, wenn Zulassungen = NTEP

Auswerteelektronik Satus

Funktion Ungesichert Gesichert
Ausgdnge mA Ausgang Verhalten Beim ausgeben einer Durchflussvariablen | Normal
gibt der mA Ausgang Null Durchfluss aus.
Ansonsten normal.
Frequenzausgang Verhal- | Inaktiv (es werden keine Impulse erzeugt), Normal
ten selbst bei Storzustdnden
Bindrausgang Verhalten Normal Normal

Prozessvariablen

Alle Durchfliisse

Als Null ausgegeben

Normalerweise ausgegeben

Dichte Normalerweise ausgegeben Normalerweise ausgegeben

Temperatur Normalerweise ausgegeben Normalerweise ausgegeben
Summenzdhler | Werte Nicht erh6hen oder verringern Normal erh6hen
Gesamtzdhler | Werte Nicht erhéhen oder verringern Normal erhéhen

Tabelle 10-4: Auswerteelektronik-Ausgdnge und Prozessdaten, wenn Zulassungen = OIML

Auswerteelektronik Satus

fuhrt

Funktion Ungesichert Gesichert
Ausgdnge mA Ausgang Verhalten Konfigurierte Storaktion wird durchge- Normal
fihrt
Frequenzausgang Verhal- | Konfigurierte Storaktion wird durchge- Normal
ten fuhrt
Bindrausgang Verhalten | Konfigurierte Stéraktion wird durchge- Normal

Prozessvariablen

Alle Durchflisse

Normalerweise ausgegeben

Normalerweise ausgegeben

Dichte Normalerweise ausgegeben Normalerweise ausgegeben

Temperatur Normalerweise ausgegeben Normalerweise ausgegeben
Summenzdhler | Werte Nicht erhdhen oder verringern Normal erhéhen
Gesamtzahler Werte Nicht erhéhen oder verringern Normal erh6hen
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10.1.3 Auswirkung der eichamtlichen Transfer Anwendung auf

Betrieb und Wartung
Wenn die eichamtliche Transfer Anwendung installiert ist, sind bestimmte Funktionen und
Wartungsverfahren moglicherweise nicht zuldssig. Sie konnen auf den ungesicherten

Betrieb umschalten, die nétigen Vorgange durchfiihren und dann wieder auf den
gesicherten Betrieb schalten.

Tabelle 10-5: Verfiigbare Aktionen, wenn Zulassungen = NTEP

Auswerteelektronik Status
Funktion Ungesichert Gesichert
Verbindung von ProLink II, ProLink Ill, dem Alle unterstiitzten Ver- | Die physikalische Sicherheit verhin-
Handterminal oder einem Host bindungstypen sind dert den Zugriff auf die RS-485 Ans-
verfligbar. chlussklemmen. Daher sind weder
RS-485 Anschliisse noch Service Port
Anschlisse verfiigbar.HART/Bell 202
Anschliisse kdnnen zum Lesen von
Daten von der Auswerteelektronik
verwendet werden. Die Software Si-
cherheit verhindert jedoch Ubertra-
gungen an die Auswerteelektronik.
Konfiguration Messwert Erlaubt Erlaubt
Andern Erlaubt Nicht erlaubt
Kalibrierung Nullpunkt Erlaubt Nicht erlaubt
Dichte Erlaubt Nicht erlaubt
Temperatur Erlaubt Nicht erlaubt
Smart Systemverifizierung = Ausgénge eingestellt auf | Erlaubt Erlaubt
Fortsetzung der Messung
Ausgdnge eingestellt auf | Erlaubt Erlaubt
Stérung
Ausgénge eingestellt auf | Erlaubt Nicht erlaubt
zuletzt gemessenen Wert
Externe Druck-und Tem- | Abgerufen durch Abfra- Erlaubt Erlaubt
peraturdaten gen
Geschrieben von Modbus- | Erlaubt Nicht erlaubt
oder HART-Host
Ausgdnge testenund ab- | mA Ausgang Messkreist- | Erlaubt Nicht erlaubt
gleichen est
mA Ausgangsabgleich Erlaubt Nicht erlaubt
Frequenzausgang Mes- Nicht erlaubt Nicht erlaubt
skreistest
Bindrausgang Messkreist- | Erlaubt Nicht erlaubt
est
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Tabelle 10-5: Verfiigbare Aktionen, wenn Zulassungen = NTEP (Fortsetzung)

Auswerteelektronik Status
Funktion Ungesichert Gesichert
Summenzdhler Zuriicksetzen Erlaubt Wird einein- | Je nach Konfiguration zuldssig oder
zelner Summenzahler | nicht zuldssig. Kann nur durchgefihrt
zuriickgesetzt, wer- werden, wenn der Durchfluss Null ist.
den alle anderen Sum- | Wird ein einzelner Summenzahler
menzahler automa- zurlickgesetzt, werden alle anderen
tisch auch zuriickge- | Summenzdhler automatisch auch
setzt. zurlickgesetzt.
Starten Nicht erlaubt k.A.
Stoppen - Nicht erlaubt
Gesamtzdhler Zuriicksetzen Nicht erlaubt Nicht erlaubt
Sensorsimulation Erlaubt Nicht erlaubt

Tabelle 10-6: Verfiigbare Aktionen, wenn Zulassungen = OIML

Funktion Auswerteelektronik Satus
Ungesichert Gesichert
Verbindung von ProLink I, ProLink Ill, dem Alle unterstiitzten Ver- | Die physikalische Sicherheit verhindert
Handterminal oder einem Host bindungstypen sind ver- | den Zugriff auf die RS-485 Anschlisse.
fligbar. Daher sind weder RS-485-Anschliisse

noch Service-Port Anschliisse verfiig-
bar.HART/Bell 202 Anschliisse kdnnen
zum Lesen von Daten von der Auswer-
teelektronik verwendet werden. Die
Software Sicherheit verhindert jedoch
Ubertragungen an die Auswerteelek-

tronik.
Konfiguration Messwert Erlaubt Erlaubt
Andern Erlaubt Nicht erlaubt
Kalibrierung Nullpunkt Erlaubt Nicht erlaubt
Dichte Erlaubt Nicht erlaubt
Temperatur Erlaubt Nicht erlaubt
Smart Systemverifizier- | Ausginge eingestellt auf | Erlaubt Erlaubt
ung Fortsetzung der Messung
Ausgédnge eingestellt auf | Erlaubt Erlaubt
Stérung
Ausgdnge eingestellt auf | Erlaubt Nicht erlaubt
zuletzt gemessenen Wert
Externe Druck- und Abgerufen durch Abfra- | Erlaubt Erlaubt
Temperaturdaten gen
Geschrieben von Mod- Erlaubt Nicht erlaubt
bus- oder HART-Host
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Tabelle 10-6: Verfiigbare Aktionen, wenn Zulassungen = OIML (Fortsetzung)

est

Funktion Auswerteelektronik Satus
Ungesichert Gesichert
Ausgange mA Ausgang Messkreist- | Erlaubt Nicht erlaubt
est
mA Ausgangsabgleich Erlaubt Nicht erlaubt
Frequenzausgang Mes- Erlaubt Nicht erlaubt
skreistest
Bindrausgang Messkreist- | Erlaubt Nicht erlaubt

Prozessvariablen

Alle Durchflisse

Normalerweise ausge-
geben

Normalerweise ausgegeben

Dichte Normalerweise ausge- | Normalerweise ausgegeben
geben
Temperatur Normalerweise ausge- | Normalerweise ausgegeben
geben
Summenzéhler Zuriicksetzen Erlaubt Wird ein einzel- | Je nach Konfiguration zuldssig oder
ner Summenzahler zur- | nicht zuldssig. Kann nur durchgefiihrt
ickgesetzt, werden alle = werden, wenn der Durchfluss Null ist.
anderen Summenzéhler | Wird ein einzelner Summenzahler zur-
automatisch auch zur- | Gickgesetzt, werden alle anderen Sum-
tickgesetzt. menzahler automatisch auch zuriick-
gesetzt.
Starten Nicht erlaubt k.A.
Stoppen - Nicht erlaubt
Gesamtzahler Zuriicksetzen Erlaubt Nicht erlaubt
Sensorsimulation Erlaubt Nicht erlaubt

10.2

Umschalten zwischen gesichertem und
ungesichertem Modus

Zum Andern der Auswerteelektronik Konfiguration sowie fiir viele
Administrationsaufgaben ist der Wechsel auf den ungesicherten Betrieb erforderlich. Um
die eichamtlichen Transfer Anforderungen fiir Prozessmessungen zu erfiillen, miissen Sie
danach wieder in den gesicherten Modus zuriickschalten.

Zum Umschalten der Betriebsmodus muss eines der folgenden Hilfsmittel verwendet
werden:

L]

ProLink Il
ProLink Il

Das “Umschalt”-Hilfsprogramm fiir den eichamtlichen Transfer. Das Umschalt-
Hilfsprogramm ist kostenlos auf der Micro Motion Website erhiltlich:
www.micromotion.com/softwaredownloads.

Nur so ist der Zugriff auf die Steuererung moglich.
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10.2.1

10.2.2
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Umschalten zwischen gesichertem und ungesichertem
Modus unter Verwendung von ProLink I

Vorbereitungsverfahren

Vergewissern Sie sich vor dem Umschalten in den ungesicherten Betrieb, dass Sie in den
gesicherten Betrieb zuriickschalten kénnen. Da zum Umschalten in den ungesicherten
Betrieb die Plombe zerstort werden muss, muss zum Umschalten in den gesicherten
Modus ein zertifizierter eichamtlicher Priifer vor Ort eine neue Plombe anbringen.

Vergewissern Sie sich, dass die nétige Verdrahtung fiir einen Service Port Anschuss
vorhanden ist. Sie miissen mdglicherweise die Plombe zerstéren und die Klemme
entfernen.

Sicherstellen, dass sich die RS-485 Anschlussklemmen im Service Port Modus befinden. Die
Spannungsversorgung der Auswerteelektronik muss moglicherweise aus- und
eingeschaltet werden.

Verfahren
. So schalten Sie vom gesicherten zum ungesicherten Modus um:

1. Stellen Sie eine Service Port Verbindung zu Ihrer Auswerteelektronik her.
2. Wabhlen Sie Plug-ins > Enable/Disable Custody Transfer.
3. Klicken Sie auf Disable Custody Transfer.

. So schalten Sie vom ungesicherten zum gesicherten Modus um:

1. Stellen Sie eine Service Port Verbindung zu Ihrer Auswerteelektronik her.
2. Wabhlen Sie Plug-ins > Enable/Disable Custody Transfer.
3. Klicken Sie auf Enable Custody Transfer.

Umschalten zwischen gesichertem und ungesichertem
Modus unter Verwendung von ProLink IlI

Vorbereitungsverfahren

Vergewissern Sie sich vor dem Umschalten in den ungesicherten Betrieb, dass Sie in den
gesicherten Betrieb zuriickschalten kdnnen. Da zum Umschalten in den ungesicherten
Betrieb die Plombe zerstért werden muss, muss zum Umschalten in den gesicherten
Modus ein zertifizierter eichamtlicher Priifer vor Ort eine neue Plombe anbringen.

Vergewissern Sie sich, dass die nétige Verdrahtung fiir einen Service Port Anschuss
vorhanden ist. Sie miissen maglicherweise die Plombe zerstéren und die Klemme
entfernen.

Sicherstellen, dass sich die RS-485 Anschlussklemmen im Service Port Modus befinden. Die
Spannungsversorgung der Auswerteelektronik muss moglicherweise aus- und
eingeschaltet werden.

Verfahren
o So schalten Sie vom gesicherten zum ungesicherten Modus um:

1. Stellen Sie eine Service Port Verbindung zu Ihrer Auswerteelektronik her.
2. Wihlen Sie Device Tools > Configuration > Weights & Measures.

MicroMotion® Auswerteelektronik Modell 2500 mit konfigurierbaren Ein-/Ausgéngen



Betrieb der Auswerteelektronik mit der eichamtlichen Transfer Anwendung

3. Setzen sie Software Security auf Disabled.

. So schalten Sie vom ungesicherten zum gesicherten Modus um:

1. Stellen Sie eine Service Port Verbindung zu Ihrer Auswerteelektronik her.
2. Wabhlen Sie Device Tools > Configuration > Weights & Measures.

3. Setzen Sie Software Security auf Enabled.

10.2.3 Umschalten zwischen gesichertem und ungesichertem
Modus unter Verwendung des Umschalt-
Hilfsprogramms

Vorbereitungsverfahren

Das Umschalt-Hilfsprogramm muss auf Ihrem PC installiert sein. Das Umschalt-
Hilfsprogramm ist auf der Micro Motion Website erhaltlich: www.micromotion.com/
softwaredownloads.

Vergewissern Sie sich vor dem Umschalten in den ungesicherten Betrieb, dass Sie in den
gesicherten Betrieb zuriickschalten kénnen. Da zum Umschalten in den ungesicherten
Betrieb die Plombe zerstort werden muss, muss zum Umschalten in den gesicherten
Modus ein zertifizierter eichamtlicher Priifer vor Ort eine neue Plombe anbringen.

Vergewissern Sie sich, dass die nétige Verdrahtung fiir einen Service Port Anschuss
vorhanden ist. Sie miissen moglicherweise die Plombe zerstéren und die Klemme
entfernen.

Sicherstellen, dass sich die RS-485 Anschlussklemmen im Service Port Modus befinden. Die
Spannungsversorgung der Auswerteelektronik muss moglicherweise aus- und
eingeschaltet werden.

Verfahren
. So schalten Sie vom gesicherten zum ungesicherten Modus um:

1. Starten Sie das Umschalt-Hilfsprogramm.
2. Wabhlen Sie den gewiinschten COM-Port fiir die Verbindung.
3. Klicken Sie auf Disable Custody Transfer.

. So schalten Sie vom ungesicherten zum gesicherten Modus um:

1. Starten Sie das Umschalt-Hilfsprogramm.
2. Wabhlen Sie den gewiinschten COM-Port fiir die Verbindung.
3. Klicken Sie auf Enable Custody Transfer.

10.3 Loschen des Statusalarms A027:
Sicherheitsverletzung

Statusalarm A027 (Sicherheitsverletzung) wird ausgegeben, wenn die Auswerteelektronik
auf ungesicherten Modus umgeschaltet wird oder wenn die Auswerteelektronik feststellt,
dass sich die Kennung des Core Prozessors geandert hat.
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1. Wenn die Auswerteelektronik im gesicherten Modus betrieben wird, schalten Sie auf
den ungesicherten Modus um.

2. Fiihren Sie alle n6tigen MaBnahmen zur Behebung der Ursache fiir die
Sicherheitsverletzung durch.

3. Schalten Sie auf den gesicherten Modus um.

Austausch des Core Prozessors in einer
eichamtlichen Transfer-Installation

In einer eichamtlichen Transfer Installation muss beim Austausch des Core Prozessors die
Auswerteelektronik neu verplombt werden.

Wenn die Auswerteelektronik zum ersten Mal gesichert wird, wird die Gerdtekennung des
Core Prozessors in der Auswerteelektronik registriert. Wenn der Core Prozessor durch
einen anderen Core Prozessor ersetzt wird, gibt die Auswerteelektronik den Statusalarm
A026 (Sensor-/Auswerteelektronik-Kommunikationsfehler) aus. Um diesen Alarm zu
[6schen, muss die Auswerteelektronik in den ungesicherten Betrieb geschaltet und dann
erneut gesichert werden. Hierzu muss die Plombe zerstort und nach Abschluss des
Verfahrens eine neue Plombe angebracht werden.

AuBerdem konnen noch weitere Verfahren nétig sein. Detaillierte Informationen fiir Ihre
Installation finden Sie in der Dokumentation fiir den eichamtlichen Transfer.

Wichtig
In den meisten Fallen muss die Plombe von einem zertifizierten eichamtlichen Priifer angebracht
werden.
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11 Messunterstutzung

In diesem Kapitel behandelte Themen:

Optionen fiir den Messungs-Support

Verwendung der Smart Systemverifizierung
Nullpunktkalibrierung des Durchflussmesssystems

Messsystem validieren

(Standard) D1 und D2 Dichtekalibrierung durchfiihren

D3 und D4 Dichtekalibrierung durchfiihren (nur T-Serie Sensoren)
Durchftihren einer Temperaturkalibrierung

11.1 Optionen fiir den Messungs-Support

Micro Motion bietet verschiedene Support-Verfahren fiir Messungen, mit denen Sie die
Genauigkeit lhres Durchflussmessers beurteilen und erhalten konnen.

Die folgenden Methoden sind verfiigbar:

Die intelligente Systemverifizierung bewertet die strukturelle Integritdt der Sensor-
Messrohre durch Vergleich der aktuellen Steifigkeit der Messrohre mit der
Steifigkeit, die beim Hersteller gemessen wurde. Steifigkeit ist definiert als
Belastung pro Auslenkungseinheit oder Kraft dividiert durch die Auslenkung. Durch
die Anderung der strukturellen Integritit dndert sich die Reaktion des Sensors in
Bezug auf Masse und Dichte, dieser Wert kann als Leistungsmerkmal-Indikator der
Messung herangezogen werden.

Die Systemvalidierung vergleicht die von der Auswerteelektronik ausgegebenen
Messwerte des Durchflussmessgerdts mit einem externen Messnormal.
Systemvalidierung erfordert einen Datenpunkt.

Kalibrierung - Nachweis des Verhaltnisses zwischen einer Prozessvariablen und dem
Signal vom Sensor. Sie kénnen den Durchflussmesser auf Nullpunkt, Dichte und
Temperatur kalibrieren. Dichte- und Temperaturkalibrierung erfordern zwei
Datenpunkte (niedrig und hoch) und eine externe Messung fir jeden.

Hinweise

Um die besten Daten (ber die Leistung Ihres Systems zu erhalten, fiihren Sie regelmaRig eine
intelligente Systemverifizierung durch.

Nutzen Sie eine Systemvalidierung und die Verwendung von Gerdtefaktoren anstatt einer
Kalibrierung, um das Messsystem auf ein geeichtes Messnormal abzugleichen oder einen
Messfehler zu korrigieren.

Bevor Sie eine Feldkalibrierung durchfiihren, kontaktieren Sie Micro Motion, um
herauszufinden, ob es ggf. eine Alternative gibt. In vielen Féllen wirken sich
Feldkalibrierungen negativ auf die Messgenauigkeit aus.
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11.2

11.2.1

Verwendung der Smart Systemverifizierung

Sie kdnnen eine Smart Systemverifizierung durchfiihren, die Ergebnisse anzeigen und
auswerten sowie die automatische Ausfiihrung der Systemverifizierung einstellen.

Anforderungen an die intelligente Systemverifizierung

Um die intelligente Systemverifizierung zu verwenden, muss die Auswerteelektronik
zusammen mit einem Core-Prozessor mit erweiterter Funktionalitat eingesetzt werden
und die Option Systemverifizierung muss fiir die Auswerteelektronik installiert sein.

Mindestanforderungen an die Auswerteelektronik, den erweiterten Core-Prozessor und
das Kommunikations-Tool zur Unterstiitzung der intelligenten Systemverifizierung finden
Siein Tabelle 11-1.

Tabelle 11-1: Mindestversion zur Unterstiitzung der intelligenten
Systemverifizierung

Position Mindestversion

Auswerteelektronik 6.0

Core-Prozessor mit erweiterter Funktionalitdt | 3.6

ProLink Il 2.9

ProLink IlI 1.0

Handterminal HART-Geratebeschreibung: Gerdteversion 6, DD
Rev. 2

Wenn lhre Gerdte oder Tools nicht die Mindestanforderungen fiir die intelligente
Systemverifizierung erfiillen, konnen Sie trotzdem Zugang zu einer &lteren
Systemverifizierungsversion haben, falls diese Option fiir Ihre Auswerteelektronik bestellt
wurde. Eine Beschreibung der Hauptunterschiede zwischen der dlteren
Systemverifizierung und der neuen intelligenten Systemverifizierung finden Sie in

Tabelle 11-2.

Tabelle 11-2: Hauptunterschiede zwischen der Systemverifizierung und der
intelligenten Systemverifizierung

Intelligente Systemverifizierung

Merkmal Systemverifizierung (alter) (neuer)

Messunterbrechung Unterbrochen wéhrend des Tests (3 | Keine Unterbrechung notwendig
Minuten)

Ergebnisspeicherung | In der Auswerteelektronik werden | Die letzten 20 Ergebnisse werden in
keine Ergebnisse gespeichert der Auswerteelektronik gespeichert

Ergebnisbericht Bestanden/Fehlgeschlagen/Ab- Bestanden/Fehlgeschlagen/Ab-
bruch bruch, Abbruchcode, Vergleichsta-

bellen und Diagramme fiir gespei-
cherte Testergebnisse(V)

Teststartmethoden Nur Manuell Manuell, geplant, auf Ereignisbasis,
Bindreingang

(1) Detaillierte Testergebnisse wie Vergleichsdiagramme sind auf dem Digitalanzeiger nicht verfiigbar.
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11.2.2 Vorbereitung auf den intelligenten
Systemverifizierungstest

Obwohl fiir einen intelligenten Systemverifizierungstest die Werksbedingungen nicht
hergestellt werden miissen und die Auswerteelektronik nicht gedndert werden muss, lauft
der Test stabiler unteri stabilen Testbedingungen.

Die intelligente Systemverifizierung verfiigt tiber den Ausgangsmodus Kontinuierliche
Messung, mit dem die Auswerteelektronik wahrend des Tests weiter messen kann. Falls Sie
den Test stattdessen in den Betriebsarten Zuletzt gemessener Wert oder Storung durchgefiihrt
wird, werden die Ausgdnge der Auswerteelektronik wéhrend der zweiminiitigen Testdauer
konstant gehalten. Wenn Regelkreise von den Ausgangen der Auswerteelektronik
abhdngig sind, ergreifen Sie entsprechende MaRnahmen.

Vermeiden Sie eine Prozessinstabilitdt wahrend des Tests. Wenn die Bedingungen zu
instabil sind, wird der intelligente Systemverifizierungstest abgebrochen. Prozessstabilitat

maximieren:

o Temperatur und Druck des Prozessmediums konstant halten.

. Schwankungen in der Zusammensetzung des Mediums (z. B. Zweiphasenstrémung,
Abscheidungen, usw.) vermeiden.

. Den Durchfluss konstant halten.

Hinweise

. Der intelligente Systemverifizierungstest lauft am besten, wenn der Durchfluss durch den

Sensor gestoppt wird.

. Die intelligente Systemverifizierung wird nicht durch Parameter, die fiir Durchfluss, Dichte
oder Temperatur konfiguriert wurden, beeinflusst.

11.2.3 Smart Systemverifizierung durchftihren

Smart Systemverifizierung durchfiihren mittels ProLink II

1. Wahlen Sie Tools > Meter Verification > Run Meter Verification.
Sie missen moglicherweise einige Sekunden warten, wahrend ProLink Il die
Datenbank mit den Daten der Auswerteelektronik synchronisiert.

2. Sehen Sie sich die auf dem Bildschirm angezeigten Informationen an und klicken Sie
dann auf Next.

3.  Geben Sie die gewiinschten Informationen auf dem Bildschirm Test Definition ein
und klicken Sie auf Next.
Alle Informationen auf diesem Bildschirm sind optional.

4.  Wabhlen Sie das gewlinschte Ausgangsverhalten.

Option Beschreibung
Ausgange fahren mit Mes- = Wahrend des Tests geben alle Ausgdnge die zugewiesene Prozess-
sung fort variable weiterhin aus. Der Test lduft ca. 90 Sekunden.
Ausgangswerte auf letzten = Wahrend des Tests geben alle Ausgdnge den zuletzt gemessenen
Wert halten Wert der zugewiesenen Prozessvariable aus. Der Test lduft ca.

140 Sekunden.

Konfigurations- und Bedienungsanleitung 153



Messunterstiitzung

154

Option ‘ Beschreibung

Waéhrend des Tests werden alle Ausgange auf ihre konfigurierte
Storaktion gesetzt. Der Test lauft ca. 140 Sekunden.

Ausgangswerte bei Fehler
halten

Driicken Sie Start Meter Verification.

Der Fortschritt des Tests wird auf dem Bildschirm angezeigt.

Nachbereitungsverfahren

Sehen Sie sich die Testergebnisse an und treffen Sie entsprechende MaRnahmen.

Smart Systemverifizierung durchfiihren mittels ProLink Il

1.

4.

Wabhlen Sie Device Tools > Diagnostics > Meter Verification > Run Test.

Sie missen moglicherweise einige Sekunden warten, wéhrend ProLink Il die
Datenbank mit den Daten der Auswerteelektronik synchronisiert.

Geben Sie die gewiinschten Informationen auf dem Bildschirm Test Definition ein
und klicken Sie auf Next.

Alle Informationen auf diesem Bildschirm sind optional.

Wabhlen Sie das gewiinschte Ausgangsverhalten.

Option Beschreibung

Mit Messung fortfah- | Wdhrend des Tests geben alle Ausgénge die zugewiesene Prozessvaria-
ren ble weiterhin aus. Der Test lauft ca. 90 Sekunden.

Auf letztem Wert hal- | Wahrend des Tests geben alle Ausgdnge den zuletzt gemessenen Wert
ten der zugewiesenen Prozessvariable aus. Der Test lduft ca. 140 Sekunden.
Bei Fehler halten Wéhrend des Tests werden alle Ausgange auf ihre konfigurierte Storak-

tion gesetzt. Der Test lduft ca. 140 Sekunden.

Driicken Sie Start.

Der Fortschritt des Tests wird auf dem Bildschirm angezeigt.

Nachbereitungsverfahren

Sehen Sie sich die Testergebnisse an und treffen Sie entsprechende MaRnahmen.

Smart Systemverifizierung durchfiihren mittels
Handterminal

1.

Navigieren Sie zum Meni Smart Meter Verification:

« Ubersicht > Verkniipfungen > Systemverifizierung

» Service Tools > Maintenance > Routine Maintenance > Meter Verification
Wahlen Sie Manual Verification.

Wabhlen Sie Start.

Setzen Sie das Ausgangsverhalten wie gewiinscht und driicken Sie OK, wenn die
entsprechende Aufforderung erscheint.
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Option Beschreibung

Mit Messung fortfahren | Wahrend des Tests geben alle Ausgdnge die zugewiesene Prozess-
variable weiterhin aus. Der Test lduft ca. 90 Sekunden.

Ausgangswerte auf letzt- | Wahrend des Tests geben alle Ausgdnge den zuletzt gemessenen

en Wert halten Wert der zugewiesenen Prozessvariable aus. Der Test lduft ca.
140 Sekunden.

Ausgangswerte bei Feh-  Wahrend des Tests werden alle Ausgdnge auf ihre konfigurierte

ler halten Storaktion gesetzt. Der Test lduft ca. 140 Sekunden.

Der Fortschritt des Tests wird auf dem Bildschirm angezeigt.

Nachbereitungsverfahren

Sehen Sie sich die Testergebnisse an und treffen Sie entsprechende MaRnahmen.

11.2.4 Testdaten anzeigen

Sie konnen die Ergebnisse des aktuellen Tests ansehen. Sie kénnen auBerdem die
Ergebnisse vorhergehender Tests anzeigen.

Die Auswerteelektronik speichert die folgenden Informationen Giber die letzten 20
intelligenten Systemverifizierungen:

. Eingeschaltete Stunden zum Testzeitpunkt.

. Testergebnisse (Bestanden, Fehlgeschlagen, Abbruch).

. Steifigkeit des linken und des rechten Aufnehmers, gezeigt als eine prozentuale
Abweichung von der Werkseinstellung. Wenn der Test abgebrochen wurde, wird fiir
diese Werte 0 gespeichert.

. Abbruchcode, falls zutreffend.
Dartiiber hinaus geben ProLink Il und ProLink Il einen detaillierten Testbericht- und

Analyserahmen. Diese Informationen werden auf dem PC gespeichert, auf dem ProLink Il
oder ProLink lll installiert sind. Die Informationen umfassen:

. Zeitstempel vom PC-Dock

. Aktuelle Durchflussmesser-Kenndaten

. Aktuelle Konfigurationsparameter fiir Durchfluss und Dichte

. Aktuelle Nullpunktwerte

. Aktuelle Prozesswerte fiir den Massedurchfluss, den Volumendurchfluss, die Dichte,

die Temperatur und den externen Druck

. Kunde und Testbeschreibungen (falls vom Benutzer eingegeben)

Wenn Sie zur Ausfiihrung eines Test ProLink Il oder ProLink Ill verwenden, werden eine
Testergebnistabelle und ein Testbericht beim Abschluss des Tests angezeigt.
Bildschirmanweisungen zur Manipulation der Testdaten oder zum Export der Daten in eine
CSV-Datei zur Offline-Analyse werden gegeben.

Testergebnisse anzeigen mit ProLink Il

1. Wihlen sie Tools > Meter Verification > Run Meter Verification und klicken Sie auf View
Previous Test Results and Print Report.
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Die Tabelle zeigt Testergebnisse aller Tests, die in der ProLink Il Datenbank
gespeichert sind.

(Optional) Klicken Sie auf Next, um einen Testbericht anzuzeigen und zu drucken.

(Optional) Klicken Sie auf Export Data to CSV File, um die Daten in einer Datei auf dem
PC zu speichern.

Testergebnisse anzeigen mit ProLink IlI

1.

Wahlen Sie Device Tools > Diagnostics > Meter Verification und klicken Sie auf Previous Test
Results.

Die Tabelle zeigt Testergebnisse aller Tests, die in der ProLink Il Datenbank
gespeichert sind.

(Optional) Klicken Sie auf Next, um einen Testbericht anzuzeigen und zu drucken.

(Optional) Klicken Sie auf Export Data to CSV File, um die Daten in einer Datei auf dem
PC zu speichern.

Testergebnisse anzeigen mit Handterminal

1.

Navigieren Sie zum Men(i Smart Meter Verification:

e QOverview > Shortcuts > Meter Verification
¢ Service Tools > Maintenance > Routine Maintenance > Meter Verification

(Optional) Wenn die Handterminal Datenbank nicht mehr aktuell ist, wahlen Sie
Upload Results Data from Device.

Wabhlen Sie Most Recent Test Results, um die neuesten Testergebnisse anzuzeigen.

So zeigen Sie Daten aller Testergebnisse in der Handterminal Datenbank an:
a. Klicken Sie auf Show Results Table.

Es werden die Daten vom letzten Test angezeigt.

b. Klicken Sie auf OK, um die Daten von vorhergehenden Tests zu durchbldttern.

c. Klicken Sie auf Abort, um die Ergebnistabelle zu verlassen.

Interpretation der intelligenten
Systemverifizierungsergebnisse

Wenn der Systemverifizierungstest beendet ist, wird das Ergebnis als Erfolgreich,
Fehlgeschlagen oder Abbruch angezeigt. (Einige Softwaretools geben das fehlgeschlagene
Ergebnis stattdessen als ,Vorsicht“ aus.)

Bestanden Das Testergebnis liegt innerhalb der Spezifikations-

Unsicherheitsgrenze. Mit anderen Worten, die Steifigkeit des linken
und des rechten Aufnehmers entspricht den Werkseinstellungen plus
oder minus der Spezifikations-Unsicherheitsgrenze. Wenn
Nullpunktwert und Konfiguration den Herstellerwerten entsprechen,
entspricht der Sensor den Spezifikationen des Herstellers fiir die
Durchfluss- und Dichtemessung. Es ist zu erwarten, dass der Sensor die
Systemverifizierung bei jedem Test jederzeit durchlauft.
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Fehlgeschlagen Das Testergebnis liegt auRerhalb der Spezifikations-
Unsicherheitsgrenze. Micro Motion empfiehlt, dass Sie die
Systemverifizierung umgehend wiederholen. Wenn die Ausgange
beim fehlgeschlagenen Test auf Messung fortsetzen gesetzt waren,
setzen Sie die Ausgange stattdessen auf Stérung oder Zuletzt gemessener

Abbruch

Tabelle 11-3:

Wert.

. Besteht das System den zweiten Test, kann das erste Ergebnis
ignoriert werden.

. Wenn das System den zweiten Test nicht besteht, sind

moglicherweise die Messrohre beschddigt. Nutzen Sie lhre
Prozesskenntnisse, um die Maglichkeiten einer Beschadigung
sowie alle entsprechenden AbhilfemaRnahmen zu bestimmen.
Diese MaRnahmen kénnen auch bedeuten, dass das Messgerat
ausgebaut und die Messrohre untersucht werden miissen.
Mindestens ist jedoch die Validierung des Durchflusses und die
Kalibrierung der Dichte durchzufihren.

Ein Problem ist wahrend des Systemverifizierungstests aufgetreten
(z.B. Instabilitdt des Prozesses) oder Sie haben den Test manuell
gestoppt. Eine Liste der Abbruchcodes, eine Beschreibung jedes Codes
sowie mogliche AbhilfemaRnahmen finden Sie in Tabelle 11-3.

Abbruchcodes der intelligenten Systemverifizierung

Systemverifizierung

Code Beschreibung Empfohlene MaBnahmen

1 Vom Benutzer eingeleiteter Abbruch | Keine erforderlich. Vor Start eines weiteren
Tests 15 Sekunden warten.

3 Frequenzabweichung Sicherstellen, dass Temperatur, Durchfluss
und Dichte stabil sind und den Test erneut
durchfthren.

5 Hohe Antriebsverstarkung Sicherstellen, dass der Durchfluss stabil ist,
Gaseinschliisse auf ein Minimum reduzieren
und den Test erneut durchfiihren.

8 Instabiler Durchfluss Faktoren priifen, die eine Prozessinstabilitdt
verursachen konnen, dann den Test erneut
durchfiihren. Prozessstabilitdat maximieren:
e Temperatur und Druck des Prozessmedi-

ums konstant halten.
e Schwankungen in der Zusammenset-
zung des Mediums (z. B. Zweiphasen-
stromung, Abscheidungen, usw.) ver-
meiden.
e Den Durchfluss konstant halten.
13 Keine werksseitigen Bezugsdaten fiir | Kontaktieren Sie Micro Motion.
Systemverifizierungstests mit Luft

14 Keine werksseitigen Bezugsdaten fiir | Kontaktieren Sie Micro Motion.
Systemverifizierungstests mit Wass-
er

15 Keine Konfigurationsdaten fir die Kontaktieren Sie Micro Motion.
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Tabelle 11-3: Abbruchcodes der intelligenten Systemverifizierung (Fortsetzung)

Code

Beschreibung Empfohlene MaBnahmen

Andere

Allgemeiner Abbruch Test wiederholen. Wenn der Test wieder ab-
bricht, wenden Sie sich an Micro Motion.

Zeitplan zur automatischen Ausfiihrung der Smart
Systemverifizierung

Sie kénnen einen einzelnen Test fiir einen vom Anwender definierten Zeitpunkt planen. Sie
kénnen Tests ebenso gemaR eines regelmaRigen Zeitplans einrichten und ausfihren.

Testdurchfithrung mit Zeitplan mittels ProLink I

Wahlen Sie Tools > Meter Verification > Schedule Meter Verification.

2. Zum Planen eines einzelnen Tests oder des ersten Tests einer wiederkehrenden
Ausfiihrung geben Sie einen Wert fiir Hours Until Next Run ein.

3. ZumPlanen einer wiederkehrenden Ausfiihrung geben Sie einen Wert fiir Hours
Between Recurring Runs ein.

4, So deaktivieren Sie die zeitgesteuerte Ausfiihrung:

Zum Deaktivieren der Ausfiihrung eines einzelnen geplanten Tests setzen Sie
Hours Until Next Run auf 0.

Zum Deaktivieren wiederkehrender Ausfiihrungen setzen SieHours Between
Recurring Runs auf 0.

Zum Deaktivieren aller geplanten Ausfiihrungen klicken Sie auf Turn Off Schedule.

Zeitgesteuerte Testausfiihrung verwalten mittels ProLink Il

1. Wabhlen Sie Device Tools > Diagnostics > Meter Verification > Schedule Meter Verification.

2. Zum Planen eines einzelnen Tests oder des ersten Tests einer wiederkehrenden
Ausfiihrung geben Sie einen Wert fiir Stunden bis zum nachsten Lauf ein.

3. Zum Planen einer wiederkehrenden Ausfiihrung geben Sie einen Wert fiir Stunden
zwischen wiederkehrenden Laufen ein.

4,  Sodeaktivieren Sie die zeitgesteuerte Ausfiihrung:

Zum Deaktivieren der Ausfiihrung eines einzelnen geplanten Tests setzen Sie
Stunden bis zum néchsten Lauf auf 0.

Zum Deaktivieren wiederkehrender Ausfiihrungen setzen Sie Stunden zwischen
wiederkehrenden Laufen auf 0.

Zum Deaktivieren aller geplanten Ausfiihrungen klicken Sie auf Geplante
Ausfiihrung deaktivieren.

Testdurchfithrung mit Zeitplan mittels Handterminal

1. Navigieren Sie zum Meni Smart Meter Verification:

Overview > Shortcuts > Meter Verification

Service Tools > Maintenance > Routine Maintenance > Meter Verification
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Wahlen Sie Automatic Verification.

Zum Planen eines einzelnen Tests oder des ersten Tests einer wiederkehrenden
Ausfiihrung geben Sie einen Wert fiir Hrs Until Next Run ein.

4.  Zum Planen einer wiederkehrenden Ausfiihrung geben Sie einen Wert fiir Set
Recurring Hours ein.

5.  Sodeaktivieren Sie die zeitgesteuerte Ausfiihrung:
e Zum Deaktivieren der Ausfiihrung eines einzelnen geplanten Tests setzen Sie Hrs
Until Next Run auf 0.

* Zum Deaktivieren einer wiederkehrenden Ausfiihrung setzen Sie Set Recurring
Hours auf 0.

» Zum Deaktivieren aller geplanten Ausfiihrungen wéhlen Sie Turn Off Schedule.

11.3 Nullpunktkalibrierung des
Durchflussmesssystems

Die Nullpunktkalibrierung des Durchflussmesssystems etabliert einen Basiswert fiir die
Prozessmessung, indem der Sensorausgang analysiert wird, wenn kein Durchfluss im
Messrohr vorhanden ist.

Wichtig
In den meisten Fallen ist die werksseitige Nullpunktkalibrierung genauer als die im Feld. Kalibrieren
Sie den Nullpunkt des Durchflussmesssystems nicht, es sei denn:

. Anlagenverfahren erfordern eine Nullpunktkalibrierung.
. Der gespeicherte Nullpunktwert besteht das Nullpunktverifizierungsverfahren nicht.
11.3.1 Nullpunktkalibrierung des Durchflussmesssystems

mittels Nullpunkttaste

Die Nullpunktkalibrierung des Durchflussmesssystems etabliert einen Basiswert fiir die
Prozessmessung, indem der Sensorausgang analysiert wird, wenn kein Durchfluss im
Messrohr vorhanden ist.

Einschrdankung

Bei Verwendung der Nullpunkttaste kann der Wert fiir Zero Time nicht gedndert werden. Die
derzeitige Einstellung von Zero Time wird bei der Nullpunktkalibrierung verwendet. Der Standardwert
betrdgt 20 Sekunden. Wenn Zero Time gedandert werden soll, muss eine andere Methode verwendet
werden, um den Nullpunkt des Durchflussmesssystems zu kalibrieren.

Verfahren
1. Vorbereiten des Durchflussmesssystems:

a. Lassen Sie das Durchflussmesssystem nach dem Einschalten mindestens
20 Minuten aufwdrmen.

b. Lassen Sie das Prozessmedium durch den Sensor strémen, bis die
Sensortemperatur ungefahr die normale Betriebstemperatur erreicht hat.
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c. Stoppen Sie den Durchfluss durch den Sensor, indem Sie das in Flussrichtung
abwarts liegende Ventil und danach das in Flussrichtung aufwarts liegende Ventil
schlieBen (falls verfligbar).

d. Stellen Sie sicher, dass der Sensor abgesperrt ist, kein Durchfluss mehr
vorhanden ist und der Sensor vollstindig mit dem Prozessmedium gefillt ist.

e. Beobachten Sie die Werte fiir Antriebsverstdrkung, Temperatur und Dichte. Sind
diese stabil, priifen Sie den Wert Live Zero oder Field Verification Zero. Wenn der
Mittelwert nahe bei 0 liegt, muss der Nullpunkt des Durchflussmesssystems
nicht kalibriert werden.

2. Driicken Sie die Nullpunkttaste auf der Oberseite der Auswerteelektronik mit einem
spitzen Gegenstand, bis die Status-LED beginnt, gelb zu blinken.
Die Status-LED blinkt wahrend der Ausfiihrung des Verfahrens gelb. Am Ende des
Verfahrens:

* Wenn die Nullpunktkalibrierung erfolgreich war, leuchtet die Status-LED
dauerhaft griin oder gelb.

* Wenn die Nullpunktkalibrierung fehlgeschlagen ist, leuchtet die LED dauerhaft
rot.

Nachbereitungsverfahren

Offnen Sie die Ventile, um den normalen Durchfluss durch den Sensor wieder herzustellen.

Bendtigen Sie Hilfe? Wenn die Nullpunktkalibrierung fehlschlagt:

. Stellen Sie sicher, dass kein Durchfluss durch den Sensor erfolgt und wiederholen Sie das
Verfahren.

. Entfernen oder reduzieren Sie elektromagnetisches Rauschen und wiederholen Sie das
Verfahren.

. Setzen Sie Zero Time auf einen niedrigeren Wert und wiederholen Sie das Verfahren.

. Sollte eine Nullpunktkalibrierung weiterhin nicht méglich sein, wenden Sie sich an

Micro Motion.

Hinweis

Der werksseitige Nullpunkt kann mit einem Kommunikations-Hilfsmittel wie z. B. ProLink Il
wiederhergestellt werden. Den werksseitigen Nullpunkt nur dann wiederherstellen, wenn das
Durchflussmesssystem als eine Einheit erworben wurde, der Nullpunkt im Werk kalibriert wurde und
die Originalteile verwendet werden. Diese Funktion erfordert den Core Prozessor mit erweiterter
Funktionalitat.

Nullpunktkalibrierung des Durchflussmesssystems
mittels ProLink Il

Die Nullpunktkalibrierung des Durchflussmesssystems etabliert einen Basiswert fiir die
Prozessmessung, indem der Sensorausgang analysiert wird, wenn kein Durchfluss im
Messrohr vorhanden ist.

Vorbereitungsverfahren

ProLink Il muss laufen und muss mit der Auswerteelektronik verbunden sein.
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Verfahren

1.

Vorbereiten des Durchflussmesssystems:

a. Lassen Sie das Durchflussmesssystem nach dem Einschalten mindestens
20 Minuten aufwdrmen.

b. Lassen Sie das Prozessmedium durch den Sensor strémen, bis die
Sensortemperatur ungefahr die normale Betriebstemperatur erreicht hat.

c. Stoppen Sie den Durchfluss durch den Sensor, indem Sie das in Flussrichtung
abwarts liegende Ventil und danach das in Flussrichtung aufwarts liegende Ventil
schlieBen (falls verfligbar).

d. Stellen Sie sicher, dass der Sensor abgesperrt ist, kein Durchfluss mehr
vorhanden ist und der Sensor vollstandig mit dem Prozessmedium gefdillt ist.

e. Beobachten Sie die Werte fiir Antriebsverstarkung, Temperatur und Dichte. Sind
diese stabil, priifen Sie den Wert Live Zero oder Field Verification Zero. Wenn der
Mittelwert nahe bei 0 liegt, muss der Nullpunkt des Durchflussmesssystems
nicht kalibriert werden.

Wiéhlen Sie ProLink > Calibration > Zero Verification and Calibration.

Klicken Sie auf Calibrate Zero.

Andern Sie Zero Time falls gewiinscht.

Unter Zero Time versteht man die Zeit, die der Auswerteelektronik vorgegeben wird,
um den Referenzpunkt bei einem Durchfluss von Null zu bestimmen. Die

voreingestellte Zero Time betrdgt 20 Sekunden. Fiir die meisten Anwendungen ist die
voreingestellte Zero Time ausreichend.

Klicken Sie auf Perform Auto Zero.
Die Anzeige Calibration in Progress leuchtet wahrend der Nullpunktkalibrierung rot.
Am Ende des Verfahrens:

* Wenn die Nullpunktkalibrierung erfolgreich war, leuchtet die Anzeige Calibration
in Progress wieder griin und ein neuer Nullpunktwert wird angezeigt.

* Wenn die Kalibrierung fehlgeschlagen ist, leuchtet die Anzeige Calibration Failure
rot.

Nachbereitungsverfahren

Offnen Sie die Ventile, um den normalen Durchfluss durch den Sensor wieder herzustellen.

Benotigen Sie Hilfe? Wenn die Nullpunktkalibrierung fehlschlégt:

Stellen Sie sicher, dass kein Durchfluss durch den Sensor erfolgt und wiederholen Sie das
Verfahren.

Entfernen oder reduzieren Sie elektromagnetisches Rauschen und wiederholen Sie das
Verfahren.

Setzen Sie Zero Time auf einen niedrigeren Wert und wiederholen Sie das Verfahren.

Sollte eine Nullpunktkalibrierung weiterhin nicht méglich sein, wenden Sie sich an
Micro Motion.

Wenn das Durchflussmesssystem mit einem zuvor verwendeten Nullpunktwert wiederin
Betrieb genommen werden soll:

- Wiederherstellen des werksseitig eingestellten Nullpunktwertes: ProLink > Zero Verification
and Calibration > Calibrate Zero > Restore Factory Zero .Diese Funktion erfordert den Core
Prozessor mit erweiterter Funktionalitat.
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- Wiederherstellen des zuletzt giiltigen Nullpunktwertes vom Speicher der
Auswerteelektronik: ProLink > Zero Verification and Calibration > Calibrate Zero > Restore Prior
Zero . Restore Prior Zero ist nur dann verfiigbar, wenn das Fenster Flow Calibration angezeigt
wird. Wenn das Fenster Flow Calibration geschlossen wird, kann der vorige Nullpunktwert
nicht mehr wiederhergestellt werden.

Einschrankung

Den werksseitigen Nullpunkt nur dann wiederherstellen, wenn das Durchflussmesssystem als eine
Einheit erworben wurde, der Nullpunkt im Werk kalibriert wurde und die Originalteile verwendet
werden.

Nullpunktkalibrierung des Durchflussmesssystems
mittels ProLink Il

Die Nullpunktkalibrierung des Durchflussmesssystems etabliert einen Basiswert fiir die
Prozessmessung, indem der Sensorausgang analysiert wird, wenn kein Durchfluss im
Messrohr vorhanden ist.

Vorbereitungsverfahren
ProLink Il muss laufen und muss mit der Auswerteelektronik verbunden sein.
Verfahren
1. Vorbereiten des Durchflussmesssystems:
a. Lassen Sie das Durchflussmesssystem nach dem Einschalten mindestens

20 Minuten aufwdarmen.

b. Lassen Sie das Prozessmedium durch den Sensor stromen, bis die
Sensortemperatur ungefahr die normale Betriebstemperatur erreicht hat.

c. Stoppen Sie den Durchfluss durch den Sensor, indem Sie das in Flussrichtung
abwarts liegende Ventil und danach das in Flussrichtung aufwadrts liegende Ventil
schlieRen (falls verfiigbar).

d. Stellen Sie sicher, dass der Sensor abgesperrt ist, kein Durchfluss mehr
vorhanden ist und der Sensor vollstandig mit dem Prozessmedium gefillt ist.

e. Beobachten Sie die Werte fiir Antriebsverstarkung, Temperatur und Dichte. Sind
diese stabil, priifen Sie den Wert Live Zero oder Field Verification Zero. Wenn der
Mittelwert nahe bei 0 liegt, muss der Nullpunkt des Durchflussmesssystems
nicht kalibriert werden.

Wiéhlen Sie Device Tools > Calibration > Zero Verification and Calibration.

Klicken Sie auf Calibrate Zero.

Andern Sie Zero Time falls gewiinscht.

Unter Zero Time versteht man die Zeit, die der Auswerteelektronik vorgegeben wird,
um den Referenzpunkt bei einem Durchfluss von Null zu bestimmen. Die

voreingestellte Zero Time betrdgt 20 Sekunden. Fiir die meisten Anwendungen ist die
voreingestellte Zero Time ausreichend.

5. Klicken Sie auf Calibrate Zero.
Die Meldung Calibration in Progress wird angezeigt. Wenn die Kalibrierung
abgeschlossen ist:

*  Wenn die Nullpunktkalibrierung erfolgreich war, wird die Meldung Calibration
Success angezeigt und ein neuer Nullpunktwert wird angezeigt.
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» Wenn die Nullpunktkalibrierung fehlgeschlagen ist, wird die Meldung Calibration
Failed angezeigt.

Nachbereitungsverfahren

Offnen Sie die Ventile, um den normalen Durchfluss durch den Sensor wieder herzustellen.

Bendétigen Sie Hilfe? Wenn die Nullpunktkalibrierung fehlschlagt:

. Stellen Sie sicher, dass kein Durchfluss durch den Sensor erfolgt und wiederholen Sie das
Verfahren.

. Entfernen oder reduzieren Sie elektromagnetisches Rauschen und wiederholen Sie das
Verfahren.

. Setzen Sie Zero Time auf einen niedrigeren Wert und wiederholen Sie das Verfahren.

. Sollte eine Nullpunktkalibrierung weiterhin nicht moglich sein, wenden Sie sich an

Micro Motion.

. Wenn das Durchflussmesssystem mit einem zuvor verwendeten Nullpunktwert wieder in
Betrieb genommen werden soll:

- Wiederherstellen des werksseitig eingestellten Nullpunktwertes: Device Tools > Zero
Verification and Calibration > Calibrate Zero > Restore Factory Zero . Diese Funktion erfordert den
Core Prozessor mit erweiterter Funktionalitat.

- Wiederherstellen des zuletzt giiltigen Nullpunktwertes vom Speicher der
Auswerteelektronik: Device Tools > Zero Verification and Calibration > Calibrate Zero > Restore Prior
Zero . Restore Prior Zero ist nur dann verfiigbar, wenn das Fenster Flow Calibration angezeigt
wird. Wenn das Fenster Flow Calibration geschlossen wird, kann der vorige Nullpunktwert
nicht mehr wiederhergestellt werden.

Einschrankung

Den werksseitigen Nullpunkt nur dann wiederherstellen, wenn das Durchflussmesssystem als eine
Einheit erworben wurde, der Nullpunkt im Werk kalibriert wurde und die Originalteile verwendet
werden.

11.3.4 Nullpunktkalibrierung des Durchflussmesssystems
mittels Handterminal

Die Nullpunktkalibrierung des Durchflussmesssystems etabliert einen Basiswert fiir die
Prozessmessung, indem der Sensorausgang analysiert wird, wenn kein Durchfluss im
Messrohr vorhanden ist.

1. Vorbereiten des Durchflussmesssystems:
a. Lassen Sie das Durchflussmesssystem nach dem Einschalten mindestens
20 Minuten aufwdrmen.

b. Lassen Sie das Prozessmedium durch den Sensor stromen, bis die
Sensortemperatur ungefahr die normale Betriebstemperatur erreicht hat.

c. Stoppen Sie den Durchfluss durch den Sensor, indem Sie das in Flussrichtung
abwarts liegende Ventil und danach das in Flussrichtung aufwadrts liegende Ventil
schlieRen (falls verfiigbar).

d. Stellen Sie sicher, dass der Sensor abgesperrt ist, kein Durchfluss mehr
vorhanden ist und der Sensor vollstandig mit dem Prozessmedium gefillt ist.
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e. Beobachten Sie die Werte flir Antriebsverstdrkung, Temperatur und Dichte. Sind
diese stabil, priifen Sie den Wert Live Zero oder Field Verification Zero. Wenn der
Mittelwert nahe bei 0 liegt, muss der Nullpunkt des Durchflussmesssystems
nicht kalibriert werden.

Driicken Sie Service Tools > Maintenance > Zero Calibration > Perform Auto Zero.

Andern Sie Zero Time falls gewiinscht.

Unter Zero Time versteht man die Zeit, die der Auswerteelektronik vorgegeben wird,
um den Referenzpunkt bei einem Durchfluss von Null zu bestimmen. Die

voreingestellte Zero Time betrdgt 20 Sekunden. Fiir die meisten Anwendungen ist die
voreingestellte Zero Time ausreichend.

4, Driicken Sie OK, um die Nullpunktkalibrierung zu starten, und warten Sie, bis die
Kalibrierung abgeschlossen ist.

5. Nach der Nullpunktkalibrierung werden die Daten angezeigt.

 Driicken Sie OK, um die Daten zu akzeptieren und die Werte zu speichern.

 Driicken Sie ABORT, um die Daten zu verwerfen und die vorigen Nullpunktdaten
zu verwenden.

Nachbereitungsverfahren

Offnen Sie die Ventile, um den normalen Durchfluss durch den Sensor wieder herzustellen.

Benotigen Sie Hilfe? Wenn die Nullpunktkalibrierung fehlschlégt:

. Stellen Sie sicher, dass kein Durchfluss durch den Sensor erfolgt und wiederholen Sie das
Verfahren.

. Entfernen oder reduzieren Sie elektromagnetisches Rauschen und wiederholen Sie das
Verfahren.

. Setzen Sie Zero Time auf einen niedrigeren Wert und wiederholen Sie das Verfahren.

. Sollte eine Nullpunktkalibrierung weiterhin nicht méglich sein, wenden Sie sich an

Micro Motion.

. Wenn das Durchflussmesssystem mit einem zuvor verwendeten Nullpunktwert wiederin
Betrieb genommen werden soll:

- Wiederherstellen des werksseitig eingestellten Nullpunktwertes: Service Tools > Maintenance
> Zero Calibration > Restore Factory Zero . Diese Funktion erfordert den Core Prozessor mit
erweiterter Funktionalitdt.

Einschrdankung

Den werksseitigen Nullpunkt nur dann wiederherstellen, wenn das Durchflussmesssystem als eine
Einheit erworben wurde, der Nullpunkt im Werk kalibriert wurde und die Originalteile verwendet
werden.
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11.4 Messsystem validieren
ProLink Il ProLink > Configuration > Flow
ProLink Il Device Tools > Configuration > Process Measurement > Flow

Device Tools > Configuration > Process Measurement > Density

Handterminal Configure > Manual Setup > Measurements > Flow

Configure > Manual Setup > Measurements > Density

Uberblick

Die Systemvalidierung vergleicht die von der Auswerteelektronik ausgegebenen
Messwerte des Durchflussmessgerdts mit einem externen Messnormal. Weicht der von
der Auswerteelektronik ausgegebene Massdurchfluss-, Volumendurchfluss- oder
Dichtemesswert signifikant vom externen Messnormal ab, sollte der entsprechende
Geratefaktor gesetzt werden. Der tatsachliche Messwert des Durchflussmessgerats wird
mit dem Gerétefaktor multipliziert und der resultierende Wert wird ausgegeben und fiir
die weitere Verarbeitung verwendet.

Vorbereitungsverfahren

Identifizieren Sie den/die Geratefaktor(en), den/die Sie berechnen und setzen werden. Sie
kénnen jede Kombination der drei Geratefaktoren setzen: Massedurchfluss,
Volumendurchfluss und Dichte. Beachten Sie, dass alle drei Geratefaktoren unabhdngig

sind:

o Der Geratefaktor fiir Massedurchfluss beeinflusst nur den ausgegebenen Wert des
Massedurchflusses.

. Der Gerdtefaktor flir Dichte beeinflusst nur den ausgegebenen Wert der Dichte.

. Der Geratefaktor fiir Volumendurchfluss beeinflusst nur den ausgegebenen Wert
des Volumendurchflusses oder des Gas Standard Volumendurchflusses.

Wichtig

Zum Justieren des Volumendurchflusses ist der Geratefaktor fiir Volumendurchfluss zu setzen. Das
Setzen des Gerdtefaktors fiir Massedurchfluss und des Geratefaktors fir Dichte erzeugt nicht das
gewl(inschte Ergebnis. Die Berechnung des Volumendurchflusses basiert auf den originalen
Massedurchfluss- und Dichtewerten, bevor der entsprechende Geratefaktor angewendet wird.

Wenn Sie vorhaben, den Gerdtefaktor des Volumendurchflusses zu berechnen, sollten Sie
beachten, dass das Validieren des Volumens in der Anlage kostspielig sein kann. Dieser
Vorgang kann bei manchen Prozessmedien auRerdem gefdhrlich sein. Da das Volumen
umgekehrt proportional zur Dichte ist, ist die Berechnung des Gerdtefaktors fiir
Volumendurchfluss von dem Gerdtefaktor fiir Dichte eine alternative zur direkten
Messung. Anweisungen fiir diese Methode finden Sie in Abschnitt Abschnitt 11.4.1.

Stellen Sie ein Referenzgerdt (ein externes Messgerdt) fiir die entsprechende
Prozessvariable bereit.

Wichtig
Das Referenzgerdt muss duRerst genau sein, um zuverldssige Ergebnisse zu erzielen.
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Verfahren
1. Bestimmen Sie den Gerdtefaktor wie folgt:

a. Nehmen Sie eine Probemessung mit dem Durchflussmessgerdt vor.
b. Messen Sie die gleiche Probe mit dem Referenzgerit.
c. Berechnen Sie den Geratefaktor mit folgender Formel:

Referenzmessung

NeuerGeratefaktor = KonfigurierterGeratefaktor x
Durchfluss-MesssystemMessung

2. Stellen Sie sicher, dass der berechnete Gerdtefaktor zwischen 0,8 und 1,2 liegt
(inklusive). Wenn der Gerdtefaktor auerhalb dieser Grenzen liegt, setzen Sie sich
mit dem Micro Motion Kundenservice in Verbindung.

3. Konfigurieren Sie den Gerdtefaktor in der Auswerteelektronik.

Beispiel: Gerdtefaktor fiir Massedurchfluss berechnen

Das Durchflussmesssystem wird zum ersten Mal installiert und verifiziert. Der von der
Auswerteelektronik gemessene Massedurchfluss betrdgt 250,27 Ib. Der vom
Referenzgerdt gemessene Massedurchfluss betrdgt 250 Ib. Der Geratefaktor fiir
Massedurchfluss wird wie folgt berechnet:

Geratefaktormassedure _ 1 x i = 0,9989

hfluss 250 27

Der erste Geratefaktor fiir Massedurchfluss ist 0,9989.

Ein Jahr spater wird das Durchflussmesssystem erneut validiert. Der von der
Auswerteelektronik gemessene Massedurchfluss betragt 250,07 Ib. Der vom
Referenzgerdt gemessene Massedurchfluss betrdgt 250,25 Ib. Der neue Gerdtefaktor fiir
Massedurchfluss wird wie folgt berechnet:

atefakt
Geréitefaktormassedure _ 0.0989 X 250,25 _ 0,9996

hfluss 250’07

Der neue Geratefaktor fiir Massedurchfluss ist 0.9996.

Alternative Methode fiir die Berechnung des
Geratefaktors fiir Volumendurchfluss

Die alternative Methode fiir die Berechnung des Gerdtefaktors fiir Volumendurchfluss wird
verwendet, um die Schwierigkeiten zu vermeiden, die bei Verwendung der
Standardmethode auftreten kdnnen.

Diese alternative Methode basiert auf der Tatsache, dass das Volumen umgekehrt
proportional zur Dichte ist. Sie bietet eine Teilkorrektur der Volumendurchflussmessung
durch Justierung des Anteils des Gesamt Offsets, der durch den Offset der Dichtemessung
begriindet ist. Verwenden Sie diese Methode nur dann, wenn keine Referenz fiir den
Volumendurchfluss verfiigbar ist, jedoch eine Referenz fiir die Dichte.
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Verfahren
1. Berechnen Sie den Gerdtefaktor fiir Dichte unter Verwendung der
Standardmethode (siehe Validate the meter).
2. Berechnen Sie den Geratefaktor fiir Volumendurchfluss vom Geratefaktor fiir die
Dichte:
. 1
Geratefaktorvolumen =
Geratefaktorpichte
Anmerkung

Die folgende Gleichung ist mathematisch dquivalent zur ersten Gleichung. Sie kénnen die
Gleichung verwenden, die Sie bevorzugen.

. . . . Dichtepurchfluss-Messsystem
Geratefaktorvoumen = KonfigurierterGeratefaktorpichte X d

Dichte Referenzgeréat

3. Stellen Sie sicher, dass der berechnete Geratefaktor zwischen 0,8 und 1,2 liegt
(inklusive). Wenn der Geratefaktor auRerhalb dieser Grenzen liegt, setzen Sie sich
mit dem Micro Motion Kundenservice in Verbindung.

4.  Konfigurieren Sie den Gerdtefaktor fir Volumendurchfluss in der
Auswerteelektronik.

11.5 (Standard) D1 und D2 Dichtekalibrierung
durchfiihren

Mittels der Dichtekalibrierung wird das Verhaltnis zwischen der Mediumsdichte bei
Dichtekalibrierung und dem vom Sensor erzeugten Signal ermittelt. Die
Dichtekalibrierung umfasst das Kalibrieren der Kalibrierpunkte D1 (niedrige Dichte) und
D2 (hohe Dichte).

Wichtig

Micro Motion Auswerteelektroniken werden werksseitig kalibriert und miissen normalerweise nicht
vor Ort kalibriert werden. Fiihren Sie eine Kalibrierung des Durchflussmessers nur dann durch, wenn
dies durch gesetzliche Bestimmungen gefordert wird. Wenden Sie sich an Micro Motion, bevor Sie
den Durchflussmesser kalibrieren.

Hinweis

Micro Motion empfiehlt eine Systemvalidierung und die Verwendung von Geratefaktoren anstatt
einer Kalibrierung, um den Durchflussmesser auf ein geeichtes Messnormal abzugleichen oder einen
Messfehler zu korrigieren.
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Durchfiihren einer D1- und D2-Dichtekalibrierung
mittels ProLink Il

Vorbereitungsverfahren

Wahrend der Dichtekalibrierung muss der Sensor komplett mit dem
Kalibriermedium gefiillt sein und der Durchfluss durch den Sensor muss so klein
sein, wie es lhre Anwendung ermdglicht. Dies wird normalerweise durch SchlieRen
des auslaufseitig vom Sensor befindlichen Absperrventils erreicht. AnschlieRend
fillen Sie den Sensor mit dem entsprechenden Medium.

Die D1 und D2 Dichtekalibrierung erfordert ein D1 Medium (niedrige Dichte) und
ein D2 Medium (hohe Dichte). Hierfiir kdnnen Sie Luft und Wasser nehmen.

Wenn LD Optimization in Ihrem System aktiviert ist, deaktivieren Sie diese Funktion.
Hierzu wahlen Sie ProLink > Configuration > Sensor und stellen sicher, dass das
Kontrollkdstchen nicht markiert ist. Die Funktion LD Optimization wird nur mit groRen
Sensoren in Kohlenwasserstoffanwendungen verwendet. In einigen Installationen
hat nur der Micro Motion Kundendienst Zugriff auf diesen Parameter. Verstdndigen
Sie in diesem Fall Micro Motion, bevor Sie fortfahren.

Die Kalibrierverfahren miissen ohne Unterbrechung in der gezeigten Reihenfolge
durchgefiihrt werden. Stellen Sie sicher, dass Sie das Verfahren ohne
Unterbrechungen abschlieRen kénnen.

Bevor Sie die Kalibrierung durchfiihren, notieren Sie die aktuellen
Kalibrierparameter. Sie konnen dies tun, in dem Sie die aktuelle Konfiguration als
Datei auf dem PC speichern. Sollte die Kalibrierung fehlschlagen, konnen die alten
Werte zuriickgespeichert werden.

Einschrdankung

Bei Sensoren der T-Serie muss die D1-Kalibrierung mit Luft und die D2-Kalibrierung mit Wasser
durchgefihrt werden.

Verfahren

Siehe Abbildung 11-1.
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Abbildung 11-1: D1- und D2-Dichtekalibrierung mittels ProLink Il

D1 D2
Kalibrierung Kalibrierung
Absperrventil schliessen, .| Sensor mit D1 Medium .| Sensor mit D2 Medium
auslaufseitig vom Sensor g fiillen 7 fillen
A 4 ) 4
ProLink Menu > ProLink Menii >
Calibration > Calibration >
Density cal — Point 1 Density cal — Point 2
) 4 ) 4
Dichte des D1 Mediums Dichte des D2 Mediums
eingeben eingeben
[Kalibrierung austhren] [Kalibrierung austhren]
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Nachbereitungsverfahren

Wenn Sie die Funktion LD Optimization vor dem Kalibrierverfahren deaktiviert haben,
aktivieren Sie diese wieder.

11.5.2 Durchfiihren einer D1- und D2-Dichtekalibrierung
mittels ProLink Il

Vorbereitungsverfahren

o Wiéhrend der Dichtekalibrierung muss der Sensor komplett mit dem
Kalibriermedium gefiillt sein und der Durchfluss durch den Sensor muss so klein
sein, wie es lhre Anwendung ermdglicht. Dies wird normalerweise durch SchlieBen
des auslaufseitig vom Sensor befindlichen Absperrventils erreicht. AnschlieRend
fiillen Sie den Sensor mit dem entsprechenden Medium.

. Die D1 und D2 Dichtekalibrierung erfordert ein D1 Medium (niedrige Dichte) und
ein D2 Medium (hohe Dichte). Hierflir kdnnen Sie Luft und Wasser nehmen.

. Wenn LD Optimization in Ihrem System aktiviert ist, deaktivieren Sie diese Funktion.
Hierzu wahlen Sie Device Tools > Configuration > LD Optimization. Die Funktion LD
Optimization wird nur mit groRen Sensoren in Kohlenwasserstoffanwendungen
verwendet. In einigen Installationen hat nur der Micro Motion Kundendienst Zugriff
auf diesen Parameter. Verstandigen Sie in diesem Fall Micro Motion, bevor Sie
fortfahren.
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. Die Kalibrierverfahren miissen ohne Unterbrechung in der gezeigten Reihenfolge
durchgefiihrt werden. Stellen Sie sicher, dass Sie das Verfahren ohne
Unterbrechungen abschlieBen kdnnen.

. Bevor Sie die Kalibrierung durchfiihren, notieren Sie die aktuellen
Kalibrierparameter. Sie konnen dies tun, in dem Sie die aktuelle Konfiguration als
Datei auf dem PC speichern. Sollte die Kalibrierung fehlschlagen, kénnen die alten
Werte zuriickgespeichert werden.

Einschrdankung

Bei Sensoren der T-Serie muss die D1-Kalibrierung mit Luft und die D2-Kalibrierung mit Wasser
durchgefiihrt werden.

Verfahren

Siehe Abbildung 11-2.

Abbildung 11-2: D1- und D2-Dichtekalibrierung mittels ProLink Il

Absperrventil schliessen,
auslaufseitig vom Sensor

D1 D2
Kalibrierung b Kalibrierung
Sensor mit D1 Medium | Sensor mit D2 Medium
fiillen g fiillen
Device Tools > Device Tools >
Calibration > Calibration >
Density Calibration > Density Calibration >
Density Calibration — Point 1 (Air) Density Calibration — Point 2 (Water)
Dichte des D1 Mediums Dichte des D2 Mediums
eingeben eingeben
Schliessen Schliessen
\ 4 l
Fertig

Nachbereitungsverfahren

Wenn Sie die Funktion LD Optimization vor dem Kalibrierverfahren deaktiviert haben,
aktivieren Sie diese wieder.
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11.5.3 D1- und D2-Dichtekalibrierung durchfiihren mittels
Handterminal

Vorbereitungsverfahren

. Wahrend der Dichtekalibrierung muss der Sensor komplett mit dem
Kalibriermedium gefiillt sein und der Durchfluss durch den Sensor muss so klein
sein, wie es lhre Anwendung ermdglicht. Dies wird normalerweise durch SchlieRen
des auslaufseitig vom Sensor befindlichen Absperrventils erreicht. AnschlieRend
fullen Sie den Sensor mit dem entsprechenden Medium.

. Die D1 und D2 Dichtekalibrierung erfordert ein D1 Medium (niedrige Dichte) und
ein D2 Medium (hohe Dichte). Hierfiir kdnnen Sie Luft und Wasser nehmen.

. Wenn LD Optimization in Ihrem System aktiviert ist, deaktivieren Sie diese Funktion.
Hierzu wahlen Sie Configure > Manual Setup > Measurements > LD Optimization. Die Funktion
LD Optimization wird nur mit groBen Sensoren in Kohlenwasserstoffanwendungen
verwendet. In einigen Installationen hat nur der Micro Motion Kundendienst Zugriff
auf diesen Parameter. Verstandigen Sie in diesem Fall Micro Motion, bevor Sie
fortfahren.

o Die Kalibrierverfahren miissen ohne Unterbrechung in der gezeigten Reihenfolge
durchgefiihrt werden. Stellen Sie sicher, dass Sie das Verfahren ohne
Unterbrechungen abschlieRen kénnen.

. Bevor Sie die Kalibrierung durchfiihren, notieren Sie die aktuellen
Kalibrierparameter. Sollte die Kalibrierung fehlschlagen, kénnen die alten Werte
zuriickgespeichert werden.

Einschrdankung

Bei Sensoren der T-Serie muss die D1-Kalibrierung mit Luft und die D2-Kalibrierung mit Wasser
durchgefiihrt werden.

Verfahren

Siehe Abbildung 11-3.

Konfigurations- und Bedienungsanleitung 171



Messunterstitzung

Abbildung 11-3: D1- und D2-Dichtekalibrierung mittels Handterminal
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Nachbereitungsverfahren

Wenn Sie die Funktion LD Optimization vor dem Kalibrierverfahren deaktiviert haben,

aktivieren Sie diese wieder.

11.6

Bei T-Serie Sensoren kann die optionale D3 und D4 Kalibrierung moglicherweise die
Genauigkeit der Dichtemessung verbessern, wenn die Dichte des Prozessmediums
niedriger als 0,8 g/cm?3 oder hoher als 1,2 g/cm?3 ist.

Bei der Durchfiihrung der D3 und D4 Kalibrierung ist Folgendes zu beachten:
. Fiihren Sie keine D1 und D2 Kalibrierung durch.

. Fiihren Sie die D3 Kalibrierung durch, wenn Sie (iber ein kalibriertes Medium
verfligen.
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D3 und D4 Dichtekalibrierung durchfiihren
(nur T-Serie Sensoren)
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. Fiihren Sie sowohl die D3 als auch die D4 Kalibrierung durch, wenn Sie {iber zwei
kalibrierte Medien verfligen (andere als Luft und Wasser). Die Kalibrierverfahren
miissen ohne Unterbrechung in der gezeigten Reihenfolge durchgefiihrt werden.
Stellen Sie sicher, dass Sie das Verfahren ohne Unterbrechungen abschlieRen
kénnen.

11.6.1 Durchfiihren einer D3- oder D4-Dichtekalibrierung
mittels ProLink Il

Vorbereitungsverfahren

. Wahrend der Dichtekalibrierung muss der Sensor komplett mit dem
Kalibriermedium gefiillt sein und der Durchfluss durch den Sensor muss so klein
sein, wie es lhre Anwendung ermdglicht. Dies wird normalerweise durch SchlieRen
des auslaufseitig vom Sensor befindlichen Absperrventils erreicht. AnschlieRend
fiillen Sie den Sensor mit dem entsprechenden Medium.

o Fir die D3-Dichtekalibrierung muss das Medium folgenden Anforderungen
entsprechen:

- Min. Dichte von 0,6 g/cm?3

- Min. Dichteabweichung von 0,1 g/cm?3 zwischen D3-Medium und Wasser. Die
Dichte des D3-Mediums kann héher oder niedriger als die Dichte des Wassers
sein.

. Fir die D4-Dichtekalibrierung muss das Medium folgenden Anforderungen
entsprechen:

- Min. Dichte von 0,6 g/cm?

- Min. Dichteabweichung von 0,1 g/cm?3 zwischen D4-Medium und D3-Medium.
Die Dichte des D4-Mediums muss hoher sein als die Dichte des D3-Mediums.

- Min. Dichteabweichung von 0,1 g/cm?3 zwischen D4-Medium und Wasser. Die
Dichte des D4-Mediums kann hoher oder niedriger als die Dichte von Wasser
sein.

. Bevor Sie die Kalibrierung durchfiihren, notieren Sie die aktuellen
Kalibrierparameter. Sie konnen dies tun, in dem Sie die aktuelle Konfiguration als
Datei auf dem PC speichern. Sollte die Kalibrierung fehlschlagen, konnen die alten
Werte zuriickgespeichert werden.

Verfahren

Siehe Abbildung 11-4.
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Abbildung 11-4: D3- oder D3- und D4-Dichtekalibrierung mittels ProLink II
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[Kalibrierung ausﬁ]hren] [Kalibrierung ausfﬂhren]
Kalibrierung lauft LED Calibration in Progress
wechselt auf rot LED wechselt auf rot
Calibration in Progress LED Calibration in Progress LED
wechselt auf griin wechselt auf griin
Schliessen
L Schliessen
I
4 Y
Fertig Fertig

11.6.2
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Durchfiihren einer D3- oder einer D3- und D4-
Dichtekalibrierung mittels ProLink Il

Vorbereitungsverfahren

Wahrend der Dichtekalibrierung muss der Sensor komplett mit dem
Kalibriermedium gefiillt sein und der Durchfluss durch den Sensor muss so klein
sein, wie es lhre Anwendung ermdglicht. Dies wird normalerweise durch SchlieRen
des auslaufseitig vom Sensor befindlichen Absperrventils erreicht. AnschlieRend
fullen Sie den Sensor mit dem entsprechenden Medium.

Fiir die D3-Dichtekalibrierung muss das Medium folgenden Anforderungen
entsprechen:

- Min. Dichte von 0,6 g/cm?

- Min. Dichteabweichung von 0,1 g/cm?3 zwischen D3-Medium und Wasser. Die
Dichte des D3-Mediums kann héher oder niedriger als die Dichte des Wassers
sein.

Fiir die D4-Dichtekalibrierung muss das Medium folgenden Anforderungen
entsprechen:

- Min. Dichte von 0,6 g/cm?3

- Min. Dichteabweichung von 0,1 g/cm? zwischen D4-Medium und D3-Medium.
Die Dichte des D4-Mediums muss héher sein als die Dichte des D3-Mediums.
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- Min. Dichteabweichung von 0,1 g/cm?3 zwischen D4-Medium und Wasser. Die

Dichte des D4-Mediums kann héher oder niedriger als die Dichte von Wasser
sein.

Bevor Sie die Kalibrierung durchfiihren, notieren Sie die aktuellen
Kalibrierparameter. Sie konnen dies tun, in dem Sie die aktuelle Konfiguration als

Datei auf dem PC speichern. Sollte die Kalibrierung fehlschlagen, konnen die alten
Werte zuriickgespeichert werden.

Verfahren

Siehe Abbildung 11-5.

Abbildung 11-5: D3- oder D3- und D4-Dichtekalibrierung mittels ProLink Ill
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11.6.3

Konfigurations- und Bedienungsanleitung

Durchfiihren einer D3- oder einer D3- und D4-
Dichtekalibrierung mittels Handterminal

Vorbereitungsverfahren

Wahrend der Dichtekalibrierung muss der Sensor komplett mit dem
Kalibriermedium gefiillt sein und der Durchfluss durch den Sensor muss so klein
sein, wie es lhre Anwendung ermdglicht. Dies wird normalerweise durch SchlieRen
des auslaufseitig vom Sensor befindlichen Absperrventils erreicht. AnschlieRend
fillen Sie den Sensor mit dem entsprechenden Medium.

Fiir die D3-Dichtekalibrierung muss das Medium folgenden Anforderungen
entsprechen:

- Min. Dichte von 0,6 g/cm?
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- Min. Dichteabweichung von 0,1 g/cm?3 zwischen D3-Medium und Wasser. Die
Dichte des D3-Mediums kann hoher oder niedriger als die Dichte des Wassers
sein.

Fiir die D4-Dichtekalibrierung muss das Medium folgenden Anforderungen
entsprechen:

- Min. Dichte von 0,6 g/cm?

- Min. Dichteabweichung von 0,1 g/cm? zwischen D4-Medium und D3-Medium.
Die Dichte des D4-Mediums muss hoher sein als die Dichte des D3-Mediums.

- Min. Dichteabweichung von 0,1 g/cm?3 zwischen D4-Medium und Wasser. Die
Dichte des D4-Mediums kann héher oder niedriger als die Dichte von Wasser
sein.

Bevor Sie die Kalibrierung durchfiihren, notieren Sie sich die aktuellen
Kalibrierparameter. Sollte die Kalibrierung fehlschlagen, kénnen die alten Werte
zuriickgespeichert werden.

Verfahren

Siehe Abbildung 11-6.

Abbildung 11-6: D3- oder D3- und D4-Dichtekalibrierung mittels Handterminal
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11.7

11.7.1

Durchfiihren einer Temperaturkalibrierung

Die Temperaturkalibrierung stellt die Beziehung zwischen der Temperatur der
Kalibriermedien und dem vom Sensor erzeugten Signal her.

Durchfiihren einer Temperaturkalibrierung mit ProLink Il

Die Temperaturkalibrierung stellt die Beziehung zwischen der Temperatur der
Kalibriermedien und dem vom Sensor erzeugten Signal her.

Vorbereitungsverfahren

Die Temperaturkalibrierung ist ein zweiteiliges Verfahren: die Kalibrierung des
Temperatur-Offsets und die Kalibrierung der Temperatursteigung Die beiden
Kalibrierverfahren miissen ohne Unterbrechung in der gezeigten Reihenfolge
durchgefiihrt werden. Stellen Sie sicher, dass Sie das Verfahren ohne Unterbrechungen
abschlieBen kdnnen.

Wichtig
Wenden Sie sich an Micro Motion, bevor Sie eine Temperaturkalibrierung durchfiihren. Unter
normalen Umstédnden ist der Temperaturkreis stabil und sollte nicht eingestellt werden mdissen.

Verfahren

Siehe Abbildung 11-7.

Konfigurations- und Bedienungsanleitung
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Abbildung 11-7: Temperaturkalibrierung mit ProLink Il
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Durchfiihren einer Temperaturkalibrierung mit
ProLink Il

Die Temperaturkalibrierung stellt die Beziehung zwischen der Temperatur der
Kalibriermedien und dem vom Sensor erzeugten Signal her.

Vorbereitungsverfahren

Die Temperaturkalibrierung ist ein zweiteiliges Verfahren: die Kalibrierung des
Temperatur-Offsets und die Kalibrierung der Temperatursteigung Die beiden
Kalibrierverfahren miissen ohne Unterbrechung in der gezeigten Reihenfolge

durchgefiihrt werden. Stellen Sie sicher, dass Sie das Verfahren ohne Unterbrechungen

abschlieRen kénnen.

Wichtig

Wenden Sie sich an Micro Motion, bevor Sie eine Temperaturkalibrierung durchfiihren. Unter
normalen Umstanden ist der Temperaturkreis stabil und sollte nicht eingestellt werden miissen.

Verfahren

Siehe Abbildung 11-8.

MicroMotion® Auswerteelektronik Modell 2500 mit konfigurierbaren Ein-/Ausgéngen




Messunterstiitzung

Abbildung 11-8: Temperaturkalibrierung mit ProLink IlI
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180

Storungsanalyse und -behebung

In diesem Kapitel behandelte Themen:

e Status LED-Zustdinde

e StatusAlarme

*  Probleme bei Durchflussmessungen

*  Probleme bei Dichtemessungen

*  Probleme bei der Temperaturmessung

*  Probleme bei mA-Ausgdngen

*  Probleme beim Frequenzausgang

. Stérungen der Bindrausgénge

. Stérungen der Bindreingdnge

*  Verwenden der Sensorsimulation zur Stérungsanalyse und -beseitigung
. Verdrahtung der Spannungsversorgung priifen

e Priifen der Verdrahtung vom Sensor zur Auswerteelektronik
e Erdung (berpriifen

e Messkreistests durchfiihren

*  mAAusgdnge abgleichen

e HART Kommunikationskreis priifen

e Priifen der HART Adresse und des Messkreis Strommodus
*  HART Burst Modus priifen

. Priifen von Messanfang und Messende

. mA Ausgang Stdraktion prifen

e Priifung auf hochfrequente Stérungen (RF)

. Frequenzausgang Modus priifen

. Frequenzausgang max. Impulsbreite prifen

. Frequenzausgang Skaliermethode priifen

. Frequenzausgang Storaktion priifen

. Prtifen der Durchflussrichtung

e Priifen der Abschaltungen

e Priifen auf Schwallstrémung (Zweiphasenstrémung)
e Antriebsverstdrkung priifen

*  Aufnehmerspannung priifen

*  Priifen auf elektrische Kurzschliisse

. Core Prozessor LED priifen.

e (ore Prozessor Widerstandstest durchftihren
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12.1

12.2

Status LED-Zustdande

Die Status-LED an der Auswerteelektronik gibt an, ob ein Alarm aktiv ist. Wenn ein Alarm
aktiv ist, die Alarmliste anzeigen, um die Alarme zu identifizieren und dann die
entsprechenden KorrekturmaBnahmen ergreifen, um die Alarmbedingung zu beheben.

Tabelle 12-1: Status-LED-Zustdnde

LED-Verhalten Alarmbedingung Beschreibung
Griin Kein Alarm Normalbetrieb
Blinkt gelb Kein Alarm Eine Nullpunktkalibrierung l3uft
Gelb Alarm niedriger Stufe | Alarmbedingung, die keine Messfehler verur-
sacht (Ausgdnge geben weiterhin Prozess-
daten aus)
Rot Alarm hoher Stufe Alarmbedingung, die Messfehler verursacht
(Ausgdnge sind gestort)
Status Alarme

Tabelle 12-2: Statusalarme und empfohlene MaRBnahmen

Alarm Code Beschreibung Empfohlene MaRnahmen
A001 EEPROM-Fehler (Core-Prozes- | Die Auswerteelektronik hat ein Problem bei der Kommunikation
sor) mit dem Sensor erkannt. Das Messsystem Aus/Einschalten und
priifen, ob der Zustand sich beheben lasst. Andernfalls muss der
Core Prozessor ausgetauscht werden.
A002 RAM-Fehler (Core-Prozessor) | Die Auswerteelektronik hat ein Problem bei der Kommunikation

mit dem Sensor erkannt. Das Messsystem Aus/Einschalten und
priifen, ob der Zustand sich beheben lasst. Andernfalls muss der
Core Prozessor ausgetauscht werden.

Konfigurations- und Bedienungsanleitung
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Tabelle 12-2: Statusalarme und empfohlene MaBnahmen (Fortsetzung)

Alarm Code Beschreibung Empfohlene MaBnahmen

A003 Keine Antwort vom Sensor Die Auswerteelektronik empfangt keine elektrischen Signale
vom Sensor. Das kann bedeuten, dass die Verdrahtung zwischen
Sensor und Auswerteelektronik beschddigt ist oder dass der Sen-
sorim Werk Gberpriift werden muss.

1. Die Antriebsverstarkung und die Aufnehmerspannung prii-

fen. (Siehe Abschnitt 12.29 und Abschnitt 12.30.)

2. Die Verdrahtung zwischen Sensor und Auswerteelektronik
prifen.

a. Priifen Sie an Hand der Installationsanleitung fiir Ihre
Auswerteelektronik, ob diese entsprechend der Anwei-
sung mit dem Sensor verbunden ist. Beachten Sie beim
Offnen der Anschlussraume alle Sicherheitshinweise.

b. Priifen Sie, ob die Adern guten Kontakt mit den Ans-
chlussklemmen haben.

c. RTD-Widerstdnde und auf Kurzschliisse am Gehduse prii-
fen (siehe Abschnitt 12.31.1).

d. Die Verdrahtung zwischen Auswerteelektronik und Sen-
sor priifen.

3. Aufelektrische Kurzschliisse priifen. Siehe Abschnitt 12.31.
4. Die Unversehrtheit der Sensormessrohre priifen.

A004 Messbereichstiberschreitung ' Der Widerstandsthermometer des Sensors signalisiert einen Wi-
flr Temperatur derstand, der auBerhalb des Betriebsbereichs des Sensors liegt.
1. Die Widerstandsthermometer Widerstandswerte und auf

Widerstandsthermometer Kurzschliisse zum Gehduse tiber-

priifen. (Siehe Abschnitt 12.31.1.)

2. Die Verdrahtung zwischen Sensor und Auswerteelektronik
priifen.

a. Prifen Sie an Hand der Installationsanleitung fir Ihre
Auswerteelektronik, ob diese entsprechend der Anwei-
sung mit dem Sensor verbunden ist. Beachten Sie beim
Offnen der Anschlussraume alle Sicherheitshinweise.

b. Prifen Sie, ob die Adern guten Kontakt mit den Ans-
chlussklemmen haben.

¢. RTD-Widerstande und auf Kurzschliisse am Gehause prii-
fen (siehe Abschnitt 12.31.17).

d. Die Verdrahtung zwischen Auswerteelektronik und Sen-
sor priifen.

3. Die Temperatur-Charakterisierungsparameter (Temperaturkali-
brierfaktor) priifen.

4. Uberpriifen Sie Ihre Prozessbedingungen anhand der vom
Durchflussmesser gemeldeten Werte.
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Tabelle 12-2: Statusalarme und empfohlene MaBnahmen (Fortsetzung)

Alarm Code

Beschreibung

Empfohlene MaBnahmen

A005

Messbereichsiiberschreitung
fiir Massedurchfluss

Der Sensor signalisiert eine Durchfluss, die auRerhalb des Sen-
sorbereichs liegt.

1.

Sind andere Alarme vorhanden, diese Alarmbedingungen
zuerst beheben. Besteht der aktuelle Alarm weiterhin, fahren
Sie mit den Empfehlungen hier fort.

Uberpriifen Sie Ihre Prozessbedingungen anhand der vom

Durchflussmesser gemeldeten Werte.

Auf Schwallstromung (Zweiphasenstromung) priifen.

a. Aufdurch Schwallstrémung ausgeltste Alarme priifen.
Wird das Problem durch Schwallstrdmung verursacht,
werden Alarme ausgegeben.

b. Prozess auf Kavitation, Dampfbildung oder Leckagen
prifen.

c. Die Dichte des Prozessmediumausgangs unter normalen
Prozessbedingungen {iberwachen.

A006

Charakterisierung erforderlich

Die Kalibrierfaktoren fiir den Sensor wurden nicht eingegeben,
der Sensortyp ist falsch oder die Kalibrierfaktoren sind fiir diesen
Sensortyp falsch.

1.

Priifen Sie, ob alle Charakterisierungsparameter den Daten
auf dem Sensor-Tag entsprechen.

Den Widerstand von Adern Langenkompensator (LLC) prii-
fen. (Siehe Abschnitt 12.31.1.)

Den Parameter Sensor Type priifen und sicherstellen, dass
dieser mit dem Sensortyp (ibereinstimmt.

WennSensor Type auf Curved Tube gesetzt ist, sicherstellen,
dass keine der Parameter fiir Geradrohrsensoren gesetzt
worden sind.

Wenn alle Parameter korrekt sind und der Alarm weiterhin
besteht, den Core Prozessor austauschen.
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A008 Dichte Bereichsiiberschreitung | Der Sensor signalisiert einen Dichtewert unter 0 g/cm?3 oder iiber
10 g/cm3. Hiufige Ursachen fiir diesen Alarm sind teilweise ge-
fiillte Messrohre, extreme Gaseinschliisse oder Dampfbildung,
Rohrablagerungen (im Rohr festsitzende Fremdkorper, un-
gleichmaRige Ablagerungen im Rohrinneren oder ein ver-
stopftes Rohr) oder Rohrverformungen (eine permanente Ve-
randerung der Rohrgeometrie verursacht durch Uberdruck oder
Schlageinwirkung).

1. Sind andere Alarme vorhanden, diese Alarmbedingungen
zuerst beheben. Besteht der aktuelle Alarm weiterhin, fahren
Sie mit den Empfehlungen hier fort.

2. Uberpriifen Sie Ihre Prozessbedingungen anhand der vom
Durchflussmesser gemeldeten Werte.

3. Priifen, ob Luftin den Messrohren vorhanden ist, die Mess-
rohre nicht gefillt sind oder sich Fremdkorper oder Ablager-
ungen in den Messrohren befinden.

4. Auf Schwallstromung priifen (zweiphasiger Durchfluss).

a. AufSchwallstromungs-Alarme priifen. Verursacht die
Schallstrémung Probleme, werden Alarme ausgeldst.

b. Prozess auf Kavitation, Dampfbildung oder Leckagen
prifen.

c. Die Dichte Ihres Prozessmediumausgangs unter normal-
en Prozessbedingungen tiberwachen.

d. Die Werte von Schwallstrémungsanfang, Schwallstrdmung-
sende und Schwallstrdmungsdauer priifen.

5. Wenn zusétzlich ein AO03 Alarm besteht, auf elektrische
Kurzschliisse zwischen den Sensor Anschussklemmen und
dem Sensorgehduse priifen.

6. Priifen Sie, ob alle Charakterisierungsparameter den Daten
auf dem Sensor-Tag entsprechen.

7. Die Sensorspulen priifen (siehe Abschnitt 12.31.7).

8. Die Antriebsverstarkung und die Aufnehmerspannung prii-
fen.

9. Dichtekalibrierung durchfiihren.

10. Wenden Sie sich an Micro Motion.

A009 Auswerteelektronik Initialisier- | Die Auswerteelektronik befindet sich im Einschaltmodus. Wart-
ung/Aufwarmphase en Sie die Warmlaufzeit ab. Der Alarm sollte automatisch ge-
|6scht werden.

Wenn der Alarm nicht gel6scht wird:

1. Sicherstellen, dass der Core Prozessor mit ausreichend Span-
nung versorgt wird. Es sollten mindestens 11,5 VDC an den
Anschlussklemmen des Core Prozessors anliegen. Ist die
Spannung, die an den Anschlussklemmen des Core Prozes-
sors anliegt, zu niedrig, priifen, dass die Auswerteelektronik
mit ausreichend Spannung an den Klemmen versorgt wird.

2. Sicherstellen, dass die Messrohre vollstandig mit Prozessme-
dium gefiillt sind.

3. Die Verdrahtung zwischen Sensor und Auswerteelektronik
prifen.
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A010

Kalibrierfehler

Dieser Alarm wird normalerweise ausgeldst, wenn bei der Null-

punktkalibrierung ein Durchfluss im Sensor herrscht oder durch

einen Nullpunkt Offset, die auBerhalb des Bereichs liegt. Die

Auswerteelektronik Aus/Einschalten, um diesen Alarm zu 16-

schen.

1. Die Spannungsversorgung des Messsystems Aus/Einschal-
ten.

2. Sicherstellen, dass kein Durchfluss im Sensor vorhanden ist.

Die Nullpunktkalibrierung wiederholen.

4. Spannungsversorgung der Auswerteelektronik Aus/Einschal-
ten.

w

AO011

Nullpunktkalibrierung fehlges-
chlagen: Tief

Dieser Alarm wird ausgel6st, wenn ein Riickwartsdurchfluss

wahrend der Nullpunktkalibrierung im Sensor vorhanden ist

oder durch einen Nullpunkt Offset, der unterhalb des giltigen

Bereichs liegt. Dieser Alarm tritt zusammen mit A010 auf. Die

Auswerteelektronik muss Aus/Einschalten werden, um diesen

Alarm zu l6schen.

1. Die Spannungsversorgung des Messsystems Aus/Einschal-
ten.

2. Sicherstellen, dass kein Durchfluss im Sensor vorhanden ist.

Die Nullpunktkalibrierung wiederholen.

4. Spannungsversorgung der Auswerteelektronik Aus/Einschal-
ten.

w

A012

Nullpunktkalibrierung fehlges-
chlagen: Hoch

Dieser Alarm wird ausgel6st, wenn ein positiver Durchfluss wah-

rend der Nullpunktkalibrierung im Sensor vorhanden ist oder

durch einen Nullpunkt Offset, die oberhalb des giiltigen Bereichs

liegt. Dieser Alarm tritt zusammen mit A010 auf. Die Auswertee-

lektronik Aus/Einschalten, um diesen Alarm zu I6schen.

1. Die Spannungsversorgung des Messsystems Aus/Ein schal-
ten.

2. Sicherstellen, dass kein Durchfluss im Sensor vorhanden ist.

Die Nullpunktkalibrierung wiederholen.

4. Spannungsversorgung der Auswerteelektronik Aus/Einschal-
ten.

w

A013

Nullpunktkalibrierung fehlges-
chlagen: Instabil

Zu hohe Instabilitdat wahrend der Kalibrierung. Die Auswertee-
lektronik Aus/Einschalten, um diesen Alarm zu I6schen.
1. Elektromechanische Stérungen (z. B. Pumpen, Vibrationen,

Rohrleitungsspannungen) eliminieren bzw. reduzieren.

e Die Antriebsverstdrkung und die Aufnehmerspannung
priifen, um sicherzustellen, dass sich der Sensor in einem
stabilen Zustand befindet.

e Das Verfahren wiederholen.

2. Spannungsversorgung aus-/einschalten und erneut versu-
chen.
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A014 Auswerteelektronikfehler 1. Prifen, dass alle Abdeckungen des Anschlussklemmenge-
hduses ordnungsgemag installiert sind

2. Priifen, dass die an die Auswerteelektronik angeschlossene
Verdrahtung den Spezifikationen entspricht und dass alle Ka-
belabschirmungen ordnungsgemadf aufgelegt sind.

3. Priifen, dass der Sensor und die Auswerteelektronik ord-
nungsgemaf geerdet sind.

4. Die Umgebung auf Quellen mit hoher elektromagnetischer
Storung (EMI) untersuchen und die Auswerteelektronik oder
die Verdrahtung ggf. neu positionieren.

A016 Sensor-RTD-Fehler Der Widerstandsthermometer des Sensors signalisiert einen Wi-

derstand, der auBerhalb des Betriebsbereichs des Sensors liegt.

1. Die Verdrahtung zwischen Sensor und Auswerteelektronik
priifen.

a. Prifen Sie an Hand der Installationsanleitung fir Ihre
Auswerteelektronik, ob diese entsprechend der Anwei-
sung mit dem Sensor verbunden ist. Beachten Sie beim
Offnen der Anschlussraume alle Sicherheitshinweise.

b. Prifen Sie, ob die Adern guten Kontakt mit den Ans-
chlussklemmen haben.

¢. RTD-Widerstande und auf Kurzschliisse am Gehause prii-
fen (siehe Abschnitt 12.31.17).

d. Die Verdrahtung zwischen Auswerteelektronik und Sen-
sor priifen.

2. Uberpriifen Sie Ihre Prozessbedingungen anhand der vom

Durchflussmesser gemeldeten Werte.

3. Wenden Sie sich an Micro Motion.

A017 T-Serien-RTD-Fehler Der Widerstandsthermometer des Sensors signalisiert einen Wi-

derstand, der auBerhalb des Betriebsbereichs des Sensors liegt.

1. Die Verdrahtung zwischen Sensor und Auswerteelektronik
priifen.

a. Prifen Sie an Hand der Installationsanleitung fir Ihre
Auswerteelektronik, ob diese entsprechend der Anwei-
sung mit dem Sensor verbunden ist. Beachten Sie beim
Offnen der Anschlussraume alle Sicherheitshinweise.

b. Prifen Sie, ob die Adern guten Kontakt mit den Ans-
chlussklemmen haben.

¢. RTD-Widerstande und auf Kurzschliisse am Gehause prii-
fen (siehe Abschnitt 12.31.1).

d. Die Verdrahtung zwischen Auswerteelektronik und Sen-
sor priifen.

2. Uberpriifen Sie Ihre Prozessbedingungen anhand der vom
Durchflussmesser gemeldeten Werte. Die Temperatur sollte
zwischen -200 °F und +400 °F liegen.

3. Priifen Sie, ob alle Charakterisierungsparameter den Daten
auf dem Sensor-Tag entsprechen.

4. Wenden Sie sich an Micro Motion.
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A018 EEPROM-Fehler (Auswerteelek- = Die Auswerteelektronik Aus/Einschalten, um diesen Alarm zu |6-
tronik) schen.

1. Priifen, dass alle Abdeckungen des Anschlussklemmenge-
hduses ordnungsgemadR installiert sind

2. Prifen, dass die an die Auswerteelektronik angeschlossene
Verdrahtung den Spezifikationen entspricht und dass alle
Abschirmungen ordnungsgemaR aufgelegt sind.

3. Priifen, dass der Sensor und die Auswerteelektronik ord-
nungsgemaR geerdet sind.

4. Die Umgebung auf Quellen mit hoher elektromagnetischer
Stérung (EMI) untersuchen und die Auswerteelektronik oder
die Verdrahtung ggf. neu positionieren.

5. Die Spannungsversorgung der Auswerteelektronik aus- und
einschalten.

6. Wenn das Problem nicht beseitigt werden kann, die Auswer-
teelektronik austauschen.

A019 RAM-Fehler (Auswerteelektro- | Die Auswerteelektronik Aus/Einschalten, um diesen Alarm zu |6-

nik) schen.

1. Priifen, dass alle Abdeckungen des Anschlussklemmenge-
hduses ordnungsgemaR installiert sind

2. Prifen, dass die an die Auswerteelektronik angeschlossene
Verdrahtung den Spezifikationen entspricht und dass alle
Abschirmungen ordnungsgemaR aufgelegt sind.

3. Priifen, dass der Sensor und die Auswerteelektronik ord-
nungsgemaR geerdet sind.

4. Die Umgebung auf Quellen mit hoher elektromagnetischer
Stérung (EMI) untersuchen und die Auswerteelektronik oder
die Verdrahtung ggf. neu positionieren.

5. Die Spannungsversorgung der Auswerteelektronik Aus/Ein-
schalten

6. Wenn das Problem nicht beseitigt werden kann, die Auswer-
teelektronik austauschen.

A020 K.wrt f. k. Drchflss Der Durchflusskalibrierfaktor und/oder K1 wurden seit dem
letzten Master Reset nicht eingegeben. Priifen Sie, ob alle Char-
akterisierungsparameter den Daten auf dem Sensor-Tag en-
tsprechen. Wenn das Problem weiterhin besteht:

1. Prifen, dass der Sensortyp (gebogen oder gerade) ord-
nungsgemaf ausgewahlt wurde.

2. Uberpriifen, dass keine Kalibrierparameter der T-Serie ge-
setzt wurden, wenn dies ein Sensor mit gebogenem Mess-
rohrist.
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A021

Falscher Sensortyp (K1)

Der Sensor wird als Geradrohr erkannt, aber der K1 Wert deutet
auf einen Sensor mit gebogenem Messrohr hin oder umgekehrt.
Priifen Sie, ob alle Charakterisierungsparameter den Daten auf
dem Sensor-Tag entsprechen. Wenn das Problem weiterhin bes-
teht:

1. Prifen, dass der Sensortyp (gebogen oder gerade) ord-
nungsgemaf ausgewahlt wurde.

2. Uberpriifen, dass keine Kalibrierparameter der T-Serie ge-
setzt wurden, wenn dies ein Sensor mit gebogenem Mess-
rohrist.

3. Wenn dieser Alarm zusammen mit AQ06 auftritt, den Adern
Ldngenkompensator (LLC) Widerstand und auf Kurzschliisse
zum Gehause tberpriifen (Abschnitt 12.31.7).

A022

Konfigurationsdatenbank be-
schadigt (Core-Prozessor)

Priifen Sie durch Aus- und Einschalten der Spannungsversorgung
zum Messsystem, ob der Alarm geléscht wird. Wenn der Alarm
weiterhin besteht, den Core-Prozessor ersetzen.

A023

Interne Zahler beschadigt
(Core-Prozessor)

Priifen Sie durch Aus- und Einschalten der Spannungsversorgung
zum Messsystem, ob der Alarm gel&scht wird. Wenn der Alarm
weiterhin besteht, den Core-Prozessor ersetzen.

A024

Programm beschadigt (Core-
Prozessor)

Priifen Sie durch Aus- und Einschalten der Spannungsversorgung
zum Messsystem, ob der Alarm geldscht wird. Wenn der Alarm
weiterhin besteht, den Core-Prozessor ersetzen.

A025

Bootsektorfehler (Core-Prozes-
sor)

Priifen Sie durch Aus- und Einschalten der Spannungsversorgung
zum Messsystem, ob der Alarm gel6scht wird. Wenn der Alarm
weiterhin besteht, den Core-Prozessor ersetzen.

A026

Sensor-/Auswerteelektronik-
Kommunikationsfehler

Die Auswerteelektronik hat die Kommunikation mit dem Core

Prozessor am Sensor verloren. Dieser Alarm kann auf ein Prob-

lem mit dem Core Prozessor oder mit der Auswerteelektronik

hindeuten und erfordert moglicherweise den Austausch der ei-

nen oder der beiden Komponenten.

1. Die Verdrahtung zwischen Sensor und Auswerteelektronik
priifen.

a. Prifen Sie an Hand der Installationsanleitung fiir Ihre
Auswerteelektronik, ob diese entsprechend der Anwei-
sung mit dem Sensor verbunden ist. Beachten Sie beim
Offnen der Anschlussrdume alle Sicherheitshinweise.

b. Prifen Sie, ob die Adern guten Kontakt mit den Ans-
chlussklemmen haben.

¢. RTD-Widerstande und auf Kurzschliisse am Gehause prii-
fen (siehe Abschnitt 12.31.7).

d. Die Verdrahtung zwischen Auswerteelektronik und Sen-
sor priifen.

2. Core Prozessor LED priifen.
3. Wenn keine definitive KorrekturmaRnahme gefunden wer-
den kann, den Core Prozessor austauschen.

a. Kann das Problem nicht behoben werden, den Original
Core Prozessor wieder installieren und die Auswerteelek-
tronik austauschen.

b. Kann das Problem nicht behoben werden, die Auswer-
teelektronik und den Core Prozessor austauschen.
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A027

SicherheitsverstoR

1. Die ID des HART-Gerdts priifen.

2. Die Gewichts- und Mess-Sicherheitsfunktion der Auswertee-
lektronik ist aktuell auf “unsicher” eingestellt. Stellen Sie die
Auswerteelektronik auf “sicher” ein, um den Alarm zu |6-
schen. Um die Auswerteelektronik wieder zu sichern, kann
ein autorisiertes Verfahren erforderlich sein.

A028

Core-Prozessor-Schreibfehler

Esist ein Fehler in der Elektronik der Auswerteelektronik aufge-
treten. Das Messsystem Aus/Einschalten und priifen, ob der
Alarm gel6scht werden kann. Wenn der Alarm weiterhin bes-
teht, den Core Prozessor austauschen.

A029

PIC/Tochterboard-Kommuni-
kationsfehler

Dies kann ein Hinweis sein, dass die Kommunikation zwischen
Auswerteelektronik und dem Bedieninterfacemodul unterbro-
chen wurde. Das Messsystem Aus/Einschalten und priifen, ob
der Alarm gel6scht werden kann. Falls moglich, das Bedieninter-
facemodul austauschen.

A030

Falscher Platinentyp

Die Firmware oder die in die Auswerteelektronik geladene Konfi-
guration ist inkompatibel mit dem Platinentyp. Wenn dieser
Alarm zusammen mit einem Versuch auftritt, eine Konfiguration
in die Auswerteelektronik zu laden, sicherstellen, dass die Aus-
werteelektronik dieselbe Modellbezeichnung aufweist, wie die,
von der die Konfiguration ibertragen wurde.

Das Messsystem Aus/Einschalten und priifen, ob der Alarm ge-
|6scht werden kann. Wenn das Problem weiterhin besteht, Micro
Motion bzgl. weiterer Hilfe kontaktieren.

A031

Spannung zu niedrig

Der Core Prozessor am Sensor erhdlt zu wenig Spannung. Die
Verdrahtung zwischen Auswerteelektronik und Sensor priifen.
Die Auswerteelektronik muss Aus/Einschalten werden, um die-
sen Alarm zu |6schen.

1. Priifen Sie an Hand der Installationsanleitung fiir lhre Aus-
werteelektronik, ob diese entsprechend der Anweisung mit
dem Sensor verbunden ist. Beachten Sie beim Offnen der
Anschlussraume alle Sicherheitshinweise.

2. Prifen Sie, ob die Adern guten Kontakt mit den Anschluss-
klemmen haben.

3. Die Verdrahtung zwischen Auswerteelektronik und Sensor
priifen.

4. Spannungsversorgung aus-/einschalten und erneut versu-
chen.

5. Die Spannung an den Anschlussklemmen des Core Prozes-
sors priifen. Es missen zu jeder Zeit mindestens 11,5 V anlie-
gen.

a. Liegenwenigerals 11,5V an, sicherstellen, dass die Aus-
werteelektronik mit ausreichend Spannung versorgt
wird. (Weitere Informationen sind in der Installationsan-
leitung zu finden.)

b. Wenn die Auswerteelektronik mit ausreichend Spannung
versorgt wird und das Problem weiterhin besteht, die
Auswerteelektronik austauschen.

A032

Systemverifizierung lauft: Aus-
gange zu Fehler

Systemverifizierung lauft, Ausgdnge sind auf Stérung oder Zuletzt
Gemessener Wert gesetzt.
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A033 Unzureichendes Signal von re- | Das Signal, das von den Sensor Aufnehmerspulen kommt, ist zu

chter/linker Aufnehmerspule | schwach und deutet darauf hin, dass die Messrohre nicht in der

natirlichen Frequenz schwingen kénnen. Dieser Alarm tritt oft
zusammen mit Alarm A102 auf.

1. Auf mogliche Fliissigkeits-Separation priifen, indem der
Dichtewert iberwacht wird und die Ergebnisse mit den er-
warteten Dichtewerten verglichen werden.

2. AufVerstopfung, Ablagerung oder Schwallstromung priifen.

3. Die Beseitigung von einem zweiphasigen oder einem drei-
phasigen Medium kann diesen Alarm, selbst bei voll gefiill-
ten Messrohren, auslésen. Aus diesem Grund muss der Sen-
sor moglicherweise neu ausgerichtet werden. Weitere Infor-
mationen bzgl. Sensorausrichtung sind im Installationshand-
buch zu finden.

A035 Systemverifizierung abgebro- | Die Systemverifizierung konnte nicht erfolgreich abgeschlossen
chen werden, weil sie moglicherweise manuell abgebrochen wurde.
1. Priifen Sie die Prozessbedingungen und fiihren Sie dann den
Test erneut durch.

2. Wenden Sie sich an Micro Motion.

A100 mA-Ausgang 1 gesittigt Der berechnete mA Ausgangswert liegt auRerhalb der konfigur-

ierten Bereichs des Messsystems.

1. Die Parameter Upper Range Value und Lower Range Value pri-
fen. Sind sie korrekt gesetzt?

2. Uberpriifen Sie Ihre Prozessbedingungen anhand der vom
Durchflussmesser gemeldeten Werte.

3. Priifen Sie, ob die Messeinheiten fiir hre Anwendung korrekt
konfiguriert sind.

4. Messrohre spiilen.

5. Die Prozessbedingungen priifen, insbesondere, ob Luft in
den Messrohren vorhanden ist, ob die Messrohre nicht ge-
fllt sind oder ob sich Fremdkorper oder Ablagerungen in
den Messrohren befinden.

A101 mA-Ausgang 1 fest Die konfigurierte HART-Adresse war ungleich Null, oder der mA-
Ausgang wurde zum Senden eines Direktwerts konfiguriert.

1. Priifen Sie, ob der Ausgang im Messkreistest-Modus ist. Sol-
Ite das der Fall sein, den Ausgang l6sen.

2. Abgleich des mA-Ausgangs gegebenenfalls beenden.

Die HART-Abfrageadresse priifen.

4. Priifen Sie, ob der Ausgang (iber die digitale Kommunikation
auf einen konstanten Wert eingestellt wurde.

w
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A102

Antrieb Bereichsiiberschrei-
tung

Die Antriebsleistung (Spannung) hat die Maximalleistung er-
reicht.

1. Die Antriebsverstdrkung und die Aufnehmerspannung prii-
fen.

2. Aufelektrische Kurzschliisse zwischen Sensorklemmen oder
zwischen Sensorklemmen und Sensorgehduse priifen.

3. Auf teilweise gefiillte Messrohre, Rohrablagerungen, besché-
digte Messrohre und extreme Gaseinschliisse oder Dampfbil-
dung priifen.

4. Die Beseitigung von einem zweiphasigen oder einem drei-
phasigen Medium kann diesen Alarm auslésen, selbst wenn
die Messrohre vollstidndig gefiillt sind. Das kann bedeuten,
dass der Sensor neu ausgerichtet werden muss. Weitere In-
formationen bzgl. Sensorausrichtung sind im Installation-
shandbuch zu finden.

A103

Moglicher Datenverlust (Zdhle
und Bestdnde)

r

Die Zdhler werden nicht ordnungsgemaR gespeichert. Der Core

Prozessor konnte die Zahler beim letzten Herunterfahren nicht

speichern und muss zuvor gespeicherte Zdhler verwenden. Die

gespeicherten Zadhler konnen bereits seit zwei Stunden nicht

mehr aktuell sein.

1. Sicherstellen, dass die Auswerteelektronik und der Core Pro-
zessor mit ausreichend Spannung versorgt werden.

2. Die Spannungsversorgung und deren Verdrahtung priifen.

A104

Kalibrierung lauft

Ein Kalibrierverfahren l3uft.

A105

Schwallstrémung

Die Dichte des Prozesses hat die vom Anwender definierten
Dichtegrenzwerte iberschritten. Auf Schwallstrémung (Zwei-
phasenstromung) prifen.

A106

Burst-Betriebsart aktiviert

HART-Burstmodus ist aktiviert.

A107

Spannungsunterbrechung ein-
getreten

Die Auswerteelektronik wurde neu gestartet.

A108

Basisereignis 1 Ein

Keine MaRBnahme erforderlich.

A109

Basisereignis 2 Ein

Keine MaRBnahme erforderlich.

A110

Frequenzausgang gesattigt

Der berechnete Frequenzausgang liegt auRerhalb des konfigur-

ierten Bereichs.

1. Den Parameter Frequency Output Scaling Method priifen.

2. Uberpriifen Sie Ihre Prozessbedingungen anhand der vom
Durchflussmesser gemeldeten Werte.

3. Die Prozessbedingungen priifen, insbesondere, ob Luft in
den Messrohren vorhanden ist, ob die Messrohre nicht ge-
fiillt sind oder ob sich Fremdkorper oder Ablagerungen in
den Messrohren befinden.

4. Priifen Sie, ob die Messeinheiten fiir Ihre Anwendung korrekt

konfiguriert sind.
5. Messrohre spiilen.

Konfigurations- und Bedienungsanleitung
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Stérungsanalyse und -behebung

Tabelle 12-2: Statusalarme und empfohlene MaBnahmen (Fortsetzung)

Alarm Code Beschreibung Empfohlene MaBnahmen
A111 Frequenzausgang fixiert Der Frequenzausgang wurde zum Senden eines Direktwerts kon-
figuriert.

1. Das Anhalten des Zdhlers bewirkt, dass der Frequenzausgang
auf Null gestellt wird. Das Aus/Einschalten der Auswerteelek-
tronik oder das erneute Starten des Zéhlers setzt den Fre-
quenzausgang wieder in den normalen Betrieb zuriick.

2. Prifen Sie, ob der Ausgang im Messkreistest-Modus ist. Sol-
Ite das der Fall sein, den Ausgang l6sen.

3. Priifen Sie, ob der Ausgang (iber die digitale Kommunikation
auf einen konstanten Wert eingestellt wurde.

A112 Auswerteelektronik-Software | Micro Motion kontaktieren.
aktualisieren
A113 mA-Ausgang 2 gesdttigt 1. Uberpriifen Sie lhre Prozessbedingungen anhand der vom
Durchflussmesser gemeldeten Werte.

2. Die Prozessbedingungen priifen, insbesondere, ob Luftin
den Messrohren vorhanden ist, ob die Messrohre nicht ge-
fullt sind oder ob sich Fremdkérper oder Ablagerungen in
den Messrohren befinden.

3. Priifen Sie, ob die Messeinheiten fiir hre Anwendung korrekt
konfiguriert sind.

4. Messrohre spiilen.

5. Die Parameter Upper Range Value und Lower Range Value prii-
fen. Sind sie korrekt gesetzt?

A114 mA-Ausgang 2 fest 1. Priifen Sie, ob der Ausgang im Messkreistest-Modus ist. Sol-
Ite das der Fall sein, den Ausgang lésen.

2. Abgleich des mA-Ausgangs gegebenenfalls beenden.

3. Priifen Sie, ob der Ausgang (iber die digitale Kommunikation
auf einen konstanten Wert eingestellt wurde.

A115 Kein externer Eingang oder ab- = Die HART-Abfrageverbindung zum externen Gerét ist fehlges-
gefragte Daten chlagen. Keine Antwort vom abgefragten Gerat.

1. Den externen Gerdtebetrieb priifen.

2. Verdrahtung zwischen Auswerteelektronik und externem
Gerét prifen.

3. Die HART-Abfragekonfiguration priifen.

A116 Messbereichsiiberschreitung | 1. Uberpriifen Sie lhre Prozessbedingungen anhand der vom
der Temperatur (Mineralol) Durchflussmesser gemeldeten Werte.

2. Die Konfiguration der Mineral6lmessung gemaR der Tabelle
fir Typ und Temperatur priifen.

A117 Messbereichsiiberschreitung | 1. Uberpriifen Sie Ihre Prozessbedingungen anhand der vom
der Dichte (Mineral6l) Durchflussmesser gemeldeten Werte.

2. Die Konfiguration der Mineral6lmessung gemaR der Tabelle
fiir Typ und Dichte priifen.

A118 Bindrer mA Ausgang 1 fix Der Bindrausgang wurde zum Senden eines Direktwerts konfi-
guriert.
A120 Kurvenanpassung fehlgeschla- | Die Konfiguration der Anwendung Konzentrationsmessung prii-
gen (Konzentration) fen.
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Stérungsanalyse und -behebung

Tabelle 12-2: Statusalarme und empfohlene MaBnahmen (Fortsetzung)

Alarm Code Beschreibung Empfohlene MaBnahmen
A121 Extrapolationsalarm (Konzen- | Wenn das Produkt im Sensor Temperatur- bzw. Dichteeigen-
tration) schaften aufweist, die auBerhalb der durch die Konzentration-
smesskurve festgelegten Parameter liegen, liegt hier ein Merk-
mal vor, was jedoch aber keine MaRRnahme erforderlich macht.
Dieser Alarm wird gel6scht, wenn das Prozessmedium wieder in
den Normalbereich zuriickkehrt.
Wenn das Problem weiterhin besteht, die Konfiguration der An-
wendung zur Konzentrationsmessung priifen.
Al131 Systemverifizierung lauft: Aus- | Systemverifizierung lauft, Ausgange sind auf Zuletzt Gemessener
gange auf zuletzt gemessenen | Wert gesetzt.
Wert
A132 Sensorsimulation aktiv Simulationsmodus ist aktiviert.
A133 EEPROM-Fehler (Display) Das Bedieninterfacemodul austauschen. Wenn das Problem wei-
terhin besteht, Micro Motion kontaktieren.
A141 DDC-Trigger abgeschlossen Keine MaBnahme erforderlich.
k.A. Dichte-FD-Kalibrierung lauft Keine MaBnahme erforderlich.
k.A. Dichte-D1-Kalibrierung lauft Keine MaBnahme erforderlich.
k.A. Dichte-D2-Kalibrierung lduft Keine MaBnahme erforderlich.
k.A. Dichte-D3-Kalibrierung lauft Keine MaBnahme erforderlich.
k.A. Dichte-D4-Kalibrierung lduft Keine MaBnahme erforderlich.
k.A. Nullpunktkalibrierung lauft Keine MaRBnahme erforderlich.
k.A. Rickwartsdurchfluss Keine MaRBnahme erforderlich.

12.3

Probleme bei Durchflussmessungen

Tabelle 12-3: Probleme bei Durchflussmessungen und AbhilfemaBnahmen

Problem

Maogliche Ursachen

Empfohlene MaBnahmen

Durchflussrichtung-
sanzeige bei Null-
durchfluss oder Null-
punktverschiebung

bei neuen Installationen)

e Falscher Sensor-Nullpunkt

¢ Nicht fluchtende Rohrleitung (speziell .

¢ Offenes oder undichtes Ventil

Priifen Sie, ob alle Charakterisierungspara-

meter den Daten auf dem Sensor-Tag en-

tsprechen.

¢ Ist der gemessene Durchfluss nicht besond-
ers hoch, die Echtzeit-Nullpunktkalibrierung
prifen. Sie miissen die Werkseinstellung fir
die Nullpunktkalibrierung wiederherstellen.

* Auf offene oder undichte Ventile oder Dich-
tungen priifen.

¢ Den Sensor auf Montagespannungen priifen
(z. B. Sensor zur Abstlitzung von Rohrleitun-
gen, nicht fluchtende Rohrleitungen).

e Wenden Sie sich an Micro Motion.

Konfigurations- und Bedienungsanleitung
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Tabelle 12-3: Probleme bei Durchflussmessungen und AbhilfemaBnahmen (Fortsetzung)

Problem Magliche Ursachen Empfohlene MaBnahmen
Sprunghafter Durch- | ¢ Leckage an Ventil oder Abdichtung e Priifen, ob die Sensor-Einbaulage zu lhrer An-
fluss bei Nulldurch- e Slug flow wendung passt (siehe Sensor-Installationsan-
flussbedingungen e Messrohr verstopft oder beschichtet leitung).
e Falsche Sensor-Einbaulage e Antriebsverstirkung und Aufnehmerspan-
e Verdrahtungsproblem nung priifen. Siehe Antriebsverstdrkung priifen
e Vibrationen der Rohrleitung nahe der und Aufnehmerspannung priifen.
Sensor Messrohrfrequenz e Befindet sich in der Verdrahtung zwischen
e Dampfungswert zu niedrig Sensor und Auswerteelektronik ein 9-Leiter-
e Montagespannungen auf dem Sensor Segment, muss gepriift werden, ob die Schir-

mung des 9-Leiter-Kabel korrekt geerdet ist.

¢ Die Verdrahtung zwischen Sensor und Aus-
werteelektronik priifen. Siehe
Priifen der Verdrahtung vom Sensor zur Aus-
werteelektronik.

e Bei Sensoren mit Anschlusskasten die Feuch-
tigkeit im Anschlusskasten priifen.

e Messrohre spiilen.

* Auf offene oder undichte Ventile oder Dich-
tungen priifen.

¢ Die Ursache der Vibration priifen.

e Die Dampfungskonfiguration priifen.

 Priifen Sie, ob die Messeinheiten fiir hre An-
wendung korrekt konfiguriert sind.

e Auf Schwallstromung priifen. Siehe
Priifen auf Schwallstrémung (Zweiphasenstré-
mung).

e Auf HF-Storungen priifen. Siehe
Priifung auf hochfrequente Stérungen (RFI).

e Wenden Sie sich an Micro Motion.

194 MicroMotion® Auswerteelektronik Modell 2500 mit konfigurierbaren Ein-/Ausgéngen



Stérungsanalyse und -behebung

Tabelle 12-3: Probleme bei Durchflussmessungen und AbhilfemaBnahmen (Fortsetzung)

Empfohlene MaBnahmen

Problem Magliche Ursachen

Sprunghafter Durch- | ¢ Slug flow

fluss bei stabilem e Dampfungswert zu niedrig
Durchfluss e Messrohr verstopft oder beschichtet

e Problem mit der Ausgangsverdrahtung
e Problem mit dem empfangenden Gerat
e Verdrahtungsproblem

Priifen, ob die Sensor-Einbaulage zu Ihrer An-
wendung passt (siehe Sensor-Installationsan-
leitung).

Antriebsverstarkung und Aufnehmerspan-
nung priifen. Siehe Antriebsverstdrkung priifen
und Aufnehmerspannung priifen.

Befindet sich in der Verdrahtung zwischen
Sensor und Auswerteelektronik ein 9-Leiter-
Segment, muss gepriift werden, ob die Schir-
mung des 9-Leiter-Kabel korrekt geerdet ist.
Auf Luftanteile, Verschmutzung, Dampfbil-
dung oder Beschadigung des Messrohres
prifen.

Die Verdrahtung zwischen Sensor und Aus-
werteelektronik priifen. Siehe

Priifen der Verdrahtung vom Sensor zur Aus-
werteelektronik.

Bei Sensoren mit Anschlusskasten die Feuch-
tigkeit im Anschlusskasten priifen.
Messrohre spiilen.

Auf offene oder undichte Ventile oder Dich-
tungen priifen.

Die Ursache der Vibration priifen.

Die Dampfungskonfiguration priifen.

Priifen Sie, ob die Messeinheiten fiir Ihre An-
wendung korrekt konfiguriert sind.

Auf Schwallstrémung priifen. Siehe

Priifen auf Schwallstrémung (Zweiphasenstré-
mung).

Auf HF-Stérungen priifen. Siehe

Priifung auf hochfrequente Stérungen (RFI).
Wenden Sie sich an Micro Motion.

Konfigurations- und Bedienungsanleitung
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Tabelle 12-3: Probleme bei Durchflussmessungen und AbhilfemaBnahmen (Fortsetzung)

Problem

Maogliche Ursachen

Empfohlene MaBnahmen

Ungenauer Durchfluss
oder Batchmenge

e Verdrahtungsproblem

¢ Ungeeignete MaReinheit

e Falscher Durchflusskalibrierfaktor

e Falscher Gerdtefaktor

e Falsche Dichtekalibrierfaktoren

e Falsche Erdung des Durchflussmessers
e Slug flow

e Problem mit dem empfangenden Gerat

Die Verdrahtung zwischen Sensor und Aus-
werteelektronik priifen. Siehe

Priifen der Verdrahtung vom Sensor zur Aus-
werteelektronik.

Priifen Sie, ob die Messeinheiten fiir Ihre An-
wendung korrekt konfiguriert sind.

Priifen Sie, ob alle Charakterisierungspara-
meter den Daten auf dem Sensor-Tag en-
tsprechen.

Nullpunktkalibrierung des Messsystems.
Erdung priifen. Siehe Erdung tiberpriifen.

Auf Schwallstrémung priifen. Siehe

Priifen auf Schwallstrémung (Zweiphasenstré-
mung).

Das empfangende Gerit sowie die Verdrah-
tung zwischen Auswerteelektronik und Core-
Prozessor priifen.

Den Widerstand der Sensorspule und auf
Kurzschliisse am Gehduse priifen. Siehe
Priifen der Sensorspulen.

Kern-Prozessor oder Auswerteelektronik aus-
tauschen.

12.4

Probleme bei Dichtemessungen

Tabelle 12-4: Probleme bei Dichtemessungen und AbhilfemaRnahmen

Problem

Magliche Ursachen

Empfohlene MaRnahmen

Ungenauer Dichte-
wert

e Problem mit dem Prozessmedium

* Falsche Dichtekalibrierfaktoren

e Verdrahtungsproblem

¢ Falsche Erdung des Durchflussmessers

e Slugflow

e Messrohr verstopft oder beschichtet

e Falsche Sensor-Einbaulage

* Fehlerhafter Widerstandsthermometer

e Physikalische Charakteristik des Sensors
hat sich gedndert

Die Verdrahtung zwischen Sensor und Aus-
werteelektronik priifen. Siehe

Priifen der Verdrahtung vom Sensor zur Aus-
werteelektronik.

Erdung priifen. Siehe Erdung berpriifen.
Uberpriifen Sie Ihre Prozessbedingungen an-
hand der vom Durchflussmesser gemeldeten
Werte.

Priifen Sie, ob alle Charakterisierungspara-
meter den Daten auf dem Sensor-Tag en-
tsprechen.

Auf Schwallstromung priifen. Siehe

Priifen auf Schwallstrémung (Zweiphasenstré-
mung).

Zwei Sensoren mit ahnlicher Frequenz tren-
nen, wenn sie sich zu nahe nebeneinander
befinden.

Messrohre spiilen.
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Stérungsanalyse und -behebung

Tabelle 12-4: Probleme bei Dichtemessungen und AbhilfemaRBnahmen (Fortsetzung)

Problem

Maogliche Ursachen

Empfohlene MaBnahmen

Ungewdhnlich hoher
Dichtewert

e Messrohr verstopft oder beschichtet

e Falscher K2-Wert

e Falsche Temperaturmessung

e Widerstandsthermometerproblem

¢ InHochfrequenzmessgerdten kann dies
ein Anzeichen fiir Erosion oder Korrosion
sein

¢ In Niederfrequenzmessgerdten kann
dies auf Rohrablagerungen hindeuten

Priifen Sie, ob alle Charakterisierungspara-
meter den Daten auf dem Sensor-Tag en-
tsprechen.

Messrohre spiilen.

Auf Ablagerungen in den Messrohren priifen.

Ungewdhnlich nie-
driger Dichtewert

e Slugflow

e Falscher K2-Wert

¢ In Niederfrequenzmessgeraten kann
dies ein Anzeichen fiir Erosion oder Kor-
rosion sein

Uberpriifen Sie Ihre Prozessbedingungen an-
hand der vom Durchflussmesser gemeldeten
Werte.

Priifen Sie, ob alle Charakterisierungspara-
meter den Daten auf dem Sensor-Tag en-
tsprechen.

Die Verdrahtung zwischen Sensor und Aus-
werteelektronik priifen. Siehe

Priifen der Verdrahtung vom Sensor zur Aus-
werteelektronik.

Die Messrohre auf Erosion priifen, insbeson-
dere, wenn das Prozessmedium abrasiv ist.

12.5

Probleme bei der Temperaturmessung

Tabelle 12-5: Probleme bei der Temperaturmessung und AbhilfemaRnahmen

Problem

Maogliche Ursachen

Empfohlene MaRnahmen

Temperaturwert
weicht signifikant von
der Prozesstempera-
turab

¢ Fehlerhafter Widerstandsthermometer
e Verdrahtungsproblem

e Die Anschlussdose auf Feuchtigkeit und
Griinspan priifen.

e Am Widerstandsthermometer Wider-
standspriifungen durchfiihren und auf
Kurzschliisse zum Gehduse priifen (siehe
Abschnitt 12.31.1).

e Bestdtigen, dass der Temperaturkalibrier-
faktor mit dem Wert auf dem Typenschild
des Sensors ibereinstimmt.

e Siehe Status-Alarme (insbesondere RTD-
Fehleralarme).

e Externe Temperaturkompensation deakti-
vieren.

e Temperaturkalibrierung priifen.

 Die Verdrahtung zwischen Sensor und Aus-
werteelektronik priifen. Siehe
Abschnitt 12.12.
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Tabelle 12-5: Probleme bei der Temperaturmessung und AbhilfemaBnahmen (Fortsetzung)

Problem Magliche Ursachen Empfohlene MaBnahmen

Temperaturwert e Sensortemperatur noch nicht angeglichen | ¢« Das Widerstandsthermometer hat eine
weicht geringvonder | ¢ Sensor Warmeverlust Spezifikation von +1 °C. Wenn sich der Feh-
Prozesstemperatur ab lerin diesem Bereich bewegt, liegt kein

Problem vor. Wenn sich die Temperatur-
messung auBerhalb der Spezifikation des
Sensors befindet, Micro Motion kontaktie-
ren.

Die Temperatur des Mediums andert sich
moglicherweise schnell. Dem Sensor aus-
reichend Zeit geben, sich an das Prozess-
medium anzupassen.

Den Sensor falls erforderlich isolieren.
Am Widerstandsthermometer Wider-
standspriifungen durchfiihren und auf
Kurzschliisse zum Gehduse priifen (siehe
Abschnitt 12.31.1).

Das Widerstandsthermometer hat mogli-
cherweise keinen guten Kontakt mit dem
Sensor. Der Sensor muss moglicherweise
ausgetauscht werden.

12.6

Probleme bei mA-Ausgdngen

Tabelle 12-6: Probleme bei mA-Ausgiangen und empfohlene Ma3nahmen

Problem

Magliche Ursachen

Empfohlene MaRnahmen

Kein mA-Ausgang .

Verdrahtungsproblem
Stérung im Schaltkreis

Die Spannungsversorgung und deren Ver-
drahtung prifen. Siehe

Verdrahtung der Spannungsversorgung prii-
fen.

Die mA-Ausgangsverdrahtung Gberpriifen.
Die Einstellungen fiir Storaktion priifen.
Siehe mA Ausgang Stéraktion priifen.
Gleichspannung an den Ausgangsklem-
men messen, um zu priifen, ob der Aus-
gang aktiv ist.

Wenden Sie sich an Micro Motion.

Messkreistest fehler- |

Problem mit der Spannungsversorgung

Die Spannungsversorgung und deren Ver-

haft e Verdrahtungsproblem drahtung priifen. Siehe
e Stoérungim Schaltkreis Verdrahtung der Spannungsversorgung pri-
e Falsche Konfiguration der internen/exter- fen.
nen Spannungsversorgung e Die mA-Ausgangsverdrahtung iberpriifen.
 Die Einstellungen fir Stéraktion priifen.
Siehe mA Ausgang Stéraktion priifen.
* Wenden Sie sich an Micro Motion.
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Tabelle 12-6: Probleme bei mA-Ausgangen und empfohlene MaRBnahmen (Fortsetzung)

Problem Magliche Ursachen

Empfohlene MaBnahmen

mA-Ausgang unter4 | < Offene Verdrahtung

mA e Schlechter Ausgangskreis

e Prozessbedingungen unterhalb LRV

e LRV und URV sind nicht korrekt gesetzt

e Storbedingungen liegen vor, wenn die
Storaktion auf intern Null oder abwarts ste-
hen

e Schlechtes, empfangendes mA Gerét

Uberpriifen Sie lhre Prozessbedingungen
anhand der vom Durchflussmesser gemel-
deten Werte.

Das empfangende Gerat sowie die Ver-
drahtung zwischen Auswerteelektronik
und Core-Prozessor priifen.

Die Einstellungen fiir Messende (URV) und
Messanfang (LRV) tiberpriifen. Siehe
Priifen von Messanfang und Messende.

Die Einstellungen fiir Storaktion priifen.
Siehe mA Ausgang Stéraktion priifen.

Konstanter mA-Aus- |  Falsche dem Ausgang zugewiesene Pro-

gang zessvariable

e Storung besteht

e Eine HART-Adresse ungleich Null (mA-Aus-
gang1)

e Ausgang ist flir den Messkreistestmodus
konfiguriert.

e Fehlerhafte Nullpunktkalibrierung

Ausgangsvariablen-Zuordnung priifen.
Bestehende Alarmzustdnde anzeigen und
beheben.

HART-Adresse und mA-Messkreis-Modus pri-
fen. Siehe

Priifen der HART Adresse und des Messkreis
Strommodus.

Uberpriifen Sie, ob ein Messkreistest |duft
(der Ausgang ist fixiert).
HART-Burst-Modus-Konfiguration priifen.
Siehe HART Burst Modus prifen.

Bei einer fehlerhaften Nullpunktkalibrier-
ung die Spannungsversorgung zum Mess-
system aus-/einschalten und die Null-
punktkalibrierung zu wiederholen versu-
chen.

mA-Ausgang dauer- | ¢ Falsche dem Ausgang zugewiesene Pro-

haft auRerhalb des zessvariable oder Einheiten

Bereichs e Stoérbedingungen liegen vor, wenn die
StormaRnahme auf aufwarts oder abwarts
steht

e LRV und URV sind nicht korrekt gesetzt

Ausgangsvariablen-Zuordnung priifen.
Die fiir den Ausgang konfigurierten Mes-
seinheiten tberprifen.

Die Einstellungen fir Stdraktion priifen.
Siehe mA Ausgang Stéraktion priifen.

Die Einstellungen fir Messende (URV) und
Messanfang (LRV) Gberpriifen. Siehe
Priifen von Messanfang und Messende.
Abgleich des mA-Ausgangs tiberpriifen.
Siehe mA Ausgdnge abgleichen.

Konstant ungenaue e Problem im Messkreis
mA-Messung e Ausgang nicht richtig abgeglichen
e Falsche Durchfluss Messeinheit konfigur-
iert

e Falsche Prozessvariable konfiguriert
e LRV und URV sind nicht korrekt gesetzt

Abgleich des mA-Ausgangs tiberpriifen.
Siehe mA Ausgdnge abgleichen.

Priifen Sie, ob die Messeinheiten fiir lhre
Anwendung korrekt konfiguriert sind.
Zuordnung der Prozessvariablen zum mA-
Ausgang priifen.

Die Einstellungen fiir Messende (URV) und
Messanfang (LRV) Gberpriifen. Siehe

Priifen von Messanfang und Messende.
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Tabelle 12-6: Probleme bei mA-Ausgangen und empfohlene MaRBnahmen (Fortsetzung)

Problem

Maogliche Ursachen

Empfohlene MaBnahmen

Korrekter mA-Aus-
gang bei niedriger
Spannung, jedoch ink-
orrekt bei hoherer
Spannung

¢ mA-Messkreiswiderstand kann zu hoch
eingestellt sein

e Priifen, ob die Last am mA-Ausgang 1 un-
terhalb der max. Last liegt (siehe Installa-
tionsanleitung Ihrer Auswerteelektronik).

12.7

Probleme beim Frequenzausgang

Tabelle 12-7: Probleme beim Frequenzausgang und empfohlene MaRnahmen

Problem

Magliche Ursachen

Empfohlene MaRnahmen

Kein Frequenzaus-
gang

e Zdhler stoppen

e Prozessbedingungen unterhalb Abschal-
tung

e Storbedingungen liegen vor, wenn die
Stéraktion auf intern Null oder abwarts
stehen

e Slugflow

e Durchfluss in umgekehrter Richtung
zum konfigurierten Parameter der
Durchflussrichtung

e Schlechtes, empfangendes Frequenz
Cerat

e Ausgangspegel nicht kompatibel zum
empfangenden Gerat

¢ Schlechter Ausgangskreis

e Falsche Konfiguration der internen/ex-
ternen Spannungsversorgung

 Falsche Konfiguration der Impulsbreite

e Ausgang hat keine Spannungsversor-
gung

e Verdrahtungsproblem

Priifen Sie, ob die Prozessbedingungen un-
terhalb der Schleichmengenabschaltung
liegen. Konfigurieren Sie die Schleichmenge-
nabschaltung gegebenenfalls neu.

Die Einstellungen fiir Storaktion priifen. Siehe
mA Ausgang Stéraktion priifen.

Priifen Sie, ob die Zahler nicht gestoppt wur-
den. Durch einen gestoppten Zahler wird der
Frequenzausgang gesperrt.

Auf Schwallstromung priifen. Siehe

Priifen auf Schwallstrémung (Zweiphasenstré-
mung).

Durchflussrichtung priifen. Siehe

Priifen der Durchflussrichtung.

Das empfangende Gerat sowie die Verdrah-
tung zwischen Auswerteelektronik und Core-
Prozessor priifen.

Uberpriifen Sie, ob der Kanal verdrahtet und
als Frequenzausgang konfiguriert ist.
Uberpriifen Sie die Spannungsversorgung fiir
den Frequenzausgang (intern und extern).
Impulsbreite priifen. Siehe

Frequenzausgang max. Impulsbreite priifen.
Messkreistest durchfiihren Siehe
Messkreistests durchftihren.

Konstant ungenaue

* Ausgang nicht richtig skaliert

Die Skalierung des Frequenzausgangs (iber-

Frequenzmessung ¢ Falsche Durchfluss Messeinheit konfi- priifen. Siehe
guriert Frequenzausgang Skaliermethode priifen.
* Priifen Sie, ob die Messeinheiten fiir Ihre An-
wendung korrekt konfiguriert sind.
UngleichmaBiger Fre- | « Hochfrequenzstérungen e Auf HF-Stérungen priifen. Siehe
quenzausgang Priifung auf hochfrequente Stérungen (RFI).

Phase ein Kanal C ve-
randert sich nicht bei
der Anderung der
Durchflussrichtung

e Der Frequenzausgangsmodus ist nicht
konfiguriert, um die Durchflussrichtung
anzuzeigen.

Den Modus des Frequenzausgangs (iberpri-
fen. Siehe Frequenzausgang Modus priifen.

200

MicroMotion® Auswerteelektronik Modell 2500 mit konfigurierbaren Ein-/Ausgéngen




Stérungsanalyse und -behebung

Tabelle 12-7: Probleme beim Frequenzausgang und empfohlene MaBnahmen (Fortsetzung)

Problem Magliche Ursachen Empfohlene MaBnahmen

Kanal Ckann nicht fiir | ¢« Ungiiltige Kanalauswahl e FOund DO1 verwenden denselben Schaltk-
den Frequenzaus- reis und kdnnen nicht gleichzeitig laufen.
gangsbetrieb konfi- Konfigurieren Sie Kanal B als FO und Kanal C
guriert werden als DO2.

12.8

12.9

12.10

Storungen der Bindrausgdnge

Problem Empfohlene MaRnahmen

Kanal B kann nicht als DO1 kon- | ¢ FO und DO1 verwenden denselben Schaltkreis und konnen
figuriert werden nicht gleichzeitig laufen. Konfigurieren Sie Kanal B als FO und
Kanal Cals DO2.

Storungen der Bindreingdnge

Problem Empfohlene MaRnahmen

Bindreingang ist fixiert und rea- | * Priifen Sie, ob der Bindreingang verdrahtet und fir Ihre An-
giert nicht auf Eingangsander- wendung korrekt konfiguriert ist. (“Intern” bedeutet, dass die
ungen Auswerteelektronik die Spannung liefert. “Extern” bedeutet,

dass eine externe Spannungsversorgung mit Pull-up Wider-
stand bendtigt wird.)

Verwenden der Sensorsimulation zur
Storungsanalyse und -beseitigung

Bei aktivierter Sensorsimulation gibt die Auswerteelektronik benutzerdefinierte Werte fiir
Massedurchfluss, Temperatur und Dichte aus. Hiermit konnen unterschiedliche
Prozessbedingungen reproduziert bzw. das System gepriift werden.

Mit der Sensorsimulation kann zwischen tatsachlichem Prozessrauschen und extern
verursachten Varianten unterschieden werden. Sie haben beispielsweise ein
empfangendes Gerdt, das einen unerwartet ungleichmaRigen Durchflusswert ausgibt.
Wenn die Sensorsimulation aktiviert ist und die gemessene Durchflussrate nicht mit dem
simulierten Wert (ibereinstimmt, so liegt die Ursache des Problems wahrscheinlich
zwischen Auswerteelektronik und empfangendem Gerit.

Wichtig

Wenn die Sensorsimulation aktiviert ist, wird der simulierte Wert bei allen Ausgédngen und
Berechnungen der Auswerteelektronik, einschlieRlich Z&hler und Summen, Volumendurchfluss- und
Konzentrationsberechnungen, verwendet. Alle mit den Ausgdngen der Auswerteelektronik in
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12.11

12.12
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Verbindung stehenden automatischen Funktionen deaktivieren und den Messkreis auf Handbetrieb
setzen. Den Simulationsmodus nur aktivieren, wenn die Anwendung diese Auswirkungen toleriert.
Sicherstellen, dass der Simulationsmodus nach den Tests wieder deaktiviert wird.

Siehe #unique_301 bzgl. weiterer Informationen zur Verwendung der Sensorsimulation.

Verdrahtung der Spannungsversorgung priifen

Wenn die Verdrahtung der Spannungsversorgung beschddigt oder falsch angeschlossen
ist, wird die Auswerteelektronik moglicherweise nicht ausreichend mit Spannung versorgt.

Vorbereitungsverfahren
Weitere Informationen sind in der Installationsanleitung der Auswerteelektronik zu finden.
Verfahren

1. Die Spannungsversorgung trennen, bevor deren Verdrahtung tberpriift wird.

A\ VORSICHT!

Befindet sich die Auswerteelektronik in einer explosionsgefdhrdeten Umgebung, nach
dem Trennen der Spannungsversorgung fiinf Minuten warten.

2. Priifen, ob die richtige externe Sicherung verwendet wird.
Eine falsche Sicherung kann den Strom zur Auswerteelektronik begrenzen und so
das Hochfahren verhindern.

3. Stellen Sie sicher, dass die Adern der Spannungsversorgung an den richtigen
Anschlussklemmen angeschlossen sind.

4, Priifen Sie, ob die Adern der Spannungsversorgung guten Kontakt haben und nicht
Gber die Isolierung angeklemmt sind.

5. Erneut Spannung an der Auswerteelektronik anlegen.

/A\ VORSICHT!

Wenn die Auswerteelektronik in einer explosionsgefahrdeten Umgebung installiert ist,
nicht erneut Spannung bei entferntem Gehause anlegen. Das Anlegen von Spannung an
die Auswerteelektronik bei entferntem Gehdusedeckel kann zu einer Explosion fiithren.

6. Priifen Sie mit einem Spannungsmessgerat die Spannung an den
Anschlussklemmen der Auswerteelektronik.

Die Spannung muss sich innerhalb der festgelegten Grenzwerte befinden. Bei einer
DC Spannung kann eine Kabelauslegung erforderlich sein.

Priifen der Verdrahtung vom Sensor zur
Auswerteelektronik

Es kdnnen eine Reihe von Problemen mit der Spannungsversorgung und dem Ausgang
auftreten, wenn die Verdrahtung zwischen dem Sensor und der Auswerteelektronik nicht
ordnungsgemadR angeschlossen ist oder wenn die Verdrahtung beschadigt wird.
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Vorbereitungsverfahren
Weitere Informationen sind in der Installationsanleitung der Auswerteelektronik zu finden.
Verfahren

1. Vordem Offnen des Anschlussgehiuses die Spannungsquelle abklemmen.

A\ VORSICHT!

Befindet sich die Auswerteelektronik in einem explosionsgefdhrdeten Bereich, nach
dem Trennen der Stromversorgung fiinf Minuten warten.

2. Uberpriifen, dass die Auswerteelektronik an den Sensor entsprechend den
Informationen, die in der Installationsanleitung angegeben sind, angeschlossen ist.

3. Uberpriifen, dass die Adern guten Kontakt mit den Anschlussklemmen haben.

Die Verdrahtung aller Kabel von der Auswerteelektronik zum Sensor priifen.

12.13 Erdung tiberpriifen
Sensor und Auswerteelektronik miissen geerdet sein.
Vorbereitungsverfahren

Sie benétigen:

. Installationsanleitung fiir lhren Sensor
o Installationsanleitung fiir hre Auswerteelektronik
Verfahren

Anforderungen und Hinweise zur Erdung finden Sie in der Installationsanleitung des
Sensors und der Auswerteelektronik.

12.14 Messkreistests durchfiihren

Ein Messkreistest erméglicht die Uberpriifung, ob Auswerteelektronik und externes Gerit
ordnungsgemdB kommunizieren. Ein Messkreistest hilft Ihnen ebenso bei der
Entscheidung, ob die mA Ausgange abgeglichen werden miissen.

12.14.1 Messkreistests durchfiihren mittels ProLink Il

Ein Messkreistest erméglicht die Uberpriifung, ob Auswerteelektronik und externes Gerit
ordnungsgemdB kommunizieren. Ein Messkreistest hilft Ihnen ebenso bei der
Entscheidung, ob die mA Ausgange abgeglichen werden miissen.

Vorbereitungsverfahren

Bevor Sie den Messkreistest durchfiihren, konfigurieren Sie die Kandle der Ein-/Ausgange
der Auswerteelektronik, die fiir hre Anwendung konfiguriert sind.

Folgen Sie den entsprechenden Vorgehensweisen, um sicherzustellen, dass die
Messkreistests existierende Mess- und Regelkreise nicht beeintrachtigen.
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ProLink Il muss laufen und muss mit der Auswerteelektronik verbunden sein.

Verfahren

1.

Testen Sie den oder die mA Ausgange.

a.
b.

a n

T Ka ~ oo

Wabhlen Sie ProLink > Test > Fix Milliamp 1 oder ProLink > Test > Fix Milliamp 2.

Geben Sie 4 mA in Set Output To ein.

Klicken Sie auf Fix mA.

Lesen Sie den mA Wert am empfangenden Gerat ab und vergleichen diesen mit
dem Ausgang der Auswerteelektronik.

Die Werte miissen nicht exakt (ibereinstimmen. Weichen die Werte nur
geringfligig voneinander ab, kénnen Sie diese Abweichung durch Abgleichen des
Ausgangs korrigieren.

Klicken Sie auf UnFix mA.

Geben Sie 20 mA in Set Output To ein.

Klicken Sie auf Fix mA.

Lesen Sie den mA Wert am empfangenden Geradt ab und vergleichen diesen mit
dem Ausgang der Auswerteelektronik.

Die Werte miissen nicht exakt ibereinstimmen. Weichen die Werte nur
geringfligig voneinander ab, kénnen Sie diese Abweichung durch Abgleichen des
Ausgangs korrigieren.

Klicken Sie auf UnFix mA.

Testen Sie den oder die Frequenzausgange.

Anmerkung

Ist eine eichamtliche Anwendung (Weights & Measures) auf der Auswerteelektronik aktiviert,
ist es nicht moglich, einen Messkreistest des Frequenzausgangs durchzufiihren. Dies trifft
auch zu, wenn die Auswerteelektronik im ungesicherten Modus betrieben wird.

o N o o

e.

Wahlen Sie ProLink > Test > Fix Freq Out.
Geben Sie den Frequenzausgangswert in Set Output To ein.
Klicken Sie auf Fix Frequency.

Lesen Sie das Frequenzsignal am empfangenden Gerat ab und vergleichen dieses
mit dem Ausgang der Auswerteelektronik.

Klicken Sie auf UnFix Freq.

Testen Sie den oder die Bindrausgange.

oo

o oo N

Wahlen Sie ProLink > Test > Fix Discrete Output.
Wabhlen Sie einen Bindrausgang.

Wiéhlen Sie On.

Priifen Sie das Signal am empfangenden Gerét.
Wiéhlen Sie Off.

Priifen Sie das Signal am empfangenden Gerét.
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g. Klicken Sie auf UnFix.

4. Testen Sie den Binareingang.

Setzen Sie das externe Eingangsgerdt auf EIN.
Wahlen Sie ProLink > Test > Read Discrete Input.

o ®

Priifen Sie das Signal an der Auswerteelektronik.
Setzen Sie das externe Eingangsgerat auf AUS.
Wahlen Sie ProLink > Test > Read Discrete Input.

o oo N

Priifen Sie das Signal an der Auswerteelektronik.
Nachbereitungsverfahren

. Weicht der mA Ausgangswert am empfangenden Gerdt geringfiigig vom Wert an
der Auswerteelektronik ab, konnen Sie diese Abweichung durch Abgleichen des
Ausgangs korrigieren.

. Weicht der mA Ausgangswert am empfangenden Gerat signifikant ab oder war der
Messwert bei einem Schritt fehlerhaft, priifen Sie die Verdrahtung zwischen der
Auswerteelektronik und dem externen Gerat und wiederholen Sie den Test.

. Wird der Messwert des Bindrausgangs umgekehrt angezeigt, priifen Sie die
Einstellung der Discrete Output Polarity.

o Wird der Messwert des Bindreingangs umgekehrt angezeigt, priifen Sie die
Einstellung der Discrete Input Polarity.

12.14.2 Messkreistests durchfiihren mittels ProLink Il

Ein Messkreistest ermdglicht die Uberpriifung, ob Auswerteelektronik und externes Gerat
ordnungsgemaR kommunizieren. Ein Messkreistest hilft Ihnen ebenso bei der
Entscheidung, ob die mA Ausgdnge abgeglichen werden miissen.

Vorbereitungsverfahren

Bevor Sie den Messkreistest durchfiihren, konfigurieren Sie die Kanéle der Ein-/Ausgdnge
der Auswerteelektronik, die fiir hre Anwendung konfiguriert sind.

Folgen Sie den entsprechenden Vorgehensweisen, um sicherzustellen, dass die
Messkreistests existierende Mess- und Regelkreise nicht beeintrachtigen.

ProLink Il muss laufen und muss mit der Auswerteelektronik verbunden sein.
Verfahren
1. Testen Sie den oder die mA Ausgange.

a. Wahlen Sie Device Tools > Diagnostics > Testing > mA Output 1 Test oder Device Tools >
Diagnostics > Testing > mA Output 2 Test.

b. Geben Sie 4 in Fix to: ein.

c. Klicken Sie auf Fix mA.

d. Lesen Sie den mA Wert am empfangenden Gerat ab und vergleichen diesen mit
dem Ausgang der Auswerteelektronik.

Die Werte missen nicht exakt Gibereinstimmen. Weichen die Werte nur
geringfligig voneinander ab, kénnen Sie diese Abweichung durch Abgleichen des
Ausgangs korrigieren.
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Klicken Sie auf UnFix mA.
Geben Sie 20 in Fix to: ein.

Klicken Sie auf Fix mA.

T Ka ~ oo

Lesen Sie den mA Wert am empfangenden Gerat ab und vergleichen diesen mit
dem Ausgang der Auswerteelektronik.

Die Werte miissen nicht exakt ibereinstimmen. Weichen die Werte nur
geringfligig voneinander ab, kénnen Sie diese Abweichung durch Abgleichen des
Ausgangs korrigieren.

i. Klicken Sie auf UnFix mA.

Testen Sie den oder die Frequenzausgange.

Anmerkung

Ist eine eichamtliche Anwendung (Weights & Measures) auf der Auswerteelektronik aktiviert,
ist es nicht moglich, einen Messkreistest des Frequenzausgangs durchzufiihren. Dies trifft
auch zu, wenn die Auswerteelektronik im ungesicherten Modus betrieben wird.

Wahlen Sie Device Tools > Diagnostics > Testing > Frequency Output Test.
Geben Sie den Frequenzausgangswert in Fix to ein.
Klicken Sie auf Fix FO.

Lesen Sie das Frequenzsignal am empfangenden Gerét ab und vergleichen dieses
mit dem Ausgang der Auswerteelektronik.

e. Klicken Sie auf UnFix FO.

o N o o

Testen Sie den oder die Bindrausgange.

a. Wabhlen Sie Device Tools > Diagnostics > Testing > Discrete Output Test.

b. Wenn die Auswerteelektronik fiir zwei Bindrausgange konfiguriert ist, miissen
Sie zundchst festlegen, welchen Bindrausgang Sie testen mochten.

c. Setzen Sie Fix To: auf ON.

d. Priifen Sie das Signal am empfangenden Gerdt.

e. Setzen Sie Fix To: auf OFF.

f. Prifen Sie das Signal am empfangenden Gerit.

g. Klicken Sie auf UnFix.

h. Wiederholen Sie diesen Vorgang fiir den anderen Bindrausgang, falls zutreffend.

Testen Sie den Binareingang.

a. Setzen Sie das externe Eingangsgerdt auf EIN.
b. Wabhlen Sie Device Tools > Diagnostics > Testing > Discrete Input Test.

n

Priifen Sie das Signal an der Auswerteelektronik.

e

Setzen Sie das externe Eingangsgerat auf AUS.

e. Priifen Sie das Signal an der Auswerteelektronik.
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Nachbereitungsverfahren

. Weicht der mA Ausgangswert am empfangenden Gerdt geringfiigig vom Wert an
der Auswerteelektronik ab, konnen Sie diese Abweichung durch Abgleichen des
Ausgangs korrigieren.

o Weicht der mA Ausgangswert am empfangenden Gerdt signifikant ab oder war der
Messwert bei einem Schritt fehlerhaft, priifen Sie die Verdrahtung zwischen der
Auswerteelektronik und dem externen Gerat und wiederholen Sie den Test.

. Wird der Messwert des Bindrausgangs umgekehrt angezeigt, priifen Sie die
Einstellung der Discrete Output Polarity.

. Wird der Messwert des Bindreingangs umgekehrt angezeigt, priifen Sie die
Einstellung der Discrete Input Polarity.

12.14.3 Messkreistest durchfiihren mittels Handterminal

Ein Messkreistest erméglicht die Uberpriifung, ob Auswerteelektronik und externes Gerit
ordnungsgemaR kommunizieren. Ein Messkreistest hilft Ihnen ebenso bei der
Entscheidung, ob die mA Ausgidnge abgeglichen werden miissen.

Vorbereitungsverfahren

Bevor Sie den Messkreistest durchfiihren, konfigurieren Sie die Kandle der Ein-/Ausgdnge
der Auswerteelektronik, die fiir Ihre Anwendung konfiguriert sind.

Folgen Sie den entsprechenden Vorgehensweisen, um sicherzustellen, dass die
Messkreistests existierende Mess- und Regelkreise nicht beeintrachtigen.

Verfahren
1. Testen Sie den oder die mA Ausgange.

a. Wahlen Sie Service Tools > Simulate > Simulate Outputs > mA Output 1 Loop Test oder
Service Tools > Maintenance > Simulate Outputs > mA Output 2 Loop Test und wahlen Sie 4
mA.

b. Lesen Sie den mA Wert am empfangenden Gerét ab und vergleichen diesen mit
dem Ausgang der Auswerteelektronik.

Die Werte miissen nicht exakt tibereinstimmen. Weichen die Werte nur
geringfligig voneinander ab, kénnen Sie diese Abweichung durch Abgleichen des
Ausgangs korrigieren.

c. Driicken Sie OK.
d. Wahlen Sie 20 mA.

e. Lesen Sie den mA Wert am empfangenden Gerét ab und vergleichen diesen mit
dem Ausgang der Auswerteelektronik.

Die Werte miissen nicht exakt ibereinstimmen. Weichen die Werte nur
geringfligig voneinander ab, kénnen Sie diese Abweichung durch Abgleichen des
Ausgangs korrigieren.

f. Drlcken Sie OK.
g. Wabhlen Sie End.

2.  Testen Sie den oder die Frequenzausgdnge.
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Anmerkung

Ist eine eichamtliche Anwendung (Weights & Measures) auf der Auswerteelektronik aktiviert,
ist es nicht moglich, einen Messkreistest des Frequenzausgangs durchzufiihren. Dies trifft
auch zu, wenn die Auswerteelektronik im ungesicherten Modus betrieben wird.

a. Driicken Sie Service Tools > Simulate > Simulate Outputs > Frequency Output Test und
wahlen Sie den Frequenzausgangswert.

b. Lesen Sie das Frequenzsignal am empfangenden Gerdt ab und vergleichen dieses
mit dem Ausgang der Auswerteelektronik.

c. Wahlen Sie End.

Testen Sie den oder die Bindrausgange.

a. Drticken Sie Service Tools > Simulate > Simulate Outputs und wahlen Sie Discrete Output
1 Test oder Discrete Output 2 Test.

Wahlen Sie Off.

Priifen Sie das Signal am empfangenden Gerét.

Driicken Sie OK.

Wabhlen Sie On.

Priifen Sie das Signal am empfangenden Gerit.

Driicken Sie OK.

Wabhlen Sie End.

=

To ™o a0

Nachbereitungsverfahren

Weicht der mA Ausgangswert am empfangenden Gerdt geringfiigig vom Wert an
der Auswerteelektronik ab, konnen Sie diese Abweichung durch Abgleichen des
Ausgangs korrigieren.

Weicht der mA Ausgangswert am empfangenden Gerdt signifikant ab oder war der
Messwert bei einem Schritt fehlerhaft, priifen Sie die Verdrahtung zwischen der
Auswerteelektronik und dem externen Gerat und wiederholen Sie den Test.

Wird der Messwert des Bindrausgangs umgekehrt angezeigt, priifen Sie die
Einstellung der Discrete Output Polarity.

mA Ausgdnge abgleichen

Beim Abgleich eines mA Ausgangs wird der mA Ausgang der Auswerteelektronik
entsprechend des empfangenden Gerats kalibriert. Wenn die aktuellen Abgleichswerte
nicht richtig sind, wird der Ausgang durch die Auswerteelektronik tiber- oder
unterkompensiert.

Abgleichen der mA Ausgdnge mittels ProLink I

Der Abgleich des mA Ausgangs erzeugt einen gemeinsamen Messkreis zwischen der
Auswerteelektronik und dem Gerdt, das den mA Ausgang empfangt.
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Wichtig
Der Abgleich des Ausgangs muss an beiden Punkten (4 mA und 20 mA) durchgefiihrt werden, um

sicherzustellen, dass eine entsprechende Kompensation tiber den gesamten Ausgangsbereich
erfolgt.

Vorbereitungsverfahren

Stellen Sie sicher, dass der mA Ausgang mit dem empfangenden Gerdt verdrahtet ist, das
bei der Produktion verwendet wird.

Verfahren

1. Wahlen Sie ProLink > Calibration > Milliamp 1 Trim oder ProLink > Calibration > Milliamp 2 Trim.
2. Folgen Sie den Anweisungen der gefiihrten Methode.

Wichtig

Wenn eine HART/Bell 202 Verbindung verwendet wird, beeinflusst das (iber dem primaren
mA Ausgang liegende HART Signal den mA Messwert. Trennen Sie die kabelgebundene
Verbindung zwischen ProLink Il und den Anschlussklemmen der Auswerteelektronik, wenn
der mA Ausgang am empfangenden Gerat abgerufen wird. Stellen Sie die Verbindung wieder
her, um mit dem Abgleich fortzufahren.

3. Priifen Sie die Abgleichswerte und wenden Sie sich an den Micro Motion
Kundenservice, wenn ein Wert kleiner als =200 Mikroampere oder groRer als
+200 Mikroampere ist.

12.15.2  Abgleichen der mA Ausgdnge mittels ProLink Il

Der Abgleich des mA Ausgangs erzeugt einen gemeinsamen Messkreis zwischen der
Auswerteelektronik und dem Gerédt, das den mA Ausgang empfangt.

Wichtig
Der Abgleich des Ausgangs muss an beiden Punkten (4 mA und 20 mA) durchgefiihrt werden, um

sicherzustellen, dass eine entsprechende Kompensation iber den gesamten Ausgangsbereich
erfolgt.

Vorbereitungsverfahren

Stellen Sie sicher, dass der mA Ausgang mit dem empfangenden Gerdt verdrahtet ist, das
bei der Produktion verwendet wird.

Verfahren

1. Wabhlen Sie Device Tools > Calibration > MA Qutput Trim >mA Output 1 Trim .

2. Wahlen Sie Device Tools > Calibration > MA Output Trim > mA Output 1 Trim oder Device Tools
> Calibration > MA Output Trim > mA Output 2 Trim .

3. Folgen Sie den Anweisungen der gefiihrten Methode.

Konfigurations- und Bedienungsanleitung 209



Stérungsanalyse und -behebung

12.15.3

12.16
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Wichtig

Wenn eine HART/Bell 202 Verbindung verwendet wird, beeinflusst das (iber dem priméren
mA Ausgang liegende HART Signal den mA Messwert. Trennen Sie die kabelgebundene
Verbindung zwischen ProLink Ill und den Anschlussklemmen der Auswerteelektronik, wenn
der mA Ausgang am empfangenden Gerat abgerufen wird. Stellen Sie die Verbindung wieder
her, um mit dem Abgleich fortzufahren.

4, Priifen Sie die Abgleichswerte und wenden Sie sich an den Micro Motion
Kundenservice, wenn ein Wert kleiner als 200 Mikroampere oder gréRer als
+200 Mikroampere ist.

Abgleichen der mA Ausgange mittels Handterminal

Der Abgleich des mA Ausgangs erzeugt einen gemeinsamen Messkreis zwischen der
Auswerteelektronik und dem Gerdt, das den mA Ausgang empfangt.

Wichtig
Der Abgleich des Ausgangs muss an beiden Punkten (4 mA und 20 mA) durchgefiihrt werden, um

sicherzustellen, dass eine entsprechende Kompensation iber den gesamten Ausgangsbereich
erfolgt.

Vorbereitungsverfahren

Stellen Sie sicher, dass der mA Ausgang mit dem empfangenden Gerat verdrahtet ist, das
bei der Produktion verwendet wird.

Verfahren

1. Wibhlen Sie .

2.  Folgen Sie den Anweisungen der gefiihrten Methode.

Wichtig

Das HART Signal auf dem primdren mA Ausgang hat einen Einfluss auf den mA Wert. Trennen
Sie die kabelgebundene Verbindung zwischen Handterminal und den Anschlussklemmen der
Auswerteelektronik, wenn der mA Ausgang am empfangenden Gerdt abgerufen wird. Stellen
Sie die Verbindung wieder her, um mit dem Abgleich fortzufahren.

3. Wabhlen Sie .

Priifen Sie die Abgleichswerte und wenden Sie sich an den Micro Motion
Kundenservice, wenn ein Wert kleiner als =200 Mikroampere oder groRer als
+200 Mikroampere ist.

HART Kommunikationskreis priifen

Wenn Sie keine HART Kommunikation herstellen oder aufrechterhalten kbnnen, ist der
HART Kreis mdglicherweise falsch verdrahtet.

Vorbereitungsverfahren
Sie benotigen:

. Eine Kopie Ihrer Auswerteelektronik Installationsanleitung
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. Ein Handterminal

. Optional: HART Application Guide, verfligbar unter www.hartcomm.org
Verfahren

1. Priifen Sie, ob die Leitungsadern gemaR dem Anschlussschema der

Installationsanleitung der Auswerteelektronik angeschlossen sind.

Ist Ihr HART Netzwerk komplexer als das Anschlussschema in der
Installationsanleitung, wenden Sie sich an Micro Motion oder an die HART
Communication Foundation.

2. Trennen Sie die Verdrahtung des primaren mA Ausgangs von der
Auswerteelektronik.
3. Installieren Sie einen 250-1000 Q Widerstand tiber die Anschlussklemmen des

primdren mA Ausgangs der Auswerteelektronik.
4, Priifen Sie den Spannungsabfall iber dem Widerstand (4-20 mA = 1-5VDC).

Ist der Spannungsabfall weniger als 1 VDC, erh6hen Sie den Widerstand, um einen
Spannungsabfall von mehrals 1 VDC zu erreichen.

5. SchlieRen Sie ein Handterminal direkt Gber den Widerstand an und versuchen Sie,
eine Kommunikation herzustellen (Abfrage).

Wenn keine Kommunikation mit der Auswerteelektronik hergestellt werden kann,
muss die Auswerteelektronik ggf. gewartet werden. Kontaktieren Sie Micro Motion.

Priifen der HART Adresse und des Messkreis
Strommodus

Wenn die Auswerteelektronik einen festen Strom am mA Ausgang ausgibt, wird der
Parameter Loop Current Mode moglicherweise deaktiviert.

Wenn Loop Current Mode deaktiviert ist, erzeugt der mA Ausgang eine festen Wert und
meldet keine Prozessdaten bzw. implementiert nicht die zugehorigen FehlermaRnahmen

Wenn die HART Address geandert wird, andern einige Konfigurations-Hilfsmittel
automatisch Loop Current Mode.

Hinweis
Stets Loop Current Mode nach dem Einstellen oder dem Andern von HART Address {iberpriifen.

Verfahren
1. HART Address entsprechend den Anforderungen des HART Netzwerks einstellen.

Die Standardadresse ist 0. Das ist der empfohlene Wert, es sei denn, die
Auswerteelektronik befindet sich in einem Multidrop-Netzwerk.

2. Loop Current Mode auf Enabled einstellen.
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HART Burst Modus priifen

Der HART Burst Modus kann dazu fiihren, dass die Auswerteelektronik unerwartete Werte
ausgibt. Der Burst Modus ist normalerweise deaktiviert und sollte nur dann aktiviert
werden, wenn ein anderes Gerat innerhalb des Netzwerks eine HART Kommunikation im
Burst Modus verlangt.

1. Priifen Sie, ob der Burst Modus aktiviert oder deaktiviert ist.

2. Ist der Burst Modus aktiviert, deaktivieren Sie den Modus.

Priifen von Messanfang und Messende

Wenn die Prozessbedingungen unter den konfigurierten Lower Range Value (LRV) fallen oder
tiber den konfigurierten Upper Range Value (URV) steigen, kdnnen unerwartete Werte (iber
die Ausgange der Auswertelektronik ausgegeben werden.

1. Bewerten Sie die aktuellen Prozessbedingungen.
2. Priifen Sie die Konfiguration von LRV und URV.

mA Ausgang Storaktion priifen

Die mA Ausgang Storaktion steuert das Verhalten des mA Ausgangs, wenn die
Auswerteelektronik eine interne Stérbedingung erkennt. Wenn der mA Ausgang einen
konstanten Wert unter 4 mA oder (iber 20 mA ausgibt, weist die Auswerteelektronik
maoglicherweise eine Storbedingung auf.

1. In diesem Fall die Statusalarme auf aktive Storbedingungen priifen.

2. Wenn keine aktiven Storbedingungen vorhanden sind, funktioniert die
Auswerteelektronik ordnungsgemaR. Wenn Sie das Verhalten des
Frequenzausgangs dandern mochten, haben Sie folgende Méglichkeiten:

« Andern Sie die Finstellung der mA Ausgang Stéraktion.
* Andern Sie fiir die relevanten Statusalarme die Einstellung Alarmstufe auf Ignorieren.

3. Wenn keine aktiven Stérbedingungen vorhanden sind, setzen Sie die
Storungsanalyse und -beseitigung fort.

Priifung auf hochfrequente Stérungen (RFI)

Der Frequenzausgang bzw. der Bindrausgang der Auswerteelektronik kann durch
hochfrequente Stérungen (RFI) beeinflusst werden. Mogliche RFI-Quellen sind Sender von
Funkemissionen bzw. groBe Transformatoren, Pumpen oder Motoren, die ein starkes
elektromagnetisches Feld erzeugen kénnen. Es gibt mehrere Methoden zur Reduzierung
hochfrequenter Stérungen. Verwenden Sie eine oder mehrere der folgenden
Empfehlungen entsprechend der jeweiligen Installation.

Verfahren
. Hochfrequente Stérquelle eliminieren.
. Auswerteelektronik versetzen.

o Abgeschirmte Kabel fiir den Frequenz- bzw. Bindrausgang verwenden.
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- Kabelschirm am Ausgangsgerdt auflegen. Ist dies nicht méglich, den Schirm an
der Kabelverschraubung oder der Kabelschutzrohrverschraubung auflegen.

- Den Schirm nicht im Inneren des Anschlussraumes auflegen.

- Ein 360° Schirmabschluss ist nicht erforderlich.

Frequenzausgang Modus priifen

Wenn die Auswerteelektronik fiir zwei Frequenzausgénge konfiguriert ist und
Frequenzausgang Modus nicht entsprechend Ihrer Anwendung konfiguriert ist, kdnnen die
Frequenzausgédnge ein unerwartetes Verhalten aufweisen.

Frequenzausgang Modus wird nur verwendet, um das Verhaltnis zwischen zwei
Frequenzausgangen zu definieren. Wenn die Auswerteelektronik nicht fiir zwei
Frequenzausgange konfiguriert ist, wird das Ausgangsproblem nicht durch Frequenzausgang
Modus verursacht.

Verfahren

Priifen Sie die Konfiguration von Frequenzausgang Modus.

Frequenzausgang max. Impulsbreite priifen

Wenn die Frequenzausgang max. Impulsbreite falsch eingestellt ist, kann der Frequenzausgang
einen falschen Wert ausgeben.

Priifen Sie die Konfiguration der Frequenzausgang max. Impulsbreite.

Einschrankung

Ist die Auswerteelektronik fiir zwei Frequenzausgdnge konfiguriert, kann die Impulsbreite nicht
konfiguriert werden. Die Ausgdnge arbeiten immer mit einem Impuls/Pause-Verhdltnis von 50 %.

Fiir die meisten Anwendungen ist der fir Frequenzausgang max. Impulsbreite voreingestellte
Wert geeignet. Dieser Wert entspricht einem Impuls/Pause-Verhaltnis von 50 %.

Frequenzausgang Skaliermethode priifen

Wenn die Frequenzausgang Skaliermethode falsch eingestellt ist, kann der Frequenzausgang
einen falschen Wert ausgeben.

1. Priifen Sie die Konfiguration von Frequenzausgang Skaliermethode.

2. Wenn Sie die Einstellung flir Frequenzausgang Skaliermethode gedndert haben, priifen
Sie alle anderen Parameter des Frequenzausgangs.

Frequenzausgang Storaktion priifen

Die Frequenzausgang Storaktion steuert das Verhalten des Frequenzausgangs, wenn die
Auswerteelektronik eine interne Stérbedingung erkennt. Wenn der Frequenzausgang
einen konstanten Wert ausgibt, liegt moglicherweise eine Stérbedingung der
Auswerteelektronik vor.
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1. In diesem Fall die Statusalarme auf aktive Stérbedingungen priifen.

2. Wenn keine aktiven Storbedingungen vorhanden sind, funktioniert die
Auswerteelektronik ordnungsgemaR. Wenn Sie das Verhalten des
Frequenzausgangs dndern mochten, haben Sie folgende Méglichkeiten:

» Andern der Einstellung Frequenzausgang Stéraktion.

« Andern Sie fiir die relevanten Statusalarme die Einstellung Alarmstufe auf Ignorieren.

3. Wenn keine aktiven Stérbedingungen vorhanden sind, setzen Sie die
Storungsanalyse und -beseitigung fort.

Priifen der Durchflussrichtung

Wenn die Durchflussrichtung fiir Ihren Prozess nicht korrekt eingestellt ist, zeigt die
Auswerteelektronik méglicherweise unerwartete Durchflusswerte oder Zdhler an.

Der Parameter Durchflussrichtung interagiert mit der eigentlichen Durchflussrichtung und
hat somit Auswirkungen auf Durchflusswerte, Durchflusszadhler und -summen und das
Ausgangsverhalten. Der einfachste Betrieb wird erreicht, indem der eigentliche
Prozessfluss mit dem Richtungspfeil fiir den Durchfluss auf der Seite des Sensorgehduses
tibereinstimmt.

Verfahren

1. Die eigentliche Durchflussrichtung des Prozessflusses durch den Sensor (iberpriifen.
2. Die Konfiguration der Durchflussrichtung priifen.

Priifen der Abschaltungen

Wenn die Abschaltungen der Auswerteelektronik falsch konfiguriert sind, kann die
Auswerteelektronik bei vorhandenem Durchfluss oder bei sehr geringen
Durchflussmengen einen Null Durchfluss ausgeben.

Es gibt separate Abschaltparameter fiir Massedurchfluss, Volumendurchfluss, Standard-
Gasvolumen-Durchfluss (falls zutreffend) und Dichte. Fiir jeden mA-Ausgang an der
Auswerteelektronik gibt es eine separate Abschaltung. Die Wechselwirkung zwischen den
Abschaltungen kann zu unerwarteten Ergebnissen fiihren.

Verfahren

Die Konfiguration der Abschaltungen tiberpriifen.

Hinweis

Bei typischen Anwendungen empfiehlt Micro Motion, Mass Flow Cutoff auf den
Nullpunktstabilitdtswert des Sensors multipliziert mit 10 einzustellen. Nullpunktstabilitdtswerte sind
im Produktdatenblatt des Sensors zu finden.
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12.28 Priifen auf Schwallstromung
(Zweiphasenstromung)

Schwallstrémung (Zweiphasenstromung, Gaseinschliisse) kann zu Spitzenwerten bei der
Antriebsverstdrkung fiihren. Dies kann dazu fiihren, dass die Auswerteelektronik Null
Durchfluss oder mehrere unterschiedliche Alarme meldet.

1. Aufdurch Schwallstromung ausgeldste Alarme priifen.

Wenn die Auswerteelektronik keine Schwallstromalarme erzeugt, ist
Schwallstromung nicht die Ursache des Problems.

Prozess auf Kavitation, Dampfbildung oder Leckagen priifen.

Die Dichte des Prozessmediumausgangs unter normalen Prozessbedingungen
tiberwachen.

4, Die Einstellungen fiir Slug Low Limit, Slug High Limit und Slug Duration priifen.

Hinweis

Das Auftreten von Schwallstromalarmen kann durch die Einstellung von Slug Low Limit auf
einen niedrigeren Wert, Slug High Limit auf einen héheren oder Slug Duration auf einen héheren
Wert reduziert werden.

12.29  Antriebsverstdrkung priifen

UbermiRige oder fehlerhafte Antriebsverstirkung kann auf vielfiltige
Prozessbedingungen, Sensor- oder Konfigurationsprobleme hindeuten.

Um herauszufinden, ob die Antriebsverstarkung zu hoch oder fehlerhaft ist, miissen Daten
in der Problemsituation gesammelt und mit den Daten der Antriebsverstarkung unter
normalen Betriebsbedingungen verglichen werden.

UbermiRige (gesattigte) Antriebsverstirkung

Tabelle 12-8: Mogliche Ursachen und AbhilfemaBnahmen bei iibermaRiger
(gesattigter) Antriebsverstarkung

Magliche Ursache Empfohlene MaBnahmen
Schwallstrémung Auf Schwallstromung priifen. Siehe
Priifen auf Schwallstrémung (Zweiphasenstrémung).
Teilweise gefiilltes Durch- Prozessbedingungen so korrigieren, dass die Durchflussrohre ge-
flussrohr fllt sind.
Verstopfte Messrohre Aufnehmerspannungen priifen (siehe Aufnehmerspannung priifen).

Ist eine der Spannungen fast null (aber keine null), kénnen ver-
stopfte Rohre die Ursache des Problems sein. Rohre spiilen. In Ex-
tremféllen kann es sein, dass der Sensor ersetzt werden muss.
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Tabelle 12-8: Mdogliche Ursachen und AbhilfemaBnahmen bei iibermaRiger
(gesattigter) Antriebsverstarkung (Fortsetzung)

Magliche Ursache

Empfohlene MaBnahmen

Kavitation, Dampfbildung
oder Lufteinschluss; Abschei-
den von Zwei- oder Dreis-
tromfliissigkeiten

e Den einlaufseitigen oder auslaufseitigen Druck am Sensor erho-
hen.

e Befindet sich einlaufseitig vor dem Sensor eine Pumpe, den Ab-
stand zwischen Pumpe und Sensor vergréRern.

e Der Sensor muss moglicherweise neu ausgerichtet werden.
Weitere Informationen bzgl. der Sensorausrichtung sind im In-
stallationshandbuch zu finden.

Stérung in Antriebsplatine
oder Modul

Kontaktieren Sie Micro Motion.

Messrohr verbogen

Aufnehmerspannungen priifen (siehe Aufnehmerspannung priifen).
Ist eine der Spannungen fast null (aber keine null), sind die Mess-
rohre moglicherweise verbogen. Der Sensor muss ausgetauscht
werden.

Messrohr gerissen

Sensor austauschen.

Sensorunwucht

Kontaktieren Sie Micro Motion.

Mechanische Verbindung am
Sensor

Stellen Sie sicher, dass der Sensor frei schwingen kann.

Offene Antriebs- oder Auf-
nehmerspule links

Kontaktieren Sie Micro Motion.

Durchfluss auRerhalb des Be-
reichs

Stellen Sie sicher, dass der Durchfluss innerhalb der Sensorgrenzen
liegt.

Falsche Sensor-Charakteri-

sierung

Charakterisierungsparameter priifen.

Sprunghafte Antriebsverstarkung

Tabelle 12-9: Maégliche Ursachen und AbhilfemaBnahmen bei fehlerhafter
Antriebsverstarkung

Magliche Ursache

Empfohlene MaBnahmen

den Sensor

Falsche K1-Charakterisierungskonstante fiir | Charakterisierungsparameter K1 priifen.

vertauscht

Polaritat der Aufnehmer- oder Antriebsspule | Kontaktieren Sie Micro Motion.

Schwallstrémung

Auf Schwallstromung priifen. Siehe
Priifen auf Schwallstrémung (Zweiphasenstrémung).

Fremdkorper in den Messrohren * Messrohre spiilen.

e Sensor austauschen.
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12.29.1  Daten der Antriebsverstarkung sammeln

Daten der Antriebsverstdrkung kénnen fir die Diagnose einer Reihe von Prozess- und
Gerdtebedingungen verwendet werden. Die Daten der Antriebsverstarkung kénnen fiir
eine Zeitspanne wahrend des normalen Betriebs gesammelt und als Referenz zur
Stérungsanalyse/-beseitigung verwendet werden.

Verfahren
1. Zuden Daten der Antriebsverstarkung navigieren.
2. Die Daten der Antriebsverstdrkung tiber eine bestimmte Zeitspanne und unter

verschiedenen Prozessbedingungen beobachten und aufzeichnen.

12.30  Aufnehmerspannung priifen

Wenn die Aufnehmerspannungswerte ungewohnlich niedrig sind, ist es moglich, dass eine
von vielen moglichen Stérungen im Prozess oder bei der Ausriistung aufgetreten sind.

Um zu erfahren, ob die Aufnehmerspannung ungewdéhnlich niedrig ist, miissen
Aufnehmerspannungsdaten gesammelt werden, wahrend die Stérung vorherrscht, und
diese Daten dann mit Daten der Aufnehmerspannung wahrend des normalen Betriebs
verglichen werden.

Tabelle 12-10: Maogliche Ursachen und empfohlene MaRBnahmen fiir eine niedrige

Aufnehmerspannung
Magliche Ursache Empfohlene MaRnahmen
Lufteinschliisse ¢ Den einlaufseitigen oder auslaufseitigen Druck am Sensor
erhéhen.

» Befindet sich einlaufseitig vor dem Sensor eine Pumpe, den
Abstand zwischen Pumpe und Sensor vergroRern.

* Der Sensor muss mdglicherweise neu ausgerichtet werden.
Weitere Informationen bzgl. der Sensorausrichtung sind im
Installationshandbuch zu finden.

Fehlerhafte Verdrahtung zwi- Verdrahtung zwischen Sensor und Auswerteelektronik priifen.
schen Sensor und Auswerteelek-

tronik

Der Durchfluss befindet sich Stellen Sie sicher, dass der Durchfluss nicht auRerhalb des Sen-

auBerhalb der Sensorgrenzwerte. = sor-Messbereichs liegt.

Schwallstrémung Auf Schwallstrémung priifen. Siehe
Priifen auf Schwallstrémung (Zweiphasenstrémung).
Keine Schwingung der Sensor e Aufverstopfte Messrohre priifen.
Messrohre e Stellen Sie sicher, dass der Sensor frei schwingen kann

(keine mechanische Verbindungen).
e Verdrahtung priifen.

Feuchtigkeit in der Sensorelektro- | Beseitigen Sie die Feuchtigkeit in der Sensorelektronik.
nik

Der Sensor ist beschadigt oder Sensor austauschen.
die Sensormagnete haben sich
entmagnetisiert.
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Aufnehmer Spannungsdaten sammeln

Die Aufnehmer Spannungsdaten kénnen zur Diagnose einer Vielzahl von Prozess- und
Gerdtebedingungen verwendet werden. Die Aufnehmer Spannungsdaten kénnen fiir eine
Zeitspanne wahrend des normalen Betriebs gesammelt und als Referenz zur
Stérungsanalyse/-beseitigung verwendet werden.

Verfahren
1.  Die Aufnehmer Spannungsdaten aufrufen.
2. Die Daten fiir den linken und fiir den rechten Aufnehmer fir einen bestimmte

Zeitspanne und unter verschiedenen Prozessbedingungen beobachten und
aufzeichnen.

Priifen auf elektrische Kurzschliisse

Kurzschliisse zwischen Sensor Anschlussklemmen oder Sensor Anschlussklemmen und
dem Sensorgehause kénnen einen Ausfall des Sensors bewirken.

Tabelle 12-11: Maogliche Ursachen und empfohlene MaRBnahmen bei elektrischen
Kurzschliissen

Magliche Ursache Empfohlene MaBnahme
Feuchtigkeit im Innern der Ans- Sicherstellen, dass die Anschlussdose trocken und ohne
chlussdose Korrosion ist.

Flissigkeit oder Feuchtigkeit im Sen- = Micro Motion kontaktieren.

sorgehduse

Kurzschluss in interner Durchfiih- Micro Motion kontaktieren.

rung

Fehlerhaftes Kabel Das Kabel austauschen.

UnsachgemaRe Kabelanschliisse Kabelanschlisse in der Sensor Anschlussdose priifen. Das

Micro Motion Dokument mit dem Titel Kabelvorbereitung
und Installationsanleitung fiir 9-adrige Durchfluss-Messsys-
teme kann hierbei méglicherweise hilfreich sein.

Priifen der Sensorspulen

Das Priifen der Sensorspulen kann elektrische Kurzschliisse identifizieren.

Einschrankung

Dieses Verfahren betrifft nur 9-adrige extern montierte Auswerteelektroniken und externe
Auswerteelektroniken mit externen Core Prozessoren.

Verfahren

1. Spannungsversorgung des Messumformers abklemmen.
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A\ VORSICHT!

Befindet sich die Auswerteelektronik in einer explosionsgefdhrdeten Umgebung,
5 Minuten warten, bevor fortgefahren wird.

2. Die Anschlussklemmenbldcke von der Anschlussklemmenleiste am Core Prozessor
abziehen.
3. UnterVerwendung eines digitalen Multimeters die Aufnehmerspulen durch Anlegen

der Multimeteradern an die Anschlussklemmenblécke fir jedes
Anschlussklemmenpaar priifen. Siehe Tabelle 12-12 bzgl. einer Auflistung der
Spulen. Notieren Sie sich die Werte.

Tabelle 12-12: Spulen und Test-Anschlussklemmenpaare

Spule Sensor Modell Farben der Anschluss-
klemmen

Antriebsspule Alle Braun - rot

Linke Aufnehmerspule (LPO) Alle Griin - weiss

Rechte Aufnehmerspule (RPO) Alle Blau - grau

Widerstandsthermometer (RTD) | Alle Gelb - violett

Adern Ldngenkompensator (LLC) | Alle auRer T-Serie und Gelb - orange

CMF400 (siehe Hinweis)

Gemeinsame Widerstandsther- | T-Serie Gelb - orange

mometer

Fester Widerstand (siehe Hin- CMF400 Gelb - orange

weis)

Anmerkung

Der feste Widerstand des CMF400 betrifft nur bestimmte Versionen vom CMF400. Weiteren
Informationen erhalten Sie von Micro Motion.

Es diirfen keine offenen Messkreise, d. h. unendliche Widerstandsmesswerte
auftreten. Der Messwerte fiir den linken und den rechten Aufnehmer sollten gleich
sein bzw. sehr nahe beieinander liegen (¥5 Q). Sollten uniibliche Werte auftauchen,
wiederholen Sie den Test an der Sensor Anschlussdose, um so mogliche Kabelfehler
zu eliminieren. An beide Enden des entsprechenden Spulenpaars sollten die Werte
gleich sein.

4, Die Anschlussklemmen in der Sensoranschlussdose auf Kurzschliisse zum Gehduse
prifen.
a. Die Anschlussklemmenblocke abgeklemmt lassen.
b. Den Deckel des Anschlussdose entfernen.
c. Die eine Ader des Multimeters an die Anschlussklemme und die andere am
Sensorgehduse anlegen, um jeweils eine Anschlussklemme zu priifen.

Setzen Sie das Multimeter auf den héchsten Bereich, da der Widerstandswert
jedes Ader unendlich sein sollte. Wird an einer Ader ein Widerstand gemessen,
liegt ein Kurzschluss zum Gehduse vor.

5. Den Widerstand der Anschlussklemmenpaare in der Anschlussdose priifen.
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a. Die braune Anschlussklemme gegen alle anderen Anschlussklemmen auRer der
roten priifen.

b. Die rote Anschlussklemme gegen alle anderen Anschlussklemmen auBer der
braunen prifen.

c. Die griine Anschlussklemme gegen alle anderen Anschlussklemmen auRRer der
weilSen priifen.

d. Die weilRe Anschlussklemme gegen alle anderen Anschlussklemmen auRer der
griinen priifen.

e. Die blaue Anschlussklemme gegen alle anderen Anschlussklemmen auBer der
grauen priifen.

f. Die graue Anschlussklemme gegen alle anderen Anschlussklemmen auRer der
blauen priifen.

g. Die orangefarbene Anschlussklemme gegen alle anderen Anschlussklemmen
auBer der violetten priifen.

h. Die gelbe Anschlussklemme gegen alle anderen Anschlussklemmen auRBer der
orangefarbenen und der violetten priifen.

i. Die violette Anschlussklemme gegen alle anderen Anschlussklemmen auRBer der
gelben und orangefarbenen priifen.

Fiir jedes Paar sollte der Widerstand unendlich sein. Wird ein Widerstand gemessen,
liegt ein Kurzschluss zwischen den Anschliissen vor.

Nachbereitungsverfahren

Zum normalen Betrieb zurtickkehren:

1. Anschlussklemmenbldcke wieder in die Anschlussplatine einsetzen.
2. Deckel der Anschlussdose am Sensor wieder anbringen.
Wichtig

Bei der Montage der Durchfluss-Messsystem Komponenten sicherstellen, dass die O-Ringe
eingefettet werden.

Core Prozessor LED priifen.

Der Core Prozessor verfiigt (iber eine LED, die die verschiedenen Zustande des
Messsystems anzeigt.

1.  Auswerteelektronik mit Spannung versorgen.

2. Gehdusedeckel des Core Prozessors entfernen. Der Core Prozessor ist eigensicher
und kann in jeder Umgebung gedéffnet werden.

3. Den Zustand der Core Prozessor LED priifen.
Nachbereitungsverfahren

Den Deckel des Core Prozessors wieder anbringen, um zum Normalbetrieb
zuriickzukehren.
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Wichtig

Bei der Montage der Durchfluss-Messsystem Komponenten sicherstellen, dass die O-Ringe
eingefettet werden.

12.32.1

Core Prozessor-LED-Status

Tabelle 12-13: Standard Core Prozessor-LED-Status

LED-Status

Beschreibung

Empfohlene MaBnahmen

1 x Blinken pro Sekunde (AN 25
%, AUS 75%)

Normalbetrieb

Keine MaRnahme erforderlich.

1 x Blinken pro Sekunde (AN
75%, AUS 25%)

Schwallstromung (Zweiphasen-
strdomung)

Siehe
Priifen auf Schwallstrémung (Zweiphasenstré-
mung).

Standig AN

Nullpunktkalibrierung oder Kali-
brierung lduft

Keine MaRnahme erforderlich.

Core Prozessor erhdlt 11,5 bis 5
\Y

Spannungsversorgung der Auswerteelektronik
prifen.

3 x schnelles Blinken mit ans-
chlieRender Pause

Sensor nicht erkannt

Die Verdrahtung zwischen Auswerteelektronik
und Sensor priifen.

Falsche Konfiguration

Sensor-Charakterisierungs-Parameter priifen.

Abgebrochener Pin zwischen
Sensor und Core Prozessor

Das Messgerat muss zur Reparatur ins Werk ein-
gesandt werden.

4 x Blinken pro Sekunde

Stérung

Alarmstatus priifen.

AUS

Core Prozessor erhdlt weniger
als5V

e Verdrahtung der Spannungsversorgung zum
Core Prozessor priifen.

e Leuchtet die Status-LED der Auswerteelektro-
nik, bekommt die Auswerteelektronik auch
Spannung. Spannung {iber den Klemmen 1
(VDC+) und 2 (VDC-) am Core Prozessor prii-
fen. Ist der Wert kleiner als 1 VDC, Verdrah-
tung der Spannungsversorgung zum Core Pro-
zessor priifen. Adern méglicherweise vertau-
schen.

e Leuchtet die Status-LED der Auswerteelektro-
nik nicht, bekommt die Auswerteelektronik
auch keine Spannung. Spannungsversorgung
priifen. Funktioniert die Spannungsversor-
gung, so kann die interne Auswerteelektronik,
das Display oder die LED fehlerhaft sein. Das
Messgerat muss moglicherweise zur Repara-
tur ins Werk eingeschickt werden.

Interner Fehler am Core Prozes-
sor

Das Messgerat muss zur Reparatur ins Werk ein-
gesandt werden.

Tabelle 12-14: LED-Status des Core Prozessors mit erweiterter Funktionalitat

LED-Status

Beschreibung

Empfohlene MaRBnahme

Griin

Normalbetrieb

Keine MaRnahme erforderlich.
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Tabelle 12-14: LED-Status des Core Prozessors mit erweiterter Funktionalitat (Fortsetzung)

LED-Status Beschreibung Empfohlene MaBnahme

Gelb blinkend Nullpunktkalibrierung lduft Keine MaRnahme erforderlich.

Gelb Alarm niedriger Prioritdt Alarmstatus priifen.

Dauerhaft rot Alarm hoher Prioritat Alarmstatus priifen.

Rot blinkend (80 % AN, 20 % Messrohre nicht gefiillt ¢ Wenn Alarm A105 (Schwallstromung) aktiv
AUS) ist, die entsprechenden MaRnahmen fiir die-

sen Alarm befolgen.

e Ist Alarm A033 (Messrohre nicht gefiillt) aktiv,
Prozess prifen. Auf Luft in den Durchflussroh-
ren, nicht gefiillte Messrohre, Fremdkorper
oder Ablagerungen in den Messrohren priifen.

Rot blinkend (50 % AN, 50 % Elektronikfehler Das Messgerat muss zur Reparatur ins Werk ein-

AUS) gesandt werden.

Rot blinkend (50 % AN, 50 % Sensorfehler Das Messgerdt muss zur Reparatur ins Werk ein-

AUS, tberspringt jedes vierte) gesandt werden.

AUS Core Prozessor erhdlt weniger e Verdrahtung der Spannungsversorgung zum
als5Vv Core Prozessor priifen.

e Leuchtet die Status-LED der Auswerteelektro-
nik, bekommt die Auswerteelektronik auch
Spannung. Spannung (iber den Klemmen 1
(VDC+) und 2 (VDC-) am Core Prozessor prii-
fen. Ist der Wert kleiner als 1 VDC, Verdrah-
tung der Spannungsversorgung zum Core Pro-
zessor priifen. Adern méglicherweise vertau-
schen.

e Leuchtet die Status-LED der Auswerteelektro-
nik nicht, bekommt die Auswerteelektronik
auch keine Spannung. Spannungsversorgung
prifen. Funktioniert die Spannungsversor-
gung, so kann die interne Auswerteelektronik,
das Display oder die LED fehlerhaft sein. Das
Messgerdt muss moglicherweise zur Repara-
tur ins Werk eingeschickt werden.

Interner Fehler am Core Prozes- | Das Messgerdt muss zur Reparatur ins Werk ein-
sor gesandt werden.

12.33 Core Prozessor Widerstandstest durchfiihren

1. Die Spannungsversorgung des Messumformers ausschalten.
Gehdusedeckel des Core Prozessors entfernen.

Das vieradrige Kabel am Core Prozessor zwischen Core Prozessor und
Auswerteelektronik abklemmen.

4, Den Widerstand zwischen den Anschlussklemmen 3-4, 2-3 und 2-4 am Core
Prozessor messen.
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Anschlussklemmen-
paar Funktion Erwarteter Widerstand
3-4 RS-485/A und RS-485/B 40 kQ bis 50 kQ
2-3 VDC- und RS-485/A 20 kQ bis 25 kQ
2-4 VDC- und RS-485/B 20 kQ bis 25 kQ
5.  Isteiner der gemessenen Widerstande kleiner als spezifiziert, so ist der Core

Prozessor nicht in der Lage mit der Auswerteelektronik oder einem externen Host
Rechner zu kommunizieren. Das Messgerdt muss moglicherweise zur Reparatur ins
Werk eingesandt werden.

Nachbereitungsverfahren

Zum normalen Betrieb zurlickkehren:

1. Das vieradrige Kabel zwischen Core Prozessor und Auswerteelektronik wieder
anschlieRen.

2. Bringen Sie den Gehausedeckel des Core Prozessors wieder an.

3. Spannungsversorgung der Auswerteelektronik wieder herstellen.

Anmerkung

Bei der Montage der Durchfluss-Messsystem Komponenten sicherstellen, dass die O-Ringe
eingefettet werden.
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Anhang A

VerwendungProlLink Il mit der
Auswerteelektronik

A.1
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In diesem Anhang behandelte Themen:

e Grundlegende Informationen (iber das ProLink I
*  Verbinden mit ProLink Il
e Mendstruktur fir ProLink Il

Grundlegende Informationen iiber das
ProLink I

ProLink Il ist ein Softwaretool von Micro Motion. Es lduft auf Windows und erméglicht den
Zugriff auf alle Daten und Funktionen der Auswerteelektronik.

ProLink Il Anforderungen

Zur Installation von ProLink Il brauchen Sie:
. Das ProLink Il Installationsmedium

. Das ProLink Il Installationskit fir Ihre Anschlussart
ProLink Il sowie das passende Installationskit erhalten Sie von Micro Motion.
ProLink Il Dokumentation

Die meisten Anweisungen in dieser Betriebsanleitung setzen voraus, dass Sie bereits mit
ProLink Il vertraut sind oder sich mit Windows-Programmen auskennen. Wenn Sie mehr
Informationen brauchen, als Sie in dieser Betriebsanweisung finden, schlagen Sie im
Handbuch ProLink Il (ProLink® Il Software fiir Micro Motion® Auswerteelektroniken:
Installations- und Betriebsanleitung) nach.

Fiir die meisten ProLink Il Installationen wird die Betriebsanleitung zusammen mit dem
ProLink Il Programm installiert. Dariiber hinaus finden die Betriebsanleitung fiir ProLink Il
auf der Micro Motion Dokumentations-CD oder der Micro Motion Website
(www.micromotion.com).

ProLink Il Merkmale und Funktionen

ProLink Il bietet alle Funktionen zur Konfiguration und zum Betrieb der
Auswerteelektronik. ProLink Il bietet auRerdem eine Reihe zusatzlicher Merkmale und
Funktionen, einschlieRlich:

. Der Méglichkeit, die Auswerteelektronik-Konfigurationsdaten auf einer Datei auf
dem PC zu speichern und sie auf andere Auswerteelektroniken zu laden oder zu
kopieren

. Die Moglichkeit, spezifische Datentypen in einer Datei auf dem PC zu protokollieren

. Ein Inbetriebnahme-Wizard

. Ein Priifungs-Wizard
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. Ein Gas-Wizard

Diese Funktionen werden in der ProLink Il Betriebsanleitung beschrieben. Sie werden nicht
im aktuellen Handbuch beschrieben.

ProLink Il Meldungen

Wenn Sie ProLink Il mit einer Micro Motion Auswerteelektronik verwenden, sehen Sie eine
Reihe von Meldungen und Hinweisen. Diese Betriebsanleitung beschreibt nicht alle dieser
Meldungen und Hinweise.

Wichtig
Der Benutzer ist fiir die Reaktion auf Meldungen und Hinweise und die Befolgung aller
Sicherheitshinweise verantwortlich.

A.2 Verbinden mit ProLink Il

Eine Verbindung von ProLink Il zur Auswerteelektronik ermdglicht das Lesen von
Prozessdaten, die Konfiguration der Auswerteelektronik und das Durchfiihren von
MaRnahmen fiir die Wartung und fiir die Stérungsanalyse/-beseitigung.

A.2.1 ProLink Il Verbindungsarten

Es stehen unterschiedliche Verbindungsarten fiir die Verbindung von ProLink Il zur
Auswerteelektronik zur Verfiigung. Die Verbindungsart auswdhlen, die fiir das
vorgesehene Netzwerk und die jeweiligen Aufgaben geeignet ist.

Die Auswerteelektronik unterstiitzt die folgenden ProLink Il Verbindungsarten:
. Serviceport Verbindungen

o HART/Bell 202 Verbindungen

o Modbus/RS-485 7-Bit-Verbindungen (Modbus ASCII)

. Modbus/RS-485 8-Bit-Verbindungen (Modbus RTU)

Bei der Auswahl einer Verbindungsart die folgenden Faktoren beachten:

o Serviceport Verbindungen verwenden Standard-Verbindungsparameter, die bereits
in ProLink Il definiert sind, und die deshalb nicht konfiguriert werden miissen.

. HART/Bell 202 Verbindungen verwenden Standard HART Verbindungsparameter,
die bereits in ProLink lldefiniert sind. Der einzige Parameter, der noch konfiguriert
werden muss, ist die Adresse der Auswerteelektronik.

. Serviceport Verbindungen kénnen nur hergestellt werden, wenn sich die RS-485
Anschlussklemmen der Auswerteelektronik im Serviceport-Modus befinden.
Andernfalls miissen sie in den Serviceport-Modus umgeschaltet werden, indem die
Auswerteelektronik aus- und wieder eingeschaltet und eine Verbindung innerhalb
der ndchsten 10 Sekunden hergestellt wird.

. RS-485 Verbindungen kdnnen nur hergestellt werden, wenn sich die RS-485
Anschlussklemmen der Auswerteelektronik im RS-485 Modus befinden. Andernfalls
miissen sie in den RS-485 Modus umgeschaltet werden, indem die
Auswerteelektronik aus- und wieder eingeschaltet und 15 Sekunden gewartet wird,
bevor eine Verbindung hergestellt wird.
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Modbus Verbindungen, einschlieRBlich Serviceport Verbindungen, sind gew&hnlich
schneller als HART Verbindungen.

Bei Verwendung einer HART Verbindung kénnen beim ProLink Il nicht mehr als ein
Fenster gleichzeitig gedffnet werden. Dies dient dazu, den Netzwerkverkehr zu
verwalten und die Geschwindigkeit zu optimieren.

Es kdnnen nicht gleichzeitig mehrere Verbindungen an denselben
Anschlussklemmen hergestellt werden. Gleichzeitige Verbindungen kénnen dann
hergestellt werden, wenn die Verbindungen unterschiedliche Anschlussklemmen
verwenden.

Herstellen einer Service Port-Verbindung

Vorbereitungsverfahren

ProLink Il Installiert und lizenziert auf lhrem PC
Eine der folgenden Versionen:

- RS-485 zu RS-232 Signalkonverter

- USB an RS-485 Signalkonverter

Ein verfligbarer serieller Port oder USB Port
Adapter wie erforderlich (z. B. 9-adrig bis 25-adrig)

Verfahren

Signalkonverter an den seriellen Port oder USB Port des PCs anschlieen.

Zugriff auf Service Port Anschlussklemmen:

a. Die Endkappe der Auswerteelektronik entfernen, um Zugriff auf das
Anschlussgehduse zu erhalten.

b. Die Schraube an der Warnklappe I6sen und das Gehause der
Spannungsversorgung o6ffnen.

Die Adern des Signalkonverters an die Anschlussklemmen 33 (RS-485/A) und 34
(RS-485/B) anschlieRen.

Hinweis
Normalerweise, jedoch nicht immer, ist die schwarze Ader der Anschluss fiir RS-485/A und die
rote Ader fiir RS-485/B.
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Abbildung A-1: Anschluss an Service Port
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A PC
B. Signalkonverter
C. Auswerteelektronik

Anmerkung
Diese Abbildung zeigt einen seriellen Port Anschluss. USB Anschliisse werden ebenfalls unterstiitzt.

4. Starten Sie ProLink I1.
Connection > Connect to Device auswahlen.

6. Protocol (Protokoll) auf Service Port einstellen.

Hinweis
Service Port-Anschliisse verwenden Standard-Anschlussparameter und eine Standardadresse.
Diese miissen hier nicht konfiguriert werden.

7. Den Wert des COM Port auf den Wert des PC COM-Ports einstellen, der fiir diese
Verbindung verwendet wird.

8. Fall erforderlich, die Auswerteelektronik Aus/Einschalten, um die
Anschlussklemmen in den Service Port Modus zu versetzen.

Die Anschlussklemmen der Auswerteelektronik werden in einem beliebigen Service
Port Modus oder im RS-485-Modus betrieben. Wenn sie sich im RS-485 Modus
befinden, muss die Auswerteelektronik Aus/Eingeschaltet und innerhalb der
ndchsten 10 Sekunden verbunden werden. Wenn die Verbindung nicht innerhalb
von 10 Sekunden zustande kommt, schalten die Anschlussklemmen in den RS-485
Modus. Wenn sich die Anschlussklemmen bereits im Service Port Modus befinden,
diesen Schritt Giberspringen.

9. Klicken Sie auf Connect.

Benotigen Sie Hilfe? Wenn eine Fehlermeldung erscheint:

» Die Adern vertauschen und erneut versuchen.

 Sicherstellen, dass der korrekte COM-Port angegeben wurde.

* Die physische Verbindung zwischen PC und Auswerteelektronik priifen.

* Sicherstellen, dass sich die RS-485 Anschlussklemmen an der Auswerteelektronik im
Service Port Modus befinden.
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Herstellen einer HART/Bell 202 Verbindung

Der Anschluss kann direkt an die primaren mA Anschlussklemmen an der
Auswerteelektronik, an jeden beliebigen Punkt in einem HART Messkreis oder an einen
beliebigen Punkt in einem HART Multidrop-Netzwerk erfolgen.

A\ VORSICHT!

Bei einem direkten Anschluss an die mA Anschlussklemmen kann sich dies auf den mA Ausgang
der Auswerteelektronik auswirken. Wenn der mA Ausgang fiir die Durchflussiiberwachung
verwendet wird, miissen die Gerdte auf manuelle Steuerung eingestellt werden, bevor eine
direkte Verbindung mit den mA Anschlussklemmen méglich ist.

Vorbereitungsverfahren

. ProLink Il Installiert und lizenziert auf Ihrem PC
. Eine der folgenden Versionen:
- RS-232 an Bell 202 Signalkonverter
- USB an Bell 202 Signalkonverter
. Ein verfligbarer serieller Port oder USB Port
. Adapter wie erforderlich (z. B. 9-adrig bis 25-adrig)

Verfahren
1. Signalkonverter an den seriellen Port oder USB Port des PCs anschlieen.
2. Direkter Anschluss an die Anschlussklemmen der Auswerteelektronik:

a. Die Adern des Signalkonverters an die Anschlussklemmen 21 und 22
anschlieRen.

Hinweis
HART Verbindungen sind nicht polaritdtsempfindlich. Es spielt dabei keine Rolle, welche
Ader dabei an welche Anschlussklemme angeschlossen wird.

b. Widerstande nach Bedarf hinzufiigen.

Wichtig
HART/Bell 202 Verbindungen erfordern einen Spannungsabfall von 1 VDC. Um dies zu
erreichen, einen Widerstand von 250-600 Q zu der Verbindung hinzuftigen.
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Abbildung A-2: Anschluss an Anschlussklemmen der Auswerteelektronik

Cc

PC

Signalkonverter
Widerstand 250-600 2
Auswerteelektronik

onNnm>

Anmerkung

Diese Abbildung zeigt einen seriellen Port Anschluss. USB Anschliisse werden ebenfalls unterstiitzt.

3. Anschluss von einem Punkt im lokalen HART Messkreis:

a. Die Adern des Signalkonverters an einen beliebigen Punkt im Messkreis
anschlieBen.

b. Widerstiande nach Bedarf hinzufiigen.

Wichtig
HART/Bell 202 Verbindungen erfordern einen Spannungsabfall von 1 VDC. Um dies zu
erreichen, einen Widerstand von 250-600 Q zu der Verbindung hinzufiigen.
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Abbildung A-3: Anschluss iiber lokalen Messkreis

R3

Rz gc

R1

>

PC

Signalkonverter

C. Jede beliebige Kombination von Widerstédnden R1, R2 und R3, die erforderlich ist, um den Anforderungen fiir HART
Kommunikationswiderstdnde zu entsprechen.

D. Prozessleitsystem oder SPS

E. Auswerteelektronik

I

Anmerkung
Diese Abbildung zeigt einen seriellen Port Anschluss. USB Anschliisse werden ebenfalls unterstiitzt.

4.  Anschluss tiber ein HART Multidrop-Netzwerk:

a. Die Adern des Signalkonverters an einen beliebigen Punkt im Netzwerk
anschlieRen.

b. Widerstinde nach Bedarf hinzufiigen.

Wichtig

HART/Bell 202 Verbindungen erfordern einen Spannungsabfall von 1 VDC. Um dies zu
erreichen, einen Widerstand von 250-600 Q zu der Verbindung hinzufiigen.
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Abbildung A-4: Anschluss iiber Multidrop-Netzwerk

onNn®>

Signalkonverter

Widerstand 250-600 2

Gerdte im Netzwerk

Master Gerdt

10.

11.

Starten Sie ProLink II.
Connection > Connect to Device auswahlen.
Protocol auf HART Bell 202 setzen.

Hinweis
HART/Bell 202 Anschliisse verwenden Standard-Anschlussparameter. Diese miissen hier nicht
konfiguriert werden.

Wenn ein USB Signalkonverter verwendet wird, Converter Toggles RTS aktivieren.

Address/Tag auf die in der Auswerteelektronik konfigurierten HART Abfrageadresse
einstellen.

Hinweise

* Beiderersten Verbindungsherstellung mit der Auswerteelektronik die Standardadresse 0
verwenden.

e Wenn keine HART Multidrop Umgebung verwendet wird, wird gewohnlich der
Standardwert fiir die HART Abfrageadresse verwendet.

¢ Auf Poll klicken, sofern die Adresse der Auswerteelektronik nicht bekannt ist. Das
Programm durchsucht das Netzwerk und zeigt eine Liste mit erkannten
Auswerteelektroniken an.

Den Wert des COM Port auf den Wert des PC COM-Ports einstellen, der fiir diese
Verbindung verwendet wird.

Master entsprechend einstellen.

Option | Beschreibung

Sekundar | Diese Einstellung verwenden, wenn ein anderer HART Host, wie ein Prozessleit-
system, im Netzwerk vorhanden ist.
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12.

Option ‘ Beschreibung

Primdr | Diese Einstellung verwenden, wenn kein anderer Host im Netzwerk vorhanden

ist. Handterminal ist kein Host.

Klicken Sie auf Connect.

Benoétigen Sie Hilfe? Wenn eine Fehlermeldung erscheint:

e Die HART Adresse der Auswerteelektronik tiberpriifen.
 Sicherstellen, dass der korrekte COM-Port angegeben wurde.

e Die physische Verbindung zwischen PC und Auswerteelektronik priifen.
e Erhohen oder Verringern der Widerstande.

* Sicherstellen, dass es keinen Konflikt mit einem anderen HART Master gibt.

Herstellen einer Modbus/RS-485 Verbindung

Der Anschluss kann direkt an die RS-485-Anschlussklemmen an der Auswerteelektronik
oder an einen beliebigen Punkt im Netzwerk erfolgen.

Vorbereitungsverfahren

ProLink Il Installiert und lizenziert auf Ihrem PC
Eine der folgenden Versionen:

- RS-485 zu RS-232 Signalkonverter

- USB an RS-485 Signalkonverter

Ein verfligbarer serieller Port oder USB Port
Adapter wie erforderlich (z. B. 9-adrig bis 25-adrig)

Verfahren

Signalkonverter an den seriellen Port oder USB Port des PCs anschlieRen.

Die Adern des Signalkonverters an die Anschlussklemmen 33 (RS-485/A) und 34
(RS-485/B) anschlieRen.

Hinweis

Normalerweise, jedoch nicht immer, ist die schwarze Ader der Anschluss fiir RS-485/A und die

rote Ader fiir RS-485/B.
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Abbildung A-5: Anschluss an Anschlussklemmen der Auswerteelektronik
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A PC
B. Signalkonverter
C. Auswerteelektronik

Anmerkung
Diese Abbildung zeigt einen seriellen Port Anschluss. USB Anschliisse werden ebenfalls unterstiitzt.

3. Anschluss tiber ein RS-485-Netzwerk:

a. Die Adern des Signalkonverters an einen beliebigen Punkt im Netzwerk
anschlieRen.

b. Widerstdnde nach Bedarf hinzufiigen.

Abbildung A-6: Anschluss iiber Netzwerk

A

A. PC
B. Signalkonverter
C. Widerstdnde 120 £, 1/2 W an beiden Segmentenden, falls erforderlich
D. Prozessleitsystem oder SPS
E. Auswerteelektronik
Anmerkung
Diese Abbildung zeigt einen seriellen Port Anschluss. USB Anschliisse werden ebenfalls unterstiitzt.

4.  Starten Sie ProLink II.

Connection > Connect to Device auswdhlen.
6.  Die Anschlussparameter auf die in der Auswerteelektronik konfigurierten Werte

einstellen.
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Bei nicht konfigurierter Auswerteelektronik die hier gezeigten Standardwerte
verwenden.

Tabelle A-1: Standard-Anschlussparameter fiir Modbus|RS-485

Parameter Voreingestellte Wert
Protokoll Modbus RTU
Baud 9600
Paritat Ungerade
Stoppbits 1
Adresse 1
Hinweis

Wenn die RS-485-Kommunikationseinstellungen der Auswerteelektronik unbekannt sind,
kann eine Verbindung Giber den Service Port hergestellt werden, oder es kann ein anderes
Kommunikations-Hilfsmittel verwendet werden, um die Einstellungen anzuzeigen oder zu
andern.

Den Wert des COM Port auf den Wert des PC COM-Ports einstellen, der fiir diese
Verbindung verwendet wird.

Falls erforderlich, die Auswerteelektronik Aus/Einschalten und 10 Sekunden warten,
um die Anschlussklemmen in den RS-485 Modus zu versetzen.

Die Anschlussklemmen der Auswerteelektronik werden in einem beliebigen Service
Port-Modus oder im RS-485 Modus betrieben. Befinden sie sich im Service Port
Modus, muss die Auswerteelektronik aus- und wieder eingeschaltet und

10 Sekunden gewartet werden, bis eine Verbindung hergestellt werden kann. Nach
Ablauf dieser Zeitspanne schalten die Anschlussklemmen in den RS-485 Modus.
Befinden sich die Anschlussklemmen bereits im RS-485-Modus, diesen Schritt
Gberspringen.

Klicken Sie auf Connect.

Benotigen Sie Hilfe? Wenn eine Fehlermeldung erscheint:
* Die Modbus Adresse der Auswerteelektronik tiberpriifen.
 Sicherstellen, dass der korrekte COM-Port angegeben wurde.

¢ Sicherstellen, dass sich die RS-485 Anschlussklemmen an der Auswerteelektronik im
RS-485 Modus befinden.

* Die physische Verbindung zwischen PC und Auswerteelektronik prifen.
e Erhohen oder Verringern der Widerstande.

e Zur Kommunikation (iber eine groRe Entfernung oder bei Signalrauschen durch eine
externe Quelle Abschlusswiderstande mit 120 Q und 2 W parallel zum Ausgang an
beiden Enden des Kommunikationsegments installieren.

 Sicherstellen, dass keine gleichzeitige Modbus-Kommunikation mit der
Auswerteelektronik besteht.
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A.3 Meniistruktur fir ProLink I

Abbildung A-7: Hauptmenii

‘ rAdditional Menu options-

File View Connection
Load from Xmtr to File Connect to Device
Save to Xmtr from File Connect to Densitometer/
Viscometer
License Disconnect
Preferences

» Use External Temperature

* Enable Inventory Totals Reset

» Enable External Pressure Compensation
» Copper RTD

Installed options
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Abbildung A-8: Hauptmenii (Fortsetzung)

“““““ *] | |

ProLink Tools Plug-ins

Gas Unit Configurator Data Logging*
Meter Verification
Entrained Gas Analyzer Enable/Disable
Commissioning Wizard Custody Transfer
Proving Wizard
Marine Bunker Transfer
Options

Configuration

Output Levels

Process Variables

Status

Alarm Log

Diagnostic Information
Calibration

Test

API Totalizer Control

CM Totalizer Control
Totalizer Control

Core Processor Diagnostics
Finger Print

API Process Variables

CM Process Variables

PPI Variables

ED Process Variables
Batcher Control

Run Filler

NOC - Well Performance Measurement

*For information about using Data Logger, refer to the ProLink Il manual.
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Abbildung A-9: Konfigurationsmenii

ProLink >
Configuration

—————————————— - —-Additional configuration options — »

Device Alarm
* Model * Alarm
» Manufacturer * Severity

» Hardware Rev

* Distributor

« Software Rev

«ETO

» CP Software Rev

«CP ETO

* Option Board

* Firmware Checksum

* CP Firmware Checksum

* Tag

* Date

* Descriptor

* Message

* Sensor type

* Transmitter Serial

* Floating PT Ordering

* Add Comm Resp Delay

* Restore Factory Configuration
* Digital Comm Fault Setting
* HART Address

* Enable Loop Current Mode
* HART Device ID

* Modbus Address

* Enable Write Protection

» Update Rate

* Response Time

 Enable Burst

* Burst Cmd

*Burst Var 1...4
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Abbildung A-10: Konfigurationsmenii (Fortsetzung)

ProLink >
Configuration
—————————————— -»———-Additional configuration options ——»
Flow Temperature
* Flow Direction * Temp Units
* Flow Damp » Temp Cal Factor
* Flow Cal » Temp Damping
» Mass Flow Cutoff  External Temperature
* Mass Flow units » External RTD

» Mass Factor

* Dens Factor

* Vol Factor

* Flow Switch Variable

* Flow Switch Setpoint

* Flow Switch Hysteresis

* Enable Entrained Gas
Handling

* Vol Flow Cutoff

* Vol Flow Units

* Vol Flow Type

* Std Gas Vol Flow Cutoff

Density

* Dens Units

* Dens Damping

* Slug High Limit

* Slug Low Limit

* Slug Duration

* Low Density Cutoff
* K1

K2
+ Std Gas Vol Flow Units «FD
+ Std Gas Density . D1
» Gas Wizard .D2

» Temp Coeff (DT)
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Abbildung A-11: Konfigurationsmenii (Fortsetzung)

ProLink >
Configuration
—————————————— - —-Additional configuration options — »
Pressure Sensor
* Flow Factor * Sensor s/n
* Dens Factor * Sensor Model
* Cal Pressure * Sensor Matl
* Pressure Units ¢ Liner Matl
 External Pressure * Flange
Special Units T Series
* Base Mass Unit «FTG
* Base Mass Time «FFQ
* Mass Flow Conv Fact DTG
* Mass Flow Text « DFQ1
* Mass Total Text «DFQ2
«K3
* Base Vol Unit D3
* Base Vol Time D4
* Vol Flow Conv Fact K4
* Vol Flow Text
* Vol Total Text
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Abbildung A-12: Konfigurationsmenii (Fortsetzung)

ProLink >
Configuration

—————————————— - —-Additional configuration options — »

Analog Output Frequency
Primay/Secondary Output * Tertiary Variable
*PV/SV is * Freq Factor

LRV * Rate Factor

* URV * Freq Pulse Width

* AO Cutoff * Last Measured Value Timeout
* AO Added Damp * Freq Output Mode
*LSL * Scaling Method

* USL * Pulses Per SCF

* Min Span » SCF Per Pulse

* AO Fault Action * Freq Fault Action

» AO Fault Level * Freq Output Polarity
* Last Measured Value Timeout

Events Variable mapping RS-485

* Event 1/2 *PVis * Protocol

* Variable *SVis * Parity

* Type *TVis * Baud Rate
* Setpoint *QVis « Stop Bits

Abbildung A-13: Konfigurationsmenii (Fortsetzung)

ProLink >
Configuration

—————————————— - —-Additional configuration options - »

Discrete Input

Channel « Start Sensor Zero
« Channel A Discrete Output * Reset Mass Total
« Channel B Discrete Output 1/2 || * Reset Volume Total
« Type Assignment || * DO1/2 Assignment | | * Reset All Totals
« Power Type « DO1/2 Polarity « Start/Stop All Totalization
« Channel C + DO1/2 Fault action ||+ Reset Gas Std Volume Total
* Type Assignment » Reset API Ref Vol Total
» Power Type » Reset CM Ref Vol Total
» Reset CM Net Total

* Increment Current CM Curve
« Start Meter Verification
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Abbildung A-14: Konfigurationsmenii (Fortsetzung)

ProLink >
Configuration

Polled Variables
Polled Variable 1/2
* Polling Control

* External Tag

* Variable Type

* Current Value

Discrete Events

* Event Name

* Event Type

* Process Variable
* Low Setpoint (A)
* High Setpoint (B)

System

» Weights and Measures
Approval

« Software Rev

« Totalizer Reset Options
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Anhang B

VerwendungProLink Il mit der
Auswerteelektronik

B.1

242

In diesem Anhang behandelte Themen:

e Grundlegende Informationen (iber das ProLink Il
*  Verbinden mit ProLink Il
e Mendstruktur fiir ProLink Il

Grundlegende Informationen iiber das
ProLink III

ProLink Il ist eine Konfigurations- und Service-Software von Micro Motion. Sie lduft auf
Windows und ermdglicht den Zugriff auf alle Daten und Funktionen der
Auswerteelektronik.

ProLink Ill Anforderungen

Zur Installation von ProLink Il brauchen Sie:
. Das ProLink Ill Installationsmedium

. Das ProLink Il Installationskit fiir Ihre Anschlussart
ProLink lll sowie das passende Installationskit erhalten Sie von Micro Motion.
ProLink Il Dokumentation

Die meisten Anweisungen in dieser Betriebsanleitung setzen voraus, dass Sie bereits mit
ProLink lll vertraut sind oder sich mit Windows-Programmen auskennen Falls Sie weitere
Informationen benoétigen, die Sie nicht in dieser Betriebsanleitung finden, schlagen Sie im
ProLink Il Handbuch (ProLink® Il Konfigurations- und Service-Software fiir Micro Motion®
Auswerteelektroniken: Betriebsanleitungl) nach.

Fiir die meisten ProLink IIl Installationen wird die Betriebsanleitung zusammen mit dem
ProLink Il Programm installiert. Dariiber hinaus finden die Betriebsanleitung fiir ProLink I
auf der Micro Motion Dokumentations-CD oder der Micro Motion Website
(www.micromotion.com).

ProLink lll Merkmale und Funktionen

ProLink Il bietet alle Funktionen zur Konfiguration und zum Betrieb der
Auswerteelektronik. ProLink Ill bietet auRerdem eine Reihe zusatzlicher Merkmale und
Funktionen, einschlieRlich:

. Der Moglichkeit, die Auswerteelektronik-Konfigurationsdaten in einer Datei auf dem
PC zu speichern und sie auf andere Auswerteelektroniken zu laden oder zu kopieren

. Die Maglichkeit, spezifische Datentypen in einer Datei auf dem PC zu protokollieren

. Die Maglichkeit, Leistungstrends fiir verschiedene Datentypen auf dem PC
anzuzeigen

MicroMotion® Auswerteelektronik Modell 2500 mit konfigurierbaren Ein-/Ausgéngen
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. Die Mdglichkeit, die Verbindung zu mehr als einem Gerat herzustellen und deren
Informationen anzuzeigen

. Ein gefiihrter Verbindungsassistent

Diese Funktionen werden in der ProLink Il Betriebsanleitung beschrieben. Sie werden nicht
in der aktuellen Betriebsanleitung beschrieben.

ProLink Ill Meldungen

Wenn Sie ProLink Ill mit einer Micro Motion Auswerteelektronik verwenden, sehen Sie eine
Reihe von Meldungen und Hinweisen. Diese Betriebsanleitung beschreibt nicht alle dieser
Meldungen und Hinweise.

Wichtig
Der Benutzer ist fiir die Reaktion auf Meldungen und Hinweise und die Befolgung aller
Sicherheitshinweise verantwortlich.

B.2 Verbinden mit ProLink llI

Eine Verbindung von ProLink Ill zur Auswerteelektronik ermdglicht das Lesen von
Prozessdaten, die Konfiguration der Auswerteelektronik und das Durchfiihren von
MaRnahmen fiir die Wartung und fir die Stérungsanalyse/-beseitigung.

B.2.1 ProLink Ill Verbindungsarten

Es stehen unterschiedliche Verbindungsarten fiir die Verbindung von ProLink Ill zur
Auswerteelektronik zur Verfligung. Die Verbindungsart auswahlen, die fiir das
vorgesehene Netzwerk und die jeweiligen Aufgaben geeignet ist.

Die Auswerteelektronik unterstiitzt die folgenden ProLink Il Verbindungsarten:

. Serviceport Verbindungen

HART/Bell 202 Verbindungen

. Modbus/RS-485 7-Bit-Verbindungen (Modbus ASCII)

. Modbus/RS-485 8-Bit-Verbindungen (Modbus RTU)

Bei der Auswahl einer Verbindungsart die folgenden Faktoren beachten:

. Serviceport Verbindungen verwenden Standard-Verbindungsparameter, die bereits
in ProLink lll definiert sind, und die deshalb nicht konfiguriert werden miissen.

. HART/Bell 202 Verbindungen verwenden Standard HART Verbindungsparameter,
die bereits in ProLink llidefiniert sind. Der einzige Parameter, der noch konfiguriert
werden muss, ist die Adresse der Auswerteelektronik.

. Serviceport Verbindungen kénnen nur hergestellt werden, wenn sich die RS-485
Anschlussklemmen der Auswerteelektronik im Serviceport-Modus befinden.
Andernfalls miissen sie in den Serviceport-Modus umgeschaltet werden, indem die
Auswerteelektronik aus- und wieder eingeschaltet und eine Verbindung innerhalb
der ndchsten 10 Sekunden hergestellt wird.
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RS-485 Verbindungen kénnen nur hergestellt werden, wenn sich die RS-485
Anschlussklemmen der Auswerteelektronik im RS-485 Modus befinden. Andernfalls
muissen sie in den RS-485 Modus umgeschaltet werden, indem die
Auswerteelektronik aus- und wieder eingeschaltet und 15 Sekunden gewartet wird,
bevor eine Verbindung hergestellt wird.

Modbus Verbindungen, einschlieBlich Serviceport Verbindungen, sind gewéhnlich
schneller als HART Verbindungen.

Bei Verwendung einer HART Verbindung kénnen beim ProLink Ill nicht mehr als ein
Fenster gleichzeitig gedffnet werden. Dies dient dazu, den Netzwerkverkehr zu
verwalten und die Geschwindigkeit zu optimieren.

Es kdnnen nicht gleichzeitig mehrere Verbindungen an denselben
Anschlussklemmen hergestellt werden. Gleichzeitige Verbindungen kénnen dann
hergestellt werden, wenn die Verbindungen unterschiedliche Anschlussklemmen
verwenden.

B.2.2 Herstellen einer Service Port Verbindung

Vorbereitungsverfahren

ProLink Il Installiert und lizenziert auf lhrem PC
Eine der folgenden Versionen:

- RS-485 zu RS-232 Signalkonverter

- USB an RS-485 Signalkonverter

Ein verfligbarer serieller Port oder USB Port
Adapter wie erforderlich (z. B. 9-adrig bis 25-adrig)

Verfahren

244

Signalkonverter an den seriellen Port oder USB Port des PCs anschlieRen.

Zugriff auf Service Port Anschlussklemmen:

a. Die Endkappe der Auswerteelektronik entfernen, um Zugriff auf das
Anschlussgehduse zu erhalten.

b. Die Schraube an der Warnklappe I6sen und das Gehduse der
Spannungsversorgung 6ffnen.

Die Adern des Signalkonverters an die Anschlussklemmen 33 (RS-485/A) und 34
(RS-485/B) anschlieen.

Hinweis
Normalerweise, jedoch nicht immer, ist die schwarze Ader der Anschluss fiir RS-485/A und die
rote Ader fiir RS-485/B.
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Abbildung B-1: Anschluss an Service Port

i
0 El°
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CEEEE
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00000

A PC
B. Signalkonverter
C. Auswerteelektronik

Anmerkung
Diese Abbildung zeigt einen seriellen Port Anschluss. USB Anschliisse werden ebenfalls unterstiitzt.

4, Starten Sie ProLink IlI.
Connect to Physical Device auswahlen.
6. Protocol (Protokoll) auf Service Port einstellen.

Hinweis
Service Port-Anschliisse verwenden Standard-Anschlussparameter und eine Standardadresse.
Diese miissen hier nicht konfiguriert werden.

7. Den Wert des PC Port auf den Wert des PC COM-Ports einstellen, der fir diese
Verbindung verwendet wird.

8. Fall erforderlich, die Auswerteelektronik Aus/Einschalten, um die
Anschlussklemmen in den Service Port Modus zu versetzen.

Die Anschlussklemmen der Auswerteelektronik werden in einem beliebigen Service
Port Modus oder im RS-485-Modus betrieben. Wenn sie sich im RS-485 Modus
befinden, muss die Auswerteelektronik Aus/Eingeschaltet und innerhalb der
ndchsten 10 Sekunden verbunden werden. Wenn die Verbindung nicht innerhalb
von 10 Sekunden zustande kommt, schalten die Anschlussklemmen in den RS-485
Modus. Wenn sich die Anschlussklemmen bereits im Service Port Modus befinden,
diesen Schritt Giberspringen.

9. Klicken Sie auf Connect.

Benotigen Sie Hilfe? Wenn eine Fehlermeldung erscheint:

» Die Adern vertauschen und erneut versuchen.

 Sicherstellen, dass der korrekte COM-Port angegeben wurde.

* Die physische Verbindung zwischen PC und Auswerteelektronik priifen.

* Sicherstellen, dass sich die RS-485 Anschlussklemmen an der Auswerteelektronik im
Service Port Modus befinden.
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B.2.3
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Herstellen einer HART/Bell 202 Verbindung

Der Anschluss kann direkt an die primaren mA Anschlussklemmen an der
Auswerteelektronik, an jeden beliebigen Punkt in einem HART Messkreis oder an einen
beliebigen Punkt in einem HART Multidrop-Netzwerk erfolgen.

A\ VORSICHT!

Bei einem direkten Anschluss an die mA Anschlussklemmen kann sich dies auf den mA Ausgang
der Auswerteelektronik auswirken. Wenn der mA Ausgang fiir die Durchflussiiberwachung
verwendet wird, miissen die Gerdte auf manuelle Steuerung eingestellt werden, bevor eine
direkte Verbindung mit den mA Anschlussklemmen méglich ist.

Vorbereitungsverfahren

. ProLink Il Installiert und lizenziert auf lhrem PC
. Eine der folgenden Versionen:
- RS-232 an Bell 202 Signalkonverter
- USB an Bell 202 Signalkonverter
. Ein verfligbarer serieller Port oder USB Port
. Adapter wie erforderlich (z. B. 9-adrig bis 25-adrig)

Verfahren
1. Signalkonverter an den seriellen Port oder USB Port des PCs anschlieen.
2. Direkter Anschluss an die Anschlussklemmen der Auswerteelektronik:

a. Die Adern des Signalkonverters an die Anschlussklemmen 21 und 22
anschlieRen.

Hinweis
HART Verbindungen sind nicht polaritdtsempfindlich. Es spielt dabei keine Rolle, welche
Ader dabei an welche Anschlussklemme angeschlossen wird.

b. Widerstande nach Bedarf hinzufiigen.

Wichtig
HART/Bell 202 Verbindungen erfordern einen Spannungsabfall von 1 VDC. Um dies zu
erreichen, einen Widerstand von 250-600 Q zu der Verbindung hinzufiigen.
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Abbildung B-2: Anschluss an Anschlussklemmen der Auswerteelektronik

Cc

PC

Signalkonverter
Widerstand 250-600 2
Auswerteelektronik

onNnm>

Anmerkung

Diese Abbildung zeigt einen seriellen Port Anschluss. USB Anschliisse werden ebenfalls unterstiitzt.

3. Anschluss von einem Punkt im lokalen HART Messkreis:

a. Die Adern des Signalkonverters an einen beliebigen Punkt im Messkreis
anschlieBen.

b. Widerstiande nach Bedarf hinzufiigen.

Wichtig
HART/Bell 202 Verbindungen erfordern einen Spannungsabfall von 1 VDC. Um dies zu
erreichen, einen Widerstand von 250-600 Q zu der Verbindung hinzufiigen.
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Abbildung B-3: Anschluss iiber lokalen Messkreis

R3

Rz gc

R1

>

PC

Signalkonverter

C. Jede beliebige Kombination von Widerstédnden R1, R2 und R3, die erforderlich ist, um den Anforderungen fiir HART
Kommunikationswiderstdnde zu entsprechen.

D. Prozessleitsystem oder SPS

E. Auswerteelektronik

I

Anmerkung
Diese Abbildung zeigt einen seriellen Port Anschluss. USB Anschliisse werden ebenfalls unterstiitzt.

4.  Anschluss tiber ein HART Multidrop-Netzwerk:

a. Die Adern des Signalkonverters an einen beliebigen Punkt im Netzwerk
anschlieRen.

b. Widerstinde nach Bedarf hinzufiigen.

Wichtig

HART/Bell 202 Verbindungen erfordern einen Spannungsabfall von 1 VDC. Um dies zu
erreichen, einen Widerstand von 250-600 Q zu der Verbindung hinzufiigen.
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Abbildung B-4: Anschluss iiber Multidrop-Netzwerk

c
A. Signalkonverter
B. Widerstand 250-600 £2
C. Gerdte im Netzwerk
D. Master Gerdt
Starten Sie ProLink Ill.

10.

11.

Connect to Physical Device auswahlen.
Protocol auf HART Bell 202 setzen.

Hinweis
HART/Bell 202 Anschliisse verwenden Standard-Anschlussparameter. Diese miissen hier nicht
konfiguriert werden.

Wenn ein USB Signalkonverter verwendet wird, Toggle RTSaktivieren.

Address/Tag auf die in der Auswerteelektronik konfigurierten HART Abfrageadresse
einstellen.

Hinweise

* Beiderersten Verbindungsherstellung mit der Auswerteelektronik die Standardadresse 0
verwenden.

e Wenn keine HART Multidrop Umgebung verwendet wird, wird gewohnlich der
Standardwert fiir die HART Abfrageadresse verwendet.

¢ Auf Poll klicken, sofern die Adresse der Auswerteelektronik nicht bekannt ist. Das
Programm durchsucht das Netzwerk und zeigt eine Liste mit erkannten
Auswerteelektroniken an.

Den Wert des PC Port auf den Wert des PC COM-Ports einstellen, der fiir diese
Verbindung verwendet wird.

Master entsprechend einstellen.

Option | Beschreibung

Sekundar | Diese Einstellung verwenden, wenn ein anderer HART Host, wie ein Prozessleit-
system, im Netzwerk vorhanden ist.
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B.2.4
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12.

Option ‘ Beschreibung

Primdr | Diese Einstellung verwenden, wenn kein anderer Host im Netzwerk vorhanden

ist. Handterminal ist kein Host.

Klicken Sie auf Connect.

Benoétigen Sie Hilfe? Wenn eine Fehlermeldung erscheint:

e Die HART Adresse der Auswerteelektronik tiberpriifen.
 Sicherstellen, dass der korrekte COM-Port angegeben wurde.

e Die physische Verbindung zwischen PC und Auswerteelektronik priifen.
e Erhohen oder Verringern der Widerstande.

* Sicherstellen, dass es keinen Konflikt mit einem anderen HART Master gibt.

Herstellen einer Modbus/RS-485 Verbindung

Der Anschluss kann direkt an die RS-485-Anschlussklemmen an der Auswerteelektronik
oder an einen beliebigen Punkt im Netzwerk erfolgen.

Vorbereitungsverfahren

ProLink Il Installiert und lizenziert auf Ihrem PC
Eine der folgenden Versionen:

- RS-485 zu RS-232 Signalkonverter

- USB an RS-485 Signalkonverter

Ein verfligbarer serieller Port oder USB Port
Adapter wie erforderlich (z. B. 9-adrig bis 25-adrig)

Verfahren

Signalkonverter an den seriellen Port oder USB Port des PCs anschlieRen.

Die Adern des Signalkonverters an die Anschlussklemmen 33 (RS-485/A) und 34
(RS-485/B) anschlieRen.

Hinweis

Normalerweise, jedoch nicht immer, ist die schwarze Ader der Anschluss fiir RS-485/A und die

rote Ader fiir RS-485/B.
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Abbildung B-5: Anschluss an Anschlussklemmen der Auswerteelektronik
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A PC
B. Signalkonverter
C. Auswerteelektronik

Anmerkung
Diese Abbildung zeigt einen seriellen Port Anschluss. USB Anschliisse werden ebenfalls unterstiitzt.

3. Anschluss tiber ein RS-485-Netzwerk:

a. Die Adern des Signalkonverters an einen beliebigen Punkt im Netzwerk
anschlieRen.

b. Widerstdnde nach Bedarf hinzufiigen.

Abbildung B-6: Anschluss iiber Netzwerk

A

A. PC
B. Signalkonverter
C. Widerstdnde 120 £, 1/2 W an beiden Segmentenden, falls erforderlich
D. Prozessleitsystem oder SPS
E. Auswerteelektronik
Anmerkung
Diese Abbildung zeigt einen seriellen Port Anschluss. USB Anschliisse werden ebenfalls unterstiitzt.

4.  Starten Sie ProLink Il

Connect to Physical Device auswahlen.
6.  Die Anschlussparameter auf die in der Auswerteelektronik konfigurierten Werte

einstellen.
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Bei nicht konfigurierter Auswerteelektronik die hier gezeigten Standardwerte
verwenden.

Tabelle B-1: Standard-Anschlussparameter fiir Modbus/RS-485

Parameter Voreingestellte Wert
Protokoll Modbus RTU
Baud 9600
Paritat Ungerade
Stoppbits 1
Adresse 1
Hinweis

Wenn die RS-485-Kommunikationseinstellungen der Auswerteelektronik unbekannt sind,
kann eine Verbindung Giber den Service Port hergestellt werden, oder es kann ein anderes
Kommunikations-Hilfsmittel verwendet werden, um die Einstellungen anzuzeigen oder zu
andern.

Den Wert des PC Port auf den Wert des PC COM-Ports einstellen, der fiir diese
Verbindung verwendet wird.

Falls erforderlich, die Auswerteelektronik Aus/Einschalten und 10 Sekunden warten,
um die Anschlussklemmen in den RS-485 Modus zu versetzen.

Die Anschlussklemmen der Auswerteelektronik werden in einem beliebigen Service
Port-Modus oder im RS-485 Modus betrieben. Befinden sie sich im Service Port
Modus, muss die Auswerteelektronik aus- und wieder eingeschaltet und

10 Sekunden gewartet werden, bis eine Verbindung hergestellt werden kann. Nach
Ablauf dieser Zeitspanne schalten die Anschlussklemmen in den RS-485 Modus.
Befinden sich die Anschlussklemmen bereits im RS-485-Modus, diesen Schritt
Gberspringen.

Klicken Sie auf Connect.

Benotigen Sie Hilfe? Wenn eine Fehlermeldung erscheint:
* Die Modbus Adresse der Auswerteelektronik tiberpriifen.
 Sicherstellen, dass der korrekte COM-Port angegeben wurde.

¢ Sicherstellen, dass sich die RS-485 Anschlussklemmen an der Auswerteelektronik im
RS-485 Modus befinden.

* Die physische Verbindung zwischen PC und Auswerteelektronik prifen.
e Erhéhen oder Verringern der Widerstande.

e Zur Kommunikation (iber eine groRe Entfernung oder bei Signalrauschen durch eine
externe Quelle Abschlusswiderstande mit 120 Q und %2 W parallel zum Ausgang an
beiden Enden des Kommunikationsegments installieren.

 Sicherstellen, dass keine gleichzeitige Modbus-Kommunikation mit der
Auswerteelektronik besteht.
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B.3 Meniistruktur fiir ProLink lll

Abbildung B-7: Geradte-Tools: Hauptmenii

Alerts

Calibration Data
Wizards 2
Configuration [
Calibration [

Configuration Transfer »

Diagnostics k
Trending b
Data Logging...

Print...

Totalizer Control ]

Device Information

Disconmect

Abbildung B-8: Gerdte-Tools: Konfiguration (mit eichamtl. Transfer)

Alerts
Calibration Data
Wizards 3
Configuration F | Writ=-Protection
Configuration Transfer ¥ | Process Measurement ¥
Diagnostics 4 1o . g
Trending 3 F Itie'-fﬂ“t'r'.
_ ult Processing
Data Logaing...
Events F
Print... Tatalizer Control Methods
Tatalizer Contral p | Communications ¢
Weights & Measures
Device Information Informational Parameters »
Disconnect
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Abbildung B-9: Konfiguration: Prozessmessung (mit Mineralolmessung)

Alerts
Calibration Data
Wizards »
Configuration P | Write-Protection
Configuration Transfer b | Process Measurement b | Sensor Polling Rate
Diagnostics b el ) b | Flow
Trending R Ale.rttt Smrerlt',.r. Density
i [ T Fault Processing Temperature
Events b Pressure Compensation
Print... Tatalizer Control Methods Petroleum Maasurement
Totalizer Control p | Communications g
Weights & Measures
Device Information Informational Parameters b
Disconmnect

Abbildung B-10: Konfiguration: Prozessmessung (mit Konzentrationsmessung)

Alerts
Calibration Data
Wizards 3
Configuration F [ Writ=-Protection
Configuration Transfer b | Process Measurement b | Sensor Polling Rate
Diagnostics 3 1o ) ) e
Trending Ale.rtttSeverlt'.r. Density
S LT Fault Processing Temperature
Events b Pressure Compensation
Print... Cormmunications b | Concentration Measurement
Totalizer Control ’ Informational Parameters k

Device Information

Disconnect
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Abbildung B-11: Konfiguration: E[A

Alerts

Calibration Data

Wizards »

Configuration P [ Writ=-Protection

Configuration Transfer b | Process Measurement 4

Diagnostics k 1jo ) b | Channels

Trending R AlertttSeuerlt'.r. Outputs 3

e | T Fault Processing Inputs 3
Events ¥ | Action Assignment

Print... Communications 3

Totalizer Control , Informational Parameters b

Device Information

Disconnect

Abbildung B-12: Konfiguration: Ereignisse

Alerts
Calibration Data
Wizards 3
Configuration ¥ | Writ=-Protection
Configuration Transfer ¥ | Process Measurement b
Diagneostics 4 s g

' Alert Severity
Trending it ]
P LT Fault Processing

Events P | Basic Evenis

Print... Communications b | Enhanced Events
Totalizer Control , Informational Parametzrs k

Device Information

Disconnect
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Abbildung B-13: Konfiguration: Kommunikation

Alerts
Calibration Data
Wizards »
Configuration P [ Write-Protection
Configuration Transfer ¥ | Process Measurement 4
Diagnastics b o ) g
Trending b e hiﬁ'ﬁferlt'r'_

_ ult Processing
Data Logging...

Events 3

Print... Communications b | Fault Action
Totalizer Cantrol > Informational Parameters ¥ | Communications (HART)

Communications (Modbus)

Device Information R5-485 Terminals

Disconnect

Abbildung B-14: Konfiguration: Informationsparameter

Alerts
Calibration Data
‘Wizards [
Configuration P [ Writz-Protection
Configuration Transfer ¥ | Process Measurement b
Diagnostics 4 Lo ) g
Trending 2 A;iwenw_

i ult Processing
Data Logging...

Ewents 3
Print... Communications b
Totalizer Control , Informational PFarametsrs b | Sensor
Transmitter

Device Information

Disconnect
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Abbildung B-15: Gerdte-Tools: Kalibrierung

Alerts

Calibration Data

Wizards 3

Configuration 3

Calibration ¥ | Zero Verification and Calibration
Configuration Transfer » |  Density Calibration k
erreie y | Temperature Ch.lihraticun 2
Trending b me Cubput 1 Trim

Data Logging...

Print...

Totalizer Control 3

Device Infarmation

Disconnect

Abbildung B-16: Kalibrierung: Dichtekalibrierung

Blerts

Calibration Data

Wizards 3

Configuration b

Calibration ¥ | Zero Verification and Calibration

Configuration Transfer » | Density Calibration ¥ | Density Calibration - Point 1 {Air)
R y | Temperature Calibration b | Density Calibration - Point 2 {Water)
TerafTe , m Output 1 Trim Density Calibration - Flowing Density
Data Logaing...

Print...

Tatalizer Contral 2

Device Information

Disconmect
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Abbildung B-17: Kalibrierung: Temperaturkalibrierung

Alerts

Calibration Data

Wizards 3

Configuration 3

Calibration ¥ | Zero Verification and Calibration

Configuration Transfer » | Density Calibration k

e y | Temperature 'Célibmtiﬂn b | Temperature Calibration - Cffset
Trerafre N met Output 1 Trim Temperature Calibration - Slope
Data Logging...

Print...

Totalizer Control 3

Device Infarmation

Disconnect

Abbildung B-18: Gerite-Tools: Ubertragung der Konfiguration

Blerts

Calibration Data
Wizards 3
Configuration 3
Calibration 3

Configuration Transfer » | Save or Load Configuration Data
Impaort Data from ProLink I

Diagnostics F ]
et ’ Import Data from ProLink I_I
St LT Restore Factory Configuration
Print...

Taotalizer Control b

Device Information

Disconnect
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Abbildung B-19: Diagnose: Test

Alerts

Calibration Data
Wizards b
Configuration 2
Calibration [

Configuration Transfer p

Diagnostics b | Testing b | mA Output 1 Test
Trending ¥ | Core Processor Diagnostics Discrete Output Test
Data Logging...

Print...

Taotalizer Control »

Device Information

Disconmect

Abbildung B-20: Diagnose: Systemverifizierung

Alerts

Calibration Data

Wizards 3

Configuration 3

Configuration Transfer ¢

Diagnostics ¥ [ Testing 3

Trending ¥ | Core Processor Diagnostics

Data Logging... Meter Verification P [ Run Test...

Print... Schedule Meter Verification
Totalizer Control 3

Device Information

Disconnect

Konfigurations- und Bedienungsanleitung 259



VerwendungProLink Ill mit der Auswerteelektronik

Abbildung B-21: Gerdte-Tools: Trenderstellung

Blerts

Calibration Data
Wizards 3
Configuration 3
Calibration 3

Configuration Transfer

Diagnostics F

Trending b | Create Trend Chart... I
Data Logging...

Prink...

Totalizer Control 3

Device Information

Disconnect
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Anhang C

Verwendung derHandterminal mit der
Auswerteelektronik

C.1

In diesem Anhang behandelte Themen:

*  Grundlegende Informationen (iber das Handterminal
. Verbinden mit Handterminal
e Mendstruktur fiir das Handterminal

Grundlegende Informationen iiber das
Handterminal

Das Handterminal ist ein Handterminal zur Konfiguration sowie zum Daten- und
Funktionshandling, das mit verschiedenen Geraten, einschlieBlich Micro Motion
Auswerteelektroniken, verwendet werden kann. Es ermdglicht den Zugriff auf alle Daten
und Funktionen der Auswerteelektronik.

Handterminal Dokumentation

Die meisten Anweisungen in dieser Betriebsanleitung setzen voraus, dass Sie bereits mit
dem Handterminal Handterminal vertraut sind und daher die nachfolgenden Schritte
durchfiihren kénnen:

. Einschalten des Handterminal

. Navigieren durch die Men(s des Handterminal Handterminals

. Aufnahme der Kommunikation mit HART-kompatiblen Geraten

. Senden von Konfigurationsdaten an das Gerat

. Benutzen der alphanumerischen Tastatur zur Eingabe von Informationen

Wenn Sie nicht in der Lage sind die oben aufgefiihrten Punkte auszufiihren, nehmen Sie
die Betriebsanleitung des Handterminal zur Hand, bevor Sie mit dem Handterminal
arbeiten. Sie finden die Betriebsanleitung fiir Handterminal auf der Micro Motion
Dokumentations-CD oder der Micro Motion Website (www.micromotion.com).

Gerdtebeschreibungen (DDs)

Damit das Handterminal mit Ihrem Gerat arbeiten kann, missen die entsprechenden
Geratebeschreibungen (Device-Deskriptoren, DD) installiert sein. Die

Modell 2500Modell 2700 Auswerteelektronik erfordert die folgenden HART-
Geratebeschreibungen: .

Auf dem Handterminal Handterminal installierte Geratebeschreibungen anzeigen:

1. Im HART-Anwendungsmenii klicken Sie auf Utility > Available Device Descriptions.

2. Wdhlen Sie Micro Motion aus der Liste der Hersteller und gehen Sie anschlieRend zur
Liste der installierten Gerdtebeschreibungen.
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C.2

262

Wenn Micro Motion nicht aufgefiihrt ist oder Sie die erforderliche Gerdtebeschreibung nicht
sehen, verwenden Sie das Handterminal Easy Upgrade Programm, um die
Gerdteschreibung zu installieren, oder wenden Sie sich an Micro Motion.

Handterminal Menii und Meldungen

Viele der Men(is in dieser Betriebsanleitung beginnen mit dem Online-Menii. Stellen Sie
sicher, dass Sie durch das Online-Men(i navigieren kdnnen.

Wenn Sie Handterminal mit einer Micro Motion Auswerteelektronik verwenden, sehen Sie
eine Reihe von Meldungen und Hinweisen. Diese Betriebsanleitung beschreibt nicht alle
dieser Meldungen und Hinweise.

Wichtig
Der Benutzer ist fiir die Reaktion auf Meldungen und Hinweise und die Befolgung aller
Sicherheitshinweise verantwortlich.

Verbinden mit Handterminal

Eine Verbindung von Handterminal zur Auswerteelektronik ermdglicht das Lesen von
Prozessdaten, die Konfiguration der Auswerteelektronik und das Durchfiihren von
MaRnahmen fiir die Wartung und fiir die Stérungsanalyse/-beseitigung.

Handterminal kann an die primdren mA Anschlussklemmen an der Auswerteelektronik, an
jeden beliebigen Punkt in einem lokalen HART Messkreis oder an einen beliebigen Punkt in
einem HART Multidrop-Netzwerk angeschlossen werden.

Vorbereitungsverfahren
Die folgende HART Gerdtebeschreibung (DD) muss auf dem Handterminal installiert sein: .
Verfahren

1. Um eine Verbindung mit den Anschlussklemmen der Auswerteelektronik
herzustellen, die Adern von Handterminal an die Anschlussklemmen 21 und 22 an
der Auswerteelektronik anschlieBen und nach Bedarf Widerstdnde hinzufiigen.

Handterminal muss tiber einen Widerstand von 250-600 Q angeschlossen werden.

Hinweis
HART connections are not polarity-sensitive. It does not matter which lead you attach to
which terminal.
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Abbildung C-1: Handterminal Anschluss an die Anschlussklemmen der
Auswerteelektronik

A. Handterminal
B. Widerstand 250-600 2
C. Anschlussklemmen der Auswerteelektronik

2. Um eine Verbindung mit einem Punkt im lokalen HART Messkreis herzustellen, die

Adern von Handterminal an jeden beliebigen Punkt im Messkreis anschlieRen und
nach Bedarf Widerstdande hinzufiigen.

Handterminal muss (iber einen Widerstand von 250-600 Q angeschlossen werden.

Abbildung C-2: Handterminal Anschluss an lokalen HART Messkreis

A. Handterminal
B. Widerstand 250-600 2
C. Auswerteelektronik mit Anschlussgehduse und Gehduse der Spannungsversorgung gedffnet

3. Umeine Verbindung zu einem Punkt im HART Multidrop-Netzwerk herzustellen, die
Adern von Handterminal an jeden beliebigen Punkt im Netzwerk anschlieRen.
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Abbildung C-3: Handterminal Anschluss an ein Multidrop-Netzwerk

D
C

A. Handterminal

B. Widerstand 250-600 2

C. Gerdte im Netzwerk

D. Master Gerdt
4, Handterminal einschalten und warten, bis das Hauptmenii angezeigt wird.
5.  Beieiner Verbindung tiber ein Multidrop-Netzwerk:

a. Handterminal auf Abfrage einstellen.

Das Gerdt gibt alle giiltigen Adressen aus.
b. Die HART Adresse der Auswerteelektronik eingeben.
Die voreingestellte HART Adresse ist 0. In einem Multidrop-Netzwerk ist die

HART Adresse wahrscheinlich jedoch auf einen anderen eindeutigen Wert
eingestellt.

Nachbereitungsverfahren

HART Application > Online auswdhlen, um zum Menii Online zu navigieren. Die meisten
Konfigurations-, Wartungs- und FehlerbehebungsmaRnahmen werden {iber das Menii
Online ausgefiihrt.

Hinweis
Es werden moglicherweise Meldungen beziiglich DD oder aktiven Alarmen angezeigt. Durch
Betdtigen der entsprechenden Tasten die Meldung ignorieren und fortfahren.
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C3

Meniistruktur fiir das Handterminal

Abbildung C-4: Online-Menii

On-Line Menu

1 2 3
| | |
Overview Configure Service Tools
1 Check Status 1 Manual Setup 1 Alerts
2 Primary Purpose Variables 2 Alert Setup 2 Variables
3 Shortcuts 3 Trends
4 Maintenance
5 Simulate
Abbildung C-5: Ubersichtsmenii
On-Line Menu >
1 Overview
I I |
1 2 3
1 | |
Check Status Primary Purpose Variables Shortcuts

1 Refresh Alerts
2 Dev Status:

Mass Flow Rate
Volume Flow Rate

3 Comm Status: Density

1 Device Information
2 Totalizer Control

3 Zero Calibration

4 Variables

5 Trends

6 Meter Verification *

I
1
|

Device Information

1 Product Information

2 Mat. of Construction

3 Licenses

4 Weights and Measures **
5 Checksums

1
I

4

Product Information

1 Tag

2 Model

3 Xmtr Software Rev

4 CP Software Rev

5 Option Board

6 ETO Number

7 Final Asmbly Num

8 Sensor Serial Num

9 HART DD Information

Weights and Measures

1 Cstdy Trnsfr Approval
2 W&M Software Version

Displayed only if meter
verification is enabled.
Displayed only if Weights &
Measures application is enabled.
Menu numbers are adjusted as
required.
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Abbildung C-6: Konfigurationsmenii: Hochste Ebene

On-Line Menu >
1 Configure

1 2

| |
Manual Setup Alert Setup
1 Characterize 1 Configure Alerts
2 Measurements 2 Discrete Output
3 Inputs/Outputs 3 Discrete Events
4 Info Parameters

5 Communications

Abbildung C-7: Konfigurationsmenii: Héchste Ebene

On-Line Menu >
2 Configure >
1 Manual Setup

[ |
1 2 3
| | |
Characterize Measurements Inputs/Outputs
1 Sensor Type 1 Flow 1 Set Up Channels
2 Sensor Tag 2 Density 2 Set Up mA Output 1
Parameters 3 Temperature 3 Set Up mA Output 2
4 Update Rate 4 Set Up Frequency Output
5 Set Up Special Units 5 Set Up Discrete Output
6 Set Up External Compensation 6 Set Up Discrete Input
7 Set Up Petroleum * 7 Set Up RS-485 Port
8 Set Up GSV 8 Map Variables
e
4 5
| |
Info Parameters Communications
1 Transmitter Info 1 HART Address
2 Sensor Information 2 Tag
3 Device Identification

4 Device ID (CP)
5 Set Up Burst Mode

Displayed only if the petroleum measurement
application is enabled on your transmitter. Menu
numbers are adjusted as required.
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Abbildung C-8: Konfigurationsmenii: Manuelle Einstellungen: Charakterisieren

On-Line Menu >
2 Configure >

1 Manual Setup >

1 Characterize

Characterize

1 Sensor Type
2 Sensor Tag Parameters

1 2
|
Sensor Type
1 Curved Tube
2 Straight Tube
Curved Tube Sensor Type Straight Tube:
Sensor Tag Parameters Sensor Tag Parameters
1 FlowCal 1 Flow Parameters
2 D1 2 Density Parameters
3D2
4TC
5K1 I 1
6 K2 1 2
7FD I I
Flow Parameters Density Parameters
1 Flow FCF 1D1
2FTG 2D2
3 FFQ 3DT
4 DTG
5K1
6 K2
7FD
8 DFQ1
9 DFQ2
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Abbildung C-9: Konfigurationsmenii: Manuelle Einstellungen: Messungen

On-Line Menu >
2 Configure >
1 Manual Setup >
2 Measurements

Flow Set Up Special Units
1 Flow Direction —5—1 1 Mass Special Units
2 Flow Damping 2 Volume Special Units

3 Mass Flow Cutoff
—1— 4 Mass Flow Unit
5 Volume Flow Cutoff *

6 Volume Flow Unit * Set Up External Compensation
7 Mass Factor .
8 Volume Factor 1 Pressure Unit

2 Enable Press Comp
3 Flow Cal Pressure

Density | —6— 4 Static Pressure
5 Flow Press Factor
1 Density Unit 6 Dens Press Factor
2 Density Damping 7 Enable Ext Temp
—2— 3 Density Cutoff 8 External Temperature
4 Density Factor 9 External Polling

5 Slug High Limit
6 Slug Low Limit

7 Slug Duration Set Up Petroleum **

Temperature ; ; $5E‘g) CTL Table type
—3— 1 Temperature Unit 3 Ref Temperature

2 Temp Damping 4 Petroleum Msmt Setup

Update Rate
Set Up GSV

N

1 Update Rate

2100 Hz Variable 1 Volume Flow Type

g | 2 Gas Density

3 Gas Vol Flow Cutoff

4 Gas Vol Flow Unit

*  Displayed only if Volume Flow Type = Liquid. Menu 5 Gas Density Unit
numbers are adjusted as required.

** Displayed only if the petroleum measurement
application is enabled on your transmitter. Menu
numbers are adjusted as required.
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Abbildung C-10: Konfigurationsmenii: Manuelle Einstellungen: Eingdnge[Ausgdnge

On-Line Menu >
2 Configure >

1 Manual Setup >
3 Inputs/Outputs

Additional

[
1
1

I
2
|

| options
3 P

Set Up Channels

1 Channel A
2 Channel A Power Source
3 Channel B

Set Up mA Output 1

1 Primary Variable
2 mA Output Settings
3 MAO1 Fault Settings

Set Up mA Output 2

1 Secondary Variable
2 mA Output Settings
3 MAO2 Fault Settings

5 Channel C

4 Channel B Power Source

6 Channel C Power Source

mA Output Settings

1PV LRV

2 PV URV

3 PV Min Span

4 PV LSL

5PV USL

6 PV MAO1 Cutoff

7 PV Added Damping

N

mA Output Settings

18V LRV

2 SV URV

3 SV Min Span

4 SV LSL

58SV USL

6 SV MAO2 Cutoff

7 SV Added Damping

L—3—

MAO1 Fault Settings

1 MAO1 Fault Action
2 MAO1 Fault Level

3—

MAO2 Fault Settings

1 MAO2 Fault Action
2 MAO2 Fault Level
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Abbildung C-11: Konfigurationsmenii: Manuelle Einstellungen: Eingdnge|Ausgdnge (Fortsetzung)

On-Line Menu >
2 Configure >
1 Manual Setup >

3 Inputs/Outputs

> ‘L
4 6
! ! L |
Set Up Frequency Output Set Up Discrete Output Set Up Discrete Input
1 FO Settings 1 DO 1 Assignment 1 DI Assignment
2 FO Fault Parameters 2 DO 1 Polarity 2 DI Polarity
3 FO Scaling 3 DO 1 Fault Action
4 DO 2 Assignment
5 DO 2 Polarity
6 DO 2 Fault Action
7 Flow Switch Source
- 8 Flow Switch Setpoint
FO Settings 9 Hysteresis (0.1-10.0)
|—-1—{ 1 Third Variable
2 Max Pulse Width
3 FO Polarit
’ ! —
Set Up RS-485 Port Map Variables

FO Fault Parameters

l_2_{ 1 Third Variable
2 FO Fault Action
3 FO Fault Level

1 Protocol
2 Baud Rate
3 Parity

4 Stop Bits

5 Modbus Slave Address

1 Primary Variable

2 Secondary Variable
3 Third Variable

4 Fourth Variable

FO Scaling

L3 | 1 FO Scaling Method

3 TV Rate Factor
4 Set FO Scaling

2 TV Frequency Factor

Abbildung C-12: Konfigurationsmenii: Alarmeinrichtung

On-Line Menu >
2 Configure >
2 Alert Setup

[
1
|

[
2
|

|
3
|

Configure Alerts

1 Fault Timeout

2 MAO1 Fault Settings
3 MAO2 Fault Settings
4 FO Fault Action

5 FO Fault Level

6 Comm Fault Action
7 Set Alert Severity

8 View Alert Severity

Discrete Output

1 DO 1 Assignment

2 DO 1 Polarity

3 DO 1 Fault Action

4 DO 2 Assignment

5 DO 2 Polarity

6 DO 2 Fault Action

7 Flow Switch Source
8 Flow Switch Setpoint
9 Hysteresis (0.1-10.0)

Discrete Events

1 Discrete Event 1

2 Discrete Event 2

3 Discrete Event 3

4 Discrete Event 4

5 Discrete Event 5

6 Assign Discrete Action
7 Read Discrete Action

8 Review Discrete Actions

[
1,2,3,4,5
|

Discrete Event x

1 Discrete Event Var
2 Discrete Event Type
3 Setpoint A

4 Setpoint B

270

MicroMotion® Auswerteelektronik Modell 2500 mit konfigurierbaren Ein-/Ausgéngen




Verwendung derHandterminal mit der Auswerteelektronik

Abbildung C-13: Service Tools Menii: Héchste Ebene

On-Line Menu >
3 Service Tools

Alerts

1 Refresh Alerts

2 Alert Name

3 Additional Information for
Above

Variables

1 Variable Summary
2 Process Variables
3 Mapped Variables
4 External Variables
5 Totalizer Control

6 Variables (PM) *

7 Variables (CM) **
8 Outputs

Trends

1 Process Variables
2 Diagnostic Variables

Maintenance

1 Routine Maintenance

2 Zero Calibration

3 Density Calibration

4 Temperature Calibration
5 Diagnostic Variables

Simulate

1 Simulate Outputs
2 Simulate Sensor

*  Displayed only if the petroleum measurement
application is enabled on your transmitter. Menu
numbers are adjusted as required.

** Displayed only if the concentration measurement
application is enabled on your transmitter. Menu
numbers are adjusted as required.
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Abbildung C-14: Service Tools Menii: Variablen

On-Line Menu >
3 Service Tools >
2 Variables

Variable Summary

L 1—]

Process Variables

1 Mass Flow Rate

2 Volume Flow Rate *
|_o__| 3 Density

4 Temperature

Mapped Variables

1PV
28V
3TV
4 Qv

3]

External Variables

N

1 External Temperature
2 External Pressure

If Volume Flow Type = GSV, GSV variables are
displayed.

** Displayed only if the petroleum measurement
application is enabled on your transmitter. Menu
numbers are adjusted as required.

Displayed only if the concentration measurement
application is enabled on your transmitter. Menu
numbers are adjusted as required.

**** Displayed only if the Weights & Measures
application is installed on your transmitter.

5

Totalizer Control

1 All Totalizers

2 Mass

3 Volume *

4 CM Volume at Reference
Temperature

5 CM Net Mass ***

6 CM Net Volume ***

7 Temp Corrected Volume (PM) **
8 Custody Transfer *****

All Totalizers

1 Start Totalizers
—1—{ 2 Stop Totalizers

3 Reset All Totals
4 Mass Total

5 Volume Total *

Mass

1 Mass Flow Rate
| 2 Mass Total
3 Mass Inventory
4 Reset Total

Volume *

1 Volume Flow Rate
2 Volume Total

3 Volume Inventory
4 Reset Total

272

MicroMotion® Auswerteelektronik Modell 2500 mit konfigurierbaren Ein-/Ausgéngen



Verwendung derHandterminal mit der Auswerteelektronik

Abbildung C-15: Service Tools Menii: Variablen

On-Line Menu >
3 Service Tools >

2 Variables
Variables (PM) * Outputs
1 Density at Reference o | 1 mA Output (MAO)
Temperature 2 Frequency Output
2 Average Observed Density
—6— 3 Volume Flow at Reference
Temperature
4 Average Observed mA Output
Temperature L1 1 Present MAO Gauge
5 CTL 2 PV MAO
3 PV % Range
Variables (CM) **
Standard Volume Flow Rate
2 Standard Net Volume Flow Frequency Output
Rate —2— 1 Present Freq Gauge
—7— 3 Net Mass Flow Rate 2 Present Freq Output
4 Density at Reference
5 Concentration
6 Density (Fixed SG Units)

Displayed only if petroleum measurement is enabled
on your transmitter. Menu numbers are adjusted as
required.

Displayed only if concentration measurement is
enabled on your transmitter. Menu numbers are
adjusted as required.

o

Abbildung C-16: Service Tools Menii: Wartung

On-Line Menu >
3 Service Tools >
4 Maintenance

1 2 3
| | |
Routine Maintenance Zero Calibration Density Calibration
1 Trim mA Output 1 1 Mass Flow Rate 1 Density
2 Trim mA Output 2 2 Volume Flow Rate 2 Dens Pt1 (Air)
3 Meter Verification * 3 Zero Time 3 Dens Pt2 (Water)
4 Zero Value 4 Dens Pt3 T-Series
5 Standard Deviation 5 Dens Pt4 T-Series
6 Perform Auto Zero 6 Flowing Dens (FD)
7 Restore Factory Zero

3 4 5

1 1 1
Meter Verification ** Temperature Calibration Diagnostic Variables
1 Run Meter Verification 1 Temperature 1 Sensor Model
2 View Test Results 2 Temp Cal Factor 2 Drive Gain
3 Schedule Meter 3 Offset Calibration 3 Input Voltage
Verification 4 Slope Calibration 4 LPO Amplitude

5 RPO Amplitude

6 Board Temperature
7 Tube Frequency
Displayed only if meter verification is 8 Live Zero

enabled. 9 Fld Verification Zero
Displayed only if Smart Meter
Verification is enabled. For earlier
versions, the Meter Verification
Method is launched.
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Abbildung C-17: Service Tools Menii: Simulation

On-Line Menu >
3 Service Tools >
5 Simulate

Simulate

1 Simulate Outputs
2 Simulate Sensor

1 2
Simulate Outputs Simulate Sensor
1 mA Output 1 Loop Test 1 Simulation Mode
2 mA Output 2 Loop Test 2 Mass Flow Rate
3 Frequency Output Test 3 Density
4 Discrete Output 1 Test 4 Temperature
5 Discrete Output 2 Test
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Anhang D
Voreingestellte Werte und Bereiche

D.1 Voreingestellte Werte und Bereiche

Die Standardwerte und -bereiche reprasentieren die typische Auswerteelektronik-
Konfiguration. Je nach Bestellung der Auswerteelektronik sind bestimmte Werte vom
Hersteller konfiguriert und entsprechen nicht den Standardwerten und -bereichen.

Tabelle D-1: Voreingestellte Werte und Bereiche der Auswerteelektronik

Typ Parameter Standard Bereich Bemerkungen
Durchfluss FlieBrichtung Vorwadrts
Durchflussddmpfung 0,85 0,0-60,05s Vom Anwender eingegebener

Wert, korrigiert auf den néchst
niedrigeren vorkonfigurierten
Wertin der Liste. Im Modus Spe-
cial betragen die voreingestell-
ten Werte 1/5 des Normal-
wertes. Fiir Gasanwendungen
empfiehlt Micro Motion einen
Mindestwert von 2,56.

Durchflusskalibrierfaktor 1.00005.13 Bei Sensoren der T_Serie repra-
sentiert dieser Wert den ver-
knipften FCF- und FT-Faktor.

Massedurchfluss-Messeinheiten | g/s

Massedurchflussabschaltung 0,0q/s Empfohlene Einstellungist 5 %
des max. Durchflusses vom Sen-
Sor.

Volumendurchflussart FlGssigkeit

Volumendurchfluss-Messein- /s

heiten

Volumendurchflussabschaltung | 0/01/s 0,0 -xl/s x erhalten Sie durch die Multipli-

kation des Durchflusskalibrier-
faktors mit 0,2, bei Verwendung
der Einheit I/s.

Messgerate- Massefaktor 1
faktoren Dichtefaktor 1
Volumenfaktor 1
Dichte Dichteddampfung 1,65 0,0-60,0s Vom Anwender eingegebener

Wert, korrigiert auf den nachs-
ten vorkonfigurierten Wert in
der Liste.

(1) Im Modus Special betrdgt der Standardwert 0,64 s.
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Voreingestellte Werte und Bereiche

Tabelle D-1: Voreingestellte Werte und Bereiche der Auswerteelektronik (Fortsetzung)

en

Typ Parameter Standard Bereich Bemerkungen
Dichteeinheiten g/cm3
Dichteabschaltung 0,2 g/cm3 0,0-0,5
g/em?
D1 0 g/cm?3
D2 1g/cm3
K1 1000 ps 1000 - 50.000
us
K2 50.000 ps 1000 - 50.000
s
FD 0
Temp.-koeffizient 4,44
Schwallstro- Unterer Schwallstrom-Grenz- 0,0 g/cm3 0,0-10,0
mung wert g/cm?
Oberer Schwallstrom-Grenzwert | 5,0 g/cm?3 0,0-10,0
g/cm?3
Schwallstromdauer 0,0s 0,0-60,0s
Temperatur Temperaturdampfung 4,85 0,0-80s Vom Anwender eingegebener
Wert, korrigiert auf den nédchst
niedrigeren vorkonfigurierten
Wertin der Liste.
Temperatureinheiten Grad C
Temperaturkalibrierfaktor 1.00000T0.00
00
Druck Druckeinheiten PSI
Durchflussfaktor 0
Dichtefaktor 0
Kalibrierter Druck 0
SensorderT- | D3 0g/cm?3
Serie D4 0g/cm3
K3 Ous
K4 0 s
FTG 0
FFQ 0
DTG 0
DFQ1 0
DFQ2 0
Spezialeinheit- | Basis-Masseeinheit g

Basis-Massezeit

(%}

Massedurchfluss-Umrechnungs-
faktor

Basis-Volumeneinheit
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Voreingestellte Werte und Bereiche

Tabelle D-1: Voreingestellte Werte und Bereiche der Auswerteelektronik (Fortsetzung)

Typ Parameter Standard Bereich Bemerkungen
Basis-Volumenzeit s
Volumendurchfluss-Umrech- 1
nungsfaktor
Variablen- Primdrvariable Massedurch-
zuordnung fluss
Sekunddrvariable Dichte
Tertidrvariable Massedurch-
fluss
Quartidrvariable Volumen-
durchfluss
mA-Ausgang 1 | Primarvariable Massedurch-
fluss
Messanfang -200,00000 g/s
Messende 200,00000 g/s
Analogausgangsabschaltung 0,00000 g/s
AO (Analogausgang) zusatzliche | 0,00000 s
Dampfung
UsG -2004g/s Schreibgeschiitzt.
USG wird auf Basis der Sensor-
groRe und Charakterisierung-
sparameter berechnet.
0SG 200g/s Schreibgeschiitzt.
OSG wird auf Basis der Sensor-
groRe und Charakterisierung-
sparameter berechnet.
Min. Spanne 0,3g/s Schreibgeschiitzt.
FehlermaBnahme Herunterskalie-
ren
Analogausgang-Storpegel - Her- | 2,0 mA 1,0-3,6 mA
unterskalieren
Analogausgang-Storpegel - Her- 1 22 mA 21,0- 24,0 mA
aufskalieren
Zuletzt gemessener Wert vor 0,00s
Timeout
mA-Ausgang 2 | Sekunddrvariable Dichte
Messanfang 0,00 g/cm3
Messende 10,00 g/cm3
Analogausgangsabschaltung Not-A-Number
AO (Analogausgang) zusdtzliche | 0,00000 s
Dampfung
UsG 0,00 g/cm3 Schreibgeschiitzt.

USG wird auf Basis der Sensor-
groRe und Charakterisierung-
sparameter berechnet.
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Voreingestellte Werte und Bereiche

Tabelle D-1: Voreingestellte Werte und Bereiche der Auswerteelektronik (Fortsetzung)

Typ Parameter Standard Bereich Bemerkungen
0SG 10,00 g/cm3 Schreibgeschiitzt.
OSG wird auf Basis der Sensor-
groRe und Charakterisierung-
sparameter berechnet.
Min. Spanne 0,05 g/cm3 Schreibgeschiitzt.
FehlermaRnahme Herunterskalie-
ren
Analogausgang-Stérpegel - Her- | 2,0 mA 1,0 -3,6 mA
unterskalieren
Analogausgang-Storpegel - Her- | 22 mA 21,0-24,0mA
aufskalieren
Zuletzt gemessener Wert vor 0,00s
Timeout
Messanfang Massedurchflussrate -200,000 g/s
Volumendurchflussrate -0,2001L/s
Dichte 0,000 g/cm?
Temperatur -240,000 °C
Antriebsverstarkung 0,000 %
Standard-Gas-Volumendurch- -423,78 SCFM
fluss
Externe Temperatur -240,000 °C
Externer Druck 0,000 psi
Messende Massedurchflussrate 200,000 g/s
Volumendurchflussrate 0,200L/s
Dichte 10,000 g/cm3
Temperatur 450,000 °C
Antriebsverstarkung 100,000 %
Standard-Gas-Volumendurch- 423,78 SCFM
fluss
Externe Temperatur 450,000 °C
Externer Druck 100,000 psi
Frequenzaus- | Tertidrvariable Massedurch-
gang fluss
Frequenzfaktor 1.000,00 Hz 0,001 -10.000
Hz
Durchflussfaktor 1000 kg/min
Frequenz-Impulsbreite 277,0 ms 0oder0,5-
277,5ms
Skaliermethode Frequenz =
Durchfluss
Frequenz-FehlermaBnahme Herunterskalie-
ren
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Voreingestellte Werte und Bereiche

Tabelle D-1: Voreingestellte Werte und Bereiche der Auswerteelektronik (Fortsetzung)

Typ Parameter Standard Bereich Bemerkungen
Frequenz-Stérpegel — Herauf- 15.000 Hz 10,0 - 15.000
skalieren Hz
Frequenzausgangs-Polaritét Active high
Zuletzt gemessener Wert vor 0,0s 0,0-60,0s
Timeout

Bindrausgang 1| Quelle FlieBrichtung
Fehleranzeige Keine
Spannungsversorgung Intern
Polaritdt Active high

Bindrausgang 2 | Quelle Durchfluss-

schalter
Polaritat Active high

Bindreingang | Aktionen Keine
Polaritat Active low

Digitale Kom- | FehlermaRnahme Keine

munikation Fehler-Timeout 0s 0,0-60,0s
Modbus-Adresse 1
Modbus ASCII Unterstiitzung Aktiviert
FlieBkomma Byte Anweisung 3-4-1-2
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Auswerteelektronik-Komponenten und Installationsverdrahtungs

Anhang E

Auswerteelektronik-Komponenten und
Installationsverdrahtungs

In diesem Anhang behandelte Themen:

. Installationsarten
e Anschlussklemmen fiir Spannungsversorgung
e Ein-/Ausgangs-(E/A)-Verdrahtungsanschlussklemmen

E.1 Installationsarten

Die Auswerteelektroniken Modell 1500 und Modell 2500 kénnen auf zwei verschiedene
Arten installiert werden, von denen jeweils nur eine auf Ihre spezifische Installation zutrifft.

. Externe Montage, 4-adrig — Die Auswerteelektronik wird separat vom Sensor
installiert. Sie miissen die Auswerteelektronik vom Sensor separat montieren, ein 4-
adriges Kabel zwischen Auswerteelektronik und Sensor anschlieRen sowie die
Spannungsversorgungs- und E/A-Verdrahtung an die Auswerteelektronik
anschlieRen.

Abbildung E-1: Installation mit externer Montage, 4-adrig

Auswerteelektronik

Core Prozessor

4-adriges Kabel

. Externer Core Prozessor mit externem Sensor — Bei einer Installation mit
externem Core Prozessor und externem Sensor sind alle drei Komponenten -
Auswerteelektronik, Core Prozessor und Sensor - getrennt und werden separat
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Auswerteelektronik-Komponenten und Installationsverdrahtungs

installiert. Die Auswerteelektronik wird durch ein 4-adriges Kabel mit dem Core
Prozessor verbunden, und der Core Prozessor wird durch ein 9-adriges Kabel mit
dem Sensor verbunden.

Abbildung E-2: Installation mit externem Core Prozessor und externem Sensor

Auswerteelektronik

4-adriges Kabe Core Prozessor

Anschlussdose
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E.2 Anschlussklemmen fiir Spannungsversorgung

Abbildung E-3: Anschlussklemmen Spannungsversorgung

A
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A Primdre Spannungsversorgung (DC)
B. Steckbrticke der Spannungsversorgung zu anderen Auswerteelektroniken der Modelle 1500 oder
2500 (optional)

+

[

E.3 Ein-/Ausgangs-(E[A)-

Verdrahtungsanschlussklemmen

Abbildung E-4: E|A-Anschlussklemmen
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Serviceanschluss oder Modbus/RS-485

mA-Ausgang, Frequenzausgang oder Bindrausgang
Frequenzausgang, Bindrausgang oder Bindreingang
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Historie NE 53

AnhangF

Historie NE 53

F.1

Historie NE 53

Datum

Version

Typ

Anderung

Betriebsanlei-
tung

08/2000

1.x

Erweiterung

Schreiben der Gerdtekennzeichnung mittels
Modbus hinzugefiigt

Einstellung

Kommunikationshandling mit HART Tri-Loop
Produkt verbessert

Funktion

Anzeige der Ausgangsoptions-Platinentyps wird
beim Einschalten im Display angezeigt

3600204 A

05/2001

2.X

Erweiterung

Alarm A106 hinzugefiigt, um anzuzeigen, dass
der HART Burst-Modus aktiviert ist

Zugriff auf Auswerteelektronik in Fehlerstatusbit
via Modus hinzugefiigt

Steuerung des HART Burst-Modus jetzt via Mod-
bus moglich

Unterstiitzung fiir Auswerteelektronik
Modell 1700 hinzugefiigt

Unterstiitzung fiir eigensichere Auswerteelek-
tronikoption hinzugefiigt

Unterstiitzung zur Konfiguration von Prozessvar-
iableneinheiten fiir Massedurchfluss, Volumen-
durchfluss, Dichte und Temperatur mittels Be-
dieninterface hinzugefiigt.

Unterstiitzung fiir das Zuweisen von Prozessvar-
iablen zum mA- und Frequenzausgang mittels
Bedieninterface hinzugefiigt

Einstellung

Interaktion der digitalen Stéreinstellung und
Stérung-Timeouts (zuletzt gemessener Wert
Timeout) bereinigt

Funktion

Antriebsverstdrkung kann mA Ausgang zugewie-
sen werden

Druckkompensation via HART hinzugefiigt

Kanal B kann als Bindrausgang konfiguriert wer-
den

3600204 B
3600647 A

12/2001

3.x

Erweiterung

Unterstiitzung fiir konfigurierbare E/A-Options-
platine hinzugefiigt

Software-Versionsinformationen tiber Bedienin-
terface oder Modbus verfiigbar

Konfigurierbare Dichteabschaltung

3600647 B
3600785 A
20000325 A
200003258
20000150 A
200001508
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Betriebsanlei-

Datum Version Typ Anderung tung
Zusatzliche HART Variablen kdnnen QV zugewie- | 20000148 A
sen werden

Die Funktion Zahler starten/stoppen mit dem
Bedieninterface kann aktiviert oder deaktiviert
werden

Anwendung fiir die Mineral6lmessung verbes-
sert

Nullpunktwert als Displayvariable verfligbar

Optionen fir Einstellungen der Stérausgdnge er-
weitert

Temperaturalgorithmen fiir kryogene Anwen-
dungen neu

Einstellung Frequenzausgangsstabilitdt und Einheitenum-
rechnungen verbessert

Verarbeitung von Volumendurchfluss bei er-
kannter Schwallstromung verbessert

Verarbeitung von Dichtewerten und Kalibrierun-
gen wdhrend Stérbedingungen verbessert

Bedieninterface Konfiguration, Durchflussiiber-
wachung und optische Schalter gedndert

HART Kommunikation und Burst-Modus verbes-
sert

Funktion Anwendung fiir Mineraldlmessung hinzugefiigt

Option fiir eichgenauen Verkehr zur konfigurier-
baren E/A-Optionsplatine hinzugefiigt

HART Abfrage fiir externe(n) Druck/Temperatur
hinzugefiigt

06/2003 4.x Erweiterung Unterstiitzung fiir Auswerteelektronik 20000325 C
Modell 1500 hinzugefiigt 20000150 C
Auswerteelektronik Modell 1700 zeigt zusatzli- | 3600647 C
che Variablen an 20000148 B
Einstellung Verarbeitung bestimmter Alarmbedingungen 20001715A
verbessert

Verhalten bestimmter Modbus Kalibrierspeicher
geklart

Zusammenspiel zwischen bestimmten Dichte-
messeinheiten und Dichteabschaltwerten ge-
klart

Verarbeitung der mA Quelleneinstellung tiber
Bedieninterface verbessert

Druck- und Temperaturabfrage verbessert

HART Tri-Loop und andere Kommunikation ver-
bessert

Via Modbus skalierten Integerregister zuriickge-
gebener Wert wihrend Fehlerbedingung geklart
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Datum

Version

Typ

Anderung

Betriebsanlei-
tung

Funktion

Bindrwerte jetzt iber Modbus verfliigbar

09/2006

5.x

Erweiterung

Bindrausgang als Durchflussschalter zuweisbar

Storanzeige des Binarausgangs konfigurierbar

Unterstiitzung tber Bindreingang fiir mehrere
Aufgabenzuweisungen

Unterstiitzung fiir Abfrage des Bedieninterface
LED-Status via Modbus hinzugefiigt

HART und Modbus Befehle hinzugeftigt

Prozess-Komparator auf fiinf konfigurierbare
Ereignisse erweitert

Funktion zur Herstellung der Werkskonfigura-
tion

Funktion zur Nullpunktwiederherstellung

Alarmbhistorie erweitert

Schreibschutz fiir Konfigurationsdaten auswahl-
bar

Auswahl von Quellenzuordnungen fiir mA Aus-
gang erweitert

Speicherung von mA Bereichswerten erweitert

Anwendung fiir den eichgenauen Transfer fir
unabhangige Implantation der NTEP- und OIML-
Compliance erweitert

Einstellung

Display Verbesserungen fiir FlieRkommadaten

Funktion

Alarmstufe konfigurierbar

Gas Standardvolumen Funktionalitdt

Systemverifizierung als Option lieferbar

Mehrfach Display-Sprachenauswahl

200017158

09/2009

6.x

Erweiterung

Frequenzausgang als Bindrausgang bei Auswer-
teelektroniken der Serie 1000 konfigurierbar

Bindrausgang kann als Durchflussschalter bei
Auswerteelektroniken der Serie 1000 zugewie-
sen werden

Displayvariable 1 optional fixiert auf Prozessvari-
able, die dem primaren mA Ausgang zugewiesen
ist

Frequenzausgang Skaliermethode und zugehor-
ige Parameter (iber das Bedieninterface konfi-
gurierbar

Fir erweiterte Dichtemessung und Mineral6l-
messungen Prozessvariablen zeigt das Display
abwechselnd Variablennamen, Stromwert und -
einheit und Referenztemperatur an

20001715 BA
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Betriebsanlei-

Datum Version Typ Anderung tung
Einstellung Die folgenden Kombinationen sind nicht zulds-
sig:

* mA Ausgang Storaktion = Keine und Digital-
kommunikation Stéraktion = NAN

* Frequenzausgang Stoéraktion = Keine und
Digitalkommunikation Storaktion = NAN

Displayvariablen, die auf eine Volumenprozess-
variable eingestellt sind, schalten automatisch
zwischen Fliissigkeit und GSV, entsprechend den
aktuellen Einstellungen des Volumendurchflus-
stypsum

Funktion Hysterese fiir Durchflussschalter konfigurierbar

Feldverifizerungsnullpunkt zur Unterstiitzung
der Anwendung Weights & Measures hinzuge-
fugt

Priifsumme der Auswerteelektronik Firmware
und der Core Prozessor Firmware kénnen als Dis-
playvariablen zugewiesen und angezeigt werden
ProLink II
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Index

A

Abfrage
Druck
mit Handterminal 67
mit ProLink Il 63
mit ProLink Ill 65
Temperatur
Anwendung Konzentrationsmessung
mit Handterminal 58
mit ProLink Il 52
mit ProLink Ill 55
Anwendung Mineral6lmessung
mit Handterminal 50
mit ProLink Il 47
mit ProLink Il 48
Abgeleitete GroRe, siehe Anwendung
Konzentrationsmessung
Abgleichen, siehe mA-Ausgdnge, abgleichen
Abschaltungen
Dichte 44
Massedurchfluss 23
Stérungsanalyse und -beseitigung 214
Volumendurchfluss 28
address
HART address 113
Modbus address 117
Aktualisierungsrate
Auswirkung auf Prozessmessung 71
inkompatible Funktionen 71
Konfigurieren 70
Alarme
Alarmcodes 181
Antwort der Auswerteelektronik 138
Anzeigen und Quittieren
unter Verwendung des Handterminals 138
unter Verwendung von ProLink Il 136
unter Verwendung von ProLink Ill 137
Konfigurieren der Alarmbehandlung 73
Status Alarmstufe
Konfigurieren 74
Optionen 75
Stérungsanalyse und -beseitigung 181
Alarmmeldungen, siehe Alarme
Analogausgang Abschaltung 88
Antriebsverstéarkung
Daten sammeln 217
Stérungsanalyse und -beseitigung 215,216
Antwortzeit 72
Anwendung Konzentrationsmessung
Abgeleitete GroRen und berechnete
Prozessvariablen 62

Konfigurations- und Bedienungsanleitung

Konfiguration
mit Handterminal 58
mit ProLink Il 52
mit ProLink Il 55
Standardmatrizen 60
Ubersicht 52
Anwendung Mineral6lmessung
API-Referenztabellen 51
Konfiguration
mit Handterminal 50
mit ProLink Il 47
mit ProLink Il 48
Ubersicht 47
API, siehe Anwendung Mineralélmessung
Aufnehmer
Daten sammeln 218
Stérungsanalyse und -beseitigung 217
Auswerteelektronik
E/A-Anschlussklemmen 282
Installationsarten 280
Kommunikationsprotokolle 2
Modellcode 2
Spannungsversorgungs-Anschlussklemmen 282

B

basic events, siehe events
Berechnungsgeschwindigkeit 72
Bestdnde
Starten und Stoppen 139
Zuriicksetzen 140
Bindrausgdnge
Messkreistest
unter Verwendung des Handterminals 207
unter Verwendung von ProLink I 203
unter Verwendung von ProLink Ill 205
Stérungsanalyse und -beseitigung 201
Bindreingange
Messkreistest
unter Verwendung des Handterminals 207
unter Verwendung von ProLink I 203
unter Verwendung von ProLink Ill 205
Stérungsanalyse und -beseitigung 201
burst mode 114

C

channel configuration 83
Charakterisierung
Dichteparameter 10
Durchflusskalibrierparameter 9
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Index

Parameter flir Sensor-Tags 8
Verfahren 7
communications, siehe digital communications
configuration
channel 83
digital communications 112
discrete inputs 106
discrete outputs 100
events
basic 109
enhanced 110
frequency outputs 93
mA outputs 85
CTL 47
cutoffs
AO cutoff 88
interaction between AO Cutoff and process variable
cutoffs 89

D

Dampfung
Dichteddmpfung 43
Durchflussdampfung 21
Temperaturddmpfung 46
damping
Added Damping 90
interaction between Added Damping and process
variable damping 91
on mA outputs 90
Datum 80
DD, siehe HART-Geratebeschreibung (DD)
deadband, siehe hysteresis
Deskriptor 79
Diagnose
Messkreistest
unter Verwendung des Handterminals 207
unter Verwendung von ProLink Il 203
unter Verwendung von ProLink Il 205
Sensorsimulation 121
Smart Systemverifizierung 152
Dichte
Siehe auch Standarddichte
Dichtefaktor, siehe Druckkompensation
Dichtekalibrierung, siehe Kalibrierung, Dichte
Dichtemessung
Abschaltung
Konfiguration 44
Wirkung auf Volumendurchflussmessung 44
Dampfung
Wechselwirkung mit zusatzlicher Dampfung 44
Wirkung auf Volumendurchflussmessung 44
Konfiguration 40
Messeinheiten
Konfiguration 40
Optionen 40

Schwallstrémung
Konfiguration 41
Storungsanalyse und -beseitigung 215
Verhalten der Auswerteelektronik 42
Stérungsanalyse und -beseitigung 196
Systemfaktor 165
digital communications
configuring HART/Bell 202 parameters 113
configuring Modbus/RS-485 parameters 117
Digital Communications Fault Action
configuring 119
options 119
Digitale Kommunikation Stéraktion 119
discrete inputs
actions
configuring 107
options 107
configuring 106
polarity
configuring 108
options 109
discrete outputs
configuring 100
Fault Action
configuring 105
options 106
faultindication 106
flow switch 102
polarity
configuring 103
options 104
source
configuring 101
options 101
Display
Status LED-Zustdnde 181
Dokumentation 3
Druckkompensation
Druckmesseinheiten
Optionen 68
Konfiguration
mit Handterminal 67
mit ProLink Il 63
mit ProLink Ill 65
Ubersicht 63
dual-pulse mode 98
Durchflussdampfung
Konfiguration 21
Wechselwirkung mit zusatzlicher Dampfung 22
Wirkung auf Volumendurchflussmessung 22
Durchflussfaktor 63, 96, siehe Druckkompensation
Durchflussrichtung
Konfiguration 35
Optionen 35
Storungsanalyse und -beseitigung 214
Wirkung auf Bindrausgdnge 38
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Wirkung auf digitale Kommunikation 39

Wirkung auf Frequenzausgdnge 38

Wirkung auf mA-Ausgdnge 36

Wirkung auf Zahler und Bestdnde 39
Durchflussschalter (flow switch) 102

E

E/A-Anschlussklemmen 282
Eichamtliche Transfer Anwendung
Aufsichtsbehérden 125
Austausch des Core Prozessors 150
Auswirkung auf Betrieb und Wartung
NTEP 145
OIML 146
Auswirkung auf die Ausgange
NTEP 144
OIML 144
Auswirkung auf die Prozessvariablen
NTEP 144
OIML 144
Einstellung
mit ProLink Il 126
mit ProLink Ill 129
gesichert und ungesichert 125
Modi wechseln
mit dem Wechsel Hilfsprogramm 149
mit ProLink Il 148
mit ProLink Ill 148
Prozessdaten
NTEP 143
OIML 143
Sicherheitstypen 125
Statusalarm A027:Sicherheitsverletzung 125, 149
Ubersicht 125,126
Ubersicht (iber den Betrieb 142
Verplombung 126,129
Zdhler Riicksetzoptionen 126,129
Eichpflichtiger Transfer, siehe Eichamtliche Transfer
Anwendung
Einheit, siehe Messeinheiten
enhanced events, siehe events
Erdung
Storungsanalyse und -beseitigung 203
Erhohte Dichte, siehe Anwendung
Konzentrationsmessung
events
configuring basic events 109
configuring enhanced events 110
Enhanced Event Action
configuring 110
options 111
event models 109
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F

Fault Action
digital communications 119
discrete outputs 105
frequency outputs 99
mA outputs 91
Fehler-Zeitiiberschreitung
Auswirkung auf Stéraktion 73
Konfigurieren 73

Feldverifizierung Nullpunkt (FVZ), siehe Eichamtliche

Transfer Anwendung
Fliesskomma Byte Befehl 117
frequency outputs

configuring 93

Fault Action

configuring 99
options 100
maximum pulse width 97
mode
configuring 98
options 98
polarity
configuring 94
options 95
process variable
configuring 93
options 94
scaling method
configuring 95
Frequency = Flow 96
Frequenzausgdnge
Messkreistest

unter Verwendung des Handterminals 207

unter Verwendung von ProLink Il 203
unter Verwendung von ProLink Il 205
Storungsanalyse und -beseitigung 200, 213
Frequenzfaktor 96

G

Geratebeschreibung (DD), siehe HART-
Geratebeschreibung (DD)
gesichert, siehe Eichamtliche Transfer Anwendung

GSV, siehe Standard-Gasvolumendurchflussmessung

H

Handterminal

Geratebeschreibung (DD) 261

Mendistruktur 265

Startverbindung 6

Ubersicht 261,262

Verbindung mit der Auswerteelektronik 262
HART

address 113

Adresse 211
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burst mode 114
Burst-Modus 212
Geratebeschreibung (DD) 261
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